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Foreword

This draft of the RCMDD Protocol Book (as of March, 2011) is the principal written contribution 
to the RCMDD by the staffs of the Egyptian Museum Registrar Training Project (EMRTP) and the 
Egyptian Museum Database Project. Funded by a United States Agency for International 
Development (USAID) grant to the American Research Center in Egypt (ARCE), the EMRTP was 
inaugurated in 2006 with the goal of creating a collections management system for the Egyptian 
Museum, Cairo, and training a group of registrars, the first ever in Egypt, to implement this 
system. This project is complemented by the Egyptian Museum Database Project (EMDP), funded 
by a grant from the Andrew W. Mellon Foundation to ARCE. 

The protocols outlined here have been developed over the past three years from a document 
originally produced in December of 2006 by EMRTP Principal Project Consultant, Rachel 
Mauldin, and the EMRTP and EMDP Project Director, Janice Kamrin. The current procedures 
reflect the experience gained from the actual work of the registrars in the context of the museum 
itself, and have been rewritten (in 2009-2011) to incorporate the use of the museum’s new 
collections management database system, KE EMu. All of the project participants (listed below) 
have made major contributions to this document.

These protocols are designed to be updated whenever needed. One archival hard copy is to be 
kept on file, and one active hard copy should be used by the office staff. All staff members should 
keep a pdf version on their computers for easy consultation. Any corrections to the protocols 
should be written directly in the active hard copy, and incorporated into the soft copy of the 
document by the department heads as soon as possible. As the corrections are made in the soft 
copy, they should be checked off on the hard copy.

The soft copy of the protocols (a Pages document) will be maintained by the department heads, 
who will send updated copies to their staff in pdf form as soon as corrections are made. The 
master file will be stored in the RCMDD system, as per the protocols below.

Janice Kamrin, ARCE-EMRTP, EMDP  Hanane Gaber, EMC

Rachel Mauldin, ARCE-EMRTP, EMDP  Yasmin El Shazly, EMC

Elina Nuutinen, ARCE-EMRTP   Amina El Baroudi, EMC

Sari Nieminen, ARCE-EMDP   Doha Fathy, EMC

Nora Shalaby, ARCE-EMRTP, EMDP  Marwa Abdel Razek, EMC

Sara Kayser, ARCE-EMDP    Dalia Galal, EMC

Stephanie Boucher, ARCE-EMRTP   Angy Abdelaziz, EMC

Alan Francisco, ARCE-EMRTP   Ghada Tarek, EMC

Andrew Bednarski, ARCE-EMRTP   Mohamed Osman, EMC

       Eman Mohamed, EMC-GEM

       Amr Farouk, EMC
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Part I:

Introduction and 
Overview
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1. Introduction and Overview of RCMDD Protocols
The following manual contains information and procedures to be followed by the registrars of the 
Egyptian Museum, arranged in cross-referenced protocols that are broken down in the following 
large sections:

Part I: Introduction and Overview

This is an introductory section, which reviews the mission and organization of the office, 
provides job descriptions for each of the positions within the office, and briefly outlines the three 
main documentation systems in use at the RCMDD: the Database System, the Manual System, 
and the Computer Organization System.

Part II: Documentation

Here you will find detailed protocols for creating, cross-checking, copying, and approving 
catalogue records, along with overview of the multimedia and location modules, both of which 
are essential to elements of a basic object record (defined as a catalogue record with at least one 
reference image and a location).

Part III: Documentation Support

This section provides background on processes and modules that support basic object 
documentation, including image acquisition and management, the basics of determining and 
recording locations, and measuring objects, as well as introductions to the narratives, events, 
parties, and bibliography modules.

Part IV: Information Management Processes

This section provides information on processes such as searching the database, creating groups, 
sorting records, importing and exporting records, finding ID numbers, exporting records to Excel, 
and running Reports.

Part V: Collections Management

This section contains detailed protocols for collections management activities, including: 
Accessioning and De-Accessioning; Permanent Locations; Gallery Mapping and Inventories; 
Current Locations and Object Movement; Outgoing Loans; In-house Exhibitions; Outside 
Requests; and Condition Reporting.

Part VI: Office Management

The final part of the protocols details the setup for the office and reviews the manual and 
computer systems. It also covers IT and supply protocols.

Part VII: Administration

This section is primarily for the use of the department heads and a limited group of senior 
registrars. Only a small group of registrars need to be able to carry out the procedures outlined 
here, which include doing Global Replaces, dealing with the EMu Registry, setting up Lookup 
Lists, and creating and editing Crystal Reports.
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Appendix

A number of supporting documents are either described or attached here. These include the path 
to RCMDD Authority Lists, important office permissions, and various guidelines and policies.
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2. Mission Statement
The Registration, Collections Management, and Documentation Department (RCMDD) of the 
Egyptian Museum, Cairo, will henceforth be responsible for overseeing a centralized system for 
the care, maintenance, and documentation of the collections of the Egyptian Museum, in both 
paper and digital format. This department will report directly to the Director of the Egyptian 
Museum, and to the Secretary General of the Supreme Council of Antiquities. 

The duties of the registrars and their staff will include:

❖ Assisting the section heads with the accessioning of new objects, including registering 
objects in the Journal d’entrée and completing database records for new or never-before 
registered objects;

❖ Tracking all object movement, and updating the museum’s centralized records 
accordingly, both on paper and digitally;

❖ Coordinating and managing various aspects of outgoing loans and in-house exhibitions, 
and recording all loans and exhibitions both on paper and digitally; 

❖ Carrying out object inventories and maintaining accurate centralized location records 
for all museum objects;

❖ Completing condition reports on collection objects and updating museum records 
accordingly (as of March 2011: currently only during inventory work);

❖ Recording conservation and restoration events (for future implementation);

❖ Attending, where appropriate, committees for object study and photography, for the 
purpose of inventorying objects; 

❖ Whenever possible, obtaining additional data, such as photographs and updated object 
information from scholars and photographers, and incorporating this data into the 
museum’s centralized records;

❖ Keeping all centralized object records, both on paper and in the museum database, up 
to date, accurate, and retrievable;

❖ Managing and maintaining oversight of didactic material, such as labels and panels, for 
museum objects and galleries.

To successfully carry out their duties, the registrars will work very closely with the curatorial staff, 
supporting the work of the curators and serving the public trust by helping to streamline the 
museum’s processes, by creating a new layer of control and accountability, and by increasing 
accessibility of key data to authorized parties.

The RCMDD will be open Sunday through Thursday, 9:30 am to 2:00 pm. Whenever the office is 
open, at least one registrar will be present to check out register books to authorized users, 
provide forms and lists to curators and other authorized museum staff who need them, and liaise 
with researchers and photographers.
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This mission statement is supported by a decree issued by the Secretary General of the Supreme 
Council of Antiquities and submitted to the Ministry of Culture in 2007 (see Permissions and 
Decrees).
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3. RCMDD Organization
The following chart shows the basic organization of the RCMDD, including how the collections 
management and documentation processes are both distinct and overlapping.
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4. RCMDD Personnel

4.1. RCMDD Personnel Structure

The following chart outlines the current personnel structure of the office.

4.2. Job Descriptions

The following section lists the current and ideal positions within the department, as illustrated in 
the chart above. Each job description includes a title, the person to whom the position reports, 
principal duties and responsibilities in narrative form, a general section in which duties and 
responsibilities are listed in bullet form, minimum qualifications, and specialized qualities 
desired for the position.
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4.2.1. Head Registrar

Reports to:  Director of Egyptian Museum

Principal Duties and Responsibilities

Manage the Egyptian Museum’s RCMDD. Oversee all collections management processes, 
including, but not limited to, loans and exhibitions, object movement, and gallery inventories. 
Take responsibility for overall organization, development, and maintenance of permanent 
collection documentation in both paper and digital formats. Major duties include cataloging and 
documenting objects, object tracking and inventory. Supervise the personnel of the Registration 
and Collections Management; hire and train new staff, as needed.

General

• Lead the RCMDD staff in assisting with the activities of Egyptian Museum personnel, 
including the director and the curatorial staff, with regard to accessioning, documenting, 
displaying, and tracking of the Museum’s collection of objects.

• Develop, implement, and enforce policies and procedures pertaining to accessioning, 
lending, management, and disposition of collection objects.

• Attend Egyptian Museum and SCA meetings regarding review of requested objects for 
outgoing loans and in-house exhibitions, including Loan and Exhibition Committee and 
Museum Board meetings. 

• Manage and assist with logistical arrangements of objects for outgoing loans with curators, 
conservators, and outside contractors. Assist with loan agreements, object preparation, 
packing/crating, scheduling, and courier arrangements for objects going out of the museum 
on loan.

• Working with the Museum Director, curatorial staff, and outside organizers, supervise 
temporary exhibitions at the Egyptian Museum. Oversee the installation, object receipt, 
creation of object lists, return of objects, and photo documentation of temporary exhibits. 
Ensure that all documentation files are updated related to museum objects in temporary 
exhibits.

• Oversee the registrarial documentation of loans and exhibitions, including the creation of 
object lists, receipts, and other tools for object tracking.

• Assist the curatorial staff and supervise the registrars with transfer of objects from the Egyptian 
Museum to other museums under the jurisdiction of the Supreme Council of Antiquities. 
Assist in the updating of all documentation files regarding such transfers.

• Work with outside contracted companies to carry out services and activities such as packing 
and crating. Ensure that all packing and crating is overseen by registrarial staff.

• Oversee and manage the inventory process. Ensure that gallery maps are completed and 
updated, update object and gallery / vitrine photos, and update object locations in 
appropriate documentation files. Provide appropriate gallery inventory information to 
curatorial staff.
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• Assist curatorial staff by providing registrarial personnel to check and record object 
identification and location tracking during all object movements. Ensure that documentation 
files are updated upon completion of all object movements.

• Perform, assist, or supervise systems administration with regular backups as well as data 
quality control and data entry in the collections management database.

• Assist with the process of interviewing and selecting prospective RCMDD employees; 
evaluate performance of associate and assistant registrars annually.

• Interview, train, and manage volunteers for the RCMDD.

• Provide monthly written reports to the Director of the Egyptian Museum and report any 
protocol inconsistencies experienced by the RCMDD to the Director. Update the RCMDD on 
new Museum activities and protocols.

• Adhere to and assist in enforcing the Egyptian Museum’s policies.

Minimum Qualifications

• Strong knowledge of history of pharaonic Egypt.

• Proficient in Word, Excel, Photoshop, etc.; comfortable with database work.

• Management experience preferred.

• Ability to work efficiently with professional staff and the public.

Specialized

Exhibit a high level of discipline, attention to detail and professional judgment.
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4.2.2. Head of Documentation

Reports to:  Director of Egyptian Museum

Principal Duties and Responsibilities:

To manage and maintain the accuracy and completeness of the documentation contained in the 
Egyptian Museum’s collections management database. This documentation includes 
Egyptological data, images, and object history (location and movement history, as well as 
exhibition and loan information). Major duties include training and supervising the curatorial and 
registrarial staff to collect and verify object information, and to supervise the registrars in keeping 
the collections management database accurately updated.

General

• Support and assist activities of Egyptian Museum personnel – Director, Section Heads, and 
Curators – with regard to obtaining updated object information in order to keep the 
collections database accurate.

• Develop, implement, and enforce protocols for updating the collections management 
database, and train and supervise the staff of the RCMDD, as needed.

• Coordinate with the Head Registrar regarding regular backups, data quality control, and data 
entry on the collections database.

• Assist curatorial staff to access information on collection objects from the database.

• Assist the RCMDD and curatorial staff with initial and regular gallery inventories to ensure 
accurate database records are created and maintained for all museum objects.

• With the assistance and support of the RCMDD and the curatorial staff, review ID numbers 
and object information for all artifacts being accessioned into or leaving the Egyptian 
Museum.

• With the assistance and support of the RCMDD and the curatorial staff, review and approve 
all object lists connected with loans and exhibitions.

• Supervise and manage the creation and production of exhibit labels and panels for the 
museum’s permanent collections.

• Adhere to and assist in enforcing the Egyptian Museum’s policies.

• Liaise with the RCMDD and curatorial staff to assist with the fulfillment of requests from 
outside scholars for information on objects in the Museum’s collection. Ensure that the 
collections database is updated with information provided by scholars, and that material that 
supports new information is included in the records and made available to the curatorial staff.

• Attend Egyptian Museum and SCA meetings as needed, and be an advocate for effective 
coordination between the registrarial and curatorial staff.

Minimum Qualifications

• Strong knowledge of history of pharaonic Egypt.

• Proficient in Word, Excel, Photoshop, etc.; comfortable with database work.

• Management experience preferred.
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• Ability to work efficiently with professional staff and the public.

Specialized

Exhibit a high level of discipline, attention to detail and professional judgment.
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4.2.3. Associate Registrar for the Permanent Collections

Reports to:  Head Registrar and Head of Documentation

Major Duties

Under the supervision of the Head of Documentation, is responsible for organizing and 
maintaining permanent collection documents in both paper and digital formats.  Duties include 
cataloging and documenting objects for acquisition into the permanent collection of the museum 
and transfer out of the museum, supervision of permanent object moves; condition reporting, and 
gallery inventory.      

General

• Assist in data-entry of permanent collection object records into collections management 
database. Assist department in obtaining additional information from Curatorial files and 
outside scholars and researchers, as necessary. Maintain backup files on the computer as 
required by registration protocols.

• Generate and organize documentation related to accessioned objects and new acquisitions to 
the permanent collection in paper based collection file system, including legal documents 
and correspondence, object catalogue cards, condition reports, photography, and other 
paperwork related to an object’s history. Enter new accessions in the Journal d’entrée, in 
collaboration with the section heads.

• Assist Curators and RCMDD with transfer of objects from the Egyptian Museum to other 
museums under jurisdiction of the Supreme Council of Antiquities. Assist in updating all 
documentation files regarding the transfers.

• Supervise handling of objects and updating of museum records, both computerized and 
manual, during the following types of movements:

movement of permanent collection objects to new permanent locations, 

movement of permanent collection objects or objects brought into the museum 
temporarily for exhibitions

• Assist other registrars in work with outside scholars, photographers, and contracted 
companies to carry out services/activities such as object study, photography, and packing and 
crating. 

• Supervise initial and regular inventories of the museum’s gallery and storage spaces.

• Assist the RCMDD in maintaining location information for all collection objects.

• Assist in enforcing the Egyptian Museum’s policies and rules with regard to proper object 
handling and preventive care of the collection.

• Assist Curators on special projects including object research, loan and exhibition checklists, 
label information, and object inventory checks.

Minimum Qualifications

• Basic knowledge of history of pharaonic Egypt.

• Basic computer skills.
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• Ability to work efficiently with professional staff and the public.

Specialized

Exhibit a high level of discipline, attention to detail and professional judgment. 
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4.2.4. Associate Registrar for Loans

Reports to: Head Registrar

Major Duties

Under the supervision of the Head Registrar, is responsible for managing and coordinating the 
objects requested and approved for out-going loans. Duties include documentation of objects for 
out-going loans, as well as assisting with the department’s day-to-day activities related to 
managing the Museum’s collection of objects, including, but not limited to, inventory and 
maintenance of documentation systems.      

General

• Work with curators, conservation staff, and borrowing institutions to coordinate and manage 
aspects of out-going loans including: building preliminary and final object lists, tracking all 
object movements related to the loan, tracking the packing and crating of out-going objects, 
monitoring courier arrangements, updating of documentation files regarding the loan of an 
object, and return of out-going loans to the Museum. This responsibility includes both objects 
from the Egyptian Museum’s permanent collections and objects from other museums and 
magazines within the SCA that form parts of these loans.

• Monitor and track objects that are on loan to other institutions.

• Maintain out-going loan files and database records.

• Assist Curators and RCMDD with transfer of loan objects from the Egyptian Museum to other 
museums under the Supreme Council of Antiquities. Assist with updating all documentation 
files regarding the transfers.

• Assist in entry of information into permanent collection object records in collections 
management database.  Assist department in obtaining additional information from Curatorial 
files and scholars, as necessary.  Maintain backup files on the computer as per RCMDD 
protocols.

• Oversee paperwork and database data entry for object movements related to loans.

• Assist Head of Documentation with outside scholars, photographers, and contracted 
companies to carry out services/activities such as object study and photography. 

• Assist in enforcing the Egyptian Museum’s policies and rules with regard to proper object 
handling And preventive care of the collection.

• Assist Curators on special projects including object research, exhibition checklists, label 
information, and object inventory checks.

Minimum Qualifications

• Basic knowledge of history of pharaonic Egypt.

• Basic computer skills.

• Ability to work efficiently with professional staff and the public.

Specialized

Exhibit a high level of discipline, attention to detail and professional judgment.
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4.2.5. Associate Registrar for Exhibitions

Reports to: Head Registrar

Major Duties

Under the supervision of the Head Registrar, is responsible for managing and coordinating the 
objects requested and approved for in-house exhibitions. Duties include documentation of 
objects for in-house exhibitions, as well as assisting with the department’s day-to-day activities 
related to managing the Museum’s collection of objects, including, but not limited to, inventory 
and maintenance of documentation systems.      

General

• Work with the museum’s Exhibition Coordinator, curators, conservation staff, and exhibition 
organizers to coordinate and manage aspects of in-house exhibitions including: building 
preliminary and final object lists, overseeing all object movements related to the exhibition, 
overseeing the receiving of non-Egyptian Museum objects into the museum, updating of 
documentation files regarding the exhibition of an object, inventorying, mapping, and 
monitoring the exhibition itself, and tracking the return of exhibition objects to their original 
storage facilities or museums.

• Monitor and track objects that are on exhibition in the museum.

• Maintain in-house exhibition files and database records.

• Assist Curators and RCMDD with transfer of exhibition objects from the Egyptian Museum to 
other museums under the Supreme Council of Antiquities. Assist with updating all 
documentation files regarding the transfers.

• Assist in entry of information into permanent collection object records in collections 
management database.  Assist department in obtaining additional information from Curatorial 
files and scholars, as necessary.  Maintain backup files on the computer as per RCMDD 
protocols.

• Oversee paperwork and database data entry for object movements related to exhibitions.

• Assist Head of Documentation with outside scholars, photographers, and contracted 
companies to carry out services/activities such as object study and photography. 

• Assist in enforcing the Egyptian Museum’s policies and rules with regard to proper object 
handling and preventive care of the collection.

• Assist Curators on special projects including object research, exhibition checklists, label 
information, and object inventory checks.

Minimum Qualifications

• Basic knowledge of history of pharaonic Egypt.

• Basic computer skills.

• Ability to work efficiently with professional staff and the public.

Specialized

Exhibit a high level of discipline, attention to detail and professional judgment.  
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4.2.6. Associate Registrar for Object Movement

Reports to: Head Registrar; Associate Registrars for the Permanent Collections, Loans, and 
Exhibitions

Major Duties

Under the supervision of the Head Registrar, is responsible for assisting with all object 
movements within the museum, and working with the Associate Registrars for the Permanent 
Collections, Loans, and Exhibitions to make sure all movements are attended and entered into 
the database. Responsible for working with the Curatorial Coordinator to make sure activities 
involving museum committees are approved and scheduled. Duties include assisting with the 
department’s day-to-day activities related to managing the Museum’s collection of objects, 
including, but not limited to, inventory and maintenance of documentation systems.      

General

• Assist with the scheduling of committees for object movement within the museum.

• Assist with the monitoring and tracking of all objects that are moved into and out of the 
Egyptian Museum.

• Assist with the monitoring and tracking of all objects that are moved within the Egyptian 
Museum, either temporarily or permanently. This includes but is not limited to: objects moved 
into new displays; objects moved for conservation purposes; objects moved for temporary 
storage; and objects moved for the purposes of study or photography.

• Oversee entry of movement information into permanent collection object records in 
collections management database, maintain movement files, and make sure movement 
records are checked by the appropriate Associate Registrars.  Assist department in obtaining 
additional information from Curatorial files and scholars, as necessary.  Maintain backup files 
on the computer as per RCMDD protocols.

• Assist Head of Documentation with outside scholars, photographers, and contracted 
companies to carry out services/activities such as object study and photography. 

• Assist in enforcing the Egyptian Museum’s policies and rules with regard to proper object 
handling and preventive care of the collection.

• Assist Curators on special projects including object research, exhibition checklists, label 
information, and object inventory checks.

Minimum Qualifications

• Basic knowledge of history of pharaonic Egypt.

• Basic computer skills.

• Ability to work efficiently with professional staff and the public.

Specialized

Exhibit a high level of discipline, attention to detail and professional judgment. 
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4.2.7. Associate Registrar for IT

Reports to: Head of Documentation and Head Registrar

Major Duties

Under the supervision of the Head of Documentation and the Head Registrar, is responsible for 
overseeing the IT needs of the RCMDD. Duties include assisting with the department’s day-to-day 
activities related to managing the Museum’s collection of objects, including, but not limited to, 
inventory and maintenance of documentation systems.      

General

• Making daily, weekly, and monthly backups of the database.

• Making weekly backups of the RCMDD’s active files.

• Keeping the database working and taking responsibility for bringing it back up if it goes down. 

• Maintaining the electronic equipment, including but not limited to the server, the computers, 
the backup drives, and the printers.

• Keeping the office network and Internet connection working.

• Assisting RCMDD staff in all IT-related issues.

• Liaise with external IT support when needed.

• Maintain the IT records for the office, including supervision and tracking of passwords.

• Assist Head of Documentation with outside scholars, photographers, and contracted 
companies to carry out services/activities such as object study and photography. 

• Assist in enforcing the Egyptian Museum’s policies and rules with regard to proper object 
handling and preventive care of the collection.

• Assist Curators on special projects including object research, exhibition checklists, label 
information, and object inventory checks.

Minimum Qualifications

• Basic knowledge of history of pharaonic Egypt.

• Advanced computer skills.

• Ability to work efficiently with professional staff and the public.

Specialized

Exhibit a high level of discipline, attention to detail, and professional judgment.
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4.2.8. Associate Registrar for Office Management

Reports to: Head Registrar

Major Duties

Under the supervision of the Head Registrar, is responsible for making sure the office is 
organized. This includes but is not limited to overseeing the physical plant, making sure all 
aspects of the manual system are in place, and making sure necessary supplies are available. 
Duties include assisting with the department’s day-to-day activities related to managing the 
Museum’s collection of objects, including, but not limited to, inventory and maintenance of 
documentation systems.      

General

• Assist with the planning and execution of all aspects of the physical plant.

• Oversee the manual system, including the contents of all filing cabinets, Bookcases, and other 
storage furniture.

• Make sure the RCMDD library is organized, properly labeled, and kept in order.

• Make sure the RCMDD is adequately supplied, and order supplies when needed.

• Make sure the Xerox machine is in working order.

• Assist Head of Documentation with outside scholars, photographers, and contracted 
companies to carry out services/activities such as object study and photography. 

• Assist in enforcing the Egyptian Museum’s policies and rules with regard to proper object 
handling and preventive care of the collection.

• Assist Curators on special projects including object research, exhibition checklists, label 
information, and object inventory checks.

Minimum Qualifications

• Basic knowledge of history of pharaonic Egypt.

• Basic computer and organizational skills.

• Ability to work efficiently with professional staff and the public.

Specialized

Exhibit a high level of discipline, attention to detail and professional judgment.
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4.2.9. Associate Registrar for Imaging

Reports to: Head of Documentation and Head Registrar

Major Duties

Under the supervision of the Head of Documentation and the Head Registrar, is responsible for 
all activities related to the image bank. This includes making sure that all images of museum 
objects and events are entered properly into the database and linked to their related records, and 
managing academic requests for museum images. Duties include assisting with the department’s 
day-to-day activities related to managing the Museum’s collection of objects, including, but not 
limited to, inventory and maintenance of documentation systems.

General

• In consultation with the Museum Section Heads, assist the heads in making sure that a 
registrar is present for all outside photography sessions about which the department is 
informed.

• Create an event record for each outside photography session and follow all RCMDD 
protocols for tracking the session and making sure that the photographs are incorporated 
properly into the image bank, linked to their relevant records, and stored properly in the 
backup system.

• Oversee the cleanup of the image bank by making sure that all available images are in the 
database, linked properly to their relevant records, and stored properly in the backup system.

• Oversee the project to scan the IDSCC slides and import them into the database.

• Make sure that all RCMDD photography is properly processed according to the RCMDD 
protocols and train any new RCMDD employee on the photography protocols.

• Assist the department heads to fill outside requests for museum images.

• Assist Head of Documentation with outside scholars, photographers, and contracted 
companies to carry out services/activities such as object study and photography.

• Assist in enforcing the Egyptian Museum’s policies and rules with regard to the Rights and 
Reproductions Policy of the SCA.

• Assist in enforcing the Egyptian Museum’s policies and rules with regard to proper object 
handling and preventive care of the collection.

• Assist Curators on special projects including object research, exhibition checklists, label 
information, and object inventory checks.

Minimum Qualifications

• Basic knowledge of history of pharaonic Egypt.

• Advanced computer and graphic design skills.

• Ability to work efficiently with professional staff and the public.

Specialized

Exhibit a high level of discipline, attention to detail and professional judgment.
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4.2.10.  Associate Registrar, Assistant to the Heads

Reports to: Head of Documentation and Head Registrar

Major Duties

Under the supervision of the Head of Documentation and the Head Registrar, is responsible for 
assisting the Heads in whatever capacity is needed and at the Head's discretion, to effectively 
and efficiently maintain the RCMDD. General duties include, but are not limited to, the 
following: 

General

• Assist the department heads to organize, track, and fill Outside Requests according to the 
protocols of the RCMDD.

• Take principal responsibility for completing and updating maps of all of the museum’s 
galleries as part of the RCMDD’s inventory project, according to the protocols of the RCMDD.

• Assist the department heads and the Museum Director with translation of documents from 
English to Arabic, as needed and appropriate.

• Assist Head of Documentation with outside scholars, photographers, and contracted 
companies to carry out services/activities such as object study and photography.

• Assist in enforcing the Egyptian Museum’s policies and rules with regard to the Rights and 
Reproductions Policy of the SCA.

• Assist in enforcing the Egyptian Museum’s policies and rules with regard to proper object 
handling and preventive care of the collection.

• Assist Curators on special projects including object research, exhibition checklists, label 
information, and object inventory checks.

Minimum Qualifications

• Basic knowledge of history of pharaonic Egypt.

• Advanced computer and graphic design skills.

• Ability to work efficiently with professional staff and the public.

Specialized

Exhibit a high level of discipline, attention to detail and professional judgment.
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4.2.11. Registrarial Assistant

Reports to:  Head Registrar and Head of Documentation

Major Duties

Under the supervision of the Head of Documentation and Head Registrar, is responsible for 
supporting the work of the senior RCMDD staff, including but not limited to the handling of day-
to-day requests by curators, scholars, photographers, security staff, etc. for object study and 
photography. Additional duties include assisting the registrarial staff with maintaining and 
managing the collection and the records.     

General

• Assist Head of Documentation, Head Registrar, and Associate Registrars, as assigned by 
department heads, to carry out their regular duties.

• Assist in updating both paper and digital collection information in proper files and systems. 
Assist department in obtaining additional information from Curatorial files and outside 
researchers, as necessary.  Assist in the maintenance of backup files on the computer as 
requested.

• Assist Head of Documentation with outside scholars, photographers, and contracted 
companies to carry out services/activities such as object study and photography. 

• Assist in enforcing the Egyptian Museum’s policies and rules with regard to proper object 
handling and preventive care of the collection.

• Assist Curators on special projects including object research, exhibition checklists, label 
information, and object inventory checks.

Minimum Qualifications

• Basic knowledge of history of pharaonic Egypt.

• Basic computer skills.

• Ability to work efficiently with professional staff and the public.      

Specialized

Exhibit a high level of discipline, attention to detail and professional judgment.
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5. Overview of the RCMDD Documentation and Collections 
Management System

The Egyptian Museum Registration, Collections Management and Documentation Department 
(henceforth RCMDD) is responsible for maintaining both computerized and manual systems to 
document and track the collections of the Egyptian Museum, Cairo. The computerized system is 
organized around a KE EMu collections management database (the original Filemaker Pro 
database is now a legacy system, frozen as of March 1, 2009). The manual system consists of a 
series of forms, notebooks, logbooks, and files that are used to record and augment data to be 
entered into the Egyptian Museum database, and to back up the database system. The office also 
has procedures in place for storing and sharing computer files on a network, and for backing up 
all computer files, as well as the database.

5.1. Egyptian Museum Database System: KE EMu

The Egyptian Museum database was migrated to KE EMu from the original Filemaker Pro system 
in March 2009. The database is currently stored on a server in the RCMDD office, and is 
accessed remotely by the SCA-ARCE team through Ethernet and wireless networks. 

The following protocol outlines: How to sign on to the database; the principal features of the 
database screen; the principal database modules in use by the RCMDD; and the principal 
database views.

5.1.1. How to sign on to the database

When working on the database, all team members should sign on to the database through the 
remote server connection:

Make sure that the server is turned on (it should be left on all the time).  As long as the server is 
on, it can be accessed remotely either from the office workstations (wired with Ethernet cables), 
or via the wireless network (this must also be turned on).

KE EMu runs on the Windows platform, and must therefore be run on Parallels if one is using a 
Mac. Take the following steps to access the database (if on a PC, begin with Step 3):

1. Open Parallels on your computer by selecting it from the dock or the 
Applications folder.

2. In the Microsoft XP window, click on the green arrow to start 
windows:
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3. When Windows is open, go to your PC desktop and click on the KE 
EMu (EM) shortcut on your screen, or alternatively go to Start->All 
Programs->KE Emu (EM).

4. The welcome screen will appear. If your Host and/or Service fields 
are empty, then enter the information as follows: 
Host: 192.168.5.254; Service: emu.

5. Type your username and password into the 
appropriate fields, and press OK. Usually the 
username will be remembered by your computer 
so you won’t have to type it in the next time, but 
you need to remember your password.

6. If you have logged on successfully, the 
COMMAND CENTRE will appear on your screen, 
normally down the left-hand side. You can use the Command Centre to 
open one or more modules of EMu. When you click on a module in the 
Command Centre, it will open in Search mode, so you will always begin 
your work by doing a search for one or more records (see Searching the 
Database).
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5.1.2. Principal Features of the Database Screen

The EMu database screen looks basically the same, no matter which module you are in. The 
following are the major features of the screen:

1. The bar at the top (Title Bar) tells which module you are in, how many windows from this 
module are open, and which mode you are in (Search, Display, New, or Edit)

2. This is the Menu Bar. All of the words here are menu items that take you to drop-down 
menus.

3. This is the Tool Bar. Clicking on the icons here will allow you to do the following (from left to 
right):

Page icon: Create a new record

Disk Icon: Save your record

Delete Icon: Delete the record

Search Icon 1: Returns to the previous search

Search Icon 2: Starts a new search

Search Icon 3: Discard selected records
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Sort Icon

Notepad: Goes to Reports

Spelling

List View Icon

Contact Sheet View Icon

Summary View Icon

Detail View Icon

Go to First Record

Go back one record

Go to Last Record

Go forward one record

Attach current record

Attach current group of records

4. IRN (Internal Record Number, automatically generated by EMu) + Record Summary + 
Thumbnail (if desired -- set by toggling View->Thumbnails on and off)

5. Data (as Fields in List or Detail View; as Images in Contact Sheet View)

6. Tabs (only in Detail View)

7. Status Bar: Mode, number of objects and record you are on within found set, username, 
service
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5.1.3. The Principal Modules in use by the RCMDD

KE EMu consists of 26 modules, of which the RCMDD currently uses 16.

1. Catalogue

2. Events

3. Loans

4. Locations

5. Bibliography

6. Parties

7. Narratives

8. Multimedia

9. Condition Checks

10. Internal Movements

11.Valuations

12.Lookup Lists

13.Groups

14.Registry

15.Admin

16.Help
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5.1.3.1. Catalogue Module 

The core module of the database is the 
Catalogue Module. This is where the 
basic information for each object is 
stored. Information from other modules, 
such as Multimedia, Locations, and 
Loans is visible in this module.

5.1.3.2.  Events Module 

The Events Module is used primarily for 
the following purposes: to store and 
track venues for traveling loans and in-
house exhibitions; to store and track 
information about outside requests; and 
to store information and images 
connected with other events such as 
movements, photography sessions, 
parties, and incidents involving objects. 
This module is also used to store and 
generate memos and to manage signed 
decrees.

5.1.3.3.  Loans Module 

The loans module, along with the 
events module, is used to track both 
traveling loans and in-house 
exhibitions.

RCMDD Protocols 12-2010  44



5.1.3.4.  Internal Movement Module

The Internal Movement module is 
where the movements are stored. All 
object movements and locations (both 
Current and Permanent locations) 
should be entered in the Location tab of 
the Catalogue module, but if a 
movement record needs to be edited, it 
should be done in this module.

5.1.3.5.  Location Module 

The Location module stores all specific 
locations within the museum, and 
general locations outside the museum 
(such as other museums and magazines 
in the SCA system). It contains 8 levels, 
a location code field in which the 
RCMDD records information about the 
location itself or information about 
where the location information has 
been acquired, and a field for the name 
of the location supervisor.

5.1.3.6.  Bibliography Module

This module stores information about 
books, articles, and websites that 
contain information about museum 
objects. There should be only one 
record for each individual book or 
article; specific page and plate numbers 
are recorded in the catalogue module.
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5.1.3.7.  Parties Module

The names, positions, and contact 
details for all people and institutions 
connected with the museum or the 
database in any way are stored in this 
module.

5.1.3.8. Narratives Module

Text for display labels and didactic 
text for the Internet is stored here.

RCMDD Protocols 12-2010  46



5.1.3.9.  Multimedia Module

All multimedia files are stored in this 
module. The RCMDD currently uses 
this for object images, facsimiles of the 
register books, and event images; any 
type of computer file can be linked here 
(including Word documents and pdfs). 
Multimedia Records can be linked to 
relevant object and event records, as 
well as to Location and Loan records. 
This is also used to store pdfs that can 
be linked to Bibliography records.

5.1.3.10. Valuations Module

This is an audit module where 
insurance values associated with 
objects (especially those going out on 
loan) are visible; these are entered in 
the Valuations tab of the Catalogue 
module.
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5.1.3.11.  Lookup Lists Module

This is where the lookup lists that appear in a number of 
the database fields can be set up and edited. It is an 
administrative module, and requires special training to use.

5.1.3.12.  Groups Module

We access this module directly to set 
the security on Groups, which we 
otherwise work with through other 
modules, such as the catalogue module. 
More information about groups of 
records that are put together for various 
purposes can be entered here if needed. 
This may be a module that is used more 
in the future. 
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5.1.3.13.  Registry Module

This module is to be accessed only by 
the administrative team. This is where 
permissions are set, defaults are 
created, etc. Special training is 
required for the use of this module.

5.1.3.14.  Help Module

This is an important module, which 
contains general information about 
how to use the database. It is a 
reference module, and can be 
accessed by everyone.
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5.1.4. Using the Modules

In order to open any of the modules, click on the corresponding button in 
the COMMAND CENTRE.

You can open as many 
modules as will fit on your 
screen, and the most recently 
opened module will display 
on top. 

If you wish to open more than 
one window for the same module at the same time, 
for example 2 Multimedia modules, you can either 

Go to Window->New->Multimedia OR

Apple/Command/Cntrl-click on the module for which you want to open a second window. 

5.1.5. Database Views

All of the database modules can be viewed in several ways, accessed through 
Menu Bar->View, or the icons in the Tool bar.

LIST VIEW: This is the default view in which the 
database modules will open, and in which searches 
will generally be returned to you. This is basically a 
table view, in which information about a list of 
objects will be visible. You can choose from a variety 
of pre-defined sets of fields, or make your own List 
View (see Creating List Views). You can move to 
Detail View by double-clicking on a record (OR 
clicking the View Detail icon in the Tool bar).

SHEET 
(CONTACT SHEET VIEW): In this view, thumbnail 
images of each object in your found group are 
displayed, each labeled with its title. You can move 
to Detail View for any individual object by choosing 
the object and clicking View Details icon in the Tool 
bar.
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SUMMARY VIEW: In this view, you will see a 
summary of important data. We do not use this view 
very often.

DETAIL VIEW: This is the view in which you will most 
often edit records. In this view, you can see the 
various tabs along the bottom of the screen, and can 
move from field to field.

5.1.6. Signing Off

In order to sign off EMu, simply click on the red X in the upper right 
corner of the COMMAND CENTRE, or choose Exit from the Command 
Centre.
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5.2. Manual System: Overview

This section gives an overview of the basic elements of the manual system used by the RCMDD. 
Some of the material in this manual system serves to complement and back up the collections 
management database and computer file system; some is reference or archival material. More 
details on this system are available under Office Setup and Manual System.

The principal elements of the manual system are as follows:

5.2.1. Filing System

The filing system is housed in a series of filing cabinets, all of which are labeled by cabinet and 
drawer. These cabinets hold Office Administration materials, Traveling Loan and In-house 
Exhibition materials, completed Outside Request materials, and Object Files.

5.2.2. Bookcases

A number of important books and notebooks are stored in the Bookcases, including reprinted 
Register Books, Logbooks, Notebooks, Gallery Books, and a library of Reference Books, 
including catalogues from Loans and Exhibitions.

5.2.3. Storage Units

A variety of supplies and small equipment, including backup drives, pens and pencils, and other 
sundries, are kept in a series of storage units.

It is important to maintain a backup supply of these materials. For details on how to track and  
order supplies, see Supply Protocols.

5.2.4. Clipboards

The RCMDD uses both Personal Clipboards, on which a series of forms that might be needed at 
any time during committee or gallery work are kept, and Gallery Clipboards, one for each gallery 
in the process of Initial Inventory.

5.2.5. Aprons

Each registrar has an apron, which they should wear whenever they go out on a committee or to 
do gallery inventory. For details of what should be kept in each apron, see Aprons.

5.3. Computer System: Overview

The RCMDD staff works on individual computers, and backs up all files onto the server or a 
networked hard drive (see Computer Filing System for locations of primary and backup files). The 
principal types of files managed by the office are Active Files, including files connected with the 
administration of the department, documentation, and collections management; and Archival 
Files, which include digitized facsimiles and backups of the database.
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Part II:

Documentation
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6. Introduction to Object Records
Object information lies at the core of the RCMDD system. Without accurate object records, the 
foundation of the system will be seriously compromised. Proper documentation standards are 
essential to the successful running of the museum, and the protocols here should be followed 
very carefully.

A basic object record (providing the static, or permanent, information about the object) consists 
of three principal parts: fundamental information about the object, including ID numbers, title, 
dating, provenance, material, dimensions, and acquisition information; images of the object; and 
the object’s permanent location. This information is stored in the Catalogue module; the images 
are stored in the Multimedia module; and the location is stored in the Location module. The 
images and location are attached to the catalogue record, which serves as the central record for 
the object. The protocols in this section outline how to create and modify catalogue records and 
their associated multimedia and location records, and how to cross-check and approve the 
completed object record.

Object records also include additional information about movements, loans, exhibitions, and 
events. Protocols for tracking these sorts of active, dynamic, information is covered in Part V, 
Collections Management.

7. Catalogue Records
The Catalogue record is where the fundamental information about the object is stored. This 
section will introduce you to several important concepts that everyone needs to understand in 
order to create and modify catalogue records properly, and then defines the important fields used 
by the RCMDD in the Catalogue module.

7.1. Object Numbers used by the RCMDD

Correct and unique object numbers are the foundation of the RCMDD system: every object must 
have one or more unique ID numbers associated with it before it can be entered into the 
database. Checking that all ID numbers are correct, and that multiple numbers are cross-
referenced correctly, is an essential part of the work of the RCMDD. The RCMDD also records 
several types of non-unique numbers. Note that, as detailed below, unique numbers are recorded 
in the ID number field of the Catalogue module; non-unique numbers are NEVER recorded in the 
ID number field, but are recorded in other fields instead.

The system at the EMC is especially complex, since there are four official numbering systems 
already in place (numbers recorded in official museum books -- three registers and a published 
series), and several additional numbering systems that are in common use by curators and 
scholars, and thus have become semi-official numbers. This is compounded by the fact that the 
museum is part of a larger government organization, the Supreme Council of Antiquities (SCA), 
and additional official numbers can be associated with objects that are in the database. The 
RCMDD has now developed several additional types of numbers to identify objects that would 
not otherwise be able to be tracked in the database. The following section outlines the types of 
numbers that should be used in the database, and in which fields they should be recorded.
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Details about how these numbering systems are to be formatted in the database can be found 
below, in the review of the ID Numbers, Excavation Numbers, SCA Magazine Numbers, and SCA 
Museum Numbers fields.

7.1.1. Unique Numbers

There are two types of unique numbers tracked by the RCMDD and used in the ID number field 
of the database. One type is Permanent: most of the numbers in this category have been assigned 
to the objects by curatorial staff (the exceptions are EDU, Carter, and Legrain numbers). The other 
type is Temporary: all of these are numbers assigned by the RCMDD so that Catalogue records 
can be created for certain categories of objects, and so that these objects can be tracked in the 
RCMDD system. Temporary numbers should be replaced with Permanent numbers as soon as 
possible.

7.1.1.1. Unique Permanent Numbers

This category of numbers includes the museum’s register numbers, the numbers in the published 
Catalogues générals, two types of unique excavation numbers (Carter and Legrain), other SCA 
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numbers (from other SCA museums and SCA magazines) and EDU numbers, assigned by the 
RCMDD.

The following publications (copies of which can be found in the RCMDD’s digital library) review 
the principal numbering systems in detail:

Bernard Bothmer,  “Cairo Museum Numbers," Newsletter of the American Research Center 
in Egypt 22 (June 30, 1956): 13-20. 

Bernard Bothmer, "Numbering Systems of the Cairo Museum," in Biblioteque d’Étude 64/3 
(1964): 111-122.

Registers and the Catalogue général

There are four official numbering systems currently in use at the Egyptian Museum: the Journal 
d’entrée (JE), the Catalogue général (CG), the Temporary Register (TR), and the Special Register 
(SR). Some objects have been assigned a number from only one of these systems, while other 
objects have all four types of numbers. An object may also have more than one of any particular 
type of these numbers, sometimes because it has been registered in the same series more than 
once, and sometimes because it has been put together from multiple already-registered objects.

Journal d’entrée

Begun in the 19th century, with the earliest excavation date being 1858, and the earliest recorded 
registration date being 1888 (in JE IV, on page 345) the Journal d’entrée is the fundamental 
registration system for the museum. The numbers are sequential (with occasional gaps) and ran 
from 1 to 99739 as of March 2011. JE numbers are recorded in a series of 25 handwritten register 
books, of which the latest, JE XXV, was begun in December of 2007.

❖ Database format: JE 1234

❖ JE numbers in register books and on objects are usually in black ink; they are written in 
the Special Registers on the right side of the cross-reference column.

❖ Referenced in various sources as

Journal d’entrée du Musée

Museum Journal

JE

JdE

Ent. No.

Cairo J. 

J.

Catalogue général

The Catalogues générals are scholarly publications, in which objects have been grouped by 
category (e.g. amulets, shabtis, boats) and given a sequential number within a series. The total 
number of volumes varies according to the publication, but as of 2008, there were approximately 
90 books. There are also a number of unpublished manuscripts in the possession of the museum, 
and several of these had not been located by the RCMDD as of March 2011. Also CG numbers 
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given in the unpublished manuscripts are considered official museum ID numbers. CGs continue 
to be published; one recent example is a publication of clay coffins, published in February of 
2010.

❖ CG numbers (as of March 2011) run from 1 to 70754, with gaps in the sequence, and 
some overlaps:

Some objects have two CG numbers. Examples of this are amulets – many have 
been published in both the jewelry CG and the amulet CG.

Some CG numbers have been assigned twice. This will need to be sorted out at 
some point. Extra codes have been added for these in the database. For example, 
CG numbers 9201-9304 were assigned twice; once for Coptic manuscripts by 
Munier, and once, as a part of a larger group, for Greek inscriptions by Milne. To 
make these CG numbers unique, the RCMDD has added the code COP after the 
CG numbers for the Coptic manuscripts, so their CG numbers look like this: CG 
9201-COP, etc.

❖ Note that some objects have ONLY CG numbers (or CG and SR numbers), and do not 
have JE or TR numbers.

❖ Database format: CG 1234

❖ CGs are generally cross-referenced in the JEs, and vice versa (although many CG 
volumes do not have the JEs cross-referenced). Note again that there are errors in these 
cross-references that need to be corrected.

❖ CG numbers are generally written in the JE registers and on objects in red; they are 
written in the Special Registers on the left side of the cross-reference column.

❖ Referenced in various sources as

Cat. No.

Cat.

Catalogue général

Cairo catalogue

Museum catalogue

CG

CGC

❖ Note that for the Bab el-Gasus coffins, the RCMDD uses Ch/N numbers as well (these 
are the numbers given by Niwinski in his CG publication of these objects).

Temporary Registers (also known as the Yard Books)

These numbers were allocated in the past by curators if they were unsure whether an object 
already had a JE or CG number assigned to it, or if they were not certain whether or not an object 
would be officially accessioned. They were also often used for organic items. The series began in 
1914, and there are 12 handwritten Temporary Registers. The system was closed down as of 
August 2007; no more TR numbers have been given to objects from this time forward.
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❖ TR numbers on objects are written in a cross: such that day is in the upper 
left, month is in the upper right, year in the lower left, and a sequential 
number for that day in the lower right: 

❖ Database format: TR 3.12.24.7

❖ Note that these are sometimes written backwards in various curatorial lists, e.g. 
7.24.12.3, or in some other order. Look for the year to help figure out the correct 
number.

❖ TR numbers are often crossed out in the TR ledger once a JE or CG number has been 
identified for it, but the original TR is often still used as reference (and is often still 
written on the object). This should always be included in database records as an official 
ID number.

❖ Referenced in various sources as

Temporary Number

Temp. No.

TR 3/12/24/7

TR 3.12.24.7

Yard Number

Special Registers

In the 1960s, the museum was divided into 7 sections, corresponding roughly to chronological 
divisions or object categories and/or to galleries in the museum, although there are exceptions to 
both of these systems. Only objects still in the museum and generally on the display floors at this 
time, or accessioned subsequently, were given SR numbers and catalogued in a series of 
handwritten Special Registers, which are maintained by the individual sections. SR numbers are 
given in the format: SR + section number + sequential number. Objects that left the museum or 
that were in the basement were not given SR numbers.

In general, the sections can be identified as follows:

Section 1: Jewelry, Tutankhamun, and Royal Mummies

Section 2: Prehistoric Period through Old Kingdom

Section 3: Middle Kingdom

Section 4: New Kingdom

Section 5: Third Intermediate Period through Greco-Roman

Section 6-C: Coins

Section 6-P: Papyri

Section 7: Ostraca, Coffins, and Scarabs

There is now a new “section”:

Section 8: Basement
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The screen shot here, taken from The 
Egyptian Museum, Cairo, in Ten Years: 
1965-1975 (Cairo: 1976), shows the 
original division of the sections, along 
with the original section heads.

Note that the museum curators 
routinely use SR numbers without identifying the section, e.g. SR 1234, or even just 1234. An SR 
without the section is incomplete; it should never be used by the RCMDD. If an SR number 
without the section is given to the office, the section should immediately be found and added.

❖ Database format: SR 4/ 1234 (SR Section/ SN).

❖ SR numbers in register books are written in black ink.

❖ SR numbers should not be written on objects, they should be attached or near them on 
separate labels. However, occasionally an SR number can be found on the object, 
usually in black ink, and is easily confused with a JE number. A number of basement 
objects are labeled, usually on a separate slip of paper, as N 1234. These numbers are 
not used by the museum.

As of March 2011, there were 92 SR books. Each section head is legally responsible for the 
Special Registers that belong to their section. They therefore keep them under lock and key, and 
the actual books cannot be consulted without the permission of the relevant section head. In 
addition, there are 15 old “basement books” arranged in 7 series, all of which begin with the 
number 1. By agreement between the Section 8 head and the RCMDD, these are designated SR 
8-N/ 1234, where N is a letter assigned to the series according to the following list:

Farouk Collection -- SR 8-F

Various -- SR 8-V (were at the time of the writing of the book in SS50, SS57, and 
SS58, but probably have since been moved)

Medamud Objects -- SR 8-M
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Aniba Objects -- SR 8-A

Basement Pottery -- SR 8-P

Corridor SS56 -- SR 8-B

Sinai Objects -- SR 8-S

These books have now been closed: note that NO NEW SECTION NUMBERS WILL BE GIVEN 
TO BASEMENT OBJECTS.

In addition to the other special registers, there is a Garden Book, in which all the objects that 
were on display in the museum garden at one point in time were listed. Most of these have JE, 
TR, or CG numbers, but some have only “Garden” numbers. The RCMDD has given these 
numbers the format:

❖ Database format: SR G/ SN (e.g. SR G/ 43)

Unique Excavation Numbers (Carter and Legrain only)

Two types of unique excavation numbers, Carter numbers (for the Tutankhamun Collection) and 
Legrain numbers (for objects from the Karnak Cachette) are also used regularly by museum staff 
to identify objects, and have as a result become adopted as official numbers as well. In addition, 
for the Tutankhamun Collection, the staff sometimes uses “Guide” or “Exhibition” Numbers, 
which refer to numbers from two Egyptian Museum publications: A Brief Description of the 
Principal Monuments, (Institute français archéologie orientale, Cairo: 1931) AND A Guide To The 
Egyptian Museum, Cairo: A Brief Description of the Principal Monuments, (Egyptian Antiquities 
Organization, Museums Service, Cairo: 1988).

Carter Numbers

All Tut objects were given numbers from 1 to 620 by Howard Carter. These numbers are 
subdivided by alphas, e.g. Carter 256-a, Carter 256-b, Carter 256-bb, Carter 256-aaa; aaaa is 
written as, e.g. Carter 256,4,a; additional subdivisions are noted by Arabic numerals. The main 
numbers generally refer to a principal object, such as a chair or box. The alphas refer to 
associated objects. For example the third object found inside box Carter 43 would be Carter 43-
c. It is also possible to tell which chamber in the tomb the item comes from, as these were 
assigned in order from the Corridor through to the Annex.

The grouping Carter 256 refers to objects found on the mummy of the king.

Group 620, which refers to objects found in the debris on the floor of the Annex, is 
anomalous in that it was given 123 numbered subdivisions: 620(1) to 620(123).

 Since scholars and museum staff frequently refer to Tutankhamun objects by these numbers, and 
they are unique, they thus are considered valid and semi-official ID numbers and are used as 
such in the database. 

❖ Database format: Carter 469-aa (in general, follow the format of the numbers on the 
Griffith Institute website, see below)

❖ Carter numbers are NOT written on the objects.

❖ In the database, Guide/Exhibition numbers are written in the Notes field.
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❖ Guide/Exhibition numbers are often found in display cases in association with the 
objects.

❖ Note that the old “Search” database has reversed the Carter numbers and the “Guide/
Exhibition” numbers.

The principal source for the Carter numbers is the Griffith Institute website: “Tutankhamun: 
Anatomy of an Excavation”: http://griffith.ashmus.ox.ac.uk/gri/4tut.html. Carter’s original notes 
are published here in facsimile. The Carter numbers given in these notes are correct; incorrect 
cross-references in the museum register books should be corrected according to the numbers 
given by Carter. As of March 2011, a project to correct all discrepancies is well underway. For 
examples, see J. Kamrin, with E. Nuutinen and A. El Baroudi, “Getting Tutankhamun’s Number: 
Errata in the Egyptian Museum’s Journals d’entrée,” in Millions of Jubilees: Studies in Honor of 
David P. Silverman, (Eds. Z. Hawass and J. Houser Wegner). CASAE 39/I (2010), 253-278.

Legrain K. Numbers

These are the excavation numbers assigned to the statues and statue fragments discovered by 
Georges Legrain at Karnak in the early 1900s.

❖ Database format: K. 468

Other Official SCA Numbers

The RCMDD also uses other unique SCA ID numbers in the database.

SCA Museum Numbers

Official SCA museum numbers take various formats, e.g. Luxor J. 136 or GRM 6938. The formats 
for each museum can be found in SCA Museum Codes.

SCA Magazine Numbers

Official SCA storage magazine numbers must have three parts: the system proposed by the 
Project Director and currently (as of March 2011) under development by the SCA’s Director of 
Magazines, Dr. Ramadan Hussein includes a unique identifier for the magazine, an identifier for 
the register book series within that magazine, and a sequential number, e.g. SQ.SCA.145. 
Magazine numbers without these unique identifiers cannot be used in the ID field of the 
database; a provisional number (see below) must be used instead. Only objects from the Saqqara 
magazine have been given these types of numbers.

A new SCA documentation project for the magazine system is currently underway under Dr. 
Hussein (as of March 2011). Therefore, the RCMDD should NOT try to assign magazine numbers 
to any objects. Instead, an RCMDD provisional number should be used in the ID field, and the 
non-unique sequential number for the object should be put in the Magazine Number field as 
Reg. xxx (see below).

RCMDD-Assigned Numbers

Most of the types of numbers assigned to objects by the RCMDD are temporary, and are meant to 
be replaced as soon as possible (see below). There is one exception to this, the EDU Number.
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EDU Numbers

A new type of number created by the RCMDD in 2008, and currently in use only by this office, is 
the EDU, or Education number. These numbers are given by the RCMDD to objects that are not 
antiquities or art objects, but which need to be tracked because they are held by the museum. An 
EDU number can be given to a non-antiquity (even if it is considered a work of art) if it has never 
been registered and therefore does not fall under the responsibility of any curator. Objects that 
get EDU numbers include copies of antiquities, molds made from antiquities, and objects such as 
the Lego statues in the Children’s Museum. Only objects which have no other museum numbers 
are to be given EDU numbers.

❖ Database Format: EDU.Year.sequential number: e.g. EDU.2009.1

EDU objects are listed in the EDU logbook as they are assigned. This logbook tracks EDU number 
and object title only.

NOTES: Sometimes we find out later, after assigning an EDU number, that the object already has 
a register number. In these cases, replace the EDU number in the ID field with the register 
number and add the EDU number to the notes field.

7.1.1.2. Unique Temporary Numbers

In addition to the unique numbering systems outline above, the office has created several 
temporary numbering systems so that unaccessioned objects can be tracked in the database. 
These numbers are not in use by the rest of the museum; they are for internal record-keeping 
only.

Provisional Numbers

These are temporary numbers assigned by the RCMDD, and are used in the database and in the 
manual system for the purpose of tracking certain types of objects:

1. Objects in the basement for which no previous number has yet been found, but which may 
have been registered earlier;

2. Objects that come into the museum from outside for purposes other than in-house 
exhibitions, before they are accessioned, or before they leave the museum again, if they do 
not yet have an official SCA number (a museum or magazine number);

3. Objects that come into the museum temporarily as part of an SCA loan, either on their way to 
the loan or on their way back from the loan, if they do not have adequate official SCA ID 
numbers. NOTE: Excavation numbers ARE NOT considered adequate, as they are not official 
SCA numbers.

❖ Database format: PV.year.three-digit sequential number (e.g. PV.2007.001).

NOTE: Objects coming to the museum temporarily for exhibitions do not fall into this category. 
They are numbered and tracked by Temporary Exhibition numbers (see below and Exhibition 
Protocol).

NOTE: Objects for which numbers have not been found during Inventory work will be given 
Temporary Gallery numbers (see below and Inventory).

RCMDD Protocols 12-2010  62



All provisional numbers will be assigned by the RCMDD. They will be used only for temporary 
tracking purposes, and will be discarded as soon as:

❖ An original JE, CG, TR, SR, or SCA magazine number is found.

❖ The object is properly accessioned with either a JE or CG number.

❖ The object leaves the museum, and is given a number by another SCA museum or by an 
SCA storage magazine. 

Note that once a PV number is replaced with an official ID number, the original PV number 
should be recorded in the Notes field of the database.

Exhibition (E) Numbers

These are numbers assigned to objects with no official identification number (JE, CG, TR, SR, 
Other Museum, or Magazine number) coming temporarily to the Egyptian Museum for In-house 
Exhibitions.

Format: Exhibition number (E.year.sequential number) + three-digit sequential number: e.g. E.
2007.05.001.

Temporary Gallery Numbers

These are numbers assigned temporarily to objects if no number can be found during gallery 
inventory work. These should be replaced as soon as possible through consultation with the 
section heads.

Format: Gallery number.sequential number: e.g. R43.01

7.1.2. Non-Unique Numbers

Excavation Numbers

Excavation numbers CANNOT be stored in the ID number field, as they are not official SCA 
numbers and are not unique. They should be stored instead in the Excavation Number field, with 
the format: Exc. No. 1234-ab. Carter and Legrain numbers, although technically excavation 
numbers, are treated as official ID numbers by the RCMDD. They should be recorded in the ID 
number field AND in the Excavation number field (without Exc. no.).

Magazine Numbers

Objects often come to the museum, mainly for exhibitions, from SCA magazines. These are listed 
with non-unique numbers, usually as “Reg.” “Inv.”, or just “No.” These should be recorded in the 
Magazine Number field, as “Reg. XXX.”

Guide Numbers

A number of museum guidebooks were written early in the last century (and some even earlier). 
The register books often mention numbers given to objects in these books in the object entries; 
they are also sometimes referred to as “Exhibition” numbers. These are not official museum or 
SCA numbers, and are not unique. In addition, the project does not have copies of all of these 
books, and the numbering in each of them is different; the registers in general do not distinguish 
among the various editions and versions. 
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As of March 2011, we have the 1902 and 1915 guides. If the project verifies a guide number in 
one of these books, it should be entered as a proper bibliographic reference. If not, the number 
should be noted simply as “Guide NN) in the Physical Notes field of the Catalogue record. 

7.2. Objects, Pieces, and Families
The fundamental type of record is an object record, but objects can be broken down into pieces, 
or grouped together into families. The following sections provide definitions and guidelines to 
help you understand and implement these concepts.

7.2.1. Object vs. Piece

An object is defined as a single artifact, such as a statue, vase, scarab, etc. An object can be 
made up of more than one piece. For example, a canopic jar, with its base and lid, is considered 
one object, but two pieces. For something to be considered a piece, it must be able to be moved 
separately. If it cannot be moved separately, do not make a separate database record for it. See 
below, ID Numbers, for details on the proper format for object and piece numbers.

In general, when an object has been created from a number of fragments, (for example, a statue 
has been put together from several large fragments), only one record should be created, with all 
of the ID numbers of all the parts used to create it included. Because of the complex nature of 
some of the museum’s jewelry records, a separate protocol has been created for jewelry. 

There should eventually be one record per piece in the database, along with “parent” records 
bringing pieces together into objects. However, this is time-consuming, so for now, the RCMDD 
is trying to create one record per object, and only break objects down into pieces when there is a 
reason to do so (e.g. they are going out on loan, or are being moved separately). The reverse is 
now true -- at this point, a number of objects have been broken down into pieces, so only “child” 
records exist; for now, a “parent” record should only be created when necessary for an outside 
request, loan, or exhibition, or when a full gallery inventory is being done. Eventually, “parent” 
records should be created for all of these.

7.2.2. Parent-Child Records

The default setting for catalogue 
records is Is Parent = “Yes.” All object 
records should be Parent records. If 
you create “piece” records for an 
object, you should mark these as 
“Child” records; the object of which 
they form a part will be their “Parent” 
record. Here is an example.

Parent Record (Object): Sarcophagus 
of Hatshepsut as King

Child Records (Pieces): Sarcophagus 
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of Hatshepsut as a King: Box AND Sarcophagus of Hatshepsut as a King: Lid

Parent Records: Parent records should be marked as “Yes” 
under Independently Moveable (on the Location Tab, lower 
right). 

Child Records: all Child records should be marked as “No” 
under Independently Moveable (on the Location Tab, lower right).

MOVEMENT NOTES: If all children are moved at once to the same new location (i.e., entire 
object moves), move only the parent. The children will all move. If pieces are moved separately, 
move the child records separately.

7.2.2.1. ID numbers for Parent records

Most often parent records are created for objects that have two or more pieces with one ID 
number (e.g. coffin JE 52344, where the parent record will be assigned JE 52344 and the children 
will be JE 52344.1 (box) and JE 52344.2 (lid)). Sometimes, a parent record can be created for a 
group of pieces which have multiple different ID numbers. In these cases, the original numbers 
will be used for the children, and other solutions must be used for the parent record. The guiding 
principle here is to make sure that both parent and children records can be found when the 
database is searched by ID #.

Examples:

This Parent record has two ID #s that apply to all its children: JE 62058 and SR 1/ 83. These have 
been subdivided for the child records. However, the children have different Carter #s, and these 
need to be put in the ID Number field of the parent. They cannot simply be listed, for two 
reasons: First, if they are used in the Child records, they cannot be entered into the ID Numbers 
field of the Parent record, since they will not be unique. Second, there will not be enough room 
-- most reports show only 6 lines from the ID Number field, and in general, it is better to use 
fewer lines. Therefore, multiple numbers can and should be listed on single lines -- the database 
will not recognize these as overlapping ID numbers, and they will take up fewer lines.

Example 1: Senet Game from the Tomb of Tutankhamun

Parent: 
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Senet Game: Board, Drawer, Stool, Four 
Game Sticks, Eight Game Pieces, and Two 
Knucklebones. (Note that Carter 46-w, 46-
x, and 54-ww are divided into  the child 
records and therefore can be listed alone 
here.) This record can be found through a 
search for any of the numbers here: to find 
e.g. Carter 383 it is enough to have Carter 
and 383 in the same field.

JE 62058
SR 1/ 83
Carter 46-w
Carter 46-x
Carter 54-ww
Carter 345, 383, 580

 Children:

Board:
JE 62058-A.1 (JE 62058-A divided into .1-.3: game board, 
drawer, stand.)
SR 1/ 83 -A.1 (SR 1/ 83-A divided into .1-.3: game board, 
drawer, stand)
Carter 345.1 (Carter 345 divided into .1-.5: game board and 
4 Gaming Sticks)

Drawer:

JE 62058-A.2 (JE 62058-A divided into .1-.3: game 
board, drawer, stand.)
SR 1/ 83 -A.2 (SR 1/ 83-A divided into .1-.3: game 
board, drawer, stand.)
Carter 383
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Stool
JE 62058-A.3 (JE 62058-A divided into .1-.3: game board, 
drawer, stand.)
SR 1/ 83 -A.3 (SR 1/ 83-A divided into .1-.3: game board, 
drawer, stand.)
Carter 580

Game Stick
JE 62058-B
SR 1/ 83-B
Carter 345.2 (Carter 345 divided into .1-.5: game board and 
4 Gaming Sticks)

Game Stick
JE 62058-C
SR 1/ 83-C
Carter 345.3 (Carter 345 divided into .1-.5: game board and 
4 Gaming Sticks)

Game Stick
JE 62058-D
SR 1/ 83-D
Carter 345.4 (Carter 345 divided into .1-.5: game board and 
4 Gaming Sticks)

Game Stick
JE 62058-E
SR 1/ 83-E
Carter 345.5 (Carter 345 divided into .1-.5: game board and 
4 Gaming Sticks)

Knucklebone
JE 62058-F
SR 1/ 83-F
Carter 46-w.1 (Carter 46-w divided into .1-.2: two knucklebones)

Knucklebone
JE 62058-G
SR 1/ 83-G
Carter 46-w.2 (Carter 46-w divided into .1-.2: two knucklebones)

Game Piece
JE 62058-H
SR 1/ 83-H
Carter 54-ww.1 (Carter 54-ww divided into .1-.3: three game pieces)

Game Piece
JE 62058-I
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SR 1/ 83-I
Carter 54-ww.2 (Carter 54-ww divided into .1-.3: three game pieces)

Game Piece
JE 62058-J
SR 1/ 83-J
Carter 54-ww.3 (Carter 54-ww divided into .1-.3: three game pieces)

Game Piece
JE 62058-K
SR 1/ 83-K
Carter 46-x.1 (Carter 46-x divided into .1-.5: five game pieces)

Game Piece
JE 62058-L
SR 1/ 83-L
Carter 46-x.2 (Carter 46-x divided into .1-.5: five game pieces)

Game Piece
JE 62058-M
SR 1/ 83-M
Carter 46-x.3 (Carter 46-x divided into .1-.5: five game pieces)

Game Piece
JE 62058-N
SR 1/ 83-N
Carter 46-x.4 (Carter 46-x divided into .1-.5: five game pieces)

Game Piece
JE 62058-O
SR 1/ 83-O
Carter 46-x.5 (Carter 46-x divided into .1-.5: five game pieces)

Example 2: Tutankhamun’s Toe Stalls

In this case, there are ten Children for the Parent. The Children are grouped under two JE #s, and 
both of these need to be mentioned in the ID Numbers field. A search will find either of these 
numbers. However, there are 10 different SR #s, and 10 different Carter #s. Since not all of these 
can fit into the ID Number field for the parent,  for both SR and Carter #s a range must be used. If 
a search is done for e.g. SR 1/ 3520 in the ID Numbers field, only the child record will be found; 
this is why it is important to mention its connection to the Parent record in the Notes field in 
Physical tab.

All of the relevant numbers should be listed singly in the Notes field of the Parent record; the 
record will therefore be found if a Keyword search is used on the Inter- or Intranet.
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 Parent: 

Ten Gold Toe Stalls
JE 60682 - JE 60683
SR 1/ 3515 - 3524
Carter 256-ll(m-v)

 

 Children: 

Toe Stall
JE 60682-a
SR 1/ 3515
Carter 256-ll(m)

Toe Stall
JE 60682-b
SR 1/ 3516
Carter 256-ll(n)

Toe Stall
JE 60682.3
SR 1/ 3517
Carter 256-ll(o)

Toe Stall
JE 60682.4
SR 1/ 3518
Carter 256-ll(p)

Toe Stall
JE 60682.5
SR 1/ 3519
Carter 256-ll(q)

Toe Stall
JE 60683.1
SR 1/ 3520
Carter 256-ll(r)

Toe Stall
JE 60683.2
SR 1/ 3521
Carter 256-ll(s) 

Toe Stall
JE 60683.3
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SR 1/ 3522
Carter 256-ll(t)

Toe Stall
JE 60682.4
SR 1/ 3523
Carter 256-ll(u)

Toe Stall
JE 60683.5
SR 1/ 3524
Carter 256-ll(v)

7.2.3. Family Records

Objects also can be grouped together using the database’s Parent-Child relationship feature. The 
RCMDD calls these groups “families.” Families are useful, for example, when you have a statue 
and a shrine that are separate objects but belong together, or a nest of coffins with their mummy. 
For these groups, you can create a “virtual parent” (perhaps best thought of as a “Grandparent”) 
to bring them together. 

Note that when an object is part of a Family, it can be, from the database’s point of view, a Parent 
and a Child at the same time, just like a person. Thus an object that consists of multiple pieces 
can have a Parent (object) record and several Child (piece) records; the Parent (object) record can 
then also be a Child (or subrecord) record as part of a Family record. 
Also note that each record can have only one Parent, so any one piece can only be part of one 
object, and any one object can only be part of one family.

In general, you will only create Family records when the need arises, as per the following 
guidelines:

• When one of the catalogue records for an object in the Family is submitted for approval.

• When one of the objects in the Family goes out on a Loan, is displayed in an Exhibition, or is 
part of an Outside Request.

We will use the following group of records as an example, to work through the steps needed to 
create a Family record: 

Family Record: Coffin Set of Maatkare Mutemhet

Object Subrecords: 

Subrecord 1: Mummy Board (Parent) 

Subrecord 2: Outer coffin (This is already set as a Parent record with two Child records, because 
the object consists of two pieces -- Outer coffin: box; Outer coffin: lid)

Subrecord 3: Mummy of a baboon/monkey (Parent)

Subrecord 4: Inner coffin (This is already set as a Parent record with two Child records, because 
the object consists of two pieces -- Inner coffin: box; Inner coffin: lid)

Subrecord 5: Mummy of Maatkare (Parent)
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To create the Family record:

Step 1: Create a new Catalogue record

Step 2: Give the record a title

Choose a title that makes sense. In this case, something like “Coffin Set and Mummy of Maatkare, 
with Monkey Mummy.”

Step 3: Fill out other fields as possible

Fill out Provenance, Dating, and other fields that are common to all the subrecords that will form 
part of this family. Do not fill out things like dimensions or materials, which are different for each 
subrecord.

Step 4: Fill out ID Number 

In the ID number field for the Family record, 
type in all the ID numbers the child records 
have. Since the ID numbers need to be unique, 
you may have to type in several numbers on 
each line. If all the child records have a 
number derived from one ID #, e.g. JE 
26200(a), JE 26200(b), and so on, you may use 
JE 26200 as an ID number for the family 
record, in case all the parts of this belong to it. 
If records (a) and (b) would belong to this family, but (c) to another one, JE # for this family would 
be JE 26200(a)-(b). NB. The old way of doing this was to simply copy the IRN that the database 
has assigned to the Family record; this should not be used anymore.
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Step 5: Identify the Family record as a Parent: 

Step 6: Attach Subrecords

In the Associations 1 Tab, choose the Family record as 
the Parent object for each of the subrecords. Do NOT 
try to attach the Child records to the Family record; 
they will be attached automatically when 
their Parent records are. 

In the end, you will see the following 
relationships if you go to the Parts tab of 
the Family record or any of its subrecords:

7.2.4. Jewelry and Other Complex Objects

Jewelry can be extremely complex, as much of the museum’s jewelry has been found as sets of 
loose elements and has been reconstructed later, sometimes several times in different 
combinations and designs. There is little consistency in the way these have been documented in 
the museum’s records, making them difficult to manage, and making the creation of a strict 
protocol for jewelry records impossible. Each object must be addressed individually, and 
decisions made on the basis of the way that it is currently documented in the museum’s records. 
In general, the simplest possible solution that allows the RCMDD to account for and track all of 
the objects and elements included in the museum’s records should be chosen; also keep in mind 
that it should be relatively easy to search for and find the object, both in the database itself and 
over the web. In addition to jewelry, there are occasionally other very complex objects that need 
to be treated this way. The following examples will serve as guidelines for future record creation.

In some cases, there is a one to one correspondence between a JE or TR entry or subentry and the 
CG and/or SR entries. These are easy to deal with under the RCMDD’s current protocols. In other 
cases, the group listed in a subentry has been used in the reconstruction of more than one object 
that has then been given a CG and/or SR number. In other cases, there are groups of pieces in the 
CG that are listed differently than in the JE and/or SR, and even SR entries that have later been 
combined to create new objects. In some cases, there IS no ID number, either JE, CG, TR, or SR, 
that accounts for a single and entire object. All of these are much more difficult to deal with.

A general rule of thumb: if there are 7 ID numbers or less associated with a reconstructed object, 
make one object record and list all relevant ID numbers on single lines in the ID Numbers field. 
If there are more than 7 numbers, do your best to list them all in the ID Number field, by putting 
more than one number per line, so that the object will come up in a search. Remember also to 
put any ID numbers that refer to the entire piece FIRST in the ID Numbers field. Only create 
Child records when you really need to do so.

RCMDD Protocols 12-2010  72



1. One to one correspondence: JE 4725(10) is a set 
of 24 gold plaques. These have all been joined 
together to form a bracelet, registered as CG 
52688 = SR 1/ 6591-a. Since all ID #s refer to the 
group of pieces and the object, one object record 
can be created, in which all ID #s go into the ID 
Numbers field as they are. No parent/child 
records are needed.

2. Object with 7 or less associated ID numbers: These should be treated like other objects made 
up of joined parts: all relevant ID Numbers should be listed in the ID Numbers field. See 
below, #5, for how to include divided entries. Remember to put any numbers that refer to the 
entire object first.

Example: String of 39 Lotus-shaped Beads 
of Gold, Carnelian, Lapis, and Turquoise 
(String 84) : SR 1/ 6041. This object has 
been put together with beads from a 
number of separate but in some cases 
overlapping JE and CG entries, as detailed 
in the notes field. Note that the SR number 
is first in the ID number field, since this is 
the number that refers to the entire object. 

Also note that the “String” number (see below, 
#5) is included in the title and in the Notes 
field.

3. Object with more than 7 associated ID numbers: If an object has more than 7 ID numbers 
associated with it, put the ID numbers that refer to the entire object first. If you can, fit the rest  
into the ID number field by putting more than one ID number per line. 

4. Object with clearly defined pieces: In these cases (for example, a necklace made from 
amulets of various shapes, or a necklace with a pendant, chain, and counterpoise that were 
registered separately), child records should be made for each of the parts, and linked to the 
parent record. Make sure to include “xxx: Part of OBJECT NUMBER” in the titles of each of 
the child records (see below, #6). (Note that in these cases, the catalogue card for the object 
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should be accompanied by a list of the parts, as is done for objects and pieces.)  So that the 
parent object can be found by a search, list all numbers in the ID field of the parent record, 
but with more than one number per line, e.g. JE 12345(a) - JE 12345(b). This is so that they 
will fit, and also so that the database does not complain about duplicate ID numbers. 

Example: CG 52672 = SR 1/ 6572: 
Gold Broad Collar of Ahhotep with 
Hawk End-Pieces. This has been 
made up of 12 parts. In the ID 
Numbers  field the collar the has CG 
and SR numbers first, as these refer 
to the whole of the collar, and then 
the additional numbers, with 
multiple numbers per line. Child 
records have been made for each of 
the parts. Note that the Parts field on 
the Title/ID tab tell how many 
pieces/sets of pieces have been used 
to reconstruct this piece, i.e. how 
many Child records are attached to this Parent record.

The ID numbers of the children are 
recorded in the Notes field on the Physical 
tab. Ideally, this list should include an 
explanation of each number, e.g. JE 
4725(1) = two gold and lapis lazuli hawk 
heads, but since the space is limited here 
(too much text and it won’t fit in any 
report), this cannot always be done. In these cases, simply list the relevant numbers, with = to 
indicate when two or more numbers refer to the same part.

More detail can be seen in the Parts 
tab, which includes the ID Numbers 
and Titles of all of the parts. 
Remember that the fields here can be 
expanded to the titles are fully visible.

5. Object without unique ID number: 
Some jewelry objects have no master JE, CG, or SR number. In these cases, the museum 
generally has a “String” number; this can be used as one of the ID numbers in the database as 
well. Otherwise, follow the protocols above.

RCMDD Protocols 12-2010  74



Example: Collar of Khnumit. This 
object is made up of many 
separate elements, which have 
been divided into 33 Part records. 
Since there is no single JE, CG, 
TR, or SR number that refers to the 
entire object, the project is using 
the “String” number as the one of 
the ID Numbers for the Parent 
record (written as String.number). 
Otherwise, the protocols are as 
above.

6. Divided entry - part of object with 7 ID numbers or less: In these cases, divide the entry as 
usual and simply add the divided ID numbers (e.g. JE 31118(a)) to the ID number field for the 
object itself.

7. Divided entry - part of objects with more than 7 ID numbers: In these cases, divide the entry 
as usual, and create child records to be linked to the parent/object record. Remember to 
include the main ID number of the parent record in the title.

Example: JE 4725(5) is a set of 56 spiral-shaped gold pendants; 45 of these have been used in 
the reconstruction of one collar (CG 52672 = SR 1/ 6572), and 11 in another (CG 52733 = SR 
1/ 6573). The record for JE 4725(5) has been divided in two records: JE 4725(5)(a): 45 
pendants, and JE 4725(5)(b): 11 pendants. 

Since CG 52672 (see above, #3) has more than 7 associated ID numbers, a separate record 
must be created for JE 4725(5)(a). The title here should be: 45 Spiral-Shaped Pendants: Part of 
Collar CG 52762. (This will assist a scholar or curator trying to find the object). 
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It should be marked as “Is 
Parent? No,” and linked to CG 
52672 as its parent object. 

The situation is similar for CG 
52733, which is a group of 
elements put together on a 
board made up of 13 parts. 
Therefore, another separate 
record should be created for JE 4725(5)(b), with the title: 11 Spiral-shaped Pendants: Part of 
Object CG 52733. It should be marked as “Is Parent? No,” and linked (as a Child record) to 
CG 52733, which is its parent object.

8. Earrings: Since individual earrings are often given A’s and B’s in the register books and/or 
individual CG numbers, earring pairs that are not divided already are given (a) and (b) by the 
RCMDD, and are considered individual objects.

7.3. Creating and Modifying Catalogue Records

The following section provides information about how to create and modify catalogue records, 
including detailed definitions of the key fields that need to be filled out (note that tabs and fields 
that are not necessary for these processes are not reviewed here). A final phase, of full cross-
checks and object record approval, is discussed later.

Creation of catalogue records generally begins with transcription of basic object information from 
one of the museum’s register books (JE, CG, TR, or SR). (During the early stages of the project, 
from 2005 to the present, this was often done by a volunteer.) Either at the same time, or later, all 
other relevant register books must be cross-checked carefully to make sure that all of the numbers 
are correct and that all of the information matches. Provenance and dating information is also 
checked against B. Porter & R.L.B. Moss. Topographical Bibliography of Ancient Egyptian 
Hieroglyphic Texts, Reliefs, and Paintings (henceforth PM), and the Griffith Institute On-line List of 
Objects in the Egyptian Museum, Cairo (henceforth Griffith PM).

In general, if there is a discrepancy between official books (including PM), the team should do its 
best to figure out which information is correct, and then record the discrepancy and its solution 
in the Notes field (Physical tab).

7.3.1. Creating a New Catalogue Record in the Database

Before creating a new catalogue record, check carefully to make sure that a record does not 
already exist (see Searching the Database). Once you are sure the record does not already exist, 
follow these steps:

• Open the Database, and choose the Catalogue Module.

• Create a new record by clicking on the page icon in the left-hand corner of the tool bar or 
pressing Ctrl+N on your keyboard.

• Start filling out the fields according to the definitions outlined below (see Field Definitions).
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• If possible, use shortcuts to make sure that you are not skipping any fields.

• Remember to save your work.

7.3.2. Modifying Catalogue Records

You will wish to modify a catalogue record if you find new or different information about the 
object. This information can be from register books (found during additional cross-checks), 
publications, visual observation, and/or from information provided by scholars.

To find the record that you want to modify, go into Search mode and enter your parameters. (See 
Searching the Database for detailed instructions.)

The process for modifying a record is basically the same as for creating the record. You can either 
add information or modify information that is already there. Some examples of this are:

• Adding information (for example, specific dating or provenance information, a description, 
more bibliography, additional dimensions, etc.).

• Modifying information: In some cases, you may want to correct, add, or delete information to 
or from a database record. This can happen, for example:

1. because a register entry has been misread;

2. because different register entries (e.g. from the JE and CG) do not agree with one another;

3. because an error in a register book has been discovered;

4. because a scholar has provided additional, updated, or corrected information.

In any of these cases, make the modifications needed. Make sure you follow the protocols 
carefully for each field.

IMPORTANT NOTE: If 2, 3, or 4 is the case, note the discrepancy, error, correction, or addition in 
the Notes field (Physical tab), with the source of the information followed by a colon and then 
what has been corrected or added. For publications, the source will be  the name of the author 
and the year (e.g. Richards, 1997); for scholars, the source will be the name of the scholar and 
the date, plus Pers. Comm., to indicate the information is a personal communication rather than 
a publication.

If you are doing a new cross-check or adding information from an outside source, be sure to add 
your name, the date, and the recorder process on the Recorder tab, as outlined below (see 
Recorder Tab).

7.4.  Field Definitions
The following section outlines the important tabs and the fields that should be filled out, 
whenever possible, in the database. Not all of this information will be available in the museum’s 
records, but you should be familiar with all of these fields.

Each important field is listed here, followed by the Tab in which it is found.

Note that definitions for each field are available in the database itself -- click on the Field Help 
button (arrow/question mark) in the upper right corner of the screen, then on the field for which 
you want information, and the definition will appear.
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The Catalogue module will open in the Summary Tab. You do not need to enter information here, 
since all the information that appears here can be entered in other tabs.

7.4.1. Object Type (Summary Tab)

The default here is Object, so you should not need to change anything here.
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7.4.2. Main Title (Title/ID Tab)

This should be short but comprehensive 
and clear, so it can be used to identify 
the object when it appears in a list, and 
can be used as a search field. 

• Include material where possible 
(when there is room).

• If it will help identify the object 
visually, note whether or not it is 
inscribed.

• Include the name of the object’s 
owner whenever possible, in 
Anglicized form (e.g. Amenhotep or 
Niankhptah).

• Use American capitalization (capitalize important words, DO NOT capitalize small words 
like “and,” “the,” “with,” etc.).

• Include the nicknames of well-known objects in quotation marks and/or parentheses, e.g. 
Seated Statue of Nebhepetre Mentuhotep in the Red Crown (“Bab el-Hosan”).

If the record is for a piece (Child Record), use the same title as is used for the object (Parent 
Record), followed by a colon and a specification of the piece:

 EXAMPLE:

 Parent Record:  Wooden Inner Coffin of Maiherpri

 Child Records:  Wooden Inner Coffin of Maiherpri: Box

    Wooden Inner Coffin of Maiherpri: Lid

7.4.3. Object Status (Title/ID Tab)

Mandatory field: select the current status of the object from the drop-down list:

• EMC Object: Use for objects registered in one of the museum’s register books, and still in the 
museum (as far as the official records are concerned, in any case), and for objects that have 
not been registered, but have been identified as educational by the RCMDD and given EDU 
numbers.

• Other SCA Museum: Registered at another SCA museum. This includes both objects originally 
registered at the EMC and moved, or originally registered in another SCA museum.

• SCA Magazine: Registered in an SCA magazine, with that magazine still the object’s 
Permanent Location.

• EMC-Provisional: Brought to the EMC, usually from a magazine or as a repatriated object, but 
not yet registered.

• Deaccessioned: Originally registered in the SCA system, and later removed permanently for 
any reason. This can include objects that were sold, given away as gifts, or which, according 
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to the registers, disintegrated  or were destroyed. Details as to why an object was 
deaccessioned are indicated under Object Rating (see below). Objects that are missing or 
stolen but were never officially deaccessioned are still considered EMC objects, and the fact 
that they are missing or stolen should be indicated under Object Rating.

• Non-SCA: Never registered in the SCA system (e.g. objects from a foreign country that have 
come to Egypt for an exhibition).

7.4.4. Object Rating (Title/ID Tab)

Optional field: to be used if there is additional, sometimes temporary, information about the 
object’s overall status.

• Educational: Objects that are not artifacts but are in the museum for educational purposes, 
such as replicas, casts, or other educational materials. This DOES NOT apply to any ancient 
artifacts and should therefore rarely be selected.

• Selected for Transfer: Chosen by another museum for their collections and scheduled to be 
transferred out of the EMC.

• Selected-Multiple Museums: Chosen by more than one museum. 

• Chosen for Loan

• Chosen for Exhibition

• On Loan: Abroad as part of a traveling loan.

• On Exhibition: Exhibited within the Egyptian Museum (or other SCA Museum) as part of an in-
house exhibition.

• Conservation: In the Conservation Lab (R4).

• Missing: This should be used for EMC (or other SCA Museum or Magazine) objects that the 
RCMDD, in consultation with the section heads, have not been able to locate.

• Stolen: Used for objects known for certain to be stolen.

• Buried in Garden: For EMC objects, as noted in the register books.

• Sold: Used with Deaccessioned as Object Status, as noted in the register books.

• Gifted: Used with Deaccessioned as Object Status, as noted in the register books.

• Disintegrated: Used with Deaccessioned as Object Status, as noted in the register books.

• Destroyed: Used with Deaccessioned as Object Status, as noted in the register books.

7.4.5. Phonetic Name (Title/ID Tab)

Name of the owner of the object, if this is inscribed on the object itself. This should be done in 
computer transliteration (“Manual de codage”), without dashes within names. This is a low 
priority item, and should be checked by a senior Egyptologist.

7.4.6. Parts and Part No. (Title/ID Tab)

If a record has “children,” enter the number of parts associated with the record in the Parts field 
(see Parent-Child records). 
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7.4.7. ID Numbers (Title/ID tab)

This is the key field of the database. It is essential that the numbers here be unique, correct, and 
according to protocol. Follow the guidelines here carefully. See above, Numbering Systems of the 
Egyptian Museum, for background on the various types of numbers. Proper formats are reiterated 
here.

If you have an  object for which you are having difficulty finding the correct ID number(s), 
consult the section on Finding ID Numbers.

For EMC Objects (i.e. EMC Object OR Deaccessioned under Object Status)

Enter one or more of the following accepted ID numbers, in their proper formats, in the following 
order:

• Journal d’entrée: JE number (Use the format JE xxxxx, e.g. JE 45725)

If a JE entry is broken down into more than one record because it contains more than one 
object (for example, if the original entry is for 10 vases, or 25 scarabs), and “a”s and “b”s 
have been added in the original JE, add a dash and an alpha directly after the number, e.g. 
JE 12345-A or JE 12345-a (match the case used in the register book). Occasionally, the JE 
has broken the objects into 1, 2, 3, etc. If this is the case, use JE 12345-1, etc.
NOTE: Objects entered earlier have ID numbers with an alpha directly after the number 
(without a point or parenthesis), but these will not sort properly, so going forward we will 
use the dash. EMu will write a script to add dashes to all of the older ED numbers. In the 
meantime, It is always possible to move the order of objects around by hand (see Sorting 
by Hand).)

If a JE entry is broken down by the RCMDD into more than one record because it contains 
more than one object (for example, if the original entry is for 10 vases, or 25 scarabs), and 
“A”s and “B”s or “a”s and “b”s have NOT been added in the original JE, and there are 26 
objects or less registered under one number, add lower-case alphas within parentheses, 
e.g. JE 45725(a), etc. If there are more than 26 objects, the protocol is JE 45725(1); JE 
45725(2), etc.

If an object needs to be broken down into more than one record because the object 
contains more than one piece, e.g. a sarcophagus and its lid, add .1, .2, etc. after the 
entire number: e.g. JE 14726.1, JE 14726.2; OR JE 45725(a).1, JE 45725(a).2. Start with the 
bottom as .1; the lid will be .2.

• Catalogue général: CG number (Use the format CG xxx, e.g. CG 471). See above under JE for 
details on how to split CG entries into separate object or piece records.

• Temporary Register: TR number (Use the format TR day.month.year.xx, e.g. TR 25.3.36.12). 
See above under JE for details on how to split TR entries into separate object or piece records.

• Special Register: SR number (SR section/ xxxx, e.g. SR 4/ 2451). See above under JE for details 
on how to split SR entries into separate object or piece records.

• Carter numbers: Excavation numbers for the Tutankhamun objects. These should be in the 
same form in which they are given on the Griffith Institute website, but without the 
placeholder zeros: e.g. Carter 14b (but a dash needs to be added for database sorting 
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purposes, so Carter 14b -> Carter 14-b). See: http://griffith.ox.ac.uk/gri/carter/
See above under JE for details on how to split Carter entries into separate object or piece 
records.

• Legrain numbers: Excavation numbers for the objects from the Karnak Cachette. These should 
be in the format: K. xxx, e.g. K. 371.

• Temporary Gallery Number: These are temporary numbers given to museum objects for which 
the correct ID number has not yet been found. These should be replaced as soon as possible.

Remember that other Excavation numbers DO NOT go in the ID number field, as they are not 
unique.

Non-EMC Objects (i.e. anything other than EMC Object or Deaccessioned under Object Status)

Instead of EMC numbers, use one of the following types of numbers in the first position in the ID 
number field, followed by any EMC numbers in the order outlined above:

1. Other SCA Museum Number: These numbers should be in the formats for their individual 
museums, according to the examples below (see SCA Museum Codes in the Appendix for list 
of codes for other museums), e.g.:

Luxor J. 291

GRM 891

NMI 457

Note that, for objects chosen to be transfered to other museums, numbers can be added here 
before the object actually leaves the museum, if they have already been assigned and the 
RCMDD has been informed of the new numbers. Other museum numbers for non-EMC objects 
should be put first in the ID number field.

2. SCA Magazine Number: If given by the SCA magazine documentation team, these can be 
entered (currently as Magazine Code.Register Series Code.SN, e.g. SQ.SCA.1234 (see SCA 
Magazine Codes for list of codes for SCA Magazines). Otherwise, these cannot be entered in 
the ID Number field and should be entered instead in the Magazine Number field, as Reg. 
xxxx.

3. Non-SCA Number: This will usually be an exhibition number, as this is the main way that 
non-SCA objects come into the museum. There are very few examples of this type of number.

4. RCMDD Temporary Number: This will usually be an exhibition or provisional number, given 
to an SCA object. You will use these when no official number is available, and they should be 
replaced as soon as possible.

7.4.8. Excavation Number (Title/ID Tab)

Excavation numbers are not unique, and therefore must go here and NOT in the ID Number field 
unless they are Carter numbers or Legrain K. numbers. The format should be Exc. No. NNN, 
where NNN is whatever set of numbers and alphas is assigned by the excavator.

Note that even if a Carter number is divided by the RCMDD, the original Carter number should 
go into the Excavation Number field.
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7.4.9. Magazine Number (Title/ID Tab)

If the object has a proper magazine number, according to the SCA Magazine Documentation 
team protocol, it should be entered both here and under ID number. If it does not have a proper 
magazine number, enter it here simply as Reg. xxx.

7.4.10. Other Museum (Title/ID Tab)

If the RCMDD knows the number at which an object has been registered at another SCA 
museum, it should be entered both here and under ID number.

If an object has been chosen for transfer to another museum, enter “Chosen-name of the new 
museum” here. Once the object is moved, remove “Chosen” and leave the name of the new 
museum; if the new registration number at the new museum is known, replace the name with the 
proper Other Museum Number both here and in the ID Number field.

7.4.11. Visible Numbers (Title/ID Tab)

This field is to be filled out whenever a number check is done on an object (e.g. during inventory 
or movement). Make sure to describe what you see, with any commentary in parentheses. Here 
are examples:  

If there is no visible number on the object itself: NVN

If there is a number on the object in red ink: red xxxx -- e.g. red 345

If there is a number on the object in black ink: blk xxxx -- e.g. blk 5678

If there is a number on the object in white: white xxxx -- e.g. white 34566

If there is a number on a label: xxxx on label -- e.g. 3678 (on label)

 If the number is written in a cross: 1.4.23.30 (in cross)

If you find later that the number on the object is incorrect, put this information in parentheses: 
e.g. blk 5678 (incorrect).

7.4.12. Category Details (Title/ID Tab)

NOTE: If you are having trouble finding the proper categories and subcategories, check the 
RCMDD Authority Lists. This is only available in soft copy.

ANOTHER NOTE: If you still cannot find the proper category or subcategory, still DO NOT type 
anything new into these fields. Instead, bring the issue up at morning meeting for discussion. If 
you are unclear, chances are others are as well. If the thesaurus needs to be edited, this needs to 
be done officially, according to the proper procedures.

Category

Choose appropriate object category from the look-up list.

Subcategory 1

Specify object subcategory from the look-up list.

Subcategory 2

If possible, choose a final specific object subcategory from the look-up list.
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SCULPTURE: if the object is a 
sculpture, choose Sculpture in the 
Round from the Category look-up list 
and leave the second and third levels 
blank. Once you choose Sculpture in 
the Round, the Sculpture tab will 
appear, and you can fill out the 
following fields:

Statue Category: This refers to the 
number of figures included in 
the object, i.e. Single, Dyad, 
Triad, Group.

Primary Pose: Choose the pose 
of the main figure of the group 
for the Primary Pose.

Secondary Pose: Choose the poses of the each of the other figures in the group for the 
Secondary Poses.

Primary Type: Choose the type (King, Queen, Elite Male, etc.) of the main figure of the 
group for the Primary Type.

Secondary Type: Choose the types of the secondary figures of the group for the Secondary 
Type.

Fragment: If the object is part of a sculpture, indicate the part here.

Animal: Choose from the lookup list.

Servant: This field is now used for gods instead; choose from the lookup list.

7.4.13. Object File?

The default for this field is “No.” Toggle this to Yes when a catalogue card is made for the object. 
This is the point at which the Object File should also be created.

7.4.14. Requests

Radio buttons are available here for the three main Cairo Museums:

• the EMC itself (meaning it has been officially selected to stay in the EMC);

• the GEM (meaning it has been selected for transfer to the Grand Egyptian Museum);

• the NMEC (meaning it has been selected for transfer to the National Museum of Egyptian 
Civilization).

• If the object has been selected for transfer to a different museum (such as Sohag, Suez, etc.), 
the new museum is entered in the Other Museum field (e.g. Chosen-Sohag).                                            
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7.4.15. Acquisition Method (Accession Tab)

Choose the Acquisition Method from the following drop-down list. 
Note: this field should not be left blank.

• Bequeathed: left to the museum in 
somebody’s will.

• Surrendered: seized from someone 
holding the object illegally; e.g. 
antiquities smugglers or dealers, 
where the Excavator/source and 
Sponsor refer to the person from 
whom it was seized. (Source 
Summary will read: Surrendered 
by the Aboutaam Brothers...)

• Confiscated: seized from someone 
holding the object illegally; e.g. 
antiquities smugglers or dealers, 
where the Excavator/Source and 
Sponsor refer to the person who 
has seized the object. (Source Summary will read: Confiscated by USDHS/ICE ...)

• Excavated: uncovered during scientific excavation. Use this when the excavator and/or 
sponsor is known.

• Exchanged: received in exchange for an object that was given to another collection.

• Found: found but not excavated e.g. during construction, in a field (but NOT as part of 
scientific investigations, in which case it should be Excavated). Use this field if the 
provenance is known but neither the excavator nor sponsor is known.

• Given: given to the museum as a gift.

• Purchased: use if a particular person has bought an object on behalf of the museum.

• Repatriated: returned to the museum by a foreign institution or government.

• Sold: use if a particular person has sold an object to the museum.

• Unknown: if there is no information available about how the object came to the museum.

7.4.16. Excavation/Acquisition Date (Accession Tab)

Year only, in four-digit format. The database cannot currently manage date ranges; we hope to 
upgrade this in the future. If you need a date range, choose the first year and put the range under 
Notes. If no date is known, this field may be left blank.

7.4.17. Registration Date (Accession Tab)

This date generally comes from the JE or TR. In the JE, the registration date is usually in the upper 
right hand corner of the spread. For the TR, it is the number in the lower left of the cross, the third 
number in our protocol. Do not use CG dates. Use year only, in four-digit format. If the object 
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has been registered more than once, use the first date. If no date is known, this field may be left 
blank.

7.4.18. Excavator/Source (Accession Tab)

Excavator refers to an archaeologist who has excavated an object; source is any other individual, 
such as a dealer who has sold the museum an object, an Egyptologist who has purchased an 
object for the museum, or a person or organization who has surrendered or repatriated an object, 
or from whom it has been confiscated. 

This field may be left blank.

All excavators and sources must be in the Parties module before they can be used here. Type the 
last name of the excavator/source in the field and click on the “attach record” icon or open the 
Parties module and search for the person/source and drag the record into the Catalogue module. 
If no record for the person exists, you must make one (see Entering Person Records).

7.4.19. Sponsor (Accession Tab)

This refers to the institution or person who has sponsored an expedition. This field may be left 
blank.

Type part of the sponsor name in the field and click on the “attach record” icon or open the 
Parties module, search for the sponsor on the Organization tab, and drag the record into the 
Catalogue module. If no record for the institution exists, you must make one (see Entering 
Organization Records).

7.4.20. Source Summary (Accession Tab)

Default for the source summary is to autofill the field. The format is “Acquisition method by 
Excavator/Source for Sponsor in Excavation/Acquisition Date, e.g. Excavated by G. Legrain for the 
EAS (Egyptian Antiquities Service) in 1903. In case this format does not suit your needs, you can 
override it by toggling the “No” radio button; this allows you to type in the field, e.g. Excavated 
by A. Mariette in 1858, repatriated by Z. Hawass in 2003.

7.4.21. Source Details (Accession Tab)

This is a series of fields that define the provenance of the object. The levels are Region, Area, Site, 
Monument, and Feature; for as many of these as possible, beginning with region, these should be 
filled out from the look-up lists attached to the fields. Note that if you know a lower level, for 
example the monument, and you fill this out first, the categories above will be automatically 
filled when you click on the look-up list icons next to them. 

This field may NOT be left blank. If you do not know the provenance, choose Unknown.

Region

The larger region from which the object comes, e.g. Memphite Region OR Northern Upper Egypt 
OR Thebes, etc.

Area

The area within the region from which the object comes, e.g. Giza OR Thebes: East Bank
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Site

The specific site from which the object comes, e.g. Pyramid Complex of Khufu OR Valley of the 
Kings

Monument

The tomb, temple, or other monument in which the object was found, e.g. Tomb of Ptahhotep OR 
KV62: Tutankhamun

Feature

If known, the chamber within the monument in which the object was found, e.g. Burial Chamber.

7.4.22. Dating Details (Accession Tab)

This group of fields works in a fashion similar to that of the Source Details. These fields define the 
date of manufacture of the object. Fill out as many of these fields as possible, beginning with 
Period. If you know a lower level, such as the name of a king, you can fill this out first and the 
previous levels will auto-fill. 

This field may NOT be left blank. If you do not know the dating, choose Unknown.

The list of terms for the lookup lists can be found in the RCMDD Authority Lists.

NOTE: We do not have a hard-and-fast rule about cases in which the object was made at one 
time and re-used or usurped later. In some cases, it will make more sense to put the original date 
of manufacture; more often it will make more sense to put the date of usurpation or re-use. In 
either case, make sure that you put details about the original date and reuse into the Notes field.

Period

The kingdom, intermediate period, etc., to which the object dates.

Dynasty

The dynasty or sub-period to which the object dates.

King

If known, the king to whose reign the object dates.

Absolute Dates

If you have filled out all the levels, this field will auto-fill if you click in it. If you have only filled it 
out through Level 1, 2, or 3, you will get a drop-down list that covers all the year ranges for the 
choices in the level you have gone to, plus everything underneath. For example, if you choose 
Old Kingdom, you will get all the years under this (all the dynasties and individual kings). In this 
case, choose the first option in the drop-down list.
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7.4.23. Measurement Details (Physical Tab)

An object’s measurements are an 
extremely important part of its basic 
identification information. Such 
measurements should ideally be taken 
when the object is accessioned, and 
recorded in the JE register and in the 
database. If full object measurements 
for accessioned objects are not already 
in the Catalogue record, or if there is a 
significant discrepancy between 
measurements given by various sources, 
the object should be measured when it 
moves, is inventoried, is being readied 
to go out on loan, or when the object 
record is being taken to the approval 
level.

Measurements may be entered from the register books, from reliable measurements provided by 
museum staff or scholars, or from measurements taken by RCMDD staff. See Measuring Objects 
for guidelines on how to do your own measurements. You will normally add these, if necessary, 
in the final stages of cross-checking objects in preparation for approval.

NOTE: In the past, the RCMDD has estimated object measurements from photographs. Now that 
the office has better access to the objects themselves through the cooperation of the section 
heads, this should no longer be necessary. Therefore, the old protocols for estimating object 
measurements have been deleted.

To enter measurements into the database, first select the Type field, click on the look-up list icon, 
and type max to auto-fill the field with “Maximum dimensions.”

If you wish to add other dimensions, such as the length of the arm of a statue or the height of a 
base, you may fill out a second (or third, etc.) line here. Under type, specify what you are 
measuring.

Dimensions are always in centimeters (which will be the default under Units). There should be 
three dimensions for all three-dimensional objects, if possible: height, width, and depth for most 
objects; height, width, and length for horizontal objects such as coffins and boxes. If the 
information is coming from a register book, this may not be possible, but a third dimension 
should be filled in as soon as it becomes available (if the object is moved or sent out on loan, or 
a catalogue card is done and the RCMDD has a chance to measure it).

NOTE: Use points, not commas. You will never have a reason to use a comma in any of these 
fields.

Weight can be in grams or kilograms. You can add the appropriate choice when you fill out the 
weight.
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7.4.24. Measurement Notes (Physical Tab)

Add any important notes about measurements here. You may add here, for example, 
discrepancies between the register books, or the fact that a measurement has been taken through 
a vitrine and is not completely reliable. Always mention here if the measurements have been take 
by the RCMDD. Use the following format for conflicting register entries: Dimension: source = 
measurement; e.g. SR: H. 31 cm; JE: H. 34 cm. Use the following format for measurements added 
from other sources: Dimension: Source, date if possible, (notes) e.g. D, W: RCMDD 12-2009 
(through vitrine).

7.4.25. Materials (Physical Tab)

Choose one or more materials from the look-up list. Always put primary material first. A list of 
approved materials is available in the RCMDD Authority Lists.

7.4.26. Description (Physical Tab)

Descriptions are added to catalogue records only as part of the Approval process. In general, 
leave the description blank unless you are preparing a record for approval. Notes from the 
register books may be put into this field as placeholders, but full descriptions should only be 
written when the object itself has been seen and studied.

In general, object descriptions should be written and checked against the objects themselves. A 
description can begin with an extended title OR a full sentence. The rest of the description should 
generally be in full sentences. It does not need to be long (if the title covers all necessary 
information, you can, in fact, leave it out altogether), but it should point out the most important 
distinguishing features of the object, and note any significant damage or restoration. In general, 
try to work top to bottom and left to right. Describe what you see; leave interpretation for object 
labels and website narratives. 

So that the description will appear properly on the catalogue card, you must limit it to 925 
characters or less (approximately 175 words). This will be sufficient in almost all cases for an 
adequate description.

See below, Approving Object Records, for additional guidelines on object descriptions.

7.4.27. Notes (Physical Tab)

This field should be used for all comments that do not fit easily into another field, such as 
acquisition information that does not fit into the thesaurus-built list. Enter here information about 
register entries that have been broken down; corrections that you have made based on 
discrepancies between register books; information from scholars or curators; problems that need 
to be addressed, etc. Always note the source of your information. (E.g. JE: sandstone; SR: 
quartzite. JE: Dynasty 30; SR: Dynasty 29). Do not put extra hard returns in this field because 
they will take up extra space on reports.

7.4.28. Recorder Summary (Recorder Tab)

This area is not editable; the fields here will be filled automatically when you enter the data in 
the Recorder Details fields.
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7.4.29. Database Process (Recorder Tab)

This helps keep track of where the 
office is in the process of Cross-
checking and approving the record. 
Choose from the drop-down list:

Record Creation

JE Cross-check

CG Cross-check

TR Cross-check

SR Cross-check

PM Cross-check

Griffith Cross-check (note that 
this is only for Griffith Tut, not 
Griffith PM)

Search (if you are looking up ID numbers in the old database. Make sure to include this, 
with a note in Recorder Remarks, even if you do not find the number there, so that the 
next person does waste time doing this again.)

Information Provision (if not from a Register)

Number Check (see Inventory)

Full Cross-check

Description

Catalogue Card

Record Approved

Note that you only need to make an entry here if you are doing a new process or making major 
corrections to a previously carried-out process. If you make only minor changes, such as 
correcting spelling or grammar, do not add your name or the process here.

7.4.30. Database Date (Recorder Tab)

You may autofill this field with the current date with the command [Apple/Command/Cntrl + :]. If 
you type a date, note that it should be in European format: DD/MM/YYYY (i.e. 16/03/2009). 

7.4.31. Recorded By (Recorder Tab)

Type your name in the field (usually first names and sometimes part of the last name are enough) 
and click on the “attach record” icon. This will automatically fill in your full name and title, 
unless there is more than one similar record, in which case the Parties module will open so you 
can choose which one you want to add. 
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7.4.32. Recorder Remarks (Recorder Tab)

If you add information to a record that is not in a register book, divide an entry into multiple 
Parent records, or correct an error in a register book, you may record the information and its 
source in this field. Make sure that any key information added here is also put into the Notes field 
-- it is more important to put this into the Notes field than it is to put it here.

7.4.33. Current and Permanent 
Locations (Location Tab)

These fields, and the others on this tab, 
are introduced below, under Location 
Records.

7.4.34. Independently Moveable 
(Location Tab)

This is used for Parent-Child records:

All Parent records should be marked as 
“Yes” under Independently Moveable. 

All Child records should be marked as 
as “No” under Independently Moveable (on the Location Tab, lower right).

MOVEMENT NOTES: If all children are moved at once to the same new 
location (i.e., entire object moves), move only the parent. The children will all 
move. If pieces are moved separately, move the child records separately.

7.4.35. Bibliographic References (References Tab)

This field attaches to the Bibliography 
Module. To fill it out, type part of the 
title of the reference, then hit tab. The 
Bibliography Module will open. Choose 
or create the record you want to attach 
(see Bibliography module for 
instructions). There should be only one 
record per book or article.

7.4.36. Bibliographic Notes 
(References Tab)

Add page or plate numbers, or other 
reference details, in this field. Use the 
following abbreviations:

p. (page)

pp. (pages)

Pl. (Plate)

fig. (figure)
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7.4.37. Associations 1 Tab

If an object has piece records 
associated with it, this information is 
recorded in the Associations 1 tab. For 
now, only the first two fields need to 
be filled out:

• Is Parent? (Associations 1 Tab)

The default setting is “Yes.” For most  
records, leave this as is.

For the Parent record (for example, JE 
47032, “First Sarcophagus of Queen 
Hatshepsut”), this will be marked 
“Yes.” You will also mark this “Yes” for 
Family records.

For the Child records, this should be set as “No.”

• Parent Object (Associations 1 Tab)

For Child records (for example, JE 47032.1, “First Sarcophagus of Queen Hatshepsut: Lid” and JE 
47032.2, “First Sarcophagus of Queen Hatshepsut: Base”), a link is made here to the parent 
record (JE 47032, “First Sarcophagus of Queen Hatshepsut”).

For object records that are part of a Family group, attach the Family record here (remember that 
any pieces that are part of a Family should be attached to their Parent objects, not directly to the 
Family record).

To attach the Child records or Family subrecords to the Parent record (which can be an object 
record or a family record), enter the ID number of the Parent or Family record in this field and hit 
tab, or the green plus. If more than one record matches this ID number, a new Catalogue Module 
window will open, and you will need to choose the correct record from the list and click on the 
attachment button to attach.

7.4.38. Parts Tab

You will not do any editing in this tab; 
it is read-only. For objects without 
pieces, you will see only information 
for the object itself here. For objects 
with Parent-Child parts, you will see 
information for all associated records. 
The information you see here will be 
as follows (you can change the size of 
the columns to see more or less 
information by placing your cursor 
over the divider and moving it):

• Object: summary information on 
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the object (ID Number, Title, Category, Dating)

• Location: the current location of the object

• Date: the date on which the object was moved to this location. (Note that if this date is 
unknown, you will see 01/01/1111, as per the RCMDD protocols.)

7.4.39. Notes Tab

At the moment, this is mainly used when doing Griffith Cross-checks for Tutankhamun objects. 
For these objects, copy and paste Carter's notes for the object from the website to the Notes tab. 
You can also use this for additional information from scholars (e.g. the GAP project) that does not 
fit in the physical notes field.

7.4.40. Condition Tab

Three fields are used on this tab: 

• Condition Status: choose from dropdown 
list.

• Date Checked: date on which the condition 
report was done by the RCMDD.

• Checked by: name of registrar who has 
done the condition check/report; this links 
to the Parties module.

7.4.41. Inscriptions Tab

This tab is not currently being used, but is set up 
for later use.

7.4.42. Narratives Tab

This is used to store website and label text.

7.4.43. Record Status (Security Tab)

The default here is Active. This should be left as is, since we want to make information on all 
objects, even if they have been deaccessioned in some way, available.

7.4.44. Publish on Internet (Security Tab)

Records chosen to be published on the public Internet website (for now, only approved records) 
should be marked “Yes.” All others should be left as “No” (the default setting).

7.4.45. Publish on Intranet (Security Tab)

All records should be marked “Yes” here. This is the default.
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8. Multimedia Records: Overview
Many types of files can be linked to the database through the Multimedia Module. These include 
but are not limited to:

• object photographs

• facsimile pages (including the Journal d’entrée, the Temporary Register, the Catalogue general, 
the Special Register, Porter and Moss)

• event photographs

• publications such as excavation reports and catalogues 

• other documents, such as pdfs and text documents

These files are managed through the Multimedia Module, and can be linked from here to many 
of the other modules. At this point, we are attaching multimedia records mainly to the Catalogue 
and Event modules, with certain files attached to the Locations module and pdfs of articles and 
other references attached to the Bibliography Module.

 The following section outlines the basic elements of this module, and gives an overview of how 
to manage multimedia records. For details on Image Acquisition and Management, see below.

8.1. Creating Multimedia Records

To create a new multimedia record, you can work either from an outside module (in which case 
the record will immediately be attached to the relevant outside record), or from the Multimedia 
module itself, in which case you will need to attach the Multimedia record to any relevant 
records in other modules.

In either case, you will need to find the original copy of your file. In most cases, you will work 
from your PC/Mac, although in some cases you may need to go into the RCMDD backup system:

• Object and Event images are on My Book Images, in a series of folders.

• Facsimiles are on My Book Images, in appropriately-labeled folders.

• Excavation reports and other similar documents will be in various places, including the 
RCMDD Digital Library (Akhenaten->Ruby->RCMDD-DOC->Library->Digital_Library) and in 
the object files (also on Ruby).

8.1.1. Creating a Multimedia Record in the Multimedia Module

Step 1: Create Record
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To begin a new record, click once on 
the white Page icon in the top left of 
the Tool bar.

There are several ways in which you 
can add an image file or other 
document to this record.

• Drag and drop: open the backup 
drive and folder in which the 
document is stored, and simply 
drag it into the multimedia 
window. A green plus will appear, 
and you will get a message window 
that tells you it is copying and then 
adding the document.

• Import as file, URL, or Reference. At this point, we are using files only. 
To add a file, choose file from the drop-down menu. You will get a 
browser window that will allow you to navigate to the file you want to 
add. Select this file, and say add. The file will be added to the 
multimedia record.

• Import a folder or group of folders: use the Import Tool.
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NOTE that for images, the database will automatically generate several sizes in jpeg format for 
use on the website and in reports.

NOTE ALSO: images should be in RGB mode and 8-bit. See Image Acquisition and Management.

Step 2: Fill out fields

After the file has appeared in the multimedia window, fill out the relevant information according 
to the Multimedia Field Definitions. If you have used the Import tool, most or all of these fields 
should already be filled out.

8.1.2. Creating a Multimedia Record via an Outside Module

Step 1: Find File

Go to the relevant drive from your computer (either on your computer or on a backup drive) and 
open the folder that contains the files you want to import.

Step 2: Open the outside module and find the relevant record

Open the (e.g.) Catalogue module. Search for the object you need, open that record, and move to 
the Multimedia tab. 

Step 3: Attach File

Select the file you want and drag and drop it into the image pane on the Multimedia Tab.

Step 4: Save.

Step 5: Complete Multimedia Record

Click the blue arrow on Multimedia Toolbar and the Multimedia Module will open. Complete the 
entry by filling in the following fields (see also Multimedia Field Definitions): 

• For Object images:

Title Field (insert Filename)

Creator Field (name of photographer)

Date Field (date of file creation)

• For Event images:

Title Field (insert Event number)

Creator Field (name of photographer)

Date Field (date of file creation)

Description Field (caption including, at a minimum, the names of people in the image)

• Save and close the Multimedia Module

8.2. Multimedia Field Definitions

RCMDD Protocols 12-2010  96



In general, you will only need to look at the first two tabs here, the Multimedia and Details Tabs.

8.2.1. Title (Multimedia Tab)

• For object images, the file name should be entered here. You can copy and paste from 
Identifier field.

• For event images, the Event number should be entered here.

• For other files, such as pdfs of articles, a short version of the document name should be 
entered here.

8.2.2. Creator (Multimedia Tab)

• For photographs: the name of the photographer should be entered here from the drop-down 
list. (NOTE: This does not link to the Parties module.) 

• For IDSC slide scans, this should be: IDSC: sheet #.

• For facsimile pages: leave this blank.

• For other documents: the name of the author or other responsible party should be entered 
here.

8.2.3. MIME Type (Multimedia Tab)

This is the file type (image, text, etc.). The database system will enter this automatically.
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8.2.4. MIME Format (Multimedia Tab)

This is the file format (jpeg, tiff, doc, etc.) The database system will enter this automatically.

8.2.5. Identifier (Multimedia Tab)

The database will automatically enter the file name here.

8.2.6. Description

When the data was migrated from Filemaker, this field was populated with the list of object 
records to which the image was linked. These are still important for the facsimiles, but is 
otherwise not necessary or useful. In future, this field will be used as follows:

• For register facsimiles: list of object numbers mentioned on the spread.

• For object images: leave blank (the Title is adequate for searching purposes).

• For event images: captions; at a minimum, add names of people shown in photographs, find a 
sensible way to label the photograph, and just make sure you indicate this (e.g. clockwise 
from front left; left to right; back to front, etc.).

NOTE: Not all multimedia records need to have this field filled out.

8.2.7. Source (Details Tab)

The path to the backup version of the document 
from which you attached the file will appear here if 
the record has been migrated from Filemaker.

8.2.8. Date (Details Tab)

The date should be in numerical format, in European 
style (DD/MM/YYYY).

NOTE: You may type the date without any spaces or 
slashes, e.g. for March 18, 2009, you can type 18309 and you will automatically get the correct 
date format when you move to the next field.

• For photographs: the date on which the photograph was taken should be inserted here.

• For facsimiles: leave this field blank.

• For IDSC scans, enter 1/1/2000.

• For other documents: insert a relevant date, if possible.

8.3. Attaching Multimedia Records to Outside Modules
The following protocol can be used, for example, for attaching multimedia records to object 
records in the Catalogue module, as well as to Event records in the Event module, and/or to 
Location records in the Location module.

Step 1: Find Multimedia Record

Open the Multimedia Module and search for the record you want to attach, using the Title or 
Description fields:
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• For object images: Search in the title field using the file name, which will usually be the JE 
number: JE_12334*. Add a star at the end to account for multiple images (if this does not 
work, try another relevant ID number), OR search in the description field, using the JE number 
if available, or one of the other ID numbers if not.

• For facsimiles: you can search for the whole register book, e.g. JE IX, by typing JE_IX_* in the 
title field. A specific spread in that register book would be e.g. JE_IX_Sp002-003. You can also 
search in the Description field by object ID Number.

• For event images: Search in the Title field for Event number, or in Description if searching for a 
specific person.

You may get one record, or a group of records, which will appear in List view. If you get a group 
of records, look at the list of records and double click on the one you want to see it in Detail 
view.

Step 2: Check Attachments

To see what outside records are already attached to 
the multimedia record, either click on the Objects 
Tab, or, if it is not visible, go to View->Attachments-
>Options->Show tabs. The objects tab, for example, 
will appear and you will see all the object records to 
which this multimedia record is attached.

To see what Event records are already attached to the 
multimedia record, go to View->Attachments-
>Current Record. The attachments are shown in 
green and you can choose them and click on view to 
bring them up.

Step 3: Find Outside Record

If the record you want is not linked to the outside 
module (for example, the Catalogue module), open 
the outside module and search for the record to 
which you want to attach the multimedia record. You 
will now have a Multimedia module window and 
another module window next to one another. Make sure you are in the Multimedia tab within the 
Multimedia module.

Step 4: Drag and Drop Multimedia Record

In the Multimedia Module window, click on the white Page icon with the green square inside and 
drag it to and drop in the Image Pane in the open record in the outside module.

If your image is displayed in List view, click on the record and drag and drop. To attach more 
than one image, select the images you want from the list and click and drag the icon furthest to 
the right.

Step 5: Save.
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9. Location Records: Overview
Locations are stored in the Location module, and then attached to catalogue records in the 
Location tab of the Catalogue module, in both the Permanent Location and Current Location 
fields.

To find a location, you can search in the Location module directly, or look for a location record 
through the Catalogue module (Locations tab).

9.1. Location Module

Every individual location should have its own record in the Location module.  These locations 
will be created as the museum and its objects are inventoried.

To create a new record, click on the white Page icon on the left in the Tool bar or by going to 
File->New Record.

The important fields in this module, and what is to be entered in them, are as follows:

9.1.1. Location Code

The location code gives the team 
information about source of the location, 
and allows us to see where we are in the 
process of determining locations. All EMC 
locations MUST include location codes.

The following are the accepted location 
codes, and their meanings:

Display: on display; location 
confirmed in situ through Gallery 
Inventory or Movement.

Storage: in permanent storage; location confirmed in situ through Gallery Inventory or 
Movement.

STORAGE: in storage; location either not confirmed in situ or not yet adequate in terms of 
level of detail -- this information will have come from a section head.

Temporary: in the location temporarily, usually after return from loan but before moving 
back to permanent location or in a temporary location for object study or photography.

Conservation: if the object is in the conservation lab.

Exhibition: if the object is in the exhibition gallery (generally R44).

Loan: if the object is out on loan -- used for non-EMC (and often non-Egypt) locations.

From SR: location taken from Special Register.

From JE: location taken from JE ledger.

From TR: location taken from TR ledger.

From CG: location taken from CG position book.
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From Section: information from section head or other curator.

To be det.: if object has not yet been accessioned or there is some reason that no 
permanent location has yet been assigned.

Unknown: if the location of the object is not known. This is used for the Permanent 
Location; in these cases, the Current Location should be left blank.

Other-Code (e.g. Display/Storage/From SR) - not in situ: If there is a location in a register 
book, or a location that was entered from an earlier inventory or movement, but the object 
is not where it is supposed to be, use this code. 
NOTES: The source of the location information also should be detailed in the Notes field, 
and the last known location should be entered under Permanent Location, with this code 
to indicate that it is not actually there. In these cases, the code for the Current Location 
should be Unknown, and the Current location fields should be left blank.

Stolen: Use only if the object is known to be stolen. 
NOTES: If the current location of the object is not known, enter the last known location in 
the Permanent Location field, with Stolen as the code (and detail the source of the 
information in the Notes field). Under Current Location, enter Unknown as the Location 
Code, and leave the Current Location fields blank. If the object has been located (usually 
abroad), enter this location in both the Permanent and Current locations, with Stolen as 
the code. Make sure to mention the last known museum or magazine location in the 
Notes field, along with the source of the information.

In situ: Use this if an object is still on site, rather than in a museum or magazine, e.g. 
Mummy of Tutankhamun (location is KV62).

Various: Use for Parent or Family records where the objects or pieces are in different 
locations.

9.1.2. Location Hierarchy

All locations are entered into the database in levels, from the general to the specific.

DO NOT use square brackets or spaces in any location fields.

Level 1: Enter the museum name or storage magazine in the field called Level 1, using the codes 
listed in SCA Museum and Magazine Codes.

Level 2: If you are in the Egyptian Museum, Level 2 should be the gallery name.

Level 3: The designation for the wall, center, or other zone should go here.

Levels 4-8: Enter all subsequent location information successively in Levels 4 through 8, such as 
specific locations within a wall area (indicated as lower-case alphas), vitrine names and divisions 
such as Pup, Arm, Bas, Level, etc.

Only fill out the fields to the level you need; you will rarely get to Level 8. Fill out the fields in 
order, and do not leave blank fields between filled-out fields: there should not be any empty 
fields except at the end.

Formatting Notes (see Locations):
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• Gallery names include a floor designation and a number, with a prefix or suffix in certain 
cases: R47; P14-Corr; P3-Mag; Atrium-R18.

• Wall locations are written with a cardinal direction (abbreviated as N, S, E, and W) and a 
number with no space: N3.

• Center locations are written with a dash between Center and the cardinal direction: Center-W.

• The word Vitrine should be abbreviated to Vit (note that there is no period at the end of Vit), 
and any identifiers attached with dashes: Vit-G-3823B. Alphas for vitrines should be 
uppercase.

• Dashes should used between Pup, Arm, Bas, and any identifiers: Pup-2.

• Dashes should be used between “Level” and level numbers, e.g. Level-3. 

• Specific locations should be denoted by lower case alphas.

• Examples of full locations (fields separated with -)

EMC - R49 - N3 - Vit-Y - Arm-1 - Level-2 - c

EMC - R14 - E3 - a

EMC - P3 - Center-W - Vit-N - Pup-2 - d - 3

9.1.3. Location Type

For now, all locations will have the type “Location.” We will continue to explore the Holder 
option in the future, but we have not yet figured out how to use this effectively.

9.1.4. Location Supervisor

Entered here should be the name of the section head or other museum or SCA staff in charge of 
the location (if known). This field links through to the Parties Module. All EMC locations with 
location codes of [Display] or [Storage] MUST have location supervisors.

If there is an object on display or in storage, but there does not appear to be a section head 
assigned to it, attach the “Unassigned” Parties record to the location.

If there is a record for an object that is missing, and the object has not been registered in the SR, 
attach the “Unknown” Parties record to the location.

9.1.5. Multimedia Tab

General views of galleries and vitrines should be linked to this module here.
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9.2. Catalogue Module, Location Tab

Specific locations for individual objects 
and pieces are attached to their objects 
through the Location tab of the Catalogue 
module. On this tab, you will find three 
relevant fields:

• Current Location

• Permanent Location

• Movement History

The Current and Permanent Location fields 
are linked to the Location module: the 
information you see here is a summary of 
a record in this module. The Movement 
History shows you a sorted list of all 
current locations that have been associated with the object, with the last current location on top. 
You cannot enter data here.

The remaining fields in the Current Location area are reviewed under Object Movement and 
Current Locations and Inventory.

9.2.1. Permanent and/or Current Location Fields

If the Permanent and/or Current Location of an object is known, it should be attached to the 
catalogue record in the Catalogue module, in the Permanent and/or Current Location fields on 
the Location tab.

1. Type part of the location in the location field, with dashes or spaces between the levels, and 
hit tab or press the + button. The Location Module will open, with one or more location 
records to choose from. 

2. Browse through the location records that are listed until you find the one you want.

3. Select the correct record and hit the Attach button (the + sign on the top right corner). This 
will attach the location to your catalogue record.

4. If you do not find the location you are looking for then it has not yet been entered into the 
database. In this case you must create a new Location record.

NOTE: If you find a location for the object, but it needs modification, DO NOT change the 
location unless you are sure that the modification is correct and necessary. Also be aware that 
this location might be associated with other objects; if you change this location, it will change for 
ALL the other objects attached to it.
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10. Full Cross-checking, Object Approval, and Object Files
This section outlines the steps that need to be followed to do full cross-checks for each object 
record, and how and when to submit a record for approval. These protocols are designed to 
ensure that the information in the database matches the information in all relevant registers, as 
well as Porter and Moss and any major comprehensive outside sources, as closely as possible. 
Full cross-checks include a check of all object information in all register books and an attempt to 
inventory the object in situ (at which point it will be possible to obtain a reference image, both 
Permanent and Current Locations, and a number check). After a full register cross-check has been 
done AND the object has been found in situ, the object record may be submitted for approval.

There are two levels of approval. The main difference between the two is that objects approved at 
Level 1 will not have printed catalogue cards and object files; objects approved at Level 2 will 
have printed catalogue cards and object files. All approved object records should be published 
on the Internet. 

Full cross-checks are done for a number of purposes, most often as part of the process for 
Inventory, Movements, Loans, Exhibitions, and Outside Requests. Whenever possible, move right 
to the Approval process; this will, however, be impossible for many of the objects in the 
basement, in storage, or in an outside SCA museum or magazine (most often encountered when 
processing Outside Requests).

Note that only Senior Checkers are qualified to do full cross-checks.

10.1. Full Cross-Check
To complete a full cross-check of a record, follow these steps carefully:

Step 1: Find the Catalogue Record

Do a search for the object’s catalogue record, and make sure you review the Parent and any 
relevant Child records. If the record is not already in the database, create it now.

Step 2: Check ID Numbers 

Check that all relevant official ID Numbers have been entered into the ID Numbers Field. (See 
Finding ID Numbers if you need assistance with this step.)

Step 3: Check the Multimedia Tab

Go immediately to the Multimedia Tab, and, make sure that all the images attached are for the 
correct object; if not, correct these immediately. If there are duplicate images, or bad images 
(scanned from books, or just poorly photographed), delete these. Then, IF POSSIBLE, make sure 
that you have the following thumbnails showing, in this order: 

1. Master or Placeholder Image: if possible, you should have a reference image here in which 
the entire object can be seen, from the front or in three-quarters view. If you do not have an 
image, and the object is accessible, go and take one. If the object is not accessible, make sure 
that the placeholder image (noimage.jpg) is attached and in the first position in the 
multimedia module.

2. Additional images of the object.
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3. Facsimiles of all relevant register pages, in this order: JE, CG, TR, SR. If you are missing a 
facsimile, find and attach it immediately. If the facsimile does not show up in the Multimedia 
tab, it may be linked improperly, and you should correct this immediately. (There are still 
some CGs missing; check the list to make sure the CG is available before you waste time 
looking for the relevant page.) For the CGs, put any plates before the text  pages.

4. A facsimile from Porter and Moss, if possible.

5. Any available excavation records or other publications.

If the thumbnails are not in this order, simply drag and drop them in the proper order.

NOTE: To view the basic information for a multimedia record, simply highlight the thumbnail for 
the relevant record. Note that all of the information in the Resource Information and Description 
areas comes directly from the Multimedia Module; you cannot edit it here. To go to a multimedia 
record, click on the blue right arrow (third button from the left beside the image window on the 
Multimedia Toolbar). This will take you to the Multimedia Module, to the set of Multimedia 
records attached to this Catalogue record.

Step 4: IF POSSIBLE, Inventory the Object (locate it in situ)
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It is important to fill out the Current and Permanent Locations at this point for the object if you 
can. If you cannot find the object, you will not be able to submit the record for approval.

Step 5: Check the relevant Catalogue module database fields systematically. Some people find it 
helpful to use the “Senior Checker Shortcut” that you can have to the left of the record. If the 
shortcut menu is not visible, go to Menu ->View-> Shortcuts -> View Shortcut and choose the 
Senior Checker Shortcuts.

When doing a full cross-check, it is extremely important not to assume that previous cross-checks 
of the register books have been done correctly: Just because a JE cross-check has already been 
done, for example, does not mean you should not do it again. The advantage of having all of the 
register books linked to the database is that this can be done easily and quickly. The  more 
accurate the database is, the better, and cross-checking is essential to making the database as 
clean and accurate as possible.

You can open the facsimiles in Picture Viewer from the Multimedia Tab, open the relevant 
facsimile record in the Multimedia module, or use the Facsimile module of the old Filemaker 
database. It is much easier to work if you have your record and the facsimile you are working 
from open at the same time, side-by-side. Note that if you use the old database, you still need to 
check in EMu that all the relevant pages are linked to the catalogue record, and in the right order.

• Begin by checking all fields against the SR (if available), then check Porter and Moss, if 
possible (use both the scanned publication and Griffith Institute Website List of Objects in the 
Cairo Museum - http://www.griffith.ox.ac.uk/gri/3biblist.html), then check the other relevant 
ledgers.

• If the CG number cross-referenced for the object is from a CG book which is not in the 
system, make sure you mention this in the Notes field.

• If the object is from the Tutankhamun collection, also check the Griffith Institute website: 
http://griffith.ox.ac.uk/gri/4tut.html.

• If the object comes from Giza, you may also check the Giza Archives website: http://
www.gizapyramids.org/code/emuseum.asp?newpage=search_basic, although a new project 
to work directly with the gizapyramids.org team is underway, and they may be doing this part 
of the cross-check for us.

• If the object comes from the Karnak Cachette, also check the IFAO - Karnak Cachette 
Database: http://www.ifao.egnet.net/bases/cachette/.

• Work slowly and carefully -- better to do it right once than have someone else have to correct 
your work or pick up things you’ve missed.

• Make sure that the title is in good English, with proper capitalization, and that ALL possible 
fields have been filled out.

• As you work, look for spelling mistakes and incorrect grammar, and make sure everything is 
according to the field definitions protocol.

• Make sure that all of the pre-defined fields contain approved terms from the RCMDD 
Authority Lists (an Excel file). If you find, for example, a provenance that is not in the drop-
down lists, check with the Thesaurus team to see if it is there under a different name; if not, it 
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can be added after consultation with the team heads. NOTE: If you can't find something, first 
check the Thesaurus yourself - everyone should have this, the Griffith PM and the Excavator/
sponsor Excel file (Excavator_List_draft), on their computers.

• In older records there might be some information that has no source and does not appear in 
the register books. If this is the case, try quickly to find out where this information comes from 
(check the Illustrated Guide (Bongioanni et al. 2001)), as this was used early in the project). If 
you can find the information easily, add the source to the object record, and make a note of 
the source in the Notes field. If not, make a note in the Recorder Remarks. If you cannot find 
it, you should delete it -- we do not want to keep information with no recorded source that 
does not match information in the register books.

• Make sure the record is internally consistent (e.g. the title field does not say “Inscribed 
Limestone Block” when the material field has “Calcite”).

Here is the list of fields to work through. You do not need to worry about which tabs the fields are 
located on, as you can use the shortcut menu to move from field to field. All of these fields MUST 
be filled out, unless otherwise noted.

Main Title (check carefully for correct capitalization)

Object Status

Object Rating (if applicable)

ID Numbers

Other Numbers (if applicable)

Visible Numbers (if possible)

Category (if the record is for a sculpture, make sure to go to the sculpture tab and check 
that it is filled out properly)

Subcategory 1

Subcategory 2 (if applicable)

Acquisition Method

Excavation/Acquisition Date (if known)

Registration Date (if known)

Excavator/Source (if known)

Sponsor (if known). If no sponsor is indicated in the register books, check the Excel file 
called Excavator_List_draft - this should have most of the relevant information. If you can’t 
find it here, look in the digitized version of Who Was Who in Egyptology, found attached 
to the Bibliography module and in Akhenaten->Ruby->RCMDD-DOC->Library-
>Digital_Library->Books->Bierbrier M.I_Who Was Who in Egyptology.

Source Summary (remember that this is usually generated automatically; you should save 
the record after you have finished with the other Acquisition Details and check that what 
shows up here makes sense). This field must not be blank; if no Acquisition information is 
available, you should make sure Unknown shows up here.
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Region (There must be something in this field; if it is clear that no provenance is known, 
enter Unknown here.)

Area (if known)

Site (if known)

Monument (if known)

Feature (if known)

Period (There must be something in this field; if it is clear that no dating is available, 
choose Unknown here.)

Dynasty (if known)

King (if known)

Absolute Dates (This will auto-fill when you click in the field.)

Measurements (Make sure that you check the dimensions against any available images to 
make sure they are in the correct fields. Use common sense in dealing with 
inconsistencies in measurements. If the CG and JE differ by 1 centimeter for an object that 
is over 20 centimeters tall, for example, or by 5 centimeters for an object that is over 100 
centimeters tall, consider this within the margin of error; this will reflect differences in the 
way the object was measured. Worry only if the measurement is significantly off relative to 
the object’s size. Also, remember that you should have three dimensions, if possible, so if 
you are going to submit the record for approval, try to measure additional dimensions 
yourself.)

Measurement Notes (If no image is available, and you are not sure which dimension is 
which, DO NOT put the dimensions into the fields. Put them in Measurement Notes 
instead, with an explanation.)

Materials (Make sure these are according to the current protocols.)

Notes (Make sure the information here makes sense. Be sure to note any differences 
between registers or other sources, such as different provenances or materials, or problems 
with ID numbers, here, along with an explanation of the solution you have chosen, if 
necessary.)

Permanent Location (Make sure the location code is filled out here, and that the location 
is written according to protocol. You should have something here by the time the Full 
Cross-check is finished, even if what you have comes from a register book only.)

Current Location (Remember this should only be filled out if the object has been seen in 
situ. As you do the full cross-check, make sure the locations visible in the Movement 
History are filled out according to protocol. If they are not, click on the blue arrow to 
open the records and clean them up now!)

Independently Moveable (Make sure “Yes” is checked if you are working with a Parent 
record and “No” if you are working with a Child record.)
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Recorder (Add your name and Full Cross-check here, along with any other cross-checks 
you have carried out that had not been done previously or to which you have made 
substantive changes or corrections.)

Bibliography (Make sure all references are filled out according to protocol. Note that 
cleanup of the Bibliography module is still underway as of March 2011, so you may need 
to clean up some bibliography records as you go. In general, the rule is that any 
bibliographic reference mentioned in the Notes must be attached to the Bibliography as 
well.)

REMEMBER: If you correct or update a Parent or Child record, make sure all associated 
records are updated or corrected as well.

Note that Full cross-checks for object approval must be checked in the database by a 
senior checker before the record is submitted for approval.

10.2. Object Record Approval
An important part of the RCMDD’s system is object record approval. Object records include 
Catalogue records and their associated Multimedia and Location records. All approved records 
can be published on the Internet; records at Level 1 Approval (records for objects that will leave 
the museum) follow one procedure, records at Level 2 Approval (records for objects that will stay 
in the museum, for which descriptions have been written) follow another. Specifically, records 
taken to Level 2 Approval need descriptions, and their catalogue cards will be printed and filed 
in manual object files.

Manual object files are the key element of the manual system for tracking the objects in the 
museum’s collections. These files both stand alone and provide a backup system for the database, 
as the catalogue card, along with original copies of any forms and any available published 
information, are kept in the manual object file for each object.

An object record can be approved, at either Level 1 or Level 2, ONLY after a full cross-check has 
been completed (see Full Cross-checking).

Level 1 Approval (electronic catalogue CARDX, no object file)

Object records for objects that will be leaving the museum can be submitted for approval at the 
discretion of the senior checkers and department heads. These object records will come up:

• As objects are moved within the museum.

• As objects are inventoried in their permanent locations.

• As objects are included in Outside Requests.

• As initial condition reports are generated for objects.

• As an object is published and a copy of the publication becomes available.

• As additional documentation is available on the object.

Level 2 Approval (printed catalogue CARD and object file)

At the current stage of the project, the following categories of objects should be submitted for 
approval, AND catalogue cards printed and object files should be created for:

RCMDD Protocols 12-2010  109



• New objects being registered/accessioned.

• The museum’s major masterpieces (all objects from the Illustrated Guide (Bongioanni et al. 
2001) and the Salah-Sourouzian guide should have object files by the end of the project).

• EMC objects going out on loan or being included in exhibitions.

• Objects slated to stay in the EMC that are going through the Approval process for any other 
reason (as above).

NOTE: Eventually, there should be an object file for each of the objects that stay in the Egyptian 
Museum after the GEM and NMEC open.

10.2.1. Approval Procedure

Step 1: Do Full Cross-check AND Inventory Object

A record can be submitted for approval once the following conditions have been met:

• All ID numbers have been found and corrected.

• All register books, Porter and Moss, and, if applicable, an approved outside source has been 
cross-checked, i.e. a Full Cross-check has been done. Note that if a register book (usually a 
CG) is not available, a full cross-check can not be done.

• The object has been inventoried, and a number check, a Permanent Location, and a Current 
Location have been found and entered into the database (NOTE: If the object is missing, this 
and the next step will not be possible; see below for procedures.) Only objects with 
Permanent Location codes of [Display] or [Storage] should, at this point in the project, be 
submitted for approval -- it will not be possible to inventory any other objects.

• The multimedia tab has been checked to make sure there is a good reference image, and that 
all the facsimiles are attached and in the correct order.

• The object record includes 3 dimensions (if possible).

• For objects slated to stay in the EMC, a description of the object has been written as 
necessary. If the record is for a major object (a statue, stelae, etc.), a full description should be 
written. If the record is for a minor object, the title may be sufficient. If additional description 
is needed, you may keep it as short as possible, i.e. one line (an extended title) and perhaps a 
second. Note that you should limit your description to a maximum of 925 characters 
(approximately 175 words). For most piece records, it is not necessary to write a separate 
description; the description on the object (Parent) record will generally include all pieces.

• If the record has associated records, this procedure has been completed for all Parts (see 
below for guidelines on dealing with Parent-Child records).

Step 2: Submit Record for Approval

Once these conditions have been met, you may submit the record for approval at either Level 1 
(without an object file) or Level 2 by following these steps:

• If the record is to be approved at Level 1 (no object file), leave Object File? (Title/ID tab) at 
“No.”
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• If the record is to be approved at Level 2 (object file), change Object File? (Title/ID tab) to 
“Yes.”

• Generate a Catalogue Card file for approval. This should be in pdf form. For Level 1 Approval, 
the card should be saved as CARDX_ID_Number.pdf. For Level 2 Approval, this should be in 
the format CARD_ID_Number.pdf. 

If there are children for which you do not need separate catalogue cards (the exceptions to 
this will be if Children are displayed separately from their Parents, or if a Child is traveling 
separately as part of a loan or exhibition, pull up the Child records and generate a report 
for them in list form (use “List Location” format, insert title “ID Number Children” when 
prompted, and save as ID_Number-Children).

Open the Parent Card in Adobe Acrobat. Go to 
Document->Insert Pages. Browse to your Child 
record report, and select it. Place the Child 
record report after the Parent record.

Save.

• Submit the card electronically to the Project 
Directors or Department Heads [][FOR NOW TO 
EN AND SN, IN FUTURE TO HG AND YES].

Step 3: Make Corrections

Make any corrections requested by the director or heads. Resubmit the record as necessary until 
approval is given and the record is completely clean.

Step 4: Mark Record Approved

To mark the record (or records, if there are piece records included) approved:

• In the Catalogue module>Recorder tab, add the 

Name of the approver

Record Approved as Recorder process

Recorder Date

• Go to the Admin tab for the object record (NOT for the piece records) and select “Yes” in the 
Publish to Internet? field.

Step 5: Print or File Catalogue Card

For objects approved to Level 1, file the approved card in the Permanent Collections system, in 
Akhenaten -> Ruby -> RCMDD-DOC->Permanent_Collections -> Objects_Leaving_Museum -> 
CARDX 

For objects approved at Level 2: file the pdf of the catalogue card and list in Akhenaten->Ruby-
>RCMDD-DOC->Permanent_Collections->Object_Files. Note that you may give the pdf to the 
Associate Registrar for the Permanent Collections to file properly.

For objects approved at Level 2: print the card on the front of a pre-printed card, found in the 
Catalogue Card Backs folder in the Blank Forms drawer in the filing cabinet.

RCMDD Protocols 12-2010  111



Store the printed catalogue card in its object file.

Pre-approval

Use this when the record is otherwise approved by the Project Director/Heads, but is on hold for 
some reason (usually because an object is unavailable). Example:

For a statue of Horakhty in R14: all the cross-checks have been done, and the object 
location found, but the gallery is being painted and the statue is under plastic covers. 
Therefore, a number check cannot be done and additional measurements cannot be 
taken. The record has otherwise been approved. 

Under Database Process, choose Pre-approved (note that this will only be a placeholder)

Under Recorder Remarks: Detail what  needs to be finished (e.g. waiting for number 
check/measurements as is currently unaccessible)

When the object becomes available and the process can be finished, send the record for final 
approval, and replace this entry with Record Approved.

10.3.  Parent-Child Approval
When working with Parent-Child records (where the Parent record is an object and the Child 
records are pieces), a number of important decisions must be made about how to present and file 
them. The main issues are as follows:

Create one manual file or multiple files?

Run and print one catalogue card or multiple cards?

Publish one record on the Internet, or multiple records?

These issues are closely related, and the decisions made for one of these issues will generally 
clarify the decision for the others.

To reiterate several important points:

Only approved records will have manual files and catalogue cards, but not all approved 
records will have manual files and cards (CARDX’s will only be filed in the computer 
system).

Only approved records will be published on the Internet, but not all approved records will 
be published in the Internet. 

10.3.1. Parent (Family) Records

Family records are for the purpose of the database only. They should not have manual files or 
catalogue cards, and they should not be published on the Internet.

10.3.2. Parent (Object) Records

All object records should have their own manual files and catalogue cards.

All object records should be published on the Internet.

RCMDD Protocols 12-2010  112



10.3.3. Child (Piece) Records

All Child records should be included in the manual file for their Parent. They should not have 
their own separate folders.

Some Child records should have their own catalogue cards. Other Child records should be 
attached to the catalogue cards of their parents as a list.

The decision whether or not to publish Child records on the database must be made on a case by 
case basis. 

In general, Child records that are attached to their Parent records as a list should not be published 
on the Internet. In general, Child records that are given their own catalogue cards should be 
published on the Internet.

Here are some examples:

• Coffins: Only publish the parent; box and lid only need to be published if one Child is on 
loan or in an exhibition. Attach Child records to Parent card as a list.

• Canopic Jars: Only publish the parent; jar and lid only need to be published if one Child is on 
loan or in an exhibition. Attach Child records to Parent card as a list.

• Groups of related pieces: Varies. 

One  guide can be that if pieces form an object, they need not be published; if they form a 
set, they need to be published. 

Another guide can be whether or not all the pieces are easily visible and distinguishable 
in an image of the entire object.

Example 1:  Tutankhamun’s finger stalls: there is a parent record for all of these together, 
and 10 separate child records. Only the parent needs to be published on Internet. In both 
of these cases all the children are easily visible in the master image. The individual stalls 
can be attached to the Parent card as a list.

Example 2: JE 60687, Calcite Canopic Chest of Tutankhamun: Box, Lid, Sled, Stoppers, 
and Sealings: in this case all the records that form the set should be published; these do 
form a set, but are also separate objects as well, and it would be difficult to show them all 
in one image. Run a separate catalogue card for each piece (but file them all in the same 
manual file).

Example 3: JE 43274: Limestone Relief of Maya, In Five Pieces; all of these five (JE 43274-
a to JE 43274-e) should be published separately, as the individual pieces are distinctive 
and each has their own descriptions. Run a separate catalogue card for each piece (but file 
them all in the same manual file).

10.4. Creating Manual Object Files
See above for guidelines on categories of objects for which object files should be created.

Step 1: Prepare Folders

RCMDD Protocols 12-2010  113



Label a hanging folder with the object’s ID number (JE if possible; if not then CG, if not then TR, if 
not then SR).1

Step 2: File the Card

Within this hanging folder, you will place the catalogue card and any additional materials related 
to the object, such as accessioning forms, decrees, or publications, as they come to the office. 
Make sure that the catalogue card is in the front of the folder, so that it is the first thing you see 
when you look in the folder.

Step 3: File Folders in File Cabinets

The object files are placed in File Cabinets. 

Files should be organized according to ID#, in ascending order. Most objects will be filed by JE 
number; there are separate sections in the files for objects with only CG, TR, or SR numbers.

Parent-Child Object Files: Guidelines

There are several situations where it will not be completely clear whether to make one, two, or 
more catalogue cards and/or object files. Each of these must be addressed on a case by case 
basis, but the following guidelines will help you make good decisions.

• For objects that have been divided 
into pieces: Individual catalogue cards 
do not always need to be printed for 
each piece. If you do decide to print 
cards for each piece, these cards 
should be filed together in one 
hanging file, under the ID number of 
the object. 
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For objects made up of many pieces, you can choose to print 
the information for the objects in a list (EM_List_Location 
report). Attach this list to the Catalogue Card (of the parent 
record) in Adobe Acrobat, so that you end up with one pdf 
file with multiple pages.

• For new pieces that join with previously registered objects: In 
some cases, a piece will come in from a new excavation that joins with an object that is 
already registered in the museum (JE xxxx). Since we are no longer working with the original 
JE books, and multiple copies of the books are being made, the new piece must be given a 
new JE number. However, it will NOT be given its own database record (see Accessioning) or 
object file. To avoid confusion, a new hanging file should be created and labeled with the 
new JE number (JE yyyy). Inside the hanging file for the old JE number (if one does not already 
exist, it should be created), a printed paper should be placed that says: “JE xxxx joins with JE 
yyyy. See JE yyyy for manual file.”
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Part III:

Documentation Support
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11. Image Acquisition and Management
An important role of the RCMDD is to help build and maintain the image bank (stored in the 
Multimedia Module) that forms a central part of the database. The office deals with two principal 
types of images: photographs (primarily of objects, but also of activities and events) and 
facsimiles (of the museum’s official registers and of the Topographical Bibliography, and also 
excavation reports, scholarly articles, and other documents related to the collections). Images are 
acquired either through photography (by RCMDD staff or outside photographers) or by 
digitization. 

The image bank will benefit the entire museum, the scholarly community, and the general public. 
By creating a central bank in which to store these images, they become easy to find and use for 
various purposes. Once attached to the database, these images will be viewable and usable:

1. By the entire museum staff. This can be done immediately upon request in the registrar’s office; 
and via the secure Intranet, which went on line in December of 2009:

Digital images can be provided upon request for Powerpoint presentations, Word 
documents, or any other purpose (subject to approval by section heads or the Museum 
Director).

These images can be used to enhance all the lists and forms that can be produced through 
the database.

The RCMDD has the capacity to store copies of all photographs, and encourages all staff 
members to provide whatever images they have. 

NOTE: All staff members are of course still free to store their own copies of their own 
images wherever they wish, as usual.

2. By scholars and the general public

Scholars or the general public can request that images be taken and copies provided for 
reference, scholarly publication, or commercial publication, according to the museum’s 
Outside Request and Photo Policy guidelines.

Many images are usable as soon as they are acquired, and need only be imported into the 
Multimedia module; others must be processed in some way. This is done using Adobe Creative 
Suite (primarily Adobe Photoshop).

The following protocols cover Image Acquisition, including processing; and Image Management.

11.1. Image Naming and Storage Protocols
Object Images: All filenames for object images should include the ID number of the object itself: 
JE if possible, otherwise one of the other official ID numbers. If the photograph is taken by a 
registrar, the filename should be simply the ID number; if there are multiple images of the same 
object from the same shooting session, _1, _2, etc., should be added. If the photograph is taken 
by an outside photographer, the filename given by the photographer should be left intact, and the 
ID number added to the beginning. Until November 2009, these filenames included parentheses 
and front or back slashes in cases where the ID number or the photographer’s filename included 
these characters. However, if the import tool is used, the database will not recognize these 
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characters. Therefore, replace all parentheses with underscores, and slashes (used in TR numbers 
by some photographers) with points: (e.g. JE 1234(a).jpg should become JE 1234-a.jpg and TR 
1/2/3/4.jpg should become TR_1.2.3.4.jpg). To keep things simple, this protocol will be used for 
all object image files. 

All backup copies of object images are stored on My Book Images->EMS_Object_Images, in a 
series of folders called EMS_IMAGES_*. A decision was made in September of 2009 that a new 
image folder would be started each year; the current folder is therefore EMS_Images_4_2010.

Within this folder, subfolders are named by Photographer Name and Date (YYYY-MM-DD): e.g. 
Ahmed_Amin_2009-09-27.

IDSC Scans: The IDSC scan project is stored in a separate folder within EMS_Object_Images, 
called IDSC_Scans, organized by sheet, with the sheets nested in groups of 99.

Facsimiles: All backup low-resolution copies of facsimiles, e.g. digitized images of register books 
or CGs, are stored  also on My Book Images, in EMS_Facsimiles_LR.

Event Images: Filenames for event images are left as they come from the camera or outside 
photographer. Like object images, these are placed in folders named by Photographer Name and 
Date (YYYY-MM-DD): e.g. Janice_Kamrin_2009-11-06. All event images are stored on My Book 
Images, in EMS_Event_Images->EMS_Event_Images_YYYY (currently 2010).

Backup of publications of various sorts are stored in Akhenaten->Ruby->RCMDD-DOC->Library-
>Digital_Library. These should also be imported into the multimedia module of the database and 
linked to their Bibliography records.

11.2. Image Acquisition

Images can be acquired for the database in several ways. Pictorial documents such as 
photographs and slides that currently exist as hard copy can be scanned; additional images can 
be acquired through digital photography, either by RCMDD staff, museum photographers, or, in 
limited cases, by outside photographers. (Note also that text documents such as articles and 
books can also be photographed or scanned and made into jpegs or pdfs to be attached to the 
Multimedia module and linked to the Bibliography module.)

11.3. Photography

Reference photographs can be taken by RCMDD personnel, and higher quality images can be 
taken by museum photographers or a limited number of outside photographers, as detailed 
below. Photographs taken by other museum staff should also be provided to the RCMDD for 
incorporation into the database.

11.3.1. RCMDD Photography

Many of the reference images (not for publication) for the database are now being taken by 
RCMDD (and ARCE) staff. Object photographs are taken by the RCMDD mainly during 
movements for various purposes, and during inventory work. Other photographs, of events, 
incidents, and people doing various activities, are also taken by project staff (RCMDD and ARCE). 
The RCMDD has also informed the section heads that the office has a digital camera, and can 
take photographs at their request.
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RCMDD staff should have a digital camera with them whenever they go out to the galleries for 
movement committees or inventory work. Whenever possible (mainly when working with objects 
that are outside vitrines) they should also bring a scale and a white board.

Each digital camera is different. It is important that all office staff know how to use whatever 
specific camera or cameras the RCMDD has; these protocols are not written to cover a specific 
camera. Instead, here are some basic definitions, and guidelines that should be followed 
regardless of what particular camera is being used.

Definitions

The following terms are important to understand for all digital cameras:

• Aperture: How wide the diaphragm inside the lens opens when you shoot. This affects how 
much light enters the camera and reaches the sensor (or film). Bigger apertures (identified by 
their f number [F-stop]) allow more light to reach the sensor than smaller ones. The smaller 
the aperture number, the larger the opening, and vice versa.

• Shutter Speed: How fast the shutter opens and closes when you shoot. This affects how much 
light enters the camera and reaches the sensor or film. Slower speeds, mostly shown as 
fractions (e.g. 1/60) allow more light to reach the sensor than faster ones.

• ISO: How sensitive to light the sensors (in the past, the film) are. Digital cameras can be set to 
different ISOs.

• Image size format: Digital cameras in general offer a few different sizes from which to chose. 
In many cameras these formats are defined as L (large), M (medium) and S (small).

• Macro: This is a setting in cameras/lenses usually used to photograph very small objects by 
allowing the photographer to focus at a much shorter distance to the object than in normal 
mode.

• Zooming in/out: Zoom lenses allow the photographer to make the objects look bigger (zoom 
in) or smaller (zoom out) without moving the camera either away or toward the object. NOTE: 
With digital cameras, absolutely avoid using “digital” zoom. Use only the optical zoom.

Guidelines

• Always bring the tripod. The museum is dark, and the flash should be avoided whenever 
possible (at the request of the Museum Director; it does not actually damage the objects). Use 
the tripod whenever necessary. Setting the camera on a tripod allows for slower shutter speeds 
(under 1/60), and thus avoids the necessity of increasing the ISO, which can render images 
almost unusable due to digital noise (grainy quality produced by digital cameras when set to 
higher ISOs) or images blurred by camera motion that can occur on speeds under 1/60 or 
1/30 if the camera is hand-held (remember that 1/60, for example, is slower than 1/125).

• For most situations shoot with the camera set on “Manual.”

• For single object photography, make sure the camera is set to take photos with pixel 
dimensions of approximately 1024x653 pixels, yielding a file size of approximately 2M. 

• For multiple objects, increase the camera format to its highest setting, so that you will have 
decent resolution for the individual objects.
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• If you are photographing through vitrine glass, try to shoot at an angle to the horizontal plane 
of the glass; do not shoot perpendicular to the glass. Also watch for other reflections and try to 
avoid having them fall right in front of the object.

• If you are photographing a small object, and can get close enough to it, switch to “Macro.” 
Every camera/lens has a different Macro range, and you should make sure to know your 
equipment (by reading the manual). This will save a lot of time and frustration. On Macro 
setting it is possible to shoot the object from shorter distances away.

• When taking shots of moving people it can be useful to set the camera on Shutter speed 
priority. This way the shutter speed can be fixed to something above 1/60 and the camera will 
choose the aperture according to the lighting conditions and the Shutter Speed that has been 
set.

Step 1: Photograph Objects

• Whenever possible, the identification number (JE if possible, otherwise CG, TR, or SR) should 
be included in the photograph.

Object can be turned so that number is visible.

Number can be written on white-board (available in the RCMDD office).

Number can be neatly handwritten on a piece of paper.

• Whenever possible, a scale (available in the RCMDD office) should be included in the 
photograph.

• A detailed photo log should be kept, in which images are numbered sequentially from one, 
beginning at 1 again on each day when photographs are taken. In many cases, this will be 
kept on the Object Inventory Form or other form that has been brought to the galleries by the 
registrars; if necessary, a Photo Log (a copy of which should be on each registrar’s individual 
clipboard) can be used.

Step 2: Download and Rename Images

Images should be downloaded and processed immediately, preferably on the day they were 
taken, according to the following procedures:

• Bring camera back to office.

• Connect camera to computer.

• Download images into folder called: Photographer_Name_YYYY-MM-DD.

• Make sure images are deleted from the camera AFTER making sure they have downloaded 
properly.

• For object images, rename images immediately by sequential number, so that the filenames 
match the  numbers on your photo log/Object Inventory form. (NOTE: Do not rename Event 
Images -- go directly to Step 6.)
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Open Bridge

Either drag the folder containing 
images you want to rename to 
the program icon in the dock or 
open it from the program.

Choose the files you want to 
rename - usually you will want 
to rename all of them, so use 
Apple/Command/Cntrl + a.

Go to the Menu bar and choose 
Tools -> Batch rename. 

Choose in the same folder.

Set up a new filename: best here is to use the folder name followed by a sequential 
number: e.g. type “Dalia_Galal_2009-09-25_” in the first field as Text (make sure to add 
an underscore at the end), and choose Sequence Number for the second part. You can 
choose how many digits you would like this to have (usually 2) and from which number 
you would like to start (usually 1). The last part of the name will be the extension, usually 
“.jpg.”  Note that you can add and remove parts to and from the name by using the plus 
and minus buttons next to the free text fields.

When you’ve filled in all the parts you need 
for the name press the Rename button. The 
program renames the files and saves the new 
names automatically. The filenames Bridge 
would generate with the example shown here 
would be:
Dalia_Galal_2009-09-25_01.jpg, 
Dalia_Galal_2009-09-25_02.jpg and so on.

Step 3: Process Images

If any of the images need to be modified, you can work on them in Photoshop. Try to do as little 
of this as possible; remember that you are taking reference images only; these will not be for 
publication, and you should not spend valuable time working with them unless absolutely 
necessary.

Step 4: Identify and Rename Images

Using your inventory log or other manual form as a guide, identify the images and rename them 
according to their ID Numbers (JE if possible, then CG, TR, and then SR) with the format: e.g. 
JE_1234.jpg. If you have multiple images of the same object in one folder, use _1, e.g. 
JE_1234_1.

Step 5: Import Images into Database

If there are only a few images, you may do this by hand.

If there are more than 10 images in your folder, you should use the Import Tool.
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Step 6: Link Images to Catalogue or Event Records

Attach Object images to their Catalogue records and Event images to their Event records.

Step 7: Store the Original Images

Log into Goldfish using your user name and password.

The folder containing the images should now be stored in the backup system, as follows:

• Object Images are stored in My Book Images->EMS_Object_Images->EMS_Images_* (as of 
January 2011, in EMS_Images_5_2011)

• Event Images are stored in My Book Images->EMS_Event_Images_* (currently 
EMS_Event_Images_2011)

11.3.2. Museum and Outside Photographers

Museum photographers and a very limited number of approved outside photographers will take 
photographs for both reference and publication. The procedures for both are similar, although not 
identical. It is important that all photographs taken of museum objects be given immediately to 
the RCMDD to be incorporated into the image bank; however, the RCMDD will not chase 
photographers to get these images, we will expect that all photographers follow the protocols 
decreed by the Museum Director (see SCA-EMC Rights and Reproductions Policy - internal).

The following procedures will help to ensure that photographs taken by museum and outside 
photographers can be easily incorporated into the museum’s database, where they will be 
accessible to the curatorial staff. The museum photography department should be provided with a 
copy of the Museum Rights and Reproductions policy and Photography Procedures in English 
and Arabic.

Step 1: Notification Received

The photographer or section head should notify the RCMDD of the planned photography.

Step 2: Create event in the Events Module (to be done by a Head or the Associate Registrar for 
the Image Bank)

A new event should be created in the Events 
Module to record the photography session. 
Note that a new event should be created for 
each session (i.e. each day, at a minimum) on 
which the photography is to occur.

NOTE: If the office learns about the 
photography after it has occurred, this process 
should be carried out afterward.

• Open the Events Module.

• Create a new event by clicking on the icon 
with the blank sheet in the upper left 
corner of the Events Module.
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• In the Events 1 tab, Event Number field, give the event the next number in the sequence. This 
should be in the following format EV.YYYY.NN (where NN is the sequential number). E.g. EV.
2009.66.

• Under Event Type, choose Outside Photography. 

• In the Title field, enter: Photography and 
the name of the photographer; e.g. 
Photography-Ahmed Amin.

• In the Description field, add a short 
summary of the objects to be 
photographed, for example: Silver bowls 
to be photographed for Dr. Lilyquist.

• In the Dates tab, enter the date on which 
the photography is or has occurred under 
Event Commencement Details.

• In the Tasks tab, create an alarm to remind 
the team to follow up on getting the 
photographs from the photographer. This 
should be set to about a week after the 
photography session.

Step 3: Registrar Assigned and Equipped

The RCMDD department heads will assign a 
registrar to accompany the photographer so 
they can inventory the objects and help log 
the photographs. The registrar should bring a 
printed preliminary inventory form, a blank 
inventory form or a photo log, as well as both 
white boards and scales in various sizes.

Step 4: Log Photos
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When possible, make sure that the first photograph of  every object is a reference 
shot that includes a scale and a white board in an appropriate size. All available 
ID numbers of the object should be clearly written on the white board.

Step 5: File Photo log in Central Log file.

File the Photo log in the Photo log folder of the Central Log bin, kept on the 
Head Registrar’s desk.

Step 6: Photographer Processes Images and provides RCMDD with tiffs or jpegs 
in one or a series of folders.

It is essential that all photographers process their own images and provide the RCMDD with tiffs 
or jpegs. Some photographers are at this point only giving the office low-res jpegs as references; 
as soon as possible, this practice should be stopped and high-resolution files given to the office. 
DO NOT accept RAW files of any sort.

If the images are being taken by a museum photographer, the images should be left with their 
original camera (e.g. DSC) numbers, which, in case any procedural mistakes are made, will at 
least indicate the order in which the photographs were taken, and thus help solve any 
identification problems. Note that when processing the images the photographer should include 
at least one image of each object that includes the ID number, as this will help cut down on 
numbering errors. Further processing can always be done later, if this particular image is needed 
for a commercial publication in which the number should not show.

Outside photographers can give their images to the 
RCMDD in a variety of ways: on a flash or hard 
drive, CD, DVD, or via email; the files can be 
organized in a variety of ways. This does not matter; 
what is important is that the office is provided with 
the name of the photographer, the date on which the 
photographs were taken, and ID numbers for the 
objects. (Note that this information can also be 
included in the metadata for the images, so if images 
come without this information, do your best to get it 
directly from the photographer, but if not, look at the 
metadata for the images in Photoshop or Bridge (in Photoshop, open the image and press Apple
+option+shift+I; in Bridge, select the photo and press Apple+option+shift+I).

Step 7: Record acquisition of images in database

In the Dates tab of the Event record that was created to track the photography, record the date on 
which the images are given to the office in the Event Completion Date.

Step 8: Organize and Rename (if necessary) the Folders and Images

All images must be organized and named according to the RCMDD protocols (note that the 
naming protocol for the images themselves is slightly different for outside photography, as 
outlined below), in one or a series of nested folders. Use the photo log to assist you, and discard 
the log when you are finished.
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NOTE: It is essential that all ID numbers be checked carefully, as usual.

• The main folder should be named as per the usual RCMDD protocol: photographer’s first 
name_photographer’s last name_YYYY-MM-DD (e.g. Ahmed_Amin_2009-09-25), where the 
date is the date on which the photographs were taken. (If you do not know the date, check the 
metadata for one image.)

• In some cases (especially for museum photographers), the photographer will give you 
multiple images for the same object, in some cases nested within separate folders. If you are 
given subfolders, name these with the ID number of the object.

• Inside the main or subfolders, it is necessary to determine whether the images need to be 
renamed. 

If the name the photographer has used for the images includes the ID number of the 
object then this should be kept as it is without modification unless the number is wrong. If 
the ID number in the filename is wrong, add the correct ID number to the beginning of 
the filename. 

If a different naming system has been used, then the ID number should be added to the 
beginning of the original name (DO NOT delete the original name given by the 
photographer, since you may need this in the future for communication with the 
photographer). For individual images, this can be done simply in the finder (click on the 
filename, move the cursor to the beginning of the name, and add the ID number. You will 
end up with something like: JE_4256_DSC92847.tiff). Remember to make sure that the ID 
number is correct.

If you have multiple images of the same 
object, either loose within the main folder or 
in nested subfolders, you can use the Batch 
option in Bridge, as follows: 

1. Drag the folder to Bridge, or open 
Bridge and browse to the folder. 

2. Select the images you want to rename 
(use Apple/Command/Cntrl+click to 
choose multiple images). 

3. Go to Tools->Batch Rename. 

4. Under Destination Folder, click Rename in same folder. Under New Filenames, 
choose Text in the first drop-down and type the ID Number with underlines. Under 
the second drop-down, say Current Filename and Name+Extension and Original 
Case. Check Preserve current filename in XMP Metadata. 

Step 6: Import Images

Immediately import the images to the database, using the Import Tool, and attach them to their 
appropriate Catalogue (or Event) records. Until this is done, you can keep the folder on your own 
computer, or process it from the image backup folder on My Book Images.

Step 7: Store the Original Images

RCMDD Protocols 12-2010  125



The folder containing the images should now be stored in the backup system, as follows:

• Object Images are stored in Goldfish->My Book Images->EMS_Object_Images->CURRENT 
FOLDER (currently EMS_Images_4_2010).

• Event Images are stored in Goldfish->My Book Images->EMS_Event_Images-
>EMS_Event_Images_2010.

In the rare cases when for some reason object images cannot be imported directly into the 
database (for example, because ID Numbers need to be found for them), then they should be 
placed in the 00-EMS_IMAGES TO PROCESS folder found within My Book Images-
>EMS_Object_Images. They will be kept in this folder temporarily until they have been imported 
into the database, after which they will be moved into their proper folder within the 
EMS_IMAGES folder. Within the 00-EMS_IMAGES TO PROCESS folder is a folder called 
EMS_Images-No-ID, where images that have no ID number with them are kept until they can be 
identified. There is also a sub-folder in the 00-EMS_IMAGES TO PROCESS folder called “For 
Zamalek.” This can be used temporarily to store folders with images that are non-object and non-
bibliography (i.e. not appropriate to store in the EMC database) until they can be given to the 
Secretariat in Zamalek, where another Image Bank is kept (this is in the case that we have digital 
images that fall into this category but not CD's).

Note on CD’S

Not all CD’s received by the office will need to be processed. If a CD contains non-object images 
or non-bibliographic material, then the CD should not be copied into the backup system. Instead, 
it should be given to the Secretariat in Zamalek, where it will be incorporated into the SCA Image 
Bank. 

If the CD contains object images, then the steps outlined in the proceeding protocol should be 
followed. When the images have been processed, the name of the photographer and date of the 
photography should be written directly on the CD, along with a check-mark to indicate that it has 
been put into the database, and then placed in the next available sleeve within the current CD 
case (organized chronologically). This is kept in Cupboard-1.

If the CD contains reference or bibliography material, make sure that it is entered in the 
Bibliography in the database and marked as being in the digital library, and is then put into the 
digital library (Akhenaten->Ruby->RCMDD-DOC->Library->Digital_Library).

11.4. IDSC Scanning Project

A series of about 20,000 images of museum objects was taken in the late 1990s by the Prime 
Minister’s Office. These were taken as slides; the original slides were stored in the back part of 
R39, in numerical order, in a series of shelves. As of March 2011, it is unclear where these will 
eventually be kept. For now, they are stored in the old RCMDD office (part of R44), which is now 
being used by museum security personnel.

In 2007, a project was begun to digitize these slides so that these valuable images could be 
incorporated into the EM Database. This project was finished on January 23, 2011, and all the 
images are now in the database. Instructions below can be used if more slides are found and 
need to be scanned.
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The scanner is an Epson V750 Pro, and is currently (as of March 2011) connected to one of the 
PC computers (“Tart”).

Project Procedures

Step 1:  Find the next set of slides to scan by consulting the IDSC 
Checklist.

Step 2: Turn on and Prepare the Scanner

• Turn on the scanner; wait until the green light stops flashing.

•  Load the slide holder in the scanner bed and remove the white 
insert that covers the light in the scanner lid (If the slide holder 
is not in the scanner it can be found in a plastic bag with other 
slide holders. This bag is kept next to the scanner.) Make sure 
you have the slide holder ready. 

Step 2: Open the Scanner Software

• If working from the PC, open the scanner software by going to the start menu and selecting 
“Epson Scan” from the pop up list. Select model V700/V750.

• If working from a MAC, open the software from either the dock or the applications folder. 
Select model V700/V750.

• Choose the correct settings. Slides are scanned in the “professional mode”, if not already 
chosen; choose this option from the Mode menu. 

• Check to make sure that the following settings are selected:

Document type: Film (with Film Holder)

Film Type: Positive Film

Image Type: 24-bit color

Resolution: 150 dpi

Thumbnail: NOT checked

Step 3: Load Scanner

In general, you will be able to scan half a tray of slides at a time.

• Open the scanner and load the slides into the slide holder. Slides 
should be loaded in the upright viewing orientation, correct side 
(shiny side) facing down.

• As you load the slides, check them quickly for duplicates. Try not 
to scan multiple slides that show the same object from the same 
view. If you cannot choose the best easily from the slides 
themselves, go ahead and scan them, but be prepared to discard 
some of the scans.

Step 4: Preview the scans
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Preview the slides by pressing the preview button. You will get a 
window that looks something like this:

Step 5: Set the Scan Area (frame) and Scale Size for each slide.

• Using the mouse, drag the marquee over the slide area to be 
scanned. When selecting the area to be scanned, try to frame the 
object in a sensible manner. The object should be centered in the 
frame, and any base, accompanying number cards, or other 
essential items should be included in the frame. If you are having 
trouble seeing well enough to set the frame,  the borders of the 
area, click on the “Zoom” button at the top of the preview 
window. The scanner will take a second to create a close up 
preview of the slide that you are working in. Once you have 
selected the area, return to the preview screen by clicking on the 
preview button located at the top center of the window. 

• Note that very dark slides are problematic, and do not tend to 
scan properly. We are currently uncertain how to solve this 
problem.

• Once the area has been selected, set the scale of the image at 
1000% (one thousand percent). Each image must be specified 
individually, so it is best to select the scale size at this point, 
before moving on to another image. 

• Continue selecting the image area and scale size for each slide. 

Step 6: Scan

• Once all images have been selected and scale sizes designated, 
press the “All” button in the preview window to activate all the 
slide frames. You will know when all of the frames have been 
selected because each slide will have a dotted line surrounding 
it. 

• Press the Scan button.
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• A new window will pop up asking you how you want 
each image to be saved. The following settings should be 
selected:

Location: Other> IDSC_SCANS->Sheet_#, where 
Sheet # is the number of the sheet that you are 
scanning (found on the back of the sheet case in 
Arabic).

File name: Prefix: Sheet_#. Start Number: 001.

Image format:Type:  JPEG.

• Once all settings are correct, press “OK.”

• Once the command has been given to scan, the scanner will take approximately 10-15 
minutes to scan each individual slide. While the scanner is working, you can be renaming 
and importing the previously scanned group of slides into the database.

Step 7: Rename the scans

• Once the images are all scanned, rename the photographs according to the label on the 
actual slide. This will be an SR number and should be written as such: SR_X_XXXX (e.g. 
SR_4_1234).

• If there is more than one view of the same object (ex. front and back), rename the images 
with a suffix (e.g. SR_4_1234_1; SR_4_1234_2, etc.).

• If there is more than one image of the same object showing the same view, choose the best 
picture and delete the duplicates.

Step 8: Manipulate in Photoshop, if necessary

Open all the images in a Preview program and make sure they are properly rotated and cropped. 
Make any corrections in Photoshop.

Mark that you’ve scanned and processed the images on the IDCS Scanning Checklist with your 
name and the date.

Step 9: Import the Images to the Database

Use the Import Tool to import the entire folder into 
the Multimedia module. In the Filemaker Import 
Tool, insert IDSC: Sheet # in the MulCreator_tab field 
and 1/1/2000 (an arbitrary date chosen because we 
do not know when these were taken) in the 
DetDate0 field.

Mark that you’ve imported the images on the IDCS 
Scanning Checklist with your name and the date.

Step 10: Attach the Images to their Catalogue 
Records

Keep the found set in the Multimedia module open in list view, and do a find for each object in 
the Catalogue module. If you cannot find the object by SR number, look in the photograph itself 

RCMDD Protocols 12-2010  129



to see if you can find another ID number (remember that JE is usually black and CG is usually 
red). If you still cannot find the number, you may need to use the Search database to find a JE, 
CG, or TR (see Finding ID Numbers) Make sure the image matches the title and description of the 
object! If it does not, call in a senior checker to help you.

NOTE: If you do not have time to process the images right away, store them in the staging folders: 
MyBook Images->EMS_Object_Images->01_IDSC_Scans-->IDSC_TO_IMPORT AND LINK.

Mark that you’ve linked the images on the IDCS Scanning Checklist with your name and the date.

Step 11: Store Images in Backup System and Delete from PC

Drag or copy and paste the folder to My Book Images->EMS_Object_Images-
>IDSC_Scan>IDSC_Sheets_1-99 (and so on) (organized in groups of 99)->Sheet_75 (and so on).

Delete the folder from the PC.

11.5. Other Image Capture

11.5.1. Extracting a Picture for the Image Bank

Follow these instructions to acquire an image for the image bank from an outside source such as 
a Word, Excel file, or a Powerpoint file. Use these techniques ONLY when you need an image 
urgently, and cannot take a new one for some reason.

Step 1: Open Document

Step 2: Copy Image

Click on the image once to select it and copy it [Apple/Command/Cntrl + c].

Step 3: Open Preview or Photoshop and Paste image

In Preview, simply select Apple+N, and the image in your clipboard will be pasted into a new 
document.

In Photoshop:

• Go to File > New

• The program will automatically create a new document the size of the image in the clipboard.

Make sure the resolution of the new document is between 72 and 150 pixels per inch. 

The “color mode” should be in RGB color, 8-bit. 

“Background content” should be either white or transparent.

Select OK.

• Paste the copied image onto the canvas by selecting the canvas and copying the image 
[Apple/Command/Cntrl + v].

Step 4: Modify image if necessary

If you need to modify the image, it is best to do this from Photoshop.

Step 5: Save Image

In either Preview or Photoshop:
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• Go to File > Save as.

• Name the file correctly (according to the object number, see Egyptian Museum Database 
Organization).

• Select JEPG format.

• Check “save as a copy.”

• Browse to the folder into which you want to save the image.

• Hit OK.

Step 6: Repeat for additional images

11.5.2. Screen Shots

An easy way to acquire additional images (although their quality will not be very high) is to take 
screen shots, for example, from a pdf. Only do this if there is no other way to get the images. 

On a Macintosh:

1. Make the picture as large as possible on your screen (without losing quality) by zooming in to 
the screen.

2. Select Apple + Shift + 4. Click in one corner of the image and drag the marquee to encompass 
the rest. Let go. You will hear a noise like a camera shutter (if you have your volume up). Your 
image will be on your desktop, called “Picture 1.” 

3. Rename the file as you like.

4. OR Select Apple + control + Shift + 4. Click in one corner of the image and drag the marquee 
to encompass the rest. Let go. You will hear noise like a camera shutter. Your image will be in 
your clipboard, and can be pasted into Preview or Photoshop and saved from there.

On a PC: For Windows XP and earlier:

• Make the picture as large as possible on your screen without losing quality by zooming in to 
the file.

• Press the Prt Sc button. 

• Open a new document in Photoshop, press Ctrl+V to paste. 

• Save with whatever filename you like.

For Windows Vista:

• Make the picture as large as possible on your screen without losing quality by zooming in to 
the file

• Use the Screenshot Tool to define the area for the screenshot.

• Save with whatever filename you like.

11.6. Image Processing

Whenever possible, images should be imported into the database with no manipulation. 
However, there are occasions on which it is necessary to modify or re-save an image. The 
following section outlines some basics.
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11.6.1. Imaging Basics

• Resolution: The real size of an image, measured in pixels, which are the tiny squares of color 
that make up the image that you see. Every image is composed of a certain number of pixels. 
Overall, resolution of a digital image is measured in ppi (pixels per inch). Therefore, 
resolution is determined by how many pixels are contained in a linear inch. Print resolution 
(when related to printing on an inkjet printer, for example) is measured in dpi (dots per inch).

•  File types: The RCMDD works with a number of image file types. There are three main 
categories: Most of the image files handled by the RCMDD are raster files: these are pixel-
based and resolution-dependent files. Other types are bitmap (used only for black and white 
-- good for scanning maps and plans), and vector (not pixel-based, resolution-independent, 
and based on mathematical algorithms). These latter types of files are not used often by the 
office (except for the creation of Gallery Maps, which are vector files).

• Raster File formats: Raster image files can be saved in a number of formats. The main two 
types of files used by the RMCDD are:

jpeg (lossy compression): most images taken by the RCMDD should be jpeg. 

tif: Use this for high quality, publication quality images only. If an image comes to the 
RCMDD as a tif from an outside photographer, leave it as a tif. Tif files take up more 
storage space than jpegs, so should only be used for high quality images. If you have a tif 
file, make sure it is saved with LZW compression.

• Color Space: All images have a “color space,” which tells you how the colors in the file are 
managed. These are found under Menu->Image->Mode in Photoshop. The only ones you 
need to know about are these:

CMYK: Used for printing

RGB: Used for screen viewing. All images attached to the database must be RGB, or the 
database will not display them properly.

Greyscale: Used infrequently by the RCMDD; only black and white and shades of grey.

NOTE: All images managed by the RCMDD should be 8 Bits/Channel (also found under 
Menu->Image->Mode).

11.7. Using Photoshop
The program you will be using to process images is Adobe Photoshop. Following is some basic 
information on how to use this software. Remember that you are not graphic designers, and that 
you are ONLY taking photographs for reference, not for publication. You should spend as little 
time as possible processing your photographs -- just enough to make sure they are usable.

11.7.1. The Photoshop Environment

When you open Photoshop, you will see a large window in the center, in which your image will 
appear. You can zoom in and out to see this at different view sizes. To one side (usually the left) 
will be your tool palette; to the other you will have your palettes. The main palettes you need are 
the layers and history palettes. To bring up more palettes, go to the Menu bar and choose 
Window, and you can choose new palettes to view.
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11.7.2. File basics

Every image has two fundamental aspects: pixel dimensions and document size. Both are found 
in Photoshop under Menu->Image-
>Image size. 

The pixel dimensions are given as 
height in pixels by width in pixels. 
This is an absolute measure: the 
pixel size is the fundamental size of 
the image, and tells  you how many pixels make up the entire image. The 
file size is based on the pixel dimensions -- if you have more pixels, your 
file size will be larger. 

In the example here, the pixel size is: width is 900 pixels, and the height 
is 600 pixels. The file size is 1.54 M (megabytes).

The document size is the size 
of the space into which the 

image fits, so is dependent on the pixel dimensions 
and the resolution of the image.  A file that has pixel 
dimensions of 900x600 pixels and a resolution of 
300 pixels/inch can have a document size (canvas 
size), for example, of 3x2 inches. 

If the 
resolution of the same image is changed to 100, the 
document size will change to 9x6. Since there are 
less pixels per inch, they will be spread out over a 
larger area. Notice that the pixel dimension do not 
change. Since the resolution has been divided by 3, 
the document size is multiplied by 3.

It is also important to make sure the Color Space is set properly, 
usually to RGB and 8 Bits/Channel (this latter refers to how much 
color information each individual pixel stores. The database has 
trouble with anything over 8 bits, and it is also the most common 
color depth used.) Access this menu through Menu->Image-
>Mode.
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11.7.3. Image manipulation

There are a number of other ways to manipulate images, of which the most important are 
outlined here. Anything more elaborate will require further training, and is generally beyond the 
scope of work for the RCMDD.

Changing mode

In some cases, an outside (museum or other) photographer may give the RCMDD files that are 
CMYK and/or greater color depth than 8-bit. The mode for these must be changed to RGB and 8-
bit. Do this by going to Menu->Image->Mode, and make sure RGB color and 8 Bits/Channel are 
checked. Note that you can change a group of images using the Batch tool.

Changing resolution and/or image size

NOTE: At this point in the project, you should rarely need to do this, since the RCMDD should 
be taking photographs at the correct resolution and size, and images given to the office by 
outside photographers should be imported and stored at high resolution (the database batches 
them down to sizes appropriate for reports and the like). However, it is important to know how to 
do this in the event that it is necessary.

To change the image size (not including cropping), change the Resolution: Menu->Image->Image 
Size; go to Resolution and change the number. You will need to decide whether or not to 
Resample: 

If you want to keep the pixel dimensions and file size the same, leave Resample 
unchecked.

If you want to change the pixel dimensions and file size, check Resample. Make sure you 
also check Scale Styles.

NEVER check resample if you are increasing the resolution of the image. (In fact, you will 
very rarely, if ever, increase the resolution of an image.)

Example 1: Starting with an image with a file size of 
between 2 and 3M and pixel dimensions of 
1000x688, and a resolution of over 300 pixels/inch.

• Open Image Size dialogue

• Change Resolution to 72 but DO NOT check 
Resample Image
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Note that the pixel dimensions and the file size do not change, but the document size increases.

Example 2: Starting with a very large and high 
resolution image:

1. Open Image Size dialogue

2. Check Resample Image and Scale Styles

3. Change Resolution to 72

4.  Check OK

Note that the pixel dimensions have decreased 
and the file size has decreased, but the document 
size has not changed.

Cropping

One of the tools you will use is the Crop tool. You 
will use this most often when you have taken a 
photograph that includes more than one object, and 
you want to create separate image files for each 
object. (If you do this, remember to also attach the 
original image with the multiple objects to all the relevant records.)

You can also use the crop tool if you want to reduce unused canvas area. Make sure you do not 
crop too tightly -- leave a reasonable bit of extra space around the object. 

NOTE: Make sure when cropping never to let the proportions be more rectangular than 2:3. It 
can be more square, but not more rectangular.

To crop an image:

RCMDD Protocols 12-2010  135



• Open the image.

• Click on the crop tool in the tool bar, or hit c on the 
keyboard.

• In the image window, click on the mouse, hold, and 
drag to form a box that includes the area you want to 
keep. Let go when you are finished. You can adjust 
your selection area by moving the corners.

• Press enter to crop.

“Hiding” Objects

Sometimes it will not be possible to crop a photo and keep within the necessary parameters 
(proportion no less square than 2:3). In this case, the photo can be manipulated in Photoshop in 
order to “hide” the unwanted objects. To do this:

• Open the image in Photoshop.

• Click on the Rectangular Marquee Tool in the toolbar, or hit M on the keyboard.

• In the image window, click on the mouse,  hold and drag to form a box around the object you 
want. Let go when you are finished.

• Go to Menu->Select and choose Inverse. Now the area around the object should be 
highlighted.

• Create a new layer by either going to Menu->Layer and selecting New, or by clicking on the 
‘New Layer’ button in the Layer toolbox

• Make sure that black is in the foreground at the bottom of your toolbar.

• Click on the Paint Bucket Tool in the toolbar, or hit G on the keyboard, and then click in the 
selected area in your image. The selected area should turn black.

• In the Layers palette, click on the small arrow next to “opacity” and set this as 75%.

• Press Ctrl D to remove the selection

• Go to Menu->Layer and select Flatten Image.

• Save image.
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Rotating

You also may need to rotate images on occasion:

• Open the image.

• Go to Menu->Image->Rotate Canvas->Choose 
from the list, or go to arbitrary to enter a different 
number of degrees.

Color Correction

On occasion, you will want to manipulate the color of an image. This will generally happen if 
there was not enough light, and the image is very dark. It is best to stick with the simplest fixes: 
Auto-Levels and Auto-Color. Anything more elaborate is too time-consuming and falls outside the 
responsibility of the RCMDD. 

If your image is too dark, or the color is significantly off, first try Auto-Levels: Apple/Command/
Cntrl+Shift+L. If this looks better, great. Be careful that this does not make the image too grainy, 
or make it lose quality in any of a number of other possible ways. If it does, it may be better to 
leave it alone. (Do Apple/Command/Cntrl+Z to undo.)

If Auto-Levels does not help, you can also try Auto-Colors: Apple/Command/Cntrl+Shift+B.

Some registrars have been shown by the project image consultant how to use Curves, but try not 
to do this often. Instructions are not included here.

11.7.4. Saving Manipulated Images

After you have resized, cropped, rotated, and/or any combination of the above techniques, you 
need to save your file:

You can simply save the image over itself by simply selecting Apple/Command/Cntrl+s or go to 
Menu->File->Save and say enter (this will save the picture under the original file format and 
compression ratios). 

If working on a JPEG file, it is preferable to make ALL the necessary adjustments before re-saving 
the image. Making adjustments to a JPEG file in separate sessions, and therefore saving and 
closing the file several times, will compromise the quality of the image, since JPEGS tend to be 
compressed (and thus lose quality) every time they are re-saved.
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OR
If a copy of the image is desired, thus leaving the 
original image unaltered, select Apple/Command/
Cntrl+s or go to Menu->File->Save As:

Choose to save the image as a JPG, browse to the 
folder in which you want to save the file, rename 
the file and select OK. When saving as a JPG, an 
extra screen will appear asking you to select a JPG 
quality, always select the image quality as 10. 
Format options should be “standard.”

11.7.5. Batching

If you have a significant number of images (more than 10) for which the exact same process 
should be followed, you may use batching to manipulate them more efficiently. This will allow 
you to set up a process that Adobe Photoshop will carry out automatically for each image you 
choose.

To set up a batch command, you simply “record” the steps you want the program to follow. Then 
you will tell the program to carry out the procedure for a specific group of files, which will then 
be re-saved and stored.

Note that you can also batch from Bridge; the instructions here are for Photoshop.

To set up a batch command:

• Open one image from the group in Photoshop.

• Go to the “Actions” palette.

• Click on the Down arrow in the upper right corner of the 
palette and select New Action.

• Name your action something sensible, so you can use it again 
if needed: e.g. Resolution-72dpi.

• Hit “Record”

• Carry out the steps you want to be repeated for each file.

• Hit the Stop button (the square in the lower left).
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To run the batch command:

• Go to File->Automate->Batch.

• Choose your action from the drop-down list in the upper left.

• Choose your Source: you can open a group of files, and choose 
“Opened Files”; or you can choose a folder that contains the 
files you want to manipulate.

• Choose your Destination: If you are carrying out a simple 
operation, you may want to simply Save and Close. If you want 
to save a copy, choose a folder in which to save the new files. If 
saving the file in a different format, for example, is part of your 
batching, you will need to check “Override Action “Save As” 
Commands.” If you are saving a copy, you can rename the files 
with the fields in the bottom of the dialogue box.
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12. Locations
The RCMDD has created a system to identify locations for museum objects that is as close as 
possible to the system used by the section heads, but adds specificity and, if possible, 
consistency, so that objects are easier to find. Guidelines have been created to make determining 
and finding locations as consistent as possible, but in many cases, reference must still be made to 
a map. Therefore, the RCMDD is creating a full set of Gallery and Vitrine maps, manual versions 
of which are kept in the Gallery Books, organized by gallery number or on a Gallery clipboard (if 
Inventory is in process); and digital versions of which are stored in Akhenaten->Ruby->RCMDD-
DOC->Permanent_Collections->Gallery_Work. These should be used for reference whenever 
needed, and should be kept updated.

All objects in the museum should eventually have two locations: a Permanent Location (where an 
object “lives”), and a Current Location (where it is at any point in time). All locations are entered 
in the Location Module, and then attached to catalogue records as either Permanent or Current 
Locations. Objects that are “at home” will have the same Permanent and Current Locations.

Note that Permanent Locations can be obtained from a variety of sources; Current Locations may 
ONLY be entered if an object is seen in situ (with the exception of objects traveling abroad or 
stolen objects located abroad).

12.1. Permanent Locations

The Permanent Location is defined as the “home address” of an object, i.e. the museum or 
storage magazine, gallery, area within a gallery, vitrine, and specific location within the area or 
vitrine in which the object is permanently housed. 

There should be only ONE Permanent Location in the database for each object.

Eventually, the RCMDD should have detailed Permanent Locations for all objects in the Egyptian 
Museum, and at least a Level 1 Permanent Location (museum or SCA magazine) for all objects 
that have ever been registered in the museum.

NOTE: We are no longer keeping Past Home Locations, as we did in the Filemaker. All past 
locations will be tracked through movements, i.e. through the Current Locations. 

The Permanent Location should be changed in the database (and on the Catalogue Card) only if it 
is being moved permanently, either within the museum or to another museum or storage 
magazine. If the Permanent Location changes, update the Permanent Location field and the 
Catalogue Card (see below).

12.2. Current Locations
The current location is where the object is at any point in time. In most cases, the object’s 
Permanent and Current locations will be the same. However, an object can move from its 
Permanent Location temporarily, for any of the following reasons:

Conservation

In-House Exhibition

Traveling Loan
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Photography

Outside Study

Temporary Storage

If the object is moved temporarily for any of these reasons, only the Current Location should be 
changed. Do not change the Permanent Location.

If an object goes out on a Traveling Loan, this should be indicated on the back of the catalogue 
card, but the Permanent Location should not be changed in the database.

NOTE: Current Locations can only be entered for objects that have been seen in situ by a 
registrar, with the exceptions of venues for objects out on traveling loans and objects that have 
gone to other museums, for which the RCMDD has a movement date!! Do not enter current 
locations from any other source, even from a movement that was reported but not attended by 
the RCMDD in which the object has been moved into a storage area and cannot be inventoried 
easily. In these cases, the section head must open the storage area so that the object can be 
inventoried before the current location can be entered.

12.3. Obtaining Locations
Information to be inserted in the Location fields of the catalogue record for the object can be 
obtained in the following ways:

• During Inventory. This is the best way to obtain a full and correct location. If a Location has 
been obtained this way, this should be a full, exact location, and the code should be [Display] 
or [Storage]. Locations from Inventories should be put in both the Permanent and Current 
Location fields.

• From a Movement. This is also a good way to obtain a  full and correct location, although in 
this case (e.g. if an object is moved from its home gallery to the conservation lab) the 
Permanent and Current locations may differ.

• From a register book (for Permanent Locations only): If it is not possible to find the object in 
situ, or before an in situ inventory can be done, the location can be taken from a register 
book. If possible, this should be from the SR; if an SR number or location cannot be found for 
the object, the location can be taken from the JE, TR, or CG Position Book. In all cases, the 
source of the location should be indicated in the location code field (e.g. [From SR]; [From 
JE]; [From TR]; [From CG].

• From a curator (for Permanent Location only): If the location is given to you by a section head, 
but is not confirmed in situ by the RCMDD, you may enter it, but indicate this in the location 
code field [From Section Head] OR [From Section].
NOTE: If the section head tells the RCMDD that the object is in a specific storage location, 
but does not have time to give the RCMDD access to inventory the object in situ, the code 
should be [STORAGE], and this should be entered only in the Permanent Location.
NOTE 2: If the RCMDD sees the object in a storage location, but is not given the time to get 
an exact, full location, the code should be [STORAGE], and this should be entered only in the 
Permanent Location.
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12.4. Missing Objects: Guidelines

In some cases, you will not be able to locate objects. There are several possible situations with 
which you may be confronted:

• An object in one of the museum’s registers cannot be located, and there is no indication that 
it has left the museum. In this case, use the following protocols:

Object Status: EMC Object

Object Rating: Missing

Permanent Location: [From SR/JE/TR/CG Position Book-not in situ] LAST KNOWN 
LOCATION; OR [Unknown]

Current Location: [Unknown]

• An object that has previously been inventoried but is no longer where it has been seen by the 
RCMDD, and the section head cannot find its current location. In this case, use the following 
protocols:

Object Status: EMC Object

Object Rating: Missing

Permanent Location: [Display/Storage/STORAGE-not in situ] LAST KNOWN LOCATION

Current Location: [Unknown]

• An EMC object is known to have been stolen, and has been located somewhere. In this case, 
use the following protocols:

Object Status: EMC Object

Object Rating: Stolen

Permanent Location: [Stolen] LAST KNOWN LOCATION IN EMC

Current Location: [Stolen] Actual Current Location

• An EMC object is known to have been stolen, but has NOT been located. In this case, use the 
following protocols:

Object Status: EMC Object

Object Rating: Stolen

Permanent Location: [Stolen] LAST KNOWN LOCATION IN EMC

Current Location: [Unknown]

12.5. Guidelines for Egyptian Museum Locations
The following guidelines are designed to help determine specific locations for objects in the 
Egyptian Museum. Every object in the museum should have its own location. Pieces may share a 
location with their parent object, or may have their own individual locations. (Note, if pieces 
belonging to one object are in different locations, the object (Parent) record should have Various 
as its location.)
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These guidelines have been designed to match wherever possible the locations used by the 
section heads and curators, while adding more specificity to locations for individual objects or 
object groups. However, be aware that matching the curatorial system is not always possible, so 
your locations will not always match those of the section heads.

12.5.1. Floors

The Egyptian Museum has three floors plus a basement. Each floor is identified with a letter: 

R = Ground floor (for rez de chausée)

P = First floor (for première étage)

D = Second floor (for deuxième étage)

SS = Basement (for sous-sol)

Each floor is divided into a series of galleries, each identified with a number. The numbers are 
generally the same from one floor to another. Gallery names therefore consist of a letter plus a 
number. The RCMDD always writes the gallery name with no space between the letter and the 
number:

Sample gallery names: R47; P3; SS24.

If a part of a gallery is used for locked storage, that part of the gallery is referred to with the suffix 
Mag: e.g. P3-Mag.

Galleries in the Atrium are preceded by Atrium: Atrium-R18.

There are a series of galleries surrounding the Atrium that are referred to as “corridor” galleries. 
These are labeled as: e.g. R14-Corr.

Occasionally, there are anomalous in-between spaces, for example in R37 and between the 1st 
(P) and 2nd (D) floors. These are labeled as Mez, for Mezzanine, e.g. R37-Mez.

12.5.2. Wall and Center Zones

Each gallery is divided into Wall and Center zones. An object is in a wall zone if there is no room 
for another object to be displayed between it and the wall. Otherwise, it is in a center zone.

Wall zones are designated according to their cardinal directions and divided according to the 
architecture of the gallery, e.g. N1, E4, etc.

Center zones are designated as Center or Center-Cardinal-direction, and are assigned according 
to the map done by the RCMDD (see below). 

Within each wall and center zone, if there are multiple objects, each is given a specific location. 
Work from top to bottom and left to right to identify the objects, assigning each an alpha (written 
in lowercase). If there are many small objects, or pieces that need individual locations, they may 
be grouped within an alpha, and numbered sequentially (e.g. a - 1, a - 2, a - 3). 

Complex wall or center zones should be mapped, and all alphas (sometimes indicated by a 
range, e.g. a-e, should be written on the main gallery map).
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12.5.3. Vitrines

Vitrines are identified according to all letters or numbers attached to or written on them by the 
curators. All official numbers (usually an upper-case alpha written on or attached to the front) 
should be used first, followed by any other numbers or letters permanently attached to the vitrine 
(see below for more details). If there is no number, assign double alphas, starting at the entrance 
and moving counterclockwise.

NOTE: If there are two vitrines in the same gallery with the same official designation, they should 
be assigned .1 and .2.

Vitrines can be divided into:

• Armoires -- upper enclosed shelves (Arm)

• Pupitres -- slanted “desk” areas (Pup)

• Locked cupboards below (Bas)

• Levels -- both shelves and levels should be designated as levels (Level)

In general, locations for objects in vitrines should be assigned top to bottom, and moving 
counterclockwise around the vitrine, starting from the side on which the vitrine number is 
written.

If there are many small objects, or pieces that need individual locations, they may be grouped 
within an alpha, and numbered sequentially (e.g. a - 1, a - 2, a - 3).

Complex vitrines should be mapped. This can be done by hand, or by taking a photograph that 
can be labeled in Photoshop. If you do the latter, make sure to convert the image to grayscale, so 
as not to waste color ink printing it.

12.6. EMC Gallery Maps

The system of EMC Maps is essential to the ability of the RCMDD to locate objects. Each gallery 
(both display and storage) in the museum should be mapped as accurately as possible, and 
locations within the gallery clearly marked according to the RCMDD system. All complex vitrines 
and wall areas should also be mapped, to avoid confusion.

Gallery, Vitrine, and Wall plans are stored in the Gallery Books, which are arranged by floor and 
then numerically, in ascending order.

Many of the Gallery Maps are already completed and partly approved, but new ones may need to 
be produced in the future. These guidelines will also assist you if a gallery is redone, or many 
objects or vitrines are moved.

These guidelines will show you how to create and modify these plans, and how to map vitrines 
and areas.
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12.6.1. Basics of Gallery 
Maps

Gallery maps are created on 
Adobe Illustrator, in a series of 
layers. Each map should have 
the following information on 
it:

• Gallery Number

• North arrow

• Scale 

• Date of creation or 
modification 

• Section and name of curator responsible for gallery

• Key

• Gallery architecture, including gallery boundaries, and arrows to adjoining galleries

• Gallery divisions and locations

• Large object and vitrine locations, color-coded for identification

Vitrine plans are generally sketched by hand; some of these are also redrawn on the computer, 
again in Adobe Illustrator, but this is not necessary, and should be a low priority item. Vitrine 
plans should include:

• The footprint of the vitrine (seen from above).

• Any major stands or interior “architectural features.”

• Indications, in sketch form, of the footprints of major objects or object groups, to indicate the 
sub-locations (i.e. a, b, c, etc.). DO NOT draw detailed sketches of the objects, or even of 
their footprints -- just enough to be indicative and useful.

In some cases, it may be useful to take a photograph of a vitrine, and label it clearly in 
Photoshop. Only do this if it is the simplest and fastest way to proceed.

12.6.2. Sketching a Gallery Map 

To begin a new gallery map, you will start by sketching the architecture of the gallery and, if 
possible, taking measurements. Note that it is more important to get the sketching done than to 
get the measurements -- if you are in a storage area or the basement, for example, the section 
head may not give you the time to measure. In this case, just do a sketch. If you are taking 
measurements, you will need two people to do it properly. If you are measuring, use a scale of 
1:100 (1 meter = 1 centimeter).

Note that this protocol is written with all aspects of the mapping done at once. It is also fine to 
sketch the architecture first, then move to the section on Mapping on Adobe Illustrator and 
redraw the map on the computer, then bring the computer-generated map to the gallery to 
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continue sketching areas and objects. Manage the work flow in the way that is most efficient for 
you.

Step 1: Find Gallery Name

Using the overall museum map, kept in the front of each Gallery Book, or the gallery numbers 
painted on the museum walls (although note that these are not always completely accurate), 
determine which gallery you are in.  

Once you have determined the correct designation for the gallery:

• Label a piece of paper (preferably graph paper) with the correct gallery name.

• Add the date of the map’s creation.

• Add the name of the section and the curator in charge.

Step 2: Find north

If you are on the ground floor, you can find north by making sure you are facing R3 (currently the 
Amarna Room). If you are on the first floor, you will be facing towards P3 (currently the 
Tutankhamun Jewelry Room).

Step 3: Determine the Gallery Boundaries

The boundaries of the galleries are generally marked by architectural features, such as pilasters 
projecting from the walls. In some cases pilasters will be marked with one or more gallery 
numbers; however, you need to check carefully to which numbers are correct and to understand 
exactly where each gallery begins and ends.

To check the boundaries, find an object that is displayed in a permanent fashion (built into the 
wall, or built into an installation), and record its number on an inventory sheet. Go to the 
database and find the record for this object (see finding object numbers). It is usually safe to 
assume that the gallery listed for a permanently-displayed object in the Special Register is correct. 
Assign the boundaries for the galleries according to these permanently installed objects.

The boundaries for the Corridor galleries around the Atrium should correspond with the regular 
galleries with which they line up (e.g. the boundaries for R32-Corr should be determined by 
looking at the boundaries for R32).

Add arrows and the names of the surrounding galleries for reference.

Step 4: Sketch Architectural Features

Include all walls and all built-in architectural features (columns, pilasters, doorways). 

Step 5: Add Measurements (if you can)

Measure the walls, entrances, and architectural features using the large tape measure (remember 
to keep the tape measure straight at all times and parallel to the floor). Write the numbers on your 
sketch.

Step 6: Identify and Label Wall Areas

The gallery should be divided into “wall” areas according to the architecture of the gallery.

Each wall should be identified according to its cardinal direction (N, S, E, or W).
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Divide each wall into “zones” according to the architectural features present (look at the 
wall, not the base), such as pilasters, columns, niches, or open spaces between pilasters, 
columns, and/or entrances. Do not subdivide pilasters or columns -- treat the pilaster or 
column as one zone. Each architectural division should receive a “zone” number, moving 
from left to right along each wall, e.g. N4 or E2.

An “installation” (defined as a built-in feature that is not part of the original 
architecture of the museum) does not receive a new “zone” number, but takes the 
number of the zone it is in. In other words, zone numbers are only given to features 
of the original architecture of the building.

When the boundaries of a gallery are not marked by walls, the boundary lines should be 
drawn on the map (with a dotted line). These areas are still considered “wall” areas, and 
are labeled as such.

Step 7: Identify and Label Center Zones

The gallery should also be divided into Center zones, which are are used for objects that are not 
against or near the walls. The boundaries for the Center areas are marked on the map with dotted 
lines (of a different color and weight than the gallery boundaries).

The Center divisions of galleries must be decided on a gallery by gallery basis. Some rough 
guidelines:

Do not divide the gallery any more than necessary. See where the objects are displayed, 
and divide the gallery in a way that makes the objects easiest to find.

Use the wall architecture as a guide if possible, so that the boundaries of center areas are 
attached to architectural features.

Mark the center areas according to the cardinal directions preceded by “Center”: e.g. Center; 
Center-N; Center-E, etc.

Step 8: Identify and Label other Zones

There are several galleries (e.g. R47 and R49) that contain rows of columns (colonnades). The 
areas between the line of columns and the walls should be referred to as Cardinal Direction Aisle 
(e.g. N-Aisle), and the areas defined by the columns themselves referred to as Cardinal Direction-
Colonnade (e.g. S-Colonnade). 

Step 9: Add Footprints of Installations, Large Objects and Vitrines

Add the footprints of installations (defined as built-in bases that are not part of the original 
architecture of the museum) large objects and vitrines to your sketch. Include measurements of 
the objects and vitrines, as well as their distances from the walls or columns, to the sketch.

It is not necessary to draw objects actually on the walls here; if the display is simple, there is no 
need to indicate them on the map; if the display is complex, they can be mapped according to 
the vitrine-mapping protocol. 

Step 10: Label Vitrines
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Many vitrines have large, official numbers or letters written on them. If this is the case, label the 
vitrine with this number or letter (in uppercase), as Vit-X (e.g. Vit-A OR Vit-3). If there is more than 
one identifier on the vitrine, use the one on the side with a lock as the main identifier.

If there is another identification number of any sort on the vitrine (such as a Guide or Audioguide 
number), add this after the main vitrine number (e.g. Vit-B-3245).

If the vitrine has no identifier at all on it, check if there is a name for the vitrine in the section 
records by choosing an object in the vitrine and checking its location in the relevant Special 
Register. In either case, if there is no number ON the vitrine, ask the section head to label the 
vitrine. If he or she will not, label it as follows on the map: If the vitrine has no name, label it 
with a double uppercase alpha; if the vitrine has a name in the SR but no visible identifier, label 
it with a double uppercase alpha + the SR name: e.g. Vit-CC-R. Move counterclockwise from the 
gallery entrance. 

NOTE: If there are two vitrines in the same gallery with the same official designation, they should 
be assigned .1 and .2.

Step 11: Label Locations of Large Objects

Once you have drawn the large objects, their locations should be labeled with lowercase alphas.

NOTE: Objects are considered to be in wall areas if they are against the wall (or the dotted line 
that indicates the gallery boundary), or if they are close enough to the wall that no other object 
can be displayed between them and the wall/boundary line.

If there is more than one object in a wall zone, label the location of each object according 
to its placement within the zone with a lowercase alpha: face the wall and move from left 
to right.

If there is more than one object in a Center zone, stand with your back to the center of the 
room, and move from left to right, top (closer to the wall) to bottom. If you are in Center 
(no cardinal direction), stand with your back to the entrance to do this.

12.6.1. Mapping on Adobe Illustrator

Once you have completed the sketch, you will redraw this 
in Adobe Illustrator. Again, you may do this earlier and 
work on Illustrator in stages; see what works best for you.

Begin by opening the Gallery_Map_Template.ai, stored on 
Akhenaten->Ruby->RCMDD-DOC-
>Permanent_Collections->Gallery_Work.

Open this and save it as GalleryName_plan.ai (e.g. 
P3_plan.ai).

Work on a 1:100 scale.

Make sure you always center your text in the text boxes; this will make it much easier to work 
with. If you are working on an ME version of Illustrator, make sure you use the regular Text Tool, 
NOT the right-to-left Text Tool.

Work layer by layer, as outlined below.
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Step 1: Architecture Layer

• Change Gallery Name to correct name (e.g. R35). This 
should be in Papyrus-24pt.

• Add date, section, and name of section head 
(Helvetica-10pt).

• Draw the outer walls and architectural features of the 
gallery. Always use rectangles to do this -- do not use 
individual lines. The lines should be black, 1pt, and the 
rectangles should be filled with white. Boundaries not 
demarcated by walls should be outlined with dotted 
lines (black, 1pt, dash interval 5pt).

• Once you have drawn and properly sized all of the 
overlapping rectangles that make up the gallery, join 
them together by using the merge command.

• Add grey triangular arrows to indicate the directions of 
the surrounding galleries, along with the name of the 
gallery (in grey (Helvetica-10pt).

Step 2: Hatches Layer

The Hatches Layer should always be on the bottom.

The hatches layer is preset with a large box filled with hatching. This is helpful to show exactly 
what is inside and what is outside the gallery, especially where there are objects that extend into 
a second gallery. The Hatch marks are made by drawing a rectangle, and filling it with the 
diagonal stripe pattern in grey. 

Once you have drawn the boundaries of your gallery, join them, and fill them with white, the 
hatching will be hidden within the boundaries. You should not need to do anything else, except 
perhaps to change the size and/or shape of the box filled with hatching to suit the shape and size 
of the gallery.

 Step 3: Areas Layer
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Now you will label the wall and center locations on the 
area layer of the plan (50% grey, Helvetica-10pt).

For wall locations, use the first letter of the cardinal 
direction (N, S, W, E) and the number, with no space: N2.

The labels for the wall areas should be as close as possible 
to the areas they are labeling.

The dotted lines demarcating the center areas should be 
grey, 1pt, with a 3pt interval dash.

The Center areas should be labeled as Center-Cardinal 
direction, if relevant: Center-N.

Step 4: Object and Vitrine Layer

Draw all objects and 
vitrines on this layer, 
using the following 
color codes and 
rectangles with strokes 
of 1pt for the outlines:

The template contains one 
box in each color, so you 
should be able to simply copy 
and paste the type of box you 
need, then resize it by using 
the selection arrow to click on 
the box and using the W 
(width) and H (height) boxes 
at the top of the screen to set 
the proper values.

Step 5: Vit. Names Layer
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Finally, add the Vitrine names and any detailed Object 
locations to the plan on the “Vit. Names” layer. 
(Helvetica-10pt for Vitrines, Helvetica-9pt for Object 
locations, CMYK 100-70-0-0). The format for Vitrine names 
is Vit-A-2456, etc., as outlined above.

Step 6: Store Map

Your map is now complete. Store the completed plan in the 
folder for the gallery: Akhenaten->Ruby->RCMDD-DOC-> 
Permanent_Collections->Gallery_Work->D_Second; 
P_First; R_Ground; SS_Basement; or CM_Children’s 
Museum->Gallery.

Step 7: Print and File Hard Copy

The master hard copy of the map should be kept in the 
Gallery Book. If an Inventory is in process, the copy in the 
Gallery Book should be kept on the active clipboard (and a 
sticky note put into the Gallery Book indicating that it is on a 
Gallery clipboard).

12.6.2. Modifying Gallery Maps

You may indicate modifications to the gallery map on the hard copy, but as soon as possible, you 
should also modify the map file and reprint the map. To modify the map, open it from the backup 
system, make the changes you need, resave it, reprint it and refile it, and replace the file in the 
database with the new file.

12.6.3. Creating and Modifying Vitrine Maps

Many galleries contain vitrines. Some of these are very simple, and contain only a few objects. 
These do not need to be mapped; simply follow the normal protocol of assigning alphas by 
moving from left to right and top to bottom.

If a vitrine is more complex, especially if it contains more than 10 objects, you may want to 
create a separate vitrine map. These can be done by hand, on graph paper. Here are some 
guidelines. Although the map will be the master, keep in mind that a registrar or scholar should 
be able in many cases to find an object without the map, by using common sense.

In most cases, you will produce these maps during Initial Gallery Inventory. However, you may 
also need to produce them during other inventory work; the procedures are therefore outlined 
here. In general, the rule is to map the vitrine fully the first time an object in it is inventoried, 
then store the map on the gallery clipboard, if Initial Gallery Inventory is underway, or in the 
Gallery Book if the gallery is not yet underway.

Step 1: Sketch the vitrine and label the plan

This does not have to be exactly to scale, but keep it realistic. Make sure the sketch is labeled at 
the top with the gallery, zone, and vitrine name, and in the lower right corner the date on which 
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it is made, and the initials of the person doing the mapping. If the vitrine has an identifier on it, 
mark the location of this with a small asterisk.

Indicate whether you are drawing the vitrine from a bird’s eye view or from the front/side.

Also draw small arrows to indicate which way the statue is facing (bird's eye map).

Step 2: Define the locations within the vitrine

Some vitrines have upper enclosed shelves (armoires), slanted “desk” areas (pupitres), and/
or locked cupboards below (bas). These locations should be identified as Arm, Pup, and 
Bas.

If a vertically-arranged (viewed from the front) vitrine, or a part of a vitrine, is divided into 
sides or levels, identify these from top to bottom and left to right (e.g. Vit-A - Side-1; or Vit-
A - Pup-2 - a - 1). Note that a decision was made in December 2009 to use the term level 
in all cases rather than level in some cases and shelf in others. This will mean that the 
RCMDD terminology will differ in some cases from the designation in the SR books.

When dividing a horizontally-arranged (viewable from multiple sides) vitrine into sides 
(which you should only do when necessary, because there are many objects), start 
whenever possible with the side that has the vitrine name written on it. If the vitrine does 
not have a name on it, start with the side where you think the flow of the visitors is 
directed and then go around in a counterclockwise direction.

Within a vitrine, vitrine side, or vitrine level, if there are multiple objects, identify the 
locations from top to bottom and left to right.

When there are many objects in a vitrine, try to group their locations together.  For 
example the first 5 objects would take a1-a5, the following 8 would take b1-b8 and so on. 
Try not to go beyond the letter m when giving specific locations to objects or object 
groups.

Step 3: Scan the sketch

Scan the sketch and save it as Gallery_Vit-Name.jpg.

Step 4: Store Map

Store the scanned file in Akhenaten->Ruby->RCMDD-DOC->Permanent_Collections/-
>Gallery_Work->D-Floor; P-Floor; R-Floor; SS_Basement; or CM_Children’s Museum->Gallery.

Step 7: Attach to Database

You should also import the scanned file into the Multimedia Module of the database. It will be 
attached to all relevant Location records.

Step 7: Print and File Hard Copy

The hard copy of the vitrine map should be kept in the Gallery Book.

If objects are moved around in a vitrine, you may need to remap it. Simply do a new map, 
following the guidelines above. Indicate on the old map that it is no longer valid. 
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12.6.4. Creating and Modifying Wall Maps

Some wall areas contain multiple objects. If the arrangement is simple and straightforward, you 
do not need to map it; anyone locating the object will simply follow the normal protocol of 
assigning alphas by moving from top to bottom and left to right.

If the arrangement is more complex, you may want to sketch a wall map for the wall zone. To do 
this, sketch the rough outlines of the objects, and show how you have assigned the alphas. You 
may also take a photograph and label it in Photoshop. As always, work left to right and top to 
bottom.

As with the vitrines, this should be done whenever the first object in the area is inventoried, and 
the map should be stored on the gallery clipboard, if Initial Gallery Inventory is underway, or in 
the Gallery Book if the gallery is not yet underway.

NOTE: If an object is inside a frame, we do not mention the frame in our locations. We treat the 
framed object as an ordinary object, identifying it by its wall zone and then its placement within 
the zone by lowercase alpha.

Step 3: Scan the sketch

Scan the sketch and save it as Gallery_Wall-Zone.jpg.

Step 4: Store Map

Store the scanned file in Akhenaten->Ruby->RCMDD-DOC->Permanent_Collections-
>Gallery_Work->D_Second; P_First; R_Ground; SS_Basement; or CM_Children’s Museum-
>Gallery.

Step 7: Attach to Database

You should also import the scanned file into the Multimedia Module of the database. It will be 
attached to all relevant Location records.

Step 7: Print and File Hard Copy

The hard copy of the map should be kept in the Gallery Book, filed with the gallery. If you 
remove the map temporarily for some reason, make sure to leave a sticky note in the book 
indicating where the map is.
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13. Narratives

13.1. The Narratives Module

For now, the Narratives Module will be 
used mainly for four purposes: to store 
the English versions of display labels, to 
store text to be published on the 
Internet, to store website information for 
exhibitions and loans, and to store 
catalogue text written by team 
members. There will also be a record 
for each object to store tombstone 
information, which will be used for 
now only for labels. We are using only 
a small percentage of the many fields 
available here; perhaps in the future more use can be made of this module.

13.2. Field Definitions
As with most of the modules, the Summary tab pulls information from other tabs. The original 
tabs will be indicated here, but the summary tab may be used for data entry as well.

Title (Details Tab)

Each record should have its own title, 
which should depend on the purpose of 
the narrative. For labels, this will be 
short, so that it will fit on the label. 
Website titles can be slightly longer, but 
will usually be shorter than the title of 
the object in the Catalogue module.
Example: Main Title in Catalogue 
module: Limestone Stela of Ptahmay 
with Shed and Isis; title for Label 
record: Stela of Ptahmay; title for  
Website Text: Stela of Ptahmay with 
Shed and Isis. For loans and exhibitions, use the short name.

Author (Details Tab)

Name of person who has written the narrative; links to Parties Module.

Type (Details Tab)

Choose either Tombstone; Label - Object; Label - Vitrine; Website Text, Exhibition Text, Loan Text, 
or Catalogue Text (rarely used). In the future, there may be other uses, and multiple types can be 
chosen.

Narrative (Narratives Tab)
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Text goes here. 

• For Tombstone, this should include:

Dating Summary, in the following 
format: Period, Dynasty, reign of 
King, Absolute Dates

Material (first letter of first word 
capitalized only)

Provenance, in one line, edited as 
necessary

Source Summary, in one line, 
edited as necessary

ID Numbers, as JE = CG = TR. Do 
not include SR number here unless 
it is the only official ID number available for the object. You may also include excavation 
numbers if relevant.

• For Label, this should be relatively 
short, and should depend on 
context: a stand-along masterpiece 
can have up to 150 words (900 
characters) at an absolute 
maximum; an object in a vitrine 
may have only 15-20 words 
(100-150 characters), if that.

• For the website narrative, the 
educated general public is the target 
audience. This text may combine 
material from the description and 
the label, or may be new material 
(although the information should of course be compatible). The text should be interesting, 
engaging, and informative. For a relatively minor object, one or two paragraphs (500-1200 
characters) is sufficient; for a major object, this may include up to four paragraphs, so 
between 1500 and 2000 characters. The maximum here is 2500 characters.

• For the exhibition or loan narrative, this should be about 500 characters.

• Catalogue text will depend on the catalogue. We are not currently using this.
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Object (Object Tab)

Link here to the object or objects for 
which this narrative has been 
composed.

For the most part, display labels will be 
linked with one object, although there 
are instances where a label will cover 
more than one artifact, in which cases 
multiple objects may be attached.

Event (Event Tab)

This should be linked to the master 
event record for the loan or exhibition.

Publish on Internet/Intranet (Security Tab)

For Tombstones, leave as default (no for 
both).

For Display Labels, leave as default (no 
for both).

For Website Text, toggle Publish on 
Internet to Yes.

For Exhibition or Loan Narrative, toggle 
Publish on Internet to Yes.

For Catalogue Text, leave as default (no 
for both).

Multimedia

This tab is used to store e.g. scans of 
labels with English and Arabic text, usually after having been approved and signed by the 
Museum Director.

13.3. Narrative Creation
It is not generally the job of the RCMDD to produce narrative text for objects; it is best if the role 
of the department heads is to supervise its creation, approve it, and make sure it is processed in 
the database.

Currently (as of March 2011), narrative text is being created by ARCE team members, volunteers, 
and Egyptologists. As a long-term strategy, building relationships with Egyptologists who 
specialize in particular periods or types of objects and who are willing to draft narrative text will 
help the EMC continue to populate this part of the database (and especially the public Website).

13.3.1. Narrative Preparation for Major Objects

The following materials should be prepared for the Narrative writer:
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• Object information in the form of an Narrative report (pdf).

• A Narrative file (in Word, saved as Narrative_ID_Number_Initials.doc). This should be as 
follows (important so that the text can be copied and pasted into the database):

Font: Times New Roman, 
11 pt.

Line spacing: 1

No space before

No space after

No first line indent

Filled out as follows:

Author (name of 
Narrative Writer)

Website Title

Website Text

Any corrections or additions to object information provided, with source of 
correction or addition detailed (e.g. Borchardt 1913)

Relevant bibliography, in the format:

Author Last Name, First Name 

Article or Book Title

Journal Title, if applicable, Journal number

Publication Date

Publication City (if applicable)

Publisher (if applicable)

Pages, figures, plates

13.3.2. Narrative Writing Guidelines for Web Text

The Narrative writer should be provided with the Narrative guidelines, available as a pdf, and a 
Word file, using the RCMDD_Narrative template and named as ID_Number-Object-short-
name_Initials (of writer). 

The text of the guidelines is copied here for easy reference.

Guidelines for Website Narrative Writers:

The RCMDD will provide you with a pdf containing all available object information, including a 
description and a label (if available), as well as an image. If you require additional images, please 
let your narrative coordinator know and s/he will provide you with whatever is available.

If you can, please research the object to the best of your ability, as the information you will be 
given will come primarily from the museum’s register books. You will be provided with some 
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bibliography, but please feel free to add to this, and do not assume that the museum team has 
been able to check the references listed.

For the website narrative, the educated general public is your target audience. You may use some 
of the description, as well as information from the label, if one has been provided. Make the text 
interesting, engaging, and informative. For a relatively minor object, one or two paragraphs 
(500-1200 characters) is sufficient; for a major object, you may write up to four paragraphs, aim 
for between 1500 and 2000 characters. Please do not submit more than 2500 characters.

Please submit your website narrative using the attached Word file. This will make it easier for us 
to process your submission.

If you have corrections or additions to the object information or bibliography, please note them 
clearly in your text file. 

If you are adding bibliography, please use the following format (with hard returns between each 
element):

Author Last Name, First Name

Article or Book Title

Journal Title, if applicable, Journal number

Publication Date

Publication City (if applicable)

Publisher (if applicable)

Pages, figures, plates

If you have any corrections or additions, be sure to detail the source of your information, and 
make sure to include any bibliographic references.

When you have completed your draft, please email the files back to your narrative coordinator 
for processing, and thank you!

13.3.3. Narrative Processing

Once the files have been reviewed and returned, they should be processed as follows:

• Check for corrections and additions provided by any narrative writers, and make any of these 
that are approved by the senior checkers.

13.3.3.1. For Labels
• Create a new Narrative record.

Mark this as Tombstone under Type.

Paste the Label Title into the Title field.

Paste the Author name into the Author field.

Paste the Tombstone information into the Narrative field. The text should be formatted as 
Size 3 and Times New Roman.
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Mark the record as Publish in the Internet: “No.”

Attach the relevant object to the record.

• Create a new Narrative record by dittoing the Tombstone record. Change the following fields:

Under Type, mark this as Label - Object (for single objects) or Label - Vitrine (for groups).

Paste the Label title into the Title field.

Paste the Label text into the 
Narrative field. The text should 
be formatted as Size 3 and 
Times New Roman.

If the label is for multiple 
objects, attach these.

Mark the record as Publish in 
the Internet: “No.”

13.3.3.2. For Website Text
• Create a new Narrative record.

Under Type, mark this as 
Website Text.

Add the name of the writer to 
the Authors field.

Add the Website title to the Title 
field.

Paste the Website text into the 
Narrative field. The text should 
be formatted as Size 3 and Times 
New Roman.

Mark the record as Publish in the 
Internet: “Yes.”
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14. Measuring Objects and Scales
An essential part of the basic information for each object is accurate and full measurements. In 
general, there should be three dimensions, given in maximum centimeters, for each object before 
the object record is submitted for approval.

It is also useful, whenever possible (in general, when photographing objects that are not in 
vitrines) to include a scale for reference, so that there is some indication of the object’s size.

14.1. Measuring Objects

Each object should have 3 dimensions:

• For “portrait” objects: these should be height, width and depth (e.g. stela, statue).

• For “landscape” objects (e.g. coffins): these should be length, width and height. (NOTE: even 
if a stela is wider than it is high, consider it a “portrait” object, for consistency.)

• Circular or round objects (e.g. dish, ring) require only 2 dimensions: diameter and height or 
length.

In most cases, you will be able to find at least one or possibly two dimensions for objects in the 
register books, but you will rarely find three dimensions. If the object is published in one of the 
major Egyptian Museum guidebooks, you may be able to find full dimensions there. Otherwise, 
you should try to measure the second and/or third dimension yourself.

14.1.1. Measuring Equipment

• When going out to the galleries to measure an object, take an apron with you, which will 
include gloves, measuring tape, pencil, and eraser. All measurements should be in cm so 
make sure the measuring tape has cm units.

• For large objects, make sure to take a long measuring tape.

• Write the measurements under Problems/notes on the Object Inventory form.

• If the object is large, take another person with you to help hold the tape measure.

14.1.2. Measuring Guidelines

• Make sure to always wear gloves while measuring objects! 

• Don’t put the measuring tape directly on the object, keep some distance between the tape 
and the object.

• Always start from the 0 mark on the measuring tape.

• Always keep the tape taut to get the correct measurement.

• If the object is larger than the tape, start measuring again at the point where the tape ended 
and then add the two measurements together.  Repeat as many times as necessary.
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• When measuring, choose the greatest distance from one 
side of the object to the other to measure (the 
dimensions should be the maximum dimensions).  Keep 
in mind that many objects are irregular in shape. The 
maximal points on each side may not be on the same 
level. In order to obtain an accurate measurement it will 
be necessary to measure from the maximal point on one 
side horizontally to a point directly above or below the 
maximal point on the other side. The accompanying 
image illustrates this concept.

• Write down each measurement directly after taking it so 
as not to forget.

• Enter the measurements into the database as soon as 
possible.

NOTE: If the register book(s) already have consistent measurements, it is still a good idea to 
check these, but as long as the number you get is within the margin of error, DO NOT put a new 
number in the database. For example, if the JE says a statue is 82 cm high and the CG says it is 81 
cm high, and you measure it and get 83 cm, DO NOT put 83 cm into the database. Use the JE 
number, since it is closer to yours. All of these numbers are within the margin of error. Only 
change a measurement if there is a real problem (the JE says 81 cm, and you find that the statue is 
65 cm). In such cases, you will need to do some additional detective work in any case, to make 
sure you are measuring the correct object. If you DO find a discrepancy, try to figure out where 
the problem lies, and make a clear note in the Measurement Notes field that indicates why the 
RCMDD has come up with a different number.

14.2. Scales

If you are shooting an object that is not in a vitrine, you may want to use one of the RCMDD’s 
scales. There are different sizes available, so you will want to choose the one that works best with 
the size of the object.

Here are some guidelines for how to place the scale:

• Place the scale in line with the object (not in front or behind the object), ensuring that it does 
not cover any part of the object. If possible, place it together with the white board on which 
the object number is written.

• Make sure the camera is parallel with the object, and placed at a good distance from it to 
avoid distortion.
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15. The Parties Module
The RCMDD stores information about all people and institutions that are connected in some way 
to the museum, either as current contacts, scholars, or excavators of collection objects or 
sponsors of expeditions, in EMu’s Parties Module. This module applies to much of the work of the 
office, in terms of administration, documentation, and collections management. Therefore, its use 
is introduced here.

The RCMDD deals with two major types of parties: persons and organizations.

15.1. Entering Person Records

To enter a new person into the Parties Module, follow these steps:

1. Open the Parties Module

2. Begin a new record by clicking on the new record icon (top, far left) or going to File>New

3. Make  sure you are in the Person tab, and fill out the following fields:

Party Type (Person or 
Organization): Person

Title: choose from list

First Name

Middle Name if applicable

Last name

Suffix if applicable

Gender

Language: Primary (default will 
be blank, so make sure to 
choose a language here)

Derived Names: Automatic: The default is yes -- the database will fill these names out 
when you save the record). In general, leave this as “Yes.”

RCMDD Protocols 12-2010  162



4. Go next to the Organisation2 Tab, and fill out the following fields:

Organisation: name of museum 
or organization with which the 
person is or was associated. 
This links to a separate 
Organisation record, so if this 
organization has not been 
entered previously in the 
database, you will need to 
create a new record for it, as 
per the protocols below.

Department

Position

5. Go to the Address Tab, and fill out the following fields:

Street

City/Town

State/Province

Postal/Zip Code

Country

Telephone Numbers

Email

6. Finally, go to the Roles Tab, and choose the role or roles of the person from the lookup list. 
Note that you can choose more than one role here, so make sure you put the primary role 
(e.g. Curator, Administrator, Professor) first.

15.2. Entering Organization Records

To enter a new organization (used primarily by the RCMDD for the institutions that have or are 
sponsoring excavations, as well as museums, institutions to which scholars are attached, and 
exhibition organizers) into the Parties Module, follow these steps:

1. Open the Parties Module

2. Begin a new record by clicking on the new record icon (top, far left) or going to File->New

RCMDD Protocols 12-2010  163

2 Note that tabs and fields in EMu use British spelling, whereas the RCMDD uses American spelling. Therefore, in these protocols, “Organisation” is used only 

when referring to the names of tabs or fields.



3. Make  sure you are in the first tab, and choose Organisation under Party Type; you will get the 
Organisation tab. Fill out the relevant fields here. Under organization name, if there is an 
acronym, put this first, followed by the full name of the organization in parentheses. Most 
organization names and acronyms will need to be preceded by a “the” so that the Source 
Summary autofills correctly; there are no good rules for determining whether or not to add a 
“the,” so please check with the senior team if you are entering a new organization.

4.Go next to the Address Tab, and 
fill out what you can.

5.Finally, go to the Roles Tab, and 
choose the role or roles of the 
organization from the lookup list.
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16. The Events Module
The RCMDD uses the Events Module for a number of purposes. Its principal uses are:

1. To track Outside Requests. 

2. To track Exhibitions and Loans.

3. To store images and information about these and other events, such as:

Movements

Training

Parties

Incidents for which Memos are written

The protocols for the use of this module for Outside Requests, Exhibitions, and Loans are covered 
in detail in the sections on those activities. This section provides an overview of the use of this 
module, along with details about its use for storing information about and images of events that 
do not fall into these three categories.

16.1. Event Numbers
Each event tracked by the RCMDD is given its own number, which includes a code to indicate 
the type of event, plus the year and a sequential number (for Exhibitions, this is the Exhibition 
number; for Loans, this is the Loan number, or the Loan number plus the Venue number).  Here 
are the codes used in this field:

• OR: Outside Request

• L: Loan

• E: Exhibition

• EV: Everything else

Thus each event will be given its own record in the database, with the format: CODE.YYYY.SN, 
e.g. EV.2009.06.
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16.2. Event Information

Only a few database fields need to be 
filled out for most events.

Event Number (Events 1 Tab)

Code.YYYY.SN

Event Type (Events 1 Tab)

Choose from the dropdown:

• Outside Requests

• Exhibition

• Loan

• Memo

• Decree

• Permission

• Outside Photography

• RCMDD Training

• Movement

• RCMDD Work

• Other Event (for everything else)

Event Locality (Events 1 Tab)

Indicate here whether the event will take or has taken place inside or outside the museum.

Title (Events 1 Tab)

Outside Requests are given the name 
of the scholar as their titles, plus a 
sequential number for multiple 
requests.

Exhibitions and Loans should be given 
their proper titles. For others, add a 
simple title that will make the event 
easy to find: e.g. Movement of Objects 
from Section 4 to Suez; or Party at 
ARCE-November 2009. If you will be 
using the record to run a memo, make 
sure the title will make sense as the 
subject line (Re:) on the memo.

Description (Events 1 Tab)
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You can use this field to add more information about the event you are recording, at your 
discretion. If you are using the record for a memo, type the text you wish to appear in the body of 
the memo here.

Commencement Date (Dates Tab)

The date on which the event will or has occurred should go here for events other than Outside 
Requests.

People to Notify (Dates Tab)

If the record is for a memo, insert the name or names of the people to whom the memo will be 
addressed here.

Completion Date (Dates Tab)

For Loans and Exhibitions, the end dates of the exhibition or venue go here. For Outside 
Photography, the date on which the images are delivered to the RCMDD goes here.

Other People to Notify (Dates Tab)

For memos, add the names of the person or persons from whom the memo will be sent (the From: 
line on the memo).

16.3. Event Images (Overview)

One of the principal reasons to make event records is to have a place to attach images of events 
so that they can be found easily. The images will be, like all images, stored in the Multimedia 
module, but should be attached to their relevant event records.

If you take images that are associated with an event for which a record already exists in the 
database (like an exhibition, loan, or outside request), make sure you link them to the existing 
record. If there is not already an event, you should create one right away; this will usually be 
given an EV number. Make sure you are assigning a new and unique event number to the record 
(search for all EV records, sort alpha-numerically, and see what the last one is).

You can add event images to the Multimedia tab of the relevant event in the Event module by 
hand, or you can use the Import Tool in the Multimedia module, then link the images to their 
relevant event . When you are in the Multimedia tab of the Event module, you can drag and drop 
the images in the order that you want them to appear. Note that if you will be using the record for 
a memo, put any images you want to include first, as the report is set to include the first two 
images attached to the record.

Remember the following (see Multimedia Field Definitions for details):

• the Title should be the event number.

• the Creator should be the photographer.

• the Identifier will be the file name.

• the Description is used for captions; this should at minimum include the names of the people 
in the photo. Remember to indicate the order in which you have named them: e.g. (left to 
right): Yasmin El Shazly, Hanane Gaber, Sari Nieminen, Elina Nuutinen.
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17. Bibliography
The Bibliography is an important supporting module for the object records. Ideally, all 
publications associated with Egyptian Museum objects should eventually be entered into this 
module, and linked to the relevant catalogue records.

Each Bibliography record should refer to a full publication: a book or catalogue, an article from a 
journal or edited volume, or an on-line publication. The exact page and plate numbers should be 
indicated within the catalogue records, under Bibliographic Notes on the Bibliography tab.

17.1. Creating Bibliography Records

To enter references into the Bibliography Module:

Step 1: Open the Bibliography Module and click on the New Record icon.

Step 2: Select the publication type from the Type field (in most cases you will want to use either 
Article, Book, Catalogue, Journal, or Website).

Step 3: Select the language of your publication from the drop-down list or start typing it in the 
field and click on the look-up list button. It will fill automatically if the language is already in the 
list.

Books

• Fill out the title of your book. You 
do not need a period at the end. 
Capitalize properly! E.g. 
Understanding Illuminated 
Manuscripts: A Guide to Technical 
Terms

4. Continue with the name(s) of the 
author(s). Type the name of the lead 
author in the first field and click on 
the plus to the right. If the name is 
already in the Parties module and 
you have spelled it correctly, the 
field will fill automatically. If not, you will get a message saying “not found,” and you will 
have to open the Parties module and create a new record. Attach it to the Bibliography 
module. If there are multiple authors, attach the names of each one separately. Note that if 
you have a reference that says, “et al.” (for et alia), this means there are multiple authors, and 
you need to find the names of each one. Usually a Google search will find you what you 
need. The database will automatically turn these names (back) into et al. in the reference in 
the Catalogue Module.

5. If the book has multiple editions, and you know which edition you have, record it in the 
Edition field.

• If the book has multiple volumes, indicate the volume number for which you are making a 
record in the Volume field. 
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6. If you know the number of Pages in the book, you can enter it here, but this is not very 
important. 

7. The Publisher field links to the Parties module, so if your publisher already has a record, it will 
fill automatically. If not, create a record for it as above. Remember to choose Organisation in 
Party Type.

8. Next, fill in the Publication Date (year only: YYYY) and the Publication City (select from look-
up, if not there, ask an Admin person to add it for you). 

9. If the book is part of a series, link the series record (see below) in the Published In field.

Book Series

If your book is part of a series, you 
should create a master record for the 
series. 

• Under Book Details, fill out the title 
of the series, an abbreviated title, 
and the name of the series editor(s). 

• Under Volume Range, enter the 
number of volumes to date.

• Fill out Publisher.

• Under Pub. Date Range, fill out the 
years in which the series was 
published; if it is ongoing, enter YYYY-present.

• Fill out Publisher and Publication City.

Catalogue

This Type is used only for catalogues containing EMC objects (not including the Catalogues 
générals). If you will be linking an article from a catalogue, rather than an object entry, select 
Book as its type.

• Fill out the full title of the catalogue.

• If available, enter the names of the 
Editors in the Author/Contributors 
field.

• Next fill out Publisher, Publication 
Date and Publication City as above.
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Journals

It is important to understand here that 
you will make one record for each 
journal series, rather than one record 
for each volume of the journal. The 
volume of the journal will be indicated 
in the records for the specific articles 
you will be citing.

• Fill out the title of the Journal, 
without any volume or issue 
numbers.

• If there is a standard abbreviation 
(see the Lexikon der Ägyptologie (copy on Ruby) for a list of abbreviations), indicate it here.

• ISSN: Leave blank (unless you happen to know it).

• If there is a principal editor for the journal, enter his or her name here. This links to the Parties 
module, so make sure that there is a Parties record for the editor. If one does not already exist, 
create one.

• Attach the publisher to the Publisher field. This links to the parties module; remember that this 
should be an Organisation record, not a Person record.

• Pub. Date Range: Indicate the years during which the journal was published. If it is still being 
published, put the start date and to present: YYYY-present. This is a free text field.

• Enter the publication city.

• Leave the bottom section blank, unless the office has copies of one or more issue. In this case, 
enter “RCMDD Library” under Reference Type and the name of the donor and the number of 
the issue donated under Reference Details. Add a separate line for each issue held by the 
office.

Articles (in Books or Journals)

1. In the Title field, enter the title of 
the article.
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2. Attach the Parties record(s) for the 
author to the Authors/Contributors 
field. If there is/are no Parties 
record(s) for the author(s), create 
them.

3. Enter the year of publication in 
Publication Date and the page 
numbers in Pages.

• The details of the book or journal 
in which the article was published 
are entered in the “Issue Details” 
area. If your Article was published 
in a Journal, enter Volume and Issue numbers in these fields.

• The Pages field under Issue Details refers to the complete number of pages of the Journal/Book 
(we think).

• Attach the name of the book or journal to the Published In field. If this field does not fill 
automatically (or bring up choices) when you type part of the title of the book or journal, a 
new window will open in the Bibliography module so you can create a record for it there and 
then attach it.

Website

• Type the name of the Website in 
Title field followed by the link in 
brackets (e.g. The Giza Archives 
(www.gizapyramids.org)) NOTE: this 
is the only way the website link will 
show up in the reports. 

• The same link should go in Website 
Identifier.

• If the web page you are referencing 
has an author, enter it under 
Authors/Contributors.

• Under Last Access Date, enter the date 
on which you made the record, to keep track of how up-to-date the website might be.

Step 3: If you are entering details for a book, catalogue, or journal for which there is a copy in 
the RCMDD library you should also add “RCMDD Library” in the Reference Type field (it will fill 
this automatically if you click on the look-up button). If it was a gift, type the name of the donor 
in Reference Details. If the office has a digital copy of the relevant reference, indicate this as as 
“RCMDD e-library” in the Reference Type field. At some point, the office may want to import 
these digital files to the Multimedia module and attach them to the relevant records, but at this 
point, the decision has been made not to do this.
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Step 4: Save.

Step 5: These records will be attached to individual Catalogue records as needed. Relevant page 
and/or plate numbers should be entered in the Bibliographic notes field.

RCMDD Protocols 12-2010  172



Part IV:

Information 
Management Processes
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18. Searching the Database
The primary purpose of a database is to store and retrieve information. It is of the utmost 
importance, therefore, that database users know how to search the database to find the 
information they need.  

This protocol explains how to search using the KE Emu database.

1. General vs. Exact Searches (Definition)

2. Simple Searches within Fields

3. Complex Searches

4. Using Wildcards

5. Saving Searches as Dynamic Groups

18.1. General vs. Exact Searches (Definition)

For all searches, you must begin by deciding whether you need a general search or an exact 
search.

18.1.1. General Searches

A general search asks the database to search for specific information in a chosen field in every 
record in the database, but does not exclude additional information in the same field.  For 
example, in the ID number field: if you search for JE 1234* in this field, it will find JE 1234, JE 
12345, JE 12345-a, and even JE 567 = CG 1234. Similarly, you can search for an object by 
entering a word in the Main Title, or any other "free text" field  (i.e. fields without a look-up list). 
Follow the directions below, but remember that you may need to use wildcards.

18.1.2. Exact Searches

An exact search will find exactly and only what you have entered. For example, if you do an 
exact search for R. Stadelmann in the excavator field, it will find only records that have only R. 
Stadelmann, spelled exactly as you have typed it in the search, in that field. It will not find entries 
that have Stadelmann without the R., or R. Stadelman, or R. Stadelmann and G. Dreyer. If you do 
an exact search for JE 1234 in the ID number field, it will find only JE 1234; it will not find JE 
12345 or JE 12345-a.

To perform an exact search, put your search term in quotation marks (""); e.g. "CG 123". If you 
choose a search term from the look-up lists, it will automatically be entered in quotation marks. 

18.2. Simple Searches Within Fields

The following information will show you how to find one or more objects by searching in one or 
more fields with a single search.

STEP 1: Open the database and go to the module in which you want to perform your search.

You will probably want to search most often from the Catalogue module, but you can search in a 
similar way in any module. The module will automatically open in search mode (Tip: All of your 
entries in search mode should be in red. If they are not, you are not in the right mode!). 
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STEP 2: Enter Search Parameter(s)

1. Choose the first field in which you 
wish to search and either type your 
parameter or enter it from a look-up 
list. If you want to do an exact 
search remember to put your 
parameter in quotation marks.

Examples: 

If you are searching for a 
particular object and know one 
of its ID numbers, enter this 
under ID number on either the 
Summary tab or the Title/ID 1 
tab. 

If you want to find all objects from the tomb of Tutankhamun, go to the Accession tab and 
enter KV62 under Monument or choose Thebes (Diospolis Magna; Luxor)->Thebes:West-
>Valley of the Kings (Biban el-Muluk)->KV62: Tutankhamun from the look-up lists in the 
Source Details fields. 

2. If you wish to add parameters, you can add these in the appropriate fields.

Example: If you wish to find all stelae made of calcite from the Karnak Cachette, enter:

Stela in the Object Category field on the Summary tab

Court of the Cachette under Monument (or select from the look-up lists, e.g. 
Thebes (Diospolis Magna; Luxor) ->Thebes: East -> Karnak Temple (Ipet-Isut): 
Precinct of Amun -> Court of the Cachette) on the Accession tab

Calcite in the Material field on the Summary tab.

3. Note that you can do general searches in some fields and exact searches in others.

4. Review all fields to make certain you have entered the information correctly.

STEP 3: Run the Search

1. Click on the binoculars in the top left-hand corner of the screen or press Ctrl+F on your 
keyboard.

2. If you would like to go back and refine your search without having to enter all 
parameters again, click the "previous search" button in the tool bar.

3. If you want to do a completely new search, click on the "new search" button in 
the tool bar, or if you are in Search mode, choose Clear All in the Edit menu or 
press Shift+Delete on your keyboard.
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18.3. Complex Searches

This will provide instructions for finding one or more objects by searching for characteristics via a 
complex search.

STEP 1: Open the database and the module in which you want to search

You will probably want to search most often from the Catalogue Module, but you can search in a 
similar way in any module. The module will automatically open in search mode. (Tip: All of your 
entries should be in red. If they are not, you are not in the right mode!)

STEP 2: Enter Search Parameters

The search function in KE EMu allows you to enter several parameters in each field, so that you 
can search for objects using different criteria in one search. You can do OR searches (to find more 
than one type of object at once); AND searches (to find groups of objects that share certain 
characteristics); and NOT searches (groups of objects that have one characteristic but not 
another). You do this by entering multiple parameters in the relevant fields:

OR searches:

Example: You want to find records of all necklaces that are of either gold OR lapis lazuli OR both 
from the New Kingdom:

In the Sub-Category 1 field, enter necklace.

In the Period field, enter New Kingdom. 

In the Material Field, enter Gold in one 
row and Lapis lazuli in the next row.                                               

4. Review all fields to make certain you have entered 
the information correctly.

5. Run your search.

You should find all necklaces that contain gold and/or lapis lazuli (and other materials) from the 
New Kingdom.

AND Searches

Example: You want to find records of all necklaces that have both gold AND lapis lazuli from the 
New Kingdom:

In the Sub-Category 1 field, enter necklace in one row.

In the Period field, enter New Kingdom.

In the Material field, enter Gold and 
Lapis lazuli in the same row (note 
that you have to type it in!). 

6. Review all fields to make certain you have 
entered the information correctly.

7. Run your search.

You should find all necklaces from the New Kingdom that contain both gold and lapis lazuli.
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NOT Searches (using the Wildcard!)

Example: You want to find necklaces from the New Kingdom that contain gold but NOT lapis 
lazuli.

In the Sub-Category 1 field, enter 
necklace in one row.

In the Period field, enter New 
Kingdom.

In the Material field, enter Gold !Lapis lazuli.

You should find all necklaces from the New Kingdom that contain gold but no lapis lazuli.

IF YOU NEED TO REFINE YOUR SEARCH, GO TO STEP 3.

STEP 3: Narrow or extend your search by using the “Additional Search” function 

You can use the “Additional Search” function to narrow/extend your search by Merging (OR), 
Intersecting (AND), or Subtracting (NOT) criteria from your initial search. This method is only 
really helpful if you have already run a search and only afterwards decide you would like to add 
parameters. In most cases the same search can be done using the method set out in Step 2 above.

Here are some examples: 

1. If you want to find all records of New Kingdom necklaces 
containing either lapis lazuli or gold (or both), after you have 
already run a search for New Kingdom necklaces with lapis 
lazuli, go to the File menu and choose Additional 
search>Merge(OR) and choose necklace again in the Sub-
category field, and New Kingdom in the Period field, and gold in 
the Material field. Run your search.

2. If you want to narrow the search you have done for necklaces 

containing gold and lapis lazuli to only necklaces containing 
gold, lapis lazuli, AND carnelian, go to the File menu and 
choose Additional Search>Intersect (AND) and then enter the 
new search term, carnelian, in the Material field. Run your 
search again.
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3. Finally, if you have your search results of necklaces containing 
gold and you want to omit all records of necklaces that also 
contain lapis lazuli, go to the File menu and choose Additional 
search>Subtract(NOT). Add lapis lazuli in the Material field and 
run your search.

18.4. Wildcards

EMu comes with a number of “wildcards” that allow you to expand or filter your search. Place 
the wildcard characters (also known as “operators”) before or after your search terms, or instead 
of your search terms, depending on the result you want.

Here are the most useful of these:

Wildcard Use in   Result

*  Any field  Finds all records containing data in this field.

!*  Any field  Finds records that do NOT contain data in this field.

!term  Any field  Filters out records containing term in field.

^term  Any field   Finds a term at the start of a field; e.g. ^Statue will find all records 
where "Statue" is the first word in the selected field.

term$   Any field  Finds terms at the end of a field; e.g. Statue$ will find all records 
where "Statue" is the last word in the selected field.

<, >, <=, >= Dates, Numbers Finds dates or numbers in range; e.g. <31/12/2008 will find 
records with dates before this, while >= 20 will find records with 
numbers greater or equal to 20. Note that this does not work with 
ID numbers, because the are stored in a text field.

In addition, you can use stemming to find records that contain variations of a search term, for 
example if you want to include the records where your search term, e.g. amulet, appears in plural 
(amulets) or has been misspelled (amulette), in your search as well. This is done by adding a ~ to 
the beginning of your search term; e.g. ~amulet.

Phonetic retrieval can be used to find records that contain terms that sound like the search term 
(if you are uncertain about the spelling of a word, for example), e.g. Ramesses vs. Ramses, 
Thutmosis vs. Thutmose. To do this, add an @ to the beginning of the search term; e.g. 
@Ramesses.
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18.5. Saving Searches as Dynamic Groups

You can save the parameters of a search as a “Dynamic Group.” This allows you to pull up 
updated results for your search, reflecting any changes made in the database since you last ran it. 
In the list of groups, a dynamic group is identified with a red question mark next to the group 
name.

An example of a dynamic group is a search set up to pull up all the objects from a particular site 
or time period. We could use this in the future, for example, for checking the number of objects 
in an inventoried gallery, to see whether or not it has changed.

18.5.1. Saving a Dynamic Group

Here are the steps to follow:

Step 1: Carry out a search.

For example, in the Catalogue module go to the Location tab and search for all the objects in one 
gallery.

Step 2: Save the search.

Select Tools->Group->Save Search Criteria from the 
Menu bar.

The Save Group box will appear.

Note that the Add button 
is disabled (grayed out) 
because search criteria 
cannot be added to an 
existing search.

Select the New button; the 
Group Properties box will 
display.

Give the new group a name (e.g. the Gallery 
name)

Go to the Security tab and give all other users permission to 
access the group

Select OK

The new Dynamic group 
displays in the Save Group 
box.

Select Close to exit the 
Save Group box.
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18.5.2. Retrieving a Dynamic Group 

Whenever you want to access your Dynamic group:

1. Make sure you are in Search or Display mode.

2. Select Tools->Group->Retrieve Group from the 
Menu bar. 

3. The Retrieve Group box will 
display. Select the name of 
the group and then click the 
Retrieve button.

In the example of a search for objects in a gallery, whenever you retrieve this group, new objects 
added to that location in the Catalogue module will now be listed, and objects moved out from 
that location will be removed.

Note: If you are in Display mode and have retrieved one or more objects (and thus have a found 
set), and then attempt to retrieve a dynamic group, the following message will appear: “Merge 
current matches with selected group?”

Select Yes to merge your found set with the records from the Dynamic group.

OR

Select No to replace your found set with the Dynamic group.
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19. Creating and Choosing List Views
The default view for the database modules is the List View. 

19.1. Viewing and Modifying List Views
To view a group of objects in a list: 

• Click on the List View icon in the Tool Bar or go to View->List in the Menu Bar. Your objects will be 
displayed in a list in your default list view or in the list view most recently used. 

To choose another list view:

• Go to View->List Settings->Choose list. A box will open that displays all the available list views. Select 
the one you want to use and click OK.

To change the settings for an already existing list (e.g. to 
add or remove fields),

• Select View->List Settings->Choose list and select the 
list view you want to modify. 

• Click on the Properties icon; the Field Properties box 
will open. 

• Add fields to your list view by selecting them in the 
Fields box and then clicking on the Add button. To 
remove fields, select them in the Columns box and 
click on the Remove button. 

• When you are satisfied with your list view, click OK. 

If you want to change the settings for the list currently in use:

• Select View->List settings->Change List Settings. 

If you want to change the size and order of the columns in your list view, 
hold the mouse down over a column header edge until double-arrows 
display. Drag the arrows to the left or right to increase or decrease the 
column width. To change the order, hold the mouse down over a column 
header and drag it to where you would like it to be placed. 

To save these settings, go to View->List Settings->Save Settings or 
right-click on a column and choose ->Save List Settings from the 
drop-down list.
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19.2. Creating List Views

If you wish to see a specific set of fields, you can create a 
new List View by following these steps: 

• Select View->List Settings->Choose list. 

• In the box, click on the New icon or on New button. The 
Fields box opens. 

• Start by giving your list view a name, e.g. Locations. 

• Continue by selecting the appropriate fields from your list 
from the Fields box and adding them to the Columns box. 
When you are satisfied with your list view, click OK. 

• Select your List View in the Fields box and click OK. 
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20. Creating, Modifying, and Retrieving Static Groups
If information about a group of objects is requested (for example, for an outside request, loan, or 
exhibition) or there is a need to generate a report about a specific group of objects that cannot 
easily be pulled up using a regular search, or which the registrars will want to access multiple 
times (for example, to carry out Group Checking) you can create a static group in the Catalogue 
module by following these steps. Object groups can also be created within the Loan and Event 
modules; these procedures are reviewed under Loans, Exhibitions, and Outside Requests.

NB: You must be careful if more than one person is working in a group at the same time, as only 
one person can work on one particular record at the same time.

20.1. The Groups Module
Although you will most often work with groups through another module (usually the Catalogue 
module), it is important to understand the Groups module.

This module is for the management of record groups. In this module you can create, modify and 
delete groups. Most importantly, it is through this module that the record level security 
permissions can be managed.

There are three important tabs in this module:

• Group Tab 

Name of the group (all groups are 
added to the lookup list here).

Type: Static; Terms=Dynamic 
Group (we do not use Query 
groups, which require more 
advanced training).

Module: in which module your 
group was created.

User ID: name of group creator; 
in database format (e.g. 
yelshazly).

User Name: name of group creator; in full format (e.g. Yasmin El Shazly). Note that this 
does not link to the Parties module.
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• Static Tab

After finding your group by name, the 
IRN numbers of the objects in your 
group will appear here. You can bring 
up the records in the group, in their 
original module, by clicking on the blue 
arrow, or add objects by using the green 
plus.

 
• Security Tab

Security Field: In this field you 
can choose the groups or specific 
users that can have permissions 
to modify this group.

Permissions Field: In this field 
you can choose what the groups 
or specific users chosen in the 
previous field can do to this 
group by ticking Edit, Delete or 
both.

20.2. Creating Static Groups (in 
the Catalogue Module)

Step 1: Open the Catalogue Module

Step 2: Search for objects

Search (see Searching the Database) for one or more 
objects (note that you can search for all the objects 
you want at the same time by putting the ID numbers 
in the ID number field, each in its own line, either 
with or without wildcards). From the results, select 
the objects you want: choose the first object by 
clicking the number in front of it. The object will be 
highlighted. To highlight more than one object, hold 
down shift as you click on multiple objects in a row, 
or Control to choose objects that are not next to one 
another.

Step 3: Create Group
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Go to Tools->Group->Current Record/Selected 
Records, choose New, and the Group Properties 
Window will open. Name the group according to 
the following protocol: 

EVENT#_DESCRIPTION (e.g. L.
2009.02_Horses_List)

CODE_DATE_DESCRIPTION (e.g. 
MOV_2009-05-14_Section-3-Sohag). 

Keep the name both accurate and 
short, and follow the relevant 
protocols for the type of list. 

Step 4: Allow access to other users 

Go to the Security Tab in the Group Properties window and change the security settings by 
choosing the groups of Users that can see this group.

Step 5: Go to Groups Module to Modify Permissions

It is important that all authorized users (RCMDD and ARCE staff) have permission to modify and 
delete most of the groups in the database. These permissions cannot be set automatically, so you 
must go to the Groups module to set them by hand. Only the group owner (creator) can set these 
permissions, so make sure always to do this right after creating a group. To do this:

• Open the Groups Module.

• Search for your group in the Name Field lookup list.

Note: You can also search for your group by choosing your name 
from the User Id Field lookup list; you will find a list of the groups 
you own.
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• When you have your group open, go to the 
Security Tab.

• Choose the user groups or individual users you 
want to be able to modify your group in the 
Security Field. We will always choose “registrars,” 
and “admin user” groups.

• Choose the permissions that the groups or specific 
users chosen in the previous field can do to this 
group by ticking both Edit and Delete.

20.3. Modifying Static Groups

Step 1a: Add Objects

Now you have created a group to which you can 
add more objects whenever you need. To do this, run 
search and select an object or objects. Then go to 
Tools->Group->Current Record/Selected Records. 
Choose the group you want to add records to from 
the list. Click the Add 
button, and your object 
or objects will be added 
to the group. If not all of 
your objects are already 
in the database, you will 
need to create records.

Step 1b: Discard Objects

1. If you need to discard an object from your group, 
open the group. Choose the object you need to 
discard and go to File->Discard->Current Record/
Selected Records. BE CAREFUL TO CHOOSE 
DISCARD AND NOT DELETE, OR YOU WILL 
DELETE THE RECORD INSTEAD! 

2. Go to Tools->Group->All Records in Result. 
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3. Choose your group again and click Replace.

Note that if you miss the last two points, you will 
only discard the record(s) from the group temporarily 
-- if you now close the group and open it again the 
discarded object(s) will still be there. 

20.4. Retrieving Static Groups

To work with the group after it has been created, you 
simply need to pull it up. To do this, open the 
catalogue module, and go to Tools->Group-
>Retrieve Group.

You will then see a list of 
available groups. Choose the 
group from the list and click 
Retrieve.

20.5. Deleting Static Groups

Go to Tools->Group->Retrieve Group->Choose your 
group.

Delete the group by clicking on the delete button in 
the upper left corner, and confirming.
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21. Sorting Groups of Records
KE EMu has the ability to sort records using any field in the database, regardless of what is visible 
on the screen. This allows the user to organize records in a variety of ways.  It is possible, for 
example, to sort the records in any layout according to those records’ ID numbers, Permanent 
Locations, Dates, Dimensions, etc.  You can also sort by more than one parameter at the same 
time, and chose the order of priority of search terms.

You can sort either by using predefined Sorts, or set up your own manual Sort. In both cases, you 
will begin by retrieving a group of records.

21.1. Pre-defined Sorts
EMu comes with three pre-defined sorts; of these, only Sort by Summary Data (the information 
that appears at the top of the record in Detail View: One ID number - Title - Category - Period - 
Dynasty) are really useful to us. The team has set up a number of additional pre-defined sorts in 
the Catalogue, Multimedia, Location, Event, and Loan Modules.

21.1.1. Project Pre-defined Sorts

• Catalogue Module:

By ID Number (JE, then CG, then TR, then SR) [NB: EMu cannot sort ID numbers with 
alphas on the end that are not marked off with “punctuation” of some sort (parentheses, 
points, dashes). Going forward, all alpha divisions taken from the register books, as well 
as alphas attached to Carter numbers, will be separated from the preceding digits with 
dashes. EMu will do a global cleanup of these at some point (hopefully Summer 2010), 
but for now, correct them by hand as you come across them, or your list will not sort 
properly. 

By SR Number

By Date (all levels)

By Provenance (all levels)

By Permanent Location (all levels)

By Current Location (all levels)

4. Multimedia Module

By Filename

By Date

By Photographer

• Event Module:

By Event Number

By Event Type-Title-Commencement Date

By Event Type-Number-Commencement Date

By Record Status
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• Location Module:

By Location (all levels)

• Loan Module

By Loan Number and Date

21.1.2. Running a Pre-defined Sort

Step 1: Open Module

Open the module that contains the records you want to sort.

Step 2: Retrieve group of records

Gather the records that you wish to sort, either by retrieving a dynamic or static group, or by 
doing a new search.

Select how you wish to view your group:

LIST VIEW (probably the easiest way)

DETAILS VIEW

CONTACT SHEET

Step 3: Choose Sort

• Go to Menu Bar-
>Tools->Sort Results, 
or click on the Sort 
Icon in the Tool Bar. 
This will bring up the 
Sort Options Menu.

• Choose the Sort you 
wish to run by 
highlighting it in the 
window.

Step 4: Run Sort

Click the OK button.

You will be given the option of getting a summary of your sort terms. In most cases you can just 
click No, and then your group of objects will be successfully sorted. If you press yes, then you 
receive a summary report about the objects in your group, which is a list of how many times each 
term appeared. This can be printed if required.

21.2. Creating Sorts

Step 1: Retrieve group of records

Open the module in which you will sort records, and gather the records that you wish to sort, 
either by retrieving a dynamic or static group, or by doing a new search.

Select how you wish to view your group:
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LIST VIEW (probably the easiest way)

DETAILS VIEW

CONTACT SHEET

Step 2: Set up Sort

• Go to Menu Bar->Tools->Sort Results, 
or click on the Sort Icon in the Tool 
Bar. This will bring up the Sort Options 
Menu.

• From the Sort dialogue, press the New 
button. A screen will appear called 
Sort Properties.

• Name your sort. Make the name as 
specific as possible, so other users will know how it is set 
up. (Example: By ID Numbers (JE, CG, TR, SR, Other))

• Select the first field you wish to sort with (Example: 
Choose EgJENumber from the field list).

• Click on the Add button. Your sort field will move to the 
window below.

• Choose whether you want A to Z or Z to A (A to Z also 
equals first to last) with the AZ toggle icon.

• Add other terms (Example: Add EgCGNumber ). You can 
sort by as few or as many terms as you like. The more 
specific you are, the more useful the sorts will be.

• Re-order the sort, if you wish, by highlighting the term you 
want to move, and then pressing the up and down arrows.

Step 4: Share the Sort

Go to the Security tab in the Sort Properties box to share the sort with one or all of your 
colleagues. Select the people or groups to whom you want the sort to be available, and click 
Add.

Step 5: Save and Run

• Press OK to save the Sort. 

• EMu will take you back to the list of available Sorts; your new Sort will now be included.

• Choose the Sort and click OK.

21.3. Editing and Deleting Sorts
Finally, if you wish at any point to edit your SORT terms  you can open the sort options, highlight 
the sort name in the menu field and select one of the buttons above.
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This is another way of 
making a new sort.

This deletes a sort you have 
previously saved.

This allows you to edit/
change the sort terms in 
an existing sort.

This allows search and sort: If you choose one sort and click this button (your sort 
will now be bold), every time you open a group it will automatically sort the group 
with this sort. If you don't want this to happen anymore you just click this again 
(“toggle” it on and off).

These change the views.

21.4. Sorting by Hand
Sometimes when you are trying to sort a group of objects by ID number, they do not sort 
properly. For example, in the current release of the database, ID numbers that have a letter 
attached directly to the number (e.g. JE 2345a, CG 2465b) will end up in the wrong place. (Note 
that this is a temporary problem that will be fixed during the summer of 2010.) After sorting the 
records using the predefined sort option for sorting ID numbers in the database, you will have to 
sort these objects by hand.

• Sort your group using the predefined sort option (e.g. ID Sort). 

• Go to list view and simply drag and drop the objects that are in the wrong place to their 
correct places by highlighting the record you want to move and dragging the record to the 
correct place in the list. In the example here, the object in place 6 has been moved to place 
5.
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22. The Ditto Function
The ditto function is a very useful tool 
for creating multiple records that 
contain similar information rapidly. It 
is most useful in the following 
modules, for the following purposes:

• Object Module: creating records 
for a group of similar objects, such 
as a group of rings or vessels from 
the same excavation.

• Location Module: making records 
for a group of similar locations, 
such as vitrine locations (see 
Locations).

• Movement Records: making 
records for a group of objects that 
moved at the same time, with the same committee (see Current Locations and Movement).

22.1. Ditto All Fields

Use this if you want all the fields in 
your original record to be copied into 
your source record. You will want to 
use this if you are creating new records 
in which only one or two fields will be 
different. This will be useful, for 
example, when you are creating 
multiple object records where only the 
ID numbers and perhaps Titles will be 
different.

• Open the record you want to use as 
your source record.
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• Copy the information into the Ditto 
“clipboard”: Edit->Ditto->Use 
Current Record for Ditto (or Ctrl
+F9).

• Create a new record: File->New 
Record OR Click on the Page Icon 
on the upper left.

• Go to Edit->Ditto->All Fields (or 
Shift+F9). This will fill in all the 
fields with the information that was 
in the record that you chose to 
duplicate.

• Change any relevant information. 
Make sure to check that your 
system is set so that the default for Object Rating is blank, otherwise the database may fill in 
something else.

• Save the record.

22.2. Partial Ditto
Use this if you want only the fields on 
a certain tab, e.g. the Locations tab in 
the Catalogue, or specific fields from 
one or more tabs, to be copied into a 
new record. This can be useful, for 
example, if you want to create 
movement records for a group of 
objects without changing any other 
information. The process is similar to 
the Full ditto, but instead of pasting in 
the information from all the fields into 
the new record you choose only the 
tab you want to ditto. 

1. Open the record you want to use as 
your source record.

• Copy the information into the Ditto “clipboard”: Edit->Ditto->Use Current Record for Ditto.

• Create a new record: File->New Record OR Click on the Page Icon on the upper left.

• Go to the tab in the new record to which you want to add the information and select Edit-
>Ditto->Current Tab (or Shift+Ctrl+F9). This will fill in only the fields of the tab that you have 
selected with the information that was in the record you chose to duplicate.

• OR select Edit->Ditto->Current Field if you want to ditto just one field at the time, or some 
but not all fields on different tabs.
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• Save the record. 

22.3. The Ditto Box

Every time you choose a record for 
Ditto, the information is temporarily 
saved in the Ditto box and is displayed 
in a list of the most recent Dittos. You 
can also select your record here to use 
as the template for a new Ditto if it is 
one that you have used before. To do 
this 

1. Go to Edit->Ditto->Select Ditto 
record. 

2. Click on the record you want to use 
and select OK. 

3. Follow the steps for Ditto above. 

22.4. Update on Save

If you select Update on Save, the 
current ditto record will continuously 
change to be the most recently saved 
record; i.e. you create a new record 
and Ditto, select Edit->Ditto->Update 
on Save and save the record. Your 
newly saved record will now be the 
Ditto record.
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23. Finding ID Numbers
There will be a number of instances when you will need to do some research and creative 
thinking in order to find the correct ID number for an object. For example, you may be given an 
incomplete (without number-type code or section) or incorrect ID number by a section head or 
curator, or by an outside requester; or a register book may have an incorrect cross-reference. You 
may also find incorrect numbers written on objects themselves, or in association with objects. In 
these cases, you will need to find the correct ID numbers. It is also part of your job, when you are 
in the Full Cross-check phase of completing object records, to find all possible official ID 
numbers associated with an object. The following guidelines will suggest strategies you can use 
to correct wrong numbers and find additional numbers.

For EMC objects, there are various ways in which you can find the ID Numbers attached to an 
object. You will usually be provided with one number (although you may not always be told what 
kind of number this is).

Objects for which you have an accurate SR number are the easiest to deal with, as the other ID 
Numbers should be cross-referenced in the special registers (although be aware that there can 
also be errors here). If you have only a JE, CG, and/or TR, you will need to find the other ID 
numbers for the object.

23.1. SR Facsimiles

If you have an SR number, start with the SR facsimile, which will give you cross-references to 
other ID numbers. (Note that if you have an SR number without its section code, you will have to 
search all the sections, unless it is obvious to which section the object belongs.) Unless the SR 
book contains an error, this is usually the best way to start. If the SR book does contain an error, 
you will have to do additional research to find the correct number or numbers.

23.2. The Search Database

If you have another type of number (JE, CG, or TR), you will usually want to start your research by 
using the old Search database: everyone should have a copy of this on their computer. Although 
this has many errors in it, it is still a valuable tool. Open this, and do a search by JE, CG, or TR. To 
do this:

Double-click on the mortarboard icon. 

From the Menu bar, choose ->Search.

Type the relevant number, without a code, in 
the relevant Registration No. box. For TR 
numbers, use slashes rather than periods (e.g. 
1/3/15/24).

Click Start Search.

In the list that will hopefully appear, double-
click on the correct entry to see the complete 
record, where you will be able to see other ID 
Numbers recorded in this database. Note 
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again that there are many errors here, so DO NOT assume the information is correct. Also, 
Search only finds exact matches. If you want to find JE 12345-a, you have to type in 
12345a. Wildcards do not work. In addition, the way the numbers are written can be quite 
random: for example, JE 12345-a might also be written 12345 a (with a space) or 12345a, 
which you can only find by typing exactly. 
However, Search will give you a place to 
start. 

You can also use the Search database to search by 
location, as you would in an SR book: enter the floor 
and gallery number (in Floor and then Room, Floor 
and then Corridore (for corridor galleries), or Floor 
and then Stair), or just try the gallery number in 
either Room, corridore, or stair. Since this only works 
to the gallery level, you can narrow down the search 
by adding a category or some other delimiter; 
however these are entered rather randomly in the 
Search database, so they may not be useful. Sometimes you will get lucky, especially in galleries 
without too many objects. Note that the Basement 
Books and Garden Book are not in Search.

23.3. Multimedia Module

If Search doesn't give an SR #, you can try searching by ID number in the Description field in 
EMu’s Multimedia module, as the basement books and Garden Book have been linked and the 
numbers listed here. 

23.4. Other Strategies
• Once you have found possible ID numbers, check in the relevant registers for the other 

numbers given.

• Do a number check of the object itself. If you are lucky, there will be an SR number 
associated with it, another register number, or perhaps a Guide number. You can search in the 
database for the Guide number (search in the Physical Notes field or on the Bibliography tab), 
or look in the actual Guides (Maspero 1902 or 1915).

• If you know where the object is, look on the Special Register pages that have entries for that 
location and see if you can find it that way. (Remember that the SR books were originally set 
up by location; although many locations have changed, you may still be able to use the SRs to 
find the object.)

• If you have a CG # for an object, but have failed to find an SR #, it may also be useful to get 
the location for the object in the CG Location Book; this will at least give you a place to start 
looking for an SR #.
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• Ask the section head or a section curator for assistance in finding the SR number.

• Keep in mind as well that the RCMDD database itself has some sort of entry for most objects, 
so try searching for the object there by material, category, date, or whatever other information 
you have. You may find a group of possible records against which you can crosscheck the 
actual object.

REMEMBER: When you find an incorrect number anywhere in the system, the number in the 
original book where the number is registered should be considered correct (e.g., if a JE number 
cross-referenced in a CG book does not match the JE number in the JE ledger, the correct JE 
number is the one in the JE ledger, NOT the one in the CG). For Tutankhamun objects, the 
number on Carter’s original excavation notes (facsimiles of which are on the Griffith website) 
should be considered correct (keep in mind that if the JE or TR gives the wrong Carter number, 
the cross-reference on the website is usually incorrect as well, so trust only the Carter number 
itself).

If you discover a numbering error, make sure the incorrect ID number is included in the ID field, 
followed by -xxx (e.g. JE 1234-xxx. This will allow future researchers who might be searching 
under the wrong number to find the object. Make sure to note the numbering error and how you 
have corrected it in the Notes field. This will allow people in the future to find the object under 
the incorrect number, but see immediately that the number is incorrect. If an incorrect number 
has been given to you by a scholar or a member of the museum staff, but the number is not 
incorrect in the museum’s official records, you do not need to include the incorrect ID number in 
the record. The only exception to this is with the Tutankhamun objects. When the Griffith Institute 
or the Beinlich-Saleh list has an incorrect cross-reference, this should be noted in the Notes field, 
and the incorrect ID included in the ID number field followed by xxx.
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24. Shortcuts
The Shortcuts tool is very helpful for doing cross-checks on the object records. By using this tool, 
you can easily be sure that you will check all the necessary fields without missing any. This tool is 
most useful in the Catalogue module, although it could be used in other modules as well.

You can use a shortcut that has already been set up, create your own shortcut, or modify a pre-
existing shortcut.

24.1. Using Shortcuts

To use a pre-existing shortcut:

• Go to View->Shortcut Settings->Show Shortcuts 
and the last shortcut you used will open on the 
left side of your database window.

• To select a different shortcut, go instead to View-
>Shortcut Settings->Choose Shortcuts and the 
Shortcuts... window (the list of available 
shortcuts) will open.

• Highlight the shortcut list you want and click OK. 
The selected shortcut list will appear on the left 
side of your database window.

• In the shortcut list, the left column shows the 
field, and the right column displays the value that 
has been entered into this field in the database, 
in the record you are currently browsing.
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• To use the shortcut, move systematically from top to bottom in the 
shortcut: double-click the Field name in the list and it will automatically 
move you to that field in the database. You do not even need to know in 
which tab this is in the database. Fill out or check the information in the 
field, then move to the next field.

• When you have finished checking one record, move to the next.

24.2. Creating Shortcuts

To create a shortcut:

• Go to View->Shortcut Settings->Choose Shortcuts and the Shortcuts... 
window (the list of available shortcuts) will open.

• Click the New button and the Shortcut Properties 
window will open.

• Enter the name you want for your new Shortcut in the 
field on top.

• Select all the fields you want to show up in your 
Shortcut from the Fields box by highlighting them and 
adding them to the Order box by clicking the Add 
button.

• You can change the order of your selections in the Order 
box by highlighting the one you want to move and 
clicking the blue up and down arrows on the right side 
of the box. You can also remove wrong selections by 
highlighting the one you want to remove and clicking 
the Remove button.

• After you have all the fields in correct order in the Order box, click OK and your shortcut list 
will show up in the Shortcuts window. You can choose it from there. 

• Important Note: If you want other groups or individual users to see and use your shortcuts, 
you need to go to the Shortcut Properties security tab and choose the groups or users you 
want to be able to see and use your shortcuts.

24.3. Modifying Shortcuts
If you want to modify a pre-existing shortcut: 

• Go to View->Shortcut Settings->Change Shortcut Setting.

• The Shortcut Properties window will open. You can edit your shortcut field selection and 
order here.

RCMDD Protocols 12-2010  199



25. The Import Tool
There are some situations in which, rather than entering data by hand into individual records in 
the database, you will want to use the import tool. This tool uses an outside program, such as 
Excel or Numbers, to collect data that can then be converted to a .csv (comma-separated values) 
file and imported directly into the database. Currently, this is used primarily for importing groups 
of images into the Multimedia Module, but can also be used for other purposes as well, such as 
entering a group of bibliographic references into the Bibliography module, or entering a group of 
contacts into the Parties module.

25.1. Basic Imports
The following protocol outlines the basic steps for using the Import Tool.

You will begin by creating an Excel or Numbers file in which to enter the data. The Excel file will 
collect the data in table form, with the headings corresponding to the appropriate field names in 
the database

Step 1: Create File and set up column headings

Create a new file in Excel or Numbers, and name it sensibly. This will be a work file, and after it 
has been used it will be deleted (although you may want to save a blank copy as a template if 
you will be doing similar imports in the future).

Decide into which fields you will be importing data, and find the corresponding field names by 
clicking on the arrow/question mark button located on the top right-hand corner of the relevant 
module. Your cursor will become the arrow/question mark; now click in the field you would like 
to get more information about. A column opens with a brief description of the field. Click on 
“more” located on the bottom of the column. More information will appear about the field. 
Under “Field Information,” look at Column: -- what is written across from it is the name of the 
field that will need to go in the Excel 
sheet that you will be importing.

Step 2: Fill in data

Add whatever data you need to the 
file. For example, if you are doing a 
bibliography, add the entries (Author, 
Title, etc.) to the Excel or Numbers file.

Step 3: Create csv File
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1. From Excel, go to Save As and choose Windows 
Comma Separated OR

2. From Numbers, go to 
Export and choose csv.

3. Save the file as a csv.

Step 4: Import CSV File Into EMu

1. Open the relevant module (in this example, the 
Bibliography module). 

2. Go to Tools, and choose Import.

3. You will be asked to  select a file to import. Choose your csv file. For Import Type, choose 
Typical, then click Next. 

4. A window called “Import Identifier” will come up next; without modifying it, click Next.

5. Finally confirm the Import Settings by clicking Next again.

6. A window will appear showing the progress of the import. 

7. When the import process is complete, click on the Finished button. 

8. A window telling you the import process is complete will appear.

25.2. Image Imports

One of the most important uses of the Import Tool is for bringing large groups of images, one or 
more folders at a time, into the Multimedia module. You will do this for both Object and Event 
images, with slight differences between the two processes that will be detailed below.

NOTE: So far, the office has not found a way to make this process work well on Parallels because 
of the file path, although there may be a way to work around this. For now, it is better to use a PC 
for this process; the following steps should be carried out on a PC that has the Filemaker EMu 
Import Tool and KE EMu installed on it.

Step 1: Find images to import

It is important that the images you want to import are in a properly-named folder, either on the 
PC you are using or properly stored in the backup drive.

Step 2: Import images into the Filemaker EMu Import Tool

 The EMu Import Tool is an almost blank Filemaker file, a copy of which is kept in the backup 
system (Akhenaten->Ruby->RCMDD-CM->IT_and_Database_Admin->Import Tool-
>EMu_Import_Tool). You will mainly be working from the copy on the dedicated imaging PC 
(Tart). It consists of four text fields whose titles match the relevant field names in EMu 
(MulCreator_tab, DetDate0, MulTitle, and Multimedia), a container field for the image, and a 
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script button “Delete file://. When you 
begin, it should contain only one 
record, which will serve to fill in the 
column headings when you make 
the .csv file. This record should have 
each field filled in with its field name, as 
shown in the screen shot.

The following table defines the fields 
included in this file.

CATEGORY/TITLE DEFINITION

MulTitle For object photos, this will be the filename of 
the image. For event photos, this will be the 
Event number. Example: EV.2009.13.

MulCreator_tab Name of the person who took the photo
Multimedia Path of the image (where it is stored when you 

do the import)
DetDate0 Date the image was taken in DD/MM/YYYY 

format
Image A container file for the image

To import the images:

• Go to File, Import Records, then choose Folder. A 
window will pop up: make sure the File Type is 
Picture and movie files, and “Import only a 
reference” is checked. In most cases, you should 
make sure “Include all enclosed folders” is 
unchecked -- it is safest and best to do this one 
folder at a time.
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• Click on Specify, and 

browse to the folder that 
you want to import. 
Click Choose, then 
Continue. This will take 
you to the Import Field 
Mapping dialogue box. 
It should default to the 
correct Source and 
Target field matches, but 
make sure -- the 
dialogue should look 
just as is shown in the 
screen shot here: 

•  Make sure “Add new 
records” is chosen, and 
click on Import. 

• An ‘Import Records Summary’ will 

appear that will tell you how many 
images have been imported and 
records created (this should equal 
the number of images in the folder 
you are importing). Press OK. Now 
you should have a record for each 
image that includes the filenames 
and filepaths in the correct fields. 
An example of what 1 record 
should look like:

• For all images: Now do global 
replaces to fill all of the 
MulCreator_tab and the DetDate0 
fields (Note that your found set will 
be the images you have just 
imported, so it will not include the column heading record. Therefore, the global replaces will 
not affect this):

 Click in the MulCreator_tab field and enter the photographer name (FirstName LastName, 
e.g. Kenneth Garrett). Make sure to use the correct spelling so that this field links correctly 
to the Parties module when you import to EMu. While still in this field, go to Records-
>Replace Field Contents->Replace, or press Command =, and then choose Replace. Now 
all the MulCreator_tab fields in all of the open image records should have the same name. 

Enter the photo date (from the folder name) in DetDat0 and do another global replace. 
Make sure to use the format DD/MM/YYYY so that this is correct for EMu. 
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This is all you need to do for object images.

• For event images: Now do a global replace of the MulTitle field with the event number to 
which the images relate. This will help you link the photographs properly to the Event module 
of the database.

• For gallery images: Now do a global replace of the MulTitle field with the gallery name, in 
proper format. If you have vitrine maps as well, you will probably need to do this by hand -- 
do this in Filemaker before you import.

• All your image 

records should 
now have the 
correct data in all 
the fields.

• Now correct the 
filepath, which 
contains an extra 
“file://” by 
clicking on the button located on the right-hand side labeled “Delete file://’ (see fig. above), 
and pressing OK. Let the script run.

• Go to Records, and choose Show all Records, or hit Control-J, to retrieve the column heading 
record.

Step 3: Export Records to csv file.

• Go to File and choose Export 

Records. A window will 
appear asking for the file 
name, location and 
extension. 

• Use the folder name as the 
title of the file, and save it to 
the PC desktop. Make sure to 
choose the extension csv 
(comma separated value). This is the extension the database will recognize. 

• Click Export. You now have a csv file ready to import into EMu. If you were to open the file (in 
Excel or Numbers), it would look something like this:

MulTitle MulCreator_tab Multimedia DetDate0
JE_1234 Mohamed Osman C:/Images/JE_1234.jpg 15/09/2009
JE_5678 Mohamed Osman C:/Images/JE_5678.jpg 15/09/2009
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• Delete the images from Import Tool, so that it can be used 
again for the next folder. To delete the images without deleting 
the Column Heading record, do a find for the photographer 
name (click in the MulCreator_tab field, hit Apple/Command/
Cntrl-C to copy, then go to Find mode by hitting Apple/
Command/Cntrl-F, paste in the photographer name with Apple/
Command/Cntrl-V, and hit find). Go to Record->Delete Found 
Records.

Step 4: Import cvs File to EMu

Now that the csv file has been created, you can import your batch of images into the database. To 
do this:

• Open the Multimedia Module in EMu. Go to Tools, and choose Import. It will ask you to 
select a file to import – choose your csv file. For the Import Type, choose Typical, then click 
Next. 

• A window called ‘Import Identifier’ will come up 

next. Without modifying it, click Next. 

• Finally, confirm the Import Settings by clicking 
Next. A window will appear showing the import 
process taking place. It should take about 30 
seconds per image -- you do not need to stay with 
the computer while the import is processing, as 
long as the computer is set so that it will not go to 
sleep.

• When the import process is complete, a Finished 
button will appear at the end which you click. This 
will be followed by a window telling you the 
import process is complete.

• You may delete your csv file. It is a working file 
and does not need to be saved into the system.

• If an error occurs, you will get an error message and a report. This means that there is 
something incorrect in the csv file.

Step 5: Attach Images to Catalogue, Event, or Location module

• After the import process is complete, the images imported will appear as a list. They will have 
all the necessary information so there is no need to add anything extra to the image record in 
the multimedia module. (NOTE that we are not adding the object numbers to the Description 
field; this is time consuming and unnecessary.) You will want to identify the people in the 
event images at some point.

• For object images, the easiest way to attach the images to the appropriate catalogue records is 
to sort the image list by ID number, and then to open the relevant catalogue records (if they 
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are in a group) and sort them also by ID number. You will thus have the Multimedia module 
open next to the Catalogue module.

• NOTE: in many cases, you will be doing this part of the procedure on your own computer. In 
this case, create a group of the images you have just imported so you can find them easily on 
your own computer.

• In the Catalogue module, go to Detail view, and go to the Multimedia tab for the first record. 
Drag the image record into the Multimedia window. Repeat for each image.

• If the object records are not in a group in the catalogue module, you will have to search for 
each catalogue record individually, and attach them one by one from the image list.

• If the images are associated with an event, simply find the event record in the Event module 
(search in the Event number field for the Title name), go to the Multimedia tab, select all the 
images, and drag them into the record.

• For gallery images, find the locations that correspond to the images, go to the Multimedia tab, 
and drag the images into the relevant records.
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26. Checking Object Groups
The office frequently makes lists of objects for a variety of purposes (e.g. loans, exhibitions, and 
outside requests). This protocol should be followed whenever there is a list (group) of objects that 
needs to be checked. The RCMDD heads will assign one person principal responsibility for the 
group, according to who has lead on the project with which it is associated, and at their 
discretion. The group owner and senior checkers must inform the heads as each step here is 
completed, so that the heads can track the process on the Group-checking Checklist.

Step 1: Enter Group on Group-checking Checklist and Assign Group Owner (Heads)

The groups to be checked are tracked on the Group-checking Checklist, which is kept on the 
RCMDD Head clipboard. The heads are responsible for keeping this list updated, and creating 
new Group-checking Checklists whenever necessary.

The following columns should be filled out on the Group-Checking Checklist:

• Priority: Assigned by the department 
heads if necessary with number 
from 1 to 3, with 1 meaning urgent.

• Group Name/ID in EMu: This should 
be the event number associated with 
the group, plus a descriptive title 
(e.g. L.2009.09_Shanghai_Loan; OR.2009.29_Lilyquist_Christine_2) or, if the group is not 
associated with an event, a code plus a sensible title (e.g. MOV__Sec-3-to-Sohag). The point 
of the Group Name is to make it easy for the checkers to retrieve the group in the database.

• Group Owner: Person taking lead on the group (assigned by department heads).

• Senior Checkers: Two of the authorized senior checkers, as posted in the office. As of March 
2011, the senior checkers are Elina and Sari. These may be assigned later in the process as 
well, as it is not always possible to know who will be available.

Step 2: Create Group (Group Owner)

The person responsible for the group should make a group of objects by adding them to the 
objects tab in the Events module. Make sure the relevant Event number is included in the name 
on the Group-checking Checklist.

Step 3: Check ID Numbers and Images/Facsimiles and Inventory/Number Check Objects (Group 
Owner)

The group owner should follow the Group Owner Shortcuts for each object in the group: They 
should make sure that all relevant ID numbers, at least one image (if possible), a number check (if 
possible), and a Permanent Location (see Locations) has been attached to the object record. They 
should also make sure the images and facsimiles (including any relevant pages from the 
published PM) are linked from the Multimedia Module and are in the correct order.

Inform the department heads that this process is completed; the heads will check off this part of 
the process on the Group-Checking Checklist.

Step 4: Full Cross-checks (Senior Checkers)
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The department heads will now pass the group to the first senior checker assigned to the group.

The senior checker will do full cross-checks of all unapproved objects on the list (see Full Cross-
checks). When this is completed, the heads should be informed, and they will check off this part 
of the process. The first senior checker will then run a pdf of the group as an Outside Request 
Information report and pass it to the second senior checker, as assigned by the heads. The second 
senior checker will check the information in this format, and work with the first senior checker to 
make any necessary corrections or additions. When this is completed, the heads should be 
informed, and they will check off this part of the process.

As many records as possible should also be taken to the Approval stage.

Step 5: Generate Report and and Check Information (Group Owner)

The heads will then pass the group back to the Group Owner, who will generate the appropriate 
type of report (see Generating Reports) and do a careful check of the information and images in 
this format. The final box on the Group-checking Checklist will then be checked off by the 
department head.

Step 6: Final Check and Report Given Out (Heads)

The group owner should inform the heads that the report is ready. One of the heads (if one of the 
heads is the group owner, the other should do the final review) should do a final review of the 
report,3 store the pdf in the proper place in the computer system (see Computer Filing System) 
and, in some cases, attach it to the database. The heads will cross the group off on the list, and 
give the report to the appropriate person. Note that only the heads should give out the report, 
unless they specifically delegate someone else to do it.

RCMDD Protocols 12-2010  208

3 At present, all lists must be passed by a second Senior Checker; by the end of the project, the heads themselves will take on this role.



27. Generating Reports
One major way in which the RCMDD shares information (loan and exhibition organizers, 
museum staff, SCA staff, scholars, and students) is through reports. These are generated directly 
from the database as pdfs, and can be either emailed, given out digitally, or printed (if they are 
not too long or use too many resources inappropriately, see Printing Guidelines below).

Reports currently can be generated from the Catalogue, Event, and Loan Module. Additional 
reports can be designed for any module, using Crystal Reports. Certain reports can also be 
generated using Microsoft Office or iWorks, using a mail merge. For now, this protocol only 
covers reports using Crystal Reports.

To generate a report:

• Go to the Module in which the report is saved (usually the Catalogue module).

• Retrieve the group of records you wish to include in the report (see Retrieving Groups).

• Sort the records however you want them to appear in the report (note, some reports have sorts 
built into them, but most do not). (See Sorting Records)

• Go to Tools-> Reports. Choose your report from the list.

• Click on report to generate a report for only the current record; click on report all to generate 
a report for all the records in the group you have retrieved.

•  The generated report will appear in Report Viewer.

• Print the report to a pdf. Check that all the objects are on the report, that they contain all the 
necessary information, and that all the pictures are visible. Save it with the appropriate name, 
in the correct location within the RCMDD system (detailed in the individual collections 
management protocols in Part V). 

• If appropriate, print a hard copy of the report. 
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28. Tasks and Alarms

The EMu database includes a feature 
called “database alarm.” These alarms 
can be set to send an email on a certain 
date to any chosen email address. This 
is very useful especially for Outside 
Requests, and for Loans and Exhibitions 
as well. Alarms can be set in any 
module that has a Tasks tab. Instructions 
here can be used in any module even 
though Events is being used as the 
example.

Step 1: Open the Events module, and 
find the Event for which you want to 
create the alarm. 

Step 2: Go to the Tasks tab and create 
a new Task:

• Open the Tasks tab in the relevant 
event record.

• Fill in the Description. This text will 
be in the email that will be sent, so 
it should be informative, like 
“Check if Section 3 objects have 
been moved to the Conservation 
Lab. OR.2009.72.” Make sure to 
include an event number, if there is 
one, to make the event to which it 
is attached easy to find. The alarm 
you get won't tell you which module and record it was sent from.

• Fill in Assigned to - this is the person who will complete that specific task.

• Fill in Assigned by - this is the head responsible for the request.

• Fill in Commencement date - the date this task was given out.

• You can have the alarm sent either from Commencement or Completion; this does not really 
matter, except that you may want to use Commencement for something you need to start, and 
Completion for something you need to finish. 

• For Date you can choose the date on which you set the alarm.

• For Notify On choose the date on which you wish to receive the Notification. With Outside 
Requests this could be, for example, a year after the request has been completed, if we wish 
to receive a publication from a scholar. 
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• For Notify choose the person who needs to be notified; often this will be the RCMDD. This 
field draws from the Parties module; it is important to check that there is a correct email 
address in the record there, as otherwise the alarm will be lost. 

• Choose No in Completion.

• Save the record.

• Once the task has been completed, change No to Yes and add Completion Date.
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Part V:

Collections 
Management
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29. Accessioning 
This protocol covers the procedures for registering a new object in the official system of the 
Egyptian Museum, i.e., in the Journal d’entrée. As of the writing of this protocol, most objects that 
are being accessioned fall into one of the following categories: 

• Gold or other precious objects from recent excavations or magazines;

• Objects from SCA storage magazines that have come to the Egyptian Museum for an 
exhibition, and the director wishes to keep here;

• Objects that have been in the museum’s basement for an extended period of time and are 
now being registered for the first time; and

• Recently repatriated objects. 

The Associate Registrar for the Permanent Collections takes lead on all accessioning activities, 
working under the supervision of the Head of Documentation.

29.1. General Notes: 
• Section Heads will be responsible for keeping their section records, according to their own 

systems. 

• The RCMDD will be responsible for keeping the centralized records up to date, including the 
Journal d’entrée and the database. 

• The registrars will also be responsible in future for giving out Catalogue general (CG) numbers 
to authors.

• No new Temporary Register (TR) numbers will be assigned; this series of books is now 
officially closed (as of September 2007).

29.2. Accessioning Procedures

These steps are followed when the director or section head decides to accession a new object:

Step 1: Identify Object

Usually, the Associate Registrar for the Permanent Collections or a department head is consulted 
by curatorial staff member(s) (usually the section head) who will be responsible for the object of 
the upcoming accession.

The object can be in the museum already (in the basement or elsewhere).

The object can be brought in from a recent excavation, a magazine, repatriated, or brought into 
the museum for any other reason. 

Step 2: Begin Accessioning Checklist

In order to track the accessioning process, which can take several weeks or more, it is important 
to create an Accessioning Checklist as soon as you know about an object or objects to be 
accessioned. This will allow you to monitor the accessioning process.

Accessioning Checklists are kept in the Blank Forms folder in the Miscellaneous drawer of the 
filing cabinet and in Akhenaten -> Ruby -> RCMDD-ADMIN -> Forms -> RCMDD Forms.
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Immediately fill out a brief descriptive 
title for the object, along with any 
relevant notes (for example, the source 
of the object, uncertainty over whether 
the object or objects will actually be 
accessioned, or the fact that the new 
object joins to something already in 
the collection).

As the accessioning process continues, 
check off each step listed on this form 
as it is completed.

All active Accessioning Checklists 
should be stored in the Accessioning 
Notebook in a plastic sleeve, along 
with other materials as they become 
available. When the accessioning 
process is complete, you will file 
everything in the manual object file 
(see STEP 10).

The remainder of the steps will not 
always be carried out in the same 
order, but all steps need to be 
completed.

Step 3: Obtain Decree (If Applicable)

In some cases, a decree must be obtained from the Office of the Secretary General confirming 
the accession of the artifact, and assigning it to a particular section. The Associate Registrar for 
the Permanent Collections should liaise with the Office of the Secretary General to obtain said 
decree. The following are the steps that should be taken to obtain this decree. 

• A memo should be drafted on the Museum Director’s behalf, addressed to the Secretary 
General, giving the details of the object and asking that it be accessioned.

• This memo should be given to the Museum Director for signature.

• After it has been signed, it should be delivered to the office of the Secretary General, where it 
will be processed and a decree will be issued.

• A copy of this decree should be kept in the manual object file (See Creating Manual Object 
Files).

Step 4: Fill Out Accessioning Form

The section head and Associate Registrar for the Permanent Collections should work together to 
fill out a manual Accessioning Form.
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Hard copies of these forms are stored in the Blank Forms section of the filing cabinets. Additional 
copies can be printed from the file stored on Akhenaten -> Ruby -> RCMDD-ADMIN -> Forms -> 
RCMDD Forms.

As much information should be included as possible; if research is necessary, it should be done 
at this point. IMPORTANT NOTE: This is the best time to get all of this information -- do not miss 
this chance. In many cases, it will be possible to contact the excavator directly, to make sure that 
the information is complete and accurate. Do not wait for the section head to do this.
Fill in the following:

Section that the object will 
belong to, and the SR number, 
according to the sequence in 
that section. This number will 
be assigned by the section head 
(example: SR 2/ 10948).

Curator in Charge: Fill in name 
of section head who will be 
responsible for the object 
(example: Hala Hassan).

Date that form is filled out, in 
full written form (example: 
January 20, 2007).

Title: Give the object a brief but 
accurate title (example: Male 
Reserve Head).

Description: Write a short 
description of the object. 
Include any major damage to 
the piece (example: Male 
reserve head of white 
limestone. The ears have been 
broken off, and there is damage 
to the nose. A line has been incised across the top of the head, from front to back.).

Material(s) (Primary and Other) (example: Limestone).

Dimensions in maximum centimeters, and Weight, if the object is weighed by the section 
head, in grams. Make sure all measurements are taken at this point: for most objects, this 
should include three dimensions. (See Measuring Objects.)

• In general, use height, width, and depth for sculpture and stelae.

• In general, use length, width, and depth for coffins and boxes.

Provenance (include as much detail as is known) (example: Giza, Western Field, outside 
tomb G7500).
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Dating: include the highest level of detail known (example: Old Kingdom, Dynasty 4, 
reign of Khufu OR JUST reign of Khufu).

Manner of acquisition (Check box): Bequeathed, Confiscated, Excavated, Exchanged, 
Given, Repatriated.

Excavation information: Excavator, Sponsoring Institution, Excavation Date, any excavation 
and/or magazine numbers (example: Z. Hawass, SCA, December 2006, Excavation 
number: 9384; Reg. no. 1875).

Other source (if not excavated).

Permanent location planned for object (example: R47-N1-Vit-Q).

Current location of object (example: SS12-S3-Shelf-4-Giza-box-123).

Signature of section head (example: Mahmoud el-Halwagy).

Step 5: Assign JE Number

A new JE number will be given in sequence by the department heads and the Associate Registrar 
for the Permanent Collections (checking in both the physical JE and the database for the next 
number in sequence). This number will be added to the Accessioning Form by the Associate 
Registrar for the Permanent Collections. 

NB: FOR OBJECTS THAT JOIN TO AN OBJECT OR OBJECTS ALREADY IN THE MUSEUM: If a 
recently excavated or recovered object or group of objects joins to an object already in the 
museum, a new JE number will be given to the new object or objects. (It is not possible to update 
the old JE record, as the original JEs are now put away, and multiple digitized copies are in 
circulation.)  If there are multiple pieces that join, these should be given the numbers JE xxxx.1, 
JE xxxx.2, etc.

In some cases, a CG number will be given to the object instead of a JE number. This will only be 
done if the object has been in the museum for a long time and has never been accessioned, and 
is being accessioned now because it is being included in a new volume of the CG. Such objects 
are not registered in the JE ledger.

Step 6: Process Accessioning Form

A completed and signed copy of the Accessioning Form must be given to the section head 
responsible for the object; they will keep this for their files. They should add the JE number to 
their Special Register books at this point.

The original copy of the Accessioning Form will be filed in the object file.

Step 7: Mark Object with ID Number and Do Number Check

The object is marked with the JE or CG number by a conservator, according to proper 
procedures. The object should only be physically marked with the JE or CG number; it should not 
be marked with the SR number. The SR number can be attached to or associated with the object 
by a tag or other method.

The Associate Registrar for the Permanent Collections should make sure that the object has been 
properly marked (see Guidelines for Numbering Collection Objects).
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At the same time, do a number check to see if there are any excavation numbers or magazine 
numbers on the object. If there are, these should be entered into the Number Check field of the 
database, as usual.

Step 8: Photograph Object

A new photograph should be taken of the object. If possible, a group of objects to be accessioned 
should be photographed at the same time. These photos can be taken by the museum 
photographer or one of the registrars.

File the photograph properly in the computer system and put it into the multimedia module of 
the database; attach it to the object record.

Print four copies of the photograph (See Printing Images) using the Accessioning_Images.indt 
template Ruby->RCMDD-DOC->Permanent_Collections->Accessioning->Templates

1 at 4x4 cm for the JE
1 at 4x4 cm for the fiche
1 at 4x4 cm for the Section Head’s copy of the movement form
1 at 7x7 cm for the SR

Step 9: Fill Out JE

The basic object information is recorded in the JE by the Associate Registrar for the Permanent 
Collections or the Head of Documentation, using the completed Accessioning Form. Make sure 
to start the entries in the top line of the box reserved for the record. Do not wait to do this; you 
can always add missing information later. Fill out the following information in pen, unless 
otherwise noted:

JE number

The original permanent location for the object (in pencil)

A brief title and description (only put the basic information here; more detail can be 
added in the description field of the database)

Dating, as specifically as possible.

All materials, primary material first

Dimensions, detailed as to type and unit (e.g. H: 21.2 cm). Use only points, never 
commas

Provenance, as specific as possible (e.g. Northern Upper Egypt->Abydos: Umm el-Qaab-
>ED Royal Tombs->Den/Dewen

Source (e.g. Excavated by G. Dreyer for the DAIK in 1996 and/or Repatriated by the 
Metropolitan Museum of Art in 2010).

Remarks: include all other ID numbers (excavation numbers, SCA register numbers, SR 
numbers etc.) here, along with any relevant bibliography

Attach the appropriate photograph next to the completed record with double-sided tape.
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Note: Even if some information is missing and research is still being done to obtain it, enter the 
available information in the JE and just leave the fields where information is missing blank until 
this information has been acquired.

Step 10: Create Object Record in Database

See Creating Object Records

Remember to include a number check.

After entering all the information into the database, write the date and your name in the "Entered 
in database" section at the bottom of the accessioning form.

Step 11: Create Location Records in Database

Make sure there are location records in the Location Module for the Permanent and Current 
locations and attach them to the object record.

Attach the Permanent Location to the Permanent Location field.

Create a movement record to attach the Current Location to the object record.

• When the object is coming from outside the museum, the first movement record 
created should be a Permanent move into the museum; this is often to the curators' 
office, but could also be to the Conservation Lab. If the planned Permanent 
Location is known, it can be entered now, otherwise use [To be det.] EMC. Record 
the location from which it has come (usually a magazine) in the Movement Notes.

• Track all subsequent movements, as usual. When the object is moved to its 
Permanent Location (usually the second move), this should be recorded as a 
Permanent move w/in museum, and this location should be entered under both 
Current and Permanent Location.

Step 12: Get Record Approved

You will need to have approved records for each newly accessioned object. Following the usual 
protocol, write a description, then submit a pdf of the card for approval. 

Step 12: Create Object File

Print Catalogue Card and create Manual Object File according to the office protocols. File 
relevant materials in this file.

 Step 13: Do a Condition Report

Write, or help the section head to write a condition report for the object.

NOTE: As of March 2011, this part of the protocol is not yet possible, but we hope to institute this 
in the near future.
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30. Deaccessioning/Objects Leaving Museum
The following protocol covers three categories of objects:

• Objects that have been deaccessioned from both the EMC and the SCA. Examples of these are 
objects that have been sold, or which have disintegrated.

• Objects originally registered at the Egyptian Museum that have been sent to other SCA 
Museums in the past, and are no longer considered EMC objects. These are not considered to 
be Deaccessioned, as they are still property of the SCA, so are covered under Objects Leaving 
Museum.

• Objects leaving the Egyptian Museum now and in the future, but remaining within the SCA 
system (for the most part going to new museums). These are not considered to be 
Deaccessioned, as they are still property of the SCA, so are covered under Objects Leaving 
Museum.

30.1. Deaccessioning Objects

This will rarely happen in the future, as antiquities are no longer sold or given away, but it has 
happened in the past.

An object is considered deaccessioned if it is marked in an official register book as:

Sold

Disintegrated

Buried in Garden

Given

This should be recorded in the database as follows:

• Under Object Status, select Deaccessioned.

• Under Object Rating, select the appropriate entry.

• In the Security Tab, choose Retired.

30.2. Objects That Have Left the Museum
For objects that have already left the museum but remain in the SCA system (usually in another 
museum), it is important to record this in the database as follows:

• Under Object Status, select Other SCA Museum.

• Leave Object Rating blank.

• If you know the correct ID number in the new museum, this should be entered in the Other 
Museum AND the ID Number fields on the Title/ID Tab. In the ID Number fields, the number 
assigned (if any) by the museum to which it has been moved should go first, as it is now the 
principal number.

• If you know only the museum, but not the ID Number, enter the code for the museum in the 
Other Museum field on the Title/ID Tab. Do not enter anything additional in the ID Number 
field.
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• Make sure the Permanent Location for the object contains the code for the other museum in 
Level 1. Indicate where the  information that the object is in another museum comes from 
(usually the JE or SR) in the location code.

• If you know the director of the new museum or magazine, add this under Home Curator. If 
you don’t know, find out!

• Also enter the other museum’s in formation in the Current Location. (We did not do this 
earlier in the project, so you will find objects that have left the museum with only Permanent 
Locations. You can clean these up as you find them.) 

If you know the date on which the object left the museum (this is sometimes indicated in 
the register books), add this; if not, enter 1/1/1111.

Under Movement Purpose, enter Permanent Move out of Museum.

You will not usually need anything under Movement notes. (See Object Movement and 
Current Location.)

Make sure you select “Not Present” in the Registrar field.

30.3. Objects Leaving the Museum

With the many new museums currently under construction by the SCA, this is a very important 
protocol that will be used often. 

Step 1: Record Selection

When you learn that an object has been chosen for transfer to another museum, you should 
record this immediately in the database as follows:

• Under Object Rating, choose 
Selected for Transfer.

• If the object has been chosen by the 
GEM or NMEC, indicate this with 
the radio button on the Title/ID Tab.

• In the Other Museum field, enter 
Chosen-Code of Museum (do this 
for GEM, NMEC, and all other SCA 
museums). 

If an object has been chosen by more 
than one museum (including the EMC):

• Under Object Rating, choose 
Selected-Multiple Museums.

Step 2: Track Movement

As the object is moved from the museum, follow the object movement protocols. 

Note that there may be multiple location records for each outside SCA Museum and Magazine 
that have not been inventoried by the project (i.e. the majority of such institutions). Level 1 will 
always be the name of the museum or magazine; it is the location code that will be different. 
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These records, which should be attached as both the Permanent and Current Locations for the 
relevant objects, are as follows:

For SCA Magazines

[STORAGE] NAME OF MAGAZINE: Use this for objects moved during committees attended by 
the RCMDD, at which a registrar is able to do a number check and confirm that the correct 
object is being moved. In these cases, enter the actual date of the move.

[From SR/JE/TR] NAME OF MAGAZINE: Use this if a register book indicates that the object has 
moved. In these cases, enter the date of the move recorded in the register. If there is no date, use 
1/1/1111. (Note that as yet, the project has not found objects recorded in the register books as 
having moved from the museum to a magazine.)

[From Section]: Use this for objects that have left the museum recently, but during movements 
not attended by the RCMDD. In these cases, use the date given to you by the section head as the 
movement date.

For SCA Museums

[DISPLAY] NAME OF Museum: Use this for objects moved during committees attended by the 
RCMDD, at which a registrar is able to do a number check and confirm that the correct object is 
being moved. In these cases, enter the actual date of the move.

[From SR/JE/TR] NAME OF Museum: Use this if a register book indicates that the object has 
moved. In these cases, enter the date of the move recorded in the register. If there is no date, use 
1/1/1111.

[From Section/Committee]: Use this for objects that have left the museum recently, but during 
movements not attended by the RCMDD. In these cases, use the date given to you by the section 
head or committee head as the movement date.

Step 3: Record new status after the object has left the museum

• Under Object Status, select Other SCA Museum.

• Leave Object Rating blank.

• If you know the correct ID number in the new museum, this should be entered in the Other 
Museum AND the ID Number fields on the Title/ID Tab.

• If you know only the museum, but not the ID Number, enter the code for the museum in the 
Other Museum field on the Title/ID Tab. Do not enter anything addition in the ID Number 
field.
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31. Inventory
The following protocol outlines the procedures for inventorying display and storage galleries. 
Many of the inventories being done in the next few years will be Initial Inventories, where the 
gallery is being inventoried by the RCMDD for the first time. After this project is complete, the 
office will move to the Regular Gallery Inventory process.

In many instances, a single object (or a group of objects) will need to be inventoried for purposes 
such as Loans, Exhibitions, and Outside requests. The Single Object Inventory steps apply in 
these cases.

NOTE: It is very important that you notify the section heads whenever you will be working in the 
galleries. Ideally, the best way to do this is to post your planned activities on the Museum Master 
Schedule (see Scheduling Coordination); however, this schedule is not yet being kept, so for now, 
just notify the section heads personally.

31.1. Determining Object Locations

For all types of inventories, the following procedures can be followed to determine object 
locations, which can be recorded first on manual forms and then in the database (see below).

• Identify the gallery you are in.

Using the overall museum map, kept in the front of the Gallery Book, or the gallery numbers 
painted on the museum walls (although note that these are not always completely accurate) 
determine which gallery you are in.

• Get the relevant Gallery Map from the Gallery Book; make sure to leave a placeholder to tell 
the rest of the team that you have taken the map.

• Decide whether the object or vitrine is in a wall or center area.

All objects that are against walls, in vitrines against walls, or close enough to the wall that 
another object cannot be displayed in the same location (behind the object) should be given 
“wall” locations on the map. If this has been done, find your object or vitrine. If it has not been 
done, do it now, according to the system outlined in the Location guidelines.

• If necessary, create or modify gallery, vitrine, or area maps.

31.2. Initial Gallery Inventory

The museum has over 100 galleries, all of which need to be inventoried. This is a slow process, 
but it is important to continue to proceed very carefully to lay a strong foundation for future 
work.

The steps here have been laid out in ideal order, but other than steps 1 and 2, you should be 
flexible. It is probably most efficient in most cases, IF numbers are visible on a majority of 
objects, and very little of the gallery has been inventoried, to begin with an actual gallery 
inventory; in other galleries, you may want to work in the database with the locations recorded in 
the Special Registers first and take a preliminary list out to the gallery with you (see Step 6), 
although this has not proven very effective in the past.
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Note that although you should do Steps 1 through 5 for the entire gallery first, beginning with 
Step 6, you may want to work with part of the gallery, or a vitrine, at a time, and repeat the 
process for the other areas and/or vitrines.

Step 1: Choose Gallery

The RCMDD keeps a master list of galleries to be inventoried. The department heads, with the 
assistance of the Associate Registrar for the Permanent Collections, are responsible for keeping 
this list up to date. The department heads will assign gallery work to the associate registrars.

As of March 2011, the RCMDD is working to complete one gallery per section. Once these 
galleries are complete, the project will move to working through the galleries in order, or as 
requested by museum staff. Other galleries will be completed as the need arises.

The Children’s Museum should also be prioritized.

Before beginning work in the basement, the Excel files being produced by the Section 8 head 
should be obtained and studied, and a process for incorporating this system developed.

Step 2: Begin Checklist

Get a Gallery Inventory checklist from the manual 
forms drawer, and fill out the gallery name at the 
top. This will be kept on the clipboard to track the 
progress of the gallery. Also in Ruby (Ruby -
>RCMDD-ADMIN->Forms->RCMDD Forms)

Step 3: Set up Clipboard

It is essential that there is a working clipboard for 
every gallery in process. As soon as the gallery has 
been selected, take a clipboard and set it up for 
gallery work. You will need the following:

• Gallery checklist

• Gallery map (see Step 4)

• Blank graph paper for vitrine maps

• Blank Inventory forms

• Copy of photo permission

Note that the clipboard must be left in a central location (Section-2 - Bookcase-6 - Shelf-1) when 
you are not actively working in the gallery, so that it can be accessed by other staff members.

Step 4: Obtain Map

All gallery maps are being produced as per the protocols above (see Gallery Maps). When the 
gallery has been selected, take the latest version of the map from the Gallery Book (filed 
according to Gallery Name -- by floor, then in numerical order) out of its plastic sleeve. Leave the 
plastic sleeve in place, with a post-it saying that the map is on a Gallery Clipboard. The map goes 
onto a gallery clipboard. You will check and update this map as part of the initial inventory 
process. If there is no map, you will need to create one.
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Step 5: Check Map

Take the map and clipboard out to the gallery and check it carefully against the actual layout of 
the gallery. If there are vitrines that have not been identified, do this now. If there are wall or 
center locations whose objects have not been “alphaed,” do this now. If there are errors, correct 
these now, manually. Do not update the computer file yet; wait until the gallery is finished, in 
case you make additional changes.

Step 6: OPTIONAL STEP -- Do SR Location Data Entry (if useful)

At some point, either before or during your inventory, you may want to do some preliminary 
location data entry from the Special Registers. This may help you identify objects, especially in 
galleries where there are many objects without visible numbers. You may also need to do this 
before working in storage spaces. It is most likely that this will be useful in galleries with many 
small objects in vitrines, where most objects have not moved for a long time.

Since the Special Registers were originally organized by gallery, you can usually find the pages in 
the SRs that have the majority of the objects in your gallery on them. Since many objects have 
been moved, this does not always work, but it can be a good place to start.

So that the process is easier to track, if there are other objects on the SR page that are not in your 
gallery, you should enter their locations anyway. Make sure that the SR page you enter is checked 
off on the master list, which is kept in the Register Books - Sign-out Sheets notebook (Section-3 - 
Bookcase-7 - Shelf-4).

• Find an object in your gallery.

• Find the page in the SR that includes this object.

• Using the SR numbers, or, since many of these are not yet in the database, the cross-
referenced JE, CG, or TR numbers, find the first object on the page. 

• Double-click on the object record to go to detail view and go to the Location tab, or choose a 
list view in which the Permanent Location field is visible.

• Enter the locations given in the SR 
book as follows (as per example 
here): [From SR] P2 - E9. Since the 
SRs do not generally include 
much specificity, once you have 
entered a location once, and 
made the corresponding location 
record in the location module, 
you will be able to simply type or 
copy and paste this for the other 
objects in the same location. 
NOTE: Do not copy the location 
code, as you will then not be able 
to find your location.

• Pull up List from Database
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Go to the Object Module, Location Tab

Do a New Search for EMC-Gallery Name (e.g. 
EMC-R43) and any other parameter you need. 
For example, if you are working only on the 
North wall, search for, e.g. EMC-R47-N*.

Click on the binoculars or hit Control-F

Sort by Permanent Location

9. Print the List as a Preliminary Inventory. You do 
not need to save the soft copy of the report you 
generate; this is a worksheet.

Step 7: Inventory Visible Objects with Manual Forms and Photograph Objects

Gather the following items:

Gallery Clipboard

Apron

Camera and tripod

Go to the gallery. Begin by the entrance to the gallery and work clockwise through the wall 
locations, then do the center objects. It is important to work systematically, so that the other 
registrars can work on the gallery as well. If it is a large gallery with many objects or especially 
many vitrines, as mentioned above, you do not need to do the entire gallery before going back to 
work in the database, but you should complete one wall or one vitrine at a time. It is better not to 
do too many objects at one time.

If you are working on a complex vitrine, you will need to map it at this point (see Creating and 
Modifying Vitrine Maps).

With the manual form (either a blank form or a printed 
preliminary inventory), work carefully from left to right and 
top to bottom through each wall location. Photograph each 
object as you work. 

Fill out the Object Inventory form as follows:

• Correct ID Number: leave blank for now.

• Number check: write any numbers on or associated 
with the object, including details like color, and 
whether they are on a tag or label nearby. 

• Title: write a brief but clear title that will help you 
identify the object in the register books and database. 
Include the material; this will help a great deal. This will 
not necessarily be the title that you use later in the 
database; it is meant to help make sure you are dealing 
with the correct object (if there is a visible number) or 
find the object (if there is no visible number). Example: 
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Wooden head of a man in a short wig.

• Under Problems/notes, indicate if a number needs to be written on the object; a list of these 
will be created, and this will be done with the section head and the conservation department. 
Also note here if a condition report should be written for the object (see Numbering Objects).

• Do a full set of measurements for as many objects as possible (in a small gallery, try to 
measure all of the objects). Write the measurements in the Problems/notes section of the form.

• Location: this should be as detailed as possible, according to the RCMDD protocols. Put the 
location in the Location 1 field; the 
Location 2 field is used for 
movements.

• Photo number: these should be 
sequential for the day, beginning with 
1.

NOTE: You may also work with a printed 
Preliminary Inventory report, if enough of 
the ID numbers and locations have 
already been determined.

Step 8: Process Manual Form and 
Photographs

Go back to the office, and process the 
manual form and photographs. Do not do 
another session in the gallery until you 
have processed the work you have already 
done.

• Download photographs to your desktop, into a folder marked with your name and the date, 
and batch rename them in Bridge by date and sequential number. You will work with these 
from this folder. 

• Find each object in the database. If you absolutely cannot find the correct ID number for the 
object, create a record for it as GalleryName.XX (e.g. P49.06). Fill out what you can.

• Make sure all relevant numbers are included in the ID Number field, in the correct order (JE, 
CG, TR, SR). Remember that for some complex objects (especially for jewelry), you may need 
to put the number that includes all of the pieces of the object first; this is often the SR number 
or the CG number rather than the JE.

• As you identify each object, rename its photo or photos according to ID Number, and cross 
out the photo number on your inventory form to show it has been identified. If you have given 
the object a provisional Gallery ID number, use this.

• Make sure all relevant facsimiles are attached to the catalogue record and are in the correct 
order (JE, CG, TR, SR, PM).
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• Enter the number check in the field on the Title/ID Tab. Use a 
semicolon to separate visible numbers, e.g. blk 47398; red 
345; JE 47398 (on label).

• Attach the location in the Permanent Location field on the 
Location Tab in the Catalogue Module. If a location record already exists in the location 
module, attach this. If it doesn’t you will need to create one. Note that at this point, you may 
want to work in the location module and create a group of locations for the gallery you are 
working in that can be attached to your object records. You can do this efficiently using the 
Ditto function.

• If there is already a Permanent 
Location attached to the catalogue 
record, confirm that it is correct. At 
this point, you should be able to use 
either Display or Storage as the 
location code.

• Fill out the Current Location:

Copy and paste the Permanent 
Location (WITHOUT the 
location code) into the Current 
Location field.

Enter the name of the Section 
Head under Home Curator.

Enter 1/1/1111 under Date Moved. This is the protocol to show you do not know when the 
object was moved to its current position.

Let the database autofill the time.

Under Movement Notes, put “Gallery Inventory (seen in situ-DATE).” Note that you can 
use the auto-fill feature here.

Under Registrar, put your name to show you did the inventory.

• When all of the photographs have been identified, use the Import Tool to import them into the 
Multimedia module and attach them to their Catalogue records, putting them into the proper 
order in the Multimedia tab in the Catalogue module.

• Store the images in the backup system.

• Make groups in the Catalogue module of objects which need numbers written on them. The 
RCMDD will work with the conservators and section heads to put these numbers on the 
objects; you will then do number checks and add these to the database.

• Do condition reports on the objects for which these are needed, and add these to the 
database.

Step 9: Have Senior Cross-checker do Full Cross-checks
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Have this group of objects added to the Group-Checking Checklist: Give your manual forms to 
the department heads. They will add the group to the list, and pass the forms to the designated 
senior checker (see Group-Checking). When the senior checker has finished with the group, the 
department head will pass the forms back to you. Save these until the gallery is finished, but then 
you may throw them away.

Step 10: Repeat for all Areas and Vitrines

Repeat this process for all of the areas and the vitrines in the gallery.

NOTE: If you will be working in a Bas or storage area with a section head, you may want to do as 
much preliminary work as possible, getting the SR locations and even full cross-checks done for 
the objects before the bas gets opened, as inventory with a section head may get messy 
otherwise.

Step 11: Do Final Gallery Check

After you have finished all of the vitrines and areas, you will do a final gallery check. You should 
do this with one of the senior checkers -- if possible, this should be the Associate Registrar for the 
Permanent Collections, or a member of the ARCE team.

NOTE: If you are working on a very complex gallery, and want to do a preliminary review, you 
may do a Preliminary Gallery check first, using the Preliminary Gallery report.

1. Pull up full gallery from database and sort it by Permanent Location. Remember to pull up 
only Parent records; you should not include pieces in this report.

2. The database will ask you to name the report; name it simply according to the gallery, or if 
you are working on one area or vitrine at a time, name it according to the gallery, area, and 
vitrine. Remember that you do not need underlines in the title. R30, for example, is sufficient.

3. Print the group as a Final Gallery Inventory Report to a pdf, called: INV_GalleryName_YYYY-
MM-DD (e.g. INV_R49_2009-08-13).

• Print the report in color. If everything is 
correct, this will be filed.

• Check Gallery: Go to the gallery, and check 
that all of the information on your report is 
correct. Check off each object as you go.

• Make sure to count all the objects in the 
gallery when you begin, and make sure the 
number corresponds with the number of 
objects on your list (accounting for anything 
traveling or temporarily moved).

• Mark in pencil if the object is traveling or 
moved temporarily when you do the 
inventory.

4. Make any necessary corrections in the 
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database. If you have made corrections, you will need to run the report again and re-save the 
pdf;  hopefully you will only need to print the relevant page or pages.

• Save the final pdf in Ruby->RCMDD-DOC->Permanent_Collections->Gallery_Work->Floor 
(P_First; R_Ground; etc.)->Gallery (e.g. P4)-> P4_Gall_Inv.

5. Print second copy of the final inventory for Section Head.

Step 12: Update map on computer

At this point, you should take the map, with any manual modifications you have made, and if 
necessary, either update it yourself or have another registrar update it. Print two copies.

Step 13: Prepare package for Section Head.

You will need to give the Section Head the following:

• One copy of the Gallery Map and any area or vitrine maps

• One copy of the Final Gallery Inventory

Step 14: File Forms and Retire Clipboard

When the gallery is completed, file everything properly in the Gallery Book and throw away the 
work sheets. The clipboard will now be available for use with a new gallery.

31.3. Regular Gallery Inventory

After the museum has been fully inventoried, the RCMDD will need to work with the section 
heads to develop a schedule for regular inventories. At the least, the office can inventory the 
objects on display regularly, perhaps with a schedule of two galleries a week (so that inventorying 
the display galleries would take about a year).

NOTE: The section heads do inventory their objects, but it is not clear to the project at the 
moment how this is scheduled.

For the moment, due to resource limitations, movement of objects into or out of galleries that 
have already been inventoried should of course be recorded in the database, but it will not be 
possible to run new inventories each time. Make sure the movement is indicated on the printed 
copy of the inventory. If more than 10 objects are moved in or out of a gallery, run, print and 
store a new inventory in the computer and manual systems. Move the old inventory into the 
archives.

31.4. Single/Group Object Inventory
Until the museum has been fully inventoried, you will frequently need to inventory a single 
object or a group of objects.  This happens most often in connection with Loans, Exhibitions, and 
Outside Requests.

When you receive a list or group for inventory and cross-check, you will begin by checking each 
object in the database to see whether or not it has been inventoried previously. You will only 
need to inventory objects that have NOT been inventoried previously. You will check this as part 
of the Group Set Up in the Group Checking Protocol. To reiterate here, records for inventoried 
objects should  have:
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• All relevant ID Numbers

• A number check

• A Current Location

• A Permanent Location (with a location code of [Display] or [Storage])

• A master image

• All relevant facsimiles attached and in the proper order

To inventory objects which have not been inventoried, follow these steps:

Step 1: Do Preliminary Database Work

• Do a search for the object. Make sure:

All relevant ID numbers are in the ID Number field

All of the relevant facsimiles are attached

• Find a preliminary location. You will most often find this in the SR. If you cannot find an SR 
number, look in the JE, TR, or CG Position Book.

• Enter the preliminary location into the Permanent Location field, according to protocol (e.g. 
[From SR] R30 - N1).

• If the location does not autofill (with the correct location code), the Location Module will 
open (or you should go to it by pushing the blue arrow next to the field). Fill out the location 
properly, making sure the location code is correct (i.e., if the location is from the SR, the 
location code should be [From SR]).

• If you modify or change a location, make sure it is not attached to other records, or that if it is, 
the change is valid for the other records as well.

Repeat for each object you need to 
inventory.

Step 2: Print a Preliminary Gallery 
Inventory Report

• Pull up the objects you need to 
inventory as a group.

• Sort by Location.

• Go to Tools->Reports and select EM 
Preliminary Gallery Inventory. Click 
on Report All.

• Print the report in black and white. 
You do not need to save the report.

Step 3: Do In Situ Inventories

• Get Gallery Maps for all relevant galleries from the Gallery Book and put them onto your 
clipboard, leaving sticky notes in the book to indicate that you have them.

• Go to the first Gallery (with Clipboard, Apron, and Camera) and find your object. 
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• Make any necessary modifications to the map, and map any new vitrines or wall areas which 
contain objects on your list.

• Fill in the blanks on the report

Do number checks.

Fill in the detailed location.

Take photographs, if needed.

Measure, if needed.

Note if a number needs to be written on the object.

Do a condition report if necessary.

Step 4: Process Manual Work and Photographs

• Download photographs into a folder on your desktop according to protocol.

• Make any corrections to the information in the database.

• Add number check.

• Add Permanent Location.

• Add Current Location (with movement date of 1/1/1111, if you do not know the correct date).

• Rename photographs.

• Import photographs to database and attach them to Catalogue records.

• Attach Condition reports to records.

• If you have made any additional modifications to the Gallery map, the computer file should 
be updated at this point.

• Scan any new vitrine or wall area maps and file them in the computer system.

• Re-file gallery maps and file any new vitrine or wall area maps in the Gallery Books, so that 
they will be available to everyone.

• Remember that if the objects are for a loan or exhibition, the object records should be taken 
to approval as quickly as possible.
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32. Object Movement and Current Location
An object’s current location is tracked through movement -- movements are tracked on manual 
forms and then entered into the database in the Location tab, in the current location fields, of the 
Catalogue module. The last movement entered into these fields will show up on reports as the 
object’s Current Location.

Current Location is also entered into the database when an initial Current Location has been 
confirmed visually during the Inventory process, as a “virtual” movement. (Remember that in 
these cases, the Movement date should be 1/1/1111; under Movement Notes it should say 
Gallery Inventory (seen in situ - DATE OF INVENTORY); under Registrar it should have the name 
of the team member (ARCE or RCMDD) who has done the inventory; under Home Curator it 
should have the name of the section head responsible for the object.)

The RCMDD now officially attends all object movements in the museum. This includes the 
movement of objects from one place to another within the museum, the movement of objects 
into the museum, and the movement of objects out of the museum. If the RCMDD discovers that 
a movement has taken place without a registrar present, a memo should be written immediately 
to the Museum Director. 

Note that there will be situations in which the RCMDD will choose not to attend committees: 
with many objects leaving the museum for the GEM and NMEC very quickly, and a lack of clear 
planning and scheduling, in some cases it will not be useful for the registrars to attend these 
committees, as the team simply does not have time to keep up. In such cases (as with the current 
GEM object transfer), the RCMDD should be provided immediately with the lists of objects that 
have left and the photographs taken during the inventory. These images will be added to the 
database and the movements processed as “No Registrar Present,” with an explanation of the 
circumstances in the Movement Notes field.

Movements are recorded on manual forms. This data should be entered into the database 
immediately, in order to keep object information up to date. Movement forms should be 
processed the same day or the next day, if possible. They should never remain unprocessed for 
longer than a week.

Most movements should be entered into the Current Location area in the Location Tab of the 
Catalogue module -- the fields here feed the movement history fields AND the report fields. If the 
movement needs to be edited, you should do this through the Internal Movements module -- if 
you make edits to the Current Location fields in the Catalogue module after the record has been 
saved, a new record will be added to the movement history (which you do not want!). Also use 
the Internal movements module if an older movement needs to be entered.

Whenever you add a new movement to the database, make sure that the movement history is 
essentially correct, in that there are no duplicate movements and all locations make sense (and 
have location codes).

32.1. Object Movement - RCMDD Present

The Associate Registrar for Movement must check with the Curatorial Coordinator each day to 
see if any movements are scheduled. Hopefully the office will also know if movements have been 
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scheduled previously. If the office is told about movements prior to the day of the movement, 
these should be put onto the master calendar. The heads should be informed of all movements so 
that they can assign RCMDD staff to the committees.

During the movement, the registrars are responsible for the following:

• Filling out the movement form.

• Taking photographs of any objects for which the database does not yet contain good images.

• Doing number checks on the objects.

• Inventorying the object’s starting and ending locations.

• Making sure to record any incidents or problems that occur during the movement.

The ideal is for one registrar to attend each object movement. If there are many objects being 
moved, two registrars may be necessary; these assignments should be made at the discretion of 
the department heads.

Step 1: Prepare to Attend Committee

The registrar or registrars assigned to the committee should prepare for the committee by making 
sure they have a Movement form (Ruby->RCMDD-ADMIN->Forms->RCMDD Forms-> 
Movement_Form.doc and extra Object Inventory forms (Ruby->RCMDD-ADMIN->Forms-
>RCMDD Forms->Object_Inventory.doc) on their clipboard. If the movement is for an exhibition 
or a loan, you may also have a preprinted Incoming or Outgoing Receipt to bring with you. Also 
essential are aprons and a camera.

Step 2: Fill out the Movement Form

On the front of the form, the following fields should be filled out at the movement:

1. Top blank line: This is used for Exhibitions and Loans. Put the Exhibition or Loan number 
here, if applicable.

2. Accountable Unit: Usually the section; sometimes the conservation lab; sometimes also the 
museum or magazine to which the objects are going; sometimes a shipper/packer.

3. Date of Form.

4. Purpose: Please check only ONE box here (NOTE: This is a protocol change as of early 
2010). Use the following simple guidelines to decide which box to check:

Permanent move w/in EMC: Use ONLY when an object is being moved from one 
Permanent Location to another WITHIN the museum; in other words, only use this when 
the Permanent Location is being changed.

Permanent move out of EMC: Use ONLY if an EMC object is leaving the museum for good, 
i.e. being transferred to another SCA museum or storage space. The location codes for 
these locations should be:

[STORAGE] for magazines and [DISPLAY] for museums, IF a registrar is present for 
the move;

[From Section] or [From Committee] if a registrar is not present.
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Permanent move into EMC: Use ONLY if an object is coming to the museum and will 
most likely be accessioned. If an object comes to the museum, for example, for an 
exhibition, use Exhibition as the purpose.

Conservation: Use this ONLY when regular conservation work is being carried out that is 
not in connection with an exhibition or loan.

Temporary: Use if the object is being moved temporarily, generally for Photography, 
Outside Study, or Temporary Storage.

Exhibition Number: Use for any move of objects connected with an in-house exhibition. 
(NOTE: If objects are moved to make space for an in-house exhibition, but are not part of 
the exhibition, check Temporary.)

Loan Number: Use for any move connected with a traveling loan.

5. Proposed Schedule: At this 
point, the RCMDD is rarely 
informed of movements 
before the day they occur, 
so this is generally left 
blank.

6. Actual Move: Date and Time 
of move should be filled 
out; at the end of the move, 
count the number of objects 
and/or pieces moved 
carefully and fill this in 
under # of Objects.

7. Movement Notes: Any 
secondary purpose for the 
move should be recorded 
here, along with information 
about any incidents that 
might have occurred during 
the move. Here is a list of 
possible secondary 
purposes:

Conservation (for 
Exhibitions or Loans)

Condition Reporting

Photography

Outside Study

Packing

Shipping
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Returned to EMC

Unpacking

Back Home

Installation

Deinstallation

8. Committee Head: Usually a section head.

9. Released by: Use if there is a transfer of responsibility; this will usually be the same as the 
Committee Head.

10. Released to: Use if there is a transfer of responsibility; this can be a section head, 
conservator, inspector, etc.

11. Curators.

12. Conservators.

13. Security: Member of the security staff attending the committee.

14. Registrars: Staff of RCMDD only.

15. Signatory 1: Signature of Committee Head/person releasing objects.

Printed Name 1: Write name here if signature is illegible.

Date: Date of signature.

IMPORTANT NOTE: If the person releasing the objects does not sign the form, this area 
should be left blank!

16. Signatory 2: Signature of person to whom the objects are released.

Printed Name 2: Write name here if signature is illegible.

Date: Date of signature.

IMPORTANT NOTE: If the person receiving the objects does not sign the form, this area 
should be left blank!

17. Notes: This is where you will record any incidents or problems that occur or arise during the 
move.

NOTE: You MUST make sure that all responsible parties are listed as committee members. If 
responsibility for the object is being transferred from one person to another, you must make sure 
that the names of both the person releasing the object (Released by) and the person to whom the 
object is released (Released to) are listed as are listed as Committee Head and/or Committee 
Members, not just in the Released by and Released to fields.

Step 3: Fill out Movement Object List

An object list must also be attached to the Movement Form. There are two possible types of lists: 

• A printed report generated from the database: This is generally an Exhibition or Loan report of 
some sort, or a list of objects that are being moved to another SCA museum. Hopefully, in the 
future it will be more common to be able to use such reports, if the museum begins to plan 
movements in advance so that lists can be prepared.
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• The back of the Movement Form has 
space for an Object Inventory, laid 
out exactly as on the Object 
Inventory forms, to be filled out as 
usual:

Leave the first column blank.

Fill out the ID from the section 
and a number check in the 
second column.

Add a title to the third column. 
Include enough information here 
so that the object is easy to 
identify. “Amulet” is not enough 
-- you must add enough information here so that you will be able to distinguish the 
objects on the list from one another.

Add the Location from which the object is being moved (Location 1) and the location to 
which the object is being moved (Location 2), according to protocol, in the fourth column.

If you take a photo, add a sequential number for the photo in the fifth column.
If you need space for additional objects, attach additional Object Inventory forms as 
needed. Make sure to fill out your name and the date, and use the purpose line to cross-
reference the movement. 

Notes: There is a space for notes at the bottom of the form.

If you need additional space, use additional Object Inventory forms. Fill out your  name, 
the date, and use the Purpose line to cross-reference the movement.

Step 4: Process Movement

The movement should be processed as soon as possible.

First, you need to make sure that the ID numbers are correct; make sure to write the confirmed or 
corrected numbers in the Correct ID# field on the Object Inventory form.

Search for the first object by ID number and go to: Catalogue Module->Location Tab->Current 
Location area.

The following information from the Movement Form should be entered into the database: 
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• Current Location: Specific location to 
which the object was moved. (Note 
that the Location will autofill if it is 
already in the Location module. 
Otherwise the Location module will 
open to give you a choice of locations 
or  to allow you to add a location. If 
the correct location is not in the 
database already, you should add the 
location at this point.) 
NOTE: If an object moves permanently 
out of the museum (and the registrars are present for the movement), the following location 
codes should be used (and the same location should be attached, of course, to both the 
Permanent and Current Location fields):

To an SCA magazine: [STORAGE]

To another SCA Museum: [DISPLAY]

• Home Curator: Person responsible for the gallery, lab, museum, or storage area to which the 
object has been moved, e.g. person listed on the movement form under Released to.

• Committee Head: Person who is responsible for the object during the move.

• Curators

• Conservators

• NOTE: Remember that all people present, especially the person who releases the object or 
accepts responsibility for it must be listed under at least one of these fields: Home Curator, 
Committee Head, Curators, or Conservators. This is important so that the parties records for all 
committee members are attached to the movement record.

• Date Moved

• Time Moved

• Purpose: This is where you will add the information from the “Purpose” checkboxes and 
exhibition or loan numbers. The entry here should take the following form:

Permanent Move out of EMC

Permanent Move w/in EMC

Permanent Move into EMC

Temporary

Conservation

Exhibition number

Loan number

• Movement notes: more detail about the purpose of the move taken from the Movement Notes 
field on the Movement form can go here, e.g. Packing, along with any problems encountered. 
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If there is a significant incident associated with the move, a separate event record should be 
created in the database, and a memo should be generated and given to the Museum Director. 
If one of the people either releasing or accepting responsibility for the object is not the 
Committee head or the Home Curator, note this here.

• Security: Attach the “Not Present” Parties record if there is no security present.

• Registrars: Remember to attach the “Not Present” Parties record if the RCMDD did not join 
the committee. Remember that you should NOT enter the movement until the current 
location of each object has been verified, in situ, by a registrar.

Step 5: Change Permanent Location (if relevant)

If the object’s Permanent Location has changed, change it in the Permanent Location field on the 
Locations Tab. 

Step 6: Repeat for each object

Once you have completed the data entry for the first object, use the Partial Ditto function to enter 
the movement for the additional objects. If you are going to use the ditto for a large group of 
records, have a senior checker come and check the first record to make sure that the spelling is 
correct before beginning the ditto.

• Copy the information in the Current Location fields into the Ditto “clipboard”: Edit->Ditto-
>Use Current Record for Ditto. This will place the movement information into the memory of 
your computer.

• Open the Catalogue record for the next object.

• Go to the Location tab in the new record and select Edit->Ditto->Current Tab (or Shift+Ctrl
+F9). This will fill in the fields of the Location tab that you have selected with the information 
that was in the record you chose to duplicate. 

• If necessary, change the Current Location, or any other location information that is different 
from one object to the other.

• If necessary, change the Permanent Location for the object.

IMPORTANT NOTE: If you are moving an object that is composed of pieces (i.e. moving the 
Parent of a Parent-Child object, you cannot use the ditto function in the Internal Movement 
module or the new current location will not be added to the Child records. You must instead 
enter the movement by hand from in the Location tab of the Catalogue module. 

Step 5: Have Senior Checker Check the Objects

Once a movement form has been entered into the database, put the movement forms in a folder 
(called “Lists to be cross-checked”) that is kept on the Head Registrar’s desk. Senior checkers 
should get these forms from the folder and make sure full cross-checks have been done on all 
objects associated with the move. If there are any problems, the senior checker should consult 
with one of the registrars who attended the movement. After checking the group (the Movement 
Registrar should always write down the name of the group, if one has been created, on the 
movement form), the senior checker should move the checked movement forms to the Movement 
Checks folder, also on the Head Registrar’s desk. 
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Step 6: Check Movement data entry

After the object has been checked a second registrar should do a second check of the movement 
data entry. If there are any problems, the registrar should consult with the senior checker or the 
person who did the original data entry.

Step 7: File Movement Forms

Movement Forms are filed in the Movement Logbook (Bookcase-2), in chronological order.

32.2. Parent-Child Moves

In most cases, you will be moving the parent and its children together. However, in other cases, 
you will move a child by itself. The following protocols cover both possibilities.

32.2.1. Moving Parent and Children Together

When you have a set of Parent and Child records, 
you can move all of them to a new location 
(changing the Current Location) at the same time 
by just entering the Movement information in the 
Parent record.

Step 1: Make sure that your Parent record has the 
radio button for “Independently Moveable?” set to 
“Yes” and that your Child records have the radio 
button for “Independently Moveable?” set to “No.”

Step 2: Enter the movement data in the Parent 
record and save.

Step 3: In the Child record, go to the Catalogue 
module, Location tab and check that the Current 
location has been updated. NOTE that only the 
Current Location the Date, Curator in Charge and 
Movement Notes will be filled out in the Child 
record; the rest of the committee information will 
not show up in the Child record. If the records are 
not updated,  refresh the page (View->Refresh or 
Ctrl+R) and the new information should appear.
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32.2.2. Moving Children Separately

Leave the “Independently Moveable” radio button 
set to No. Process movement as you would for a 
Parent record in the Child record. Only the Child 
record you update will be changed; the parent and 
any other children will stay where they were.

NOTE: Sometimes there is a "parent record" for 
objects which are not in the same place (like a 
coffin lid and box). In such cases, make sure you 
move only the child record, NOT the parent!

32.3. Object Movement -- RCMDD Not Present

As of the writing of these protocols, the section heads do not tell the RCMDD about object 
movements all of the time. In some cases, the section head will inform the RCMDD about a 
movement after it has happened; in others, the RCMDD will discover the movement by accident. 
Also, there may well be cases in which the RCMDD does not hear about or discover the 
movement at all; at this point, there is nothing we can do about this. In addition, as mentioned 
above, there are movement committees that the RCMDD may choose not to attend, as there is no 
way for them to keep up with the pace that is set at the committee. If proper information cannot 
be acquired in any case because the committee is working too quickly or the committee head is 
refusing to give the registrar full access, it is better to simply get the information later (although as 
soon as possible), and enter the movement as Not Present. Otherwise, since things like number 
checks and exact locations will have to be acquired later anyway, the registrar is wasting precious 
time attending the committee.

32.3.1. Movement Information Available

For situations where information is given by or can be obtained from the committee head, either 
after the move or because a registrar has been able to join the movement in progress, the 
RCMDD should follow these steps:

Step 1: Ask for information

Ask the committee head for information about the move, including the date, time, locations to 
which the objects were moved, and an object list. If photos were taken, request these as well. If a 
registrar has joined a movement in progress, make sure to take photographs.

Step 2: Begin filling out a Movement Form
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Make sure that the date of the form reflects the day on which the form is filled out, and that it is 
clearly noted that there were no registrars present in the Registrar field (attach the “Not Present” 
Parties record). If a registrar has joined the movement in progress, indicate this in the Movement 
Notes field, with the name of the registrar in parentheses.

Step 3: Inventory the objects

Inventory the objects on the list immediately, getting at least the new Current Location by in-situ 
inventory, doing a number check, and taking a photograph if necessary. If the object has been 
moved into a storage area, the RCMDD should insist that the storage area be opened so that the 
object can be checked in situ. The movement should not be processed until all the objects have 
been inventoried. Make sure to note where and how the objects have been inventoried in the 
Movement Notes field, with the name of the registrar doing the inventory in parentheses.

Step 4: Enter movements in database

Remember to indicate Not Present under the Registrar field.

Remember that if the RCMDD is not present for a move out of the museum, it can not be entered 
as a regular move, since you will not be able to do a number check to confirm that the correct 
object is being moved. There are two possibilities:

• For objects that have left the museum before the RCMDD’s inception, and information about 
movement out of the museum is taken from the register books (usually the Special Register) 
(see Objects that have Left the Museum):

Permanent Location: [From SR/JE/TR] NAME OF MUSEUM/MAGAZINE

Current Location: [From SR] NAME OF MUSEUM/MAGAZINE

• For objects that have left the museum recently, but during movements not attended by the 
RCMDD:

Permanent Location: [From Committee] NAME OF MUSEUM/MAGAZINE

Current Location: [From Committee] NAME OF MUSEUM/MAGAZINE

32.3.2. Movement Information Not Available

If the RCMDD team finds that an object has moved from a location already in the database (i.e., 
there is already at least one movement recorded in the database), and but has no information 
about when this move occurred, do not fill out a movement form. Just enter the movement as 
follows:

• Movement Date: date on which the object is seen by the RCMDD in the new location.

• Home Curator: Section head in charge of the object.

• Location: Location where object is seen in situ.

• Registrar: Not Present.

• Movement Notes: Movement date unknown: seen in situ (Name of Registrar).

As soon as they learn of an unreported movement of any sort, the department heads should write 
a memo to the Museum Director. An event should be created in the database, and a memo run 
from the event. A template for this event is available: this is record number EV.2010.8.
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32.3.3. Movement Information Provided But Unconfirmed

In some cases, a section head will tell the RCMDD about a movement after it is too late for the 
registrars to confirm, for example after the object has moved again. In these cases, do not fill out 
a movement form. Enter the movement as follows:

• Movement Date: date on which the section head says it was moved.

• Home Curator: Section head in charge of the object.

• Location: Location to which the section head says the object was moved.

• Registrar: Not Present.

• Movement Notes: Movement date unconfirmed: Information from Section Head (not seen in 
situ).

In other cases, movement information, often of an object to another museum, but also of 
permanent movements within the museum or of the inclusion of objects in loans, will be 
recorded in the SR. In these cases, do not fill out a movement form. Enter the movement as 
follows:

• Movement Date: date recorded in the SR. If no date is recorded, use the protocol: 1/1/1111 to 
indicate that the date is unknown.

• Home Curator: Supervisor of new location, if known (e.g. director of new museum or chief 
inspector at magazine).

• Location: Museum or other location recorded in the SR. Code: [From SR]

• Registrar: Not Present.

• Movement Purpose: Vhoose the relevant purpose, e.g. Permanent Move Out of Museum.

• Movement Notes: Movement information from SR (not seen in situ). 

If the object has left the museum, you may add a current location as well (see Objects that have 
left the museum).

32.4. Location “Changes” without Movements

There will be instances in which you will need to change the current location (movement) record 
attached to an object, even if it has not actually moved, usually because the RCMDD’s map for a 
particular gallery has been changed or refined because of protocol changes.

In these cases, you should edit the location record, and also edit the relevant Internal Movement 
record by adding a note in the Movement Notes field as follows: Location revised + DATE. 
Remember not to do this edit in the Catalogue module, as this will create a new movement 
record. Also be aware that the revised location will not show up in the Location tab; this is a 
glitch in the database, but know that the correct information is there, just not visible from the 
Object record.
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32.5. Group Movements

In some instances, you will want to move a group of objects at one time, rather than moving 
them one by one. This will be especially useful when moving groups of loan objects from venue 
to venue. This can be done from any module in which you can select a group of objects.

Step 1: Select Group of Objects

Bring up a group of objects in list view, either by doing a search in the catalogue module, or by 
bringing up a list of objects in another module (for example, in the loan or event module, go to 
the objects tab, where you will find a list of objects in the loan). Select all the objects that you 
want to move by highlighting one object and pressing Apple/Command/Cntrl+A or holding down 
shift and selecting each object in turn.

Step 2: Relocate Objects

Go to Tools->Relocate->Selected Records

The  Location Update window will open. Fill out the 
following fields:

• New Location (note that this links to the Location 
Module. If there is already a record for the new 
location, this field should auto-fill if you enter 
enough of the location string, or open a set of 
records in the Location module for you to choose 
from. Otherwise, you will need to create a new 
record.

• Requested By: For Venue movement, this will be 
the name of the  exhibition organizer. For Regular 
movement, this will be the name of the Home 
curator for the location. This information will go 
to the Home Curator field in the location tab.

• Released By: The name of the SCA staff member 
in charge of the previous location (for Venue 
movement, this will be the name of the previous 
courier). Note that this does not show up anywhere in the movement history or in the location 
tab.

• Accepted by: The name of the SCA staff member in charge of the new location (for Venue 
movement, this will be the name of the new courier). Note that this does not show up 
anywhere in the movement history or in the location tab.

• Date Moved: The date of the movement (for Venue movement, the date on which the objects 
are moved to the new venue, if known, otherwise use the date on which the exhibition opens 
at the venue).

• Time Moved: You will rarely know this; if you do, enter it here, otherwise let the database 
enter a default time. 
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Click on Update, and the objects will all move. If you go to the Location Tab for any object, and 
check the Current Location, you will find the new location visible here.
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33. In-house Exhibitions
The RCMDD, under the leadership of the Head Registrar and the Associate Registrar for In-house 
Exhibitions, plays an important role in exhibitions that are held in the museum, usually of SCA 
objects. The following protocol outlines the procedures to be followed for such exhibitions.

Typically, the museum or the SCA will receive a request for an exhibition from a foreign 
organization, or the museum itself (usually the director) will begin to plan an exhibition. A 
request is usually accompanied by suggested dates and a tentative list of objects.

It is essential that the RCMDD be provided with information and relevant correspondence about 
all requests as soon as this process begins. The RCMDD will work closely with the Egyptian 
Museum’s Exhibition Coordinator (EC) during this entire process, and will also be in contact with 
any external exhibition organizers when requested to do so by the Exhibition Coordinator.

It is also essential that once the RCMDD is involved in the exhibition, all lists associated with the 
exhibition be generated and distributed by the RCMDD. 

It will probably not be possible to carry out these steps in the ideal order; the important thing is 
that everything is done in a timely fashion and that the RCMDD is able to track the process of 
planning, installing, and de-installing the exhibition.

33.1. Exhibitions Overview

The RCMDD tracks the exhibition for its entire period, both before and after approval is given by 
the appropriate authorities. The following outlines the main phases of the exhibition process, 
covering the entire period of time during which the objects are chosen, brought to the museum (if 
applicable), prepared for the exhibition, displayed, and returned to their permanent locations.

This introductory section is meant as a general outline of the process; details about the 
procedures followed by the RCMDD are reviewed in the protocols below. Steps here often occur 
in different orders, or do not occur at all. The active or responsible party for each step is indicated 
in parentheses. Exhibition approval can occur at any point in this process.

Phase 1: Preparation -- Request Submitted; Object Lists Prepared

• Request for exhibition is submitted (exhibition organizer).

• Preliminary group of objects selected (museum staff, sometimes including RCMDD heads, or 
exhibition organizer).

• Proposed objects are cross-checked and object list is prepared (RCMDD).

• Full Location list prepared for the conservation lab, EC, and exhibition organizers (RCMDD).

• Conservation lab reviews and approves or rejects EMC objects (Head of Conservation). NOTE 
THAT THIS DOES NOT CURRENTLY HAPPEN, ALTHOUGH IT MAY IN THE FUTURE.

• Museum director and/or Museum Director approve object list. 

• Master Lists (including Section and Magazine Master lists) prepared and distributed (RCMDD 
prepares; RCMDD and EC distribute).

• Exhibition Checklist and Incoming Receipts prepared (RCMDD).
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Phase 2: Development

• Objects are moved from magazines to the museum, or from their home locations within the 
museum, to the conservation lab to be prepared for display (magazine staff, section heads; 
EC, conservation; recorded by RCMDD).

Phase 3: Installation

• Exhibition space is prepared and objects are mounted in the exhibition (exhibition curators, 
recorded by RCMDD).

• Exhibition space is inventoried (RCMDD).

• In the future, it might be possible to complete condition reports on the exhibition objects. 
Currently, this is not realistic, but should be kept in mind for the future.

Phase 4: Deinstallation

• Exhibition is deinstalled (EC; conservation staff; organizers; recorded by RCMDD).

• Objects are returned to their permanent locations (magazine staff; section heads; EC; 
conservators; recorded by RCMDD).

• Exhibition is closed down.

33.2. RCMDD In-house Exhibition Procedures
The following are the procedures to be followed by the RCMDD for in-house exhibitions. It is 
difficult to detail all of these procedures in order, since there is no standard procedure followed 
by the museum. Therefore, outlined here are all of the steps that should be taken at some point 
during the course of the exhibition, in general as soon as possible, along with details about the 
forms used and reports generated and disseminated by the RCMDD.

33.2.1. Exhibition Setup (Manual, Computer, and Database)

Each exhibition needs to be tracked in the manual, computer, and database systems of the 
RCMDD. You will do a preliminary setup in each category, and continue to develop each system 
as more information becomes available, and as the exhibition goes through the approval and 
development process. Set up the exhibition in all of the systems as soon as you have enough 
information to do so.

Manual System

The manual files for current exhibitions are stored in the Current Exhibition filing drawer in the 
Exhibitions File Cabinet. Note that the files for completed exhibitions are moved into the 
Completed Exhibitions Drawers in this cabinet. At some point in the future, it will probably be 
necessary to move overflow from this cabinet into another.

The following are the principal elements of the manual system, and how they are managed:

Exhibition Information Form

For each exhibition, there should be a completed Exhibition Information Form (hard copies 
located in the Exhibition File Cabinet, in the Blank Forms folder; soft copy in Ruby->RCMDD-
CM->Exhibitions->Exhibition Forms->Exhibition_Information_Form). In the early stages of the 
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exhibition,  it will usually only be possible to fill out a small part of this form. Use pencil, as there 
may be changes. Continue to fill this out as the information becomes available to the office.

• Exhibition Name: This may be 
tentative at the beginning; if there is 
not yet an official name for the 
exhibition, use something that 
identifies the exhibition in some 
way (e.g. Hungarian Exhibition).

• Exhibition Number: Even though 
the exhibition may never happen, it 
is important to assign an exhibition 
number from the beginning of the 
process. This will help track the 
process in the database and the 
manual system, and often 
exhibitions are cancelled and then 
reactivated. The exhibition number 
should take the form: E.four-digit-
year.two-digit-sequence number 
(example: E.2006.09). This number should be assigned by the Associate Registrar for 
Exhibitions.

• Total # of Objects/Pieces: detail here objects, as counted by the museum, as well as pieces, as 
counted by the RCMDD.

• Exhibition Start Date: Opening date  of exhibition.

• Exhibition End Date: Closing date of exhibition.

• Organizer: Name of institution organizing exhibition.

• Contact Person (for organizer).

• Title (of Contact Person).

• Address (of Institution).

• Phone (of Contact Person).

• Fax (of Contact Person).

• Email (of Contact Person).

• Location of Exhibition (normally R44).

• Curator in Charge (normally the Exhibition Coordinator).

NOTE: Again, it will not be possible to get complete information at the outset of the process; the 
form should be completed as additional information becomes available.

The partially filled out Exhibition Information Form should be filed in the Pending Exhibitions 
folder in the front of the Exhibitions filing drawer, inside a manila folder marked in pencil with 
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the exhibition number and a tentative name (e.g. E.2008.02 - Australian Exhibition). All 
correspondence and tentative object lists should go into this folder as well.

Exhibition Steps

The Exhibition Steps form will help you 
track the progress of your work on the 
exhibition. When you are informed of the 
exhibition, get a new Exhibition Steps from 
the Blank Forms section of the Exhibitions 
File cabinet. Write the tentative name of 
the exhibition and the Exhibition Number 
on the top of the form and begin tracking 
your work. By the end of the exhibition, all 
possible steps should be checked off on 
this form. If a step cannot be carried out for 
some reason, put an X through the 
checkbox.

Preliminary File Folder (for pending 
exhibitions)

Mark a manila folder in pencil with the Exhibition Number and proposed name for the exhibition 
(e.g. E.2010.02: Returning Stolen Treasures). File the partially filled out Exhibition Information 
Form and Exhibition Steps in this folder, which will go into the Pending Exhibitions hanging 
folder in the front of the Exhibition filing drawer. All correspondence and object lists should go 
into this folder as well.

Full Filing System (for approved exhibitions)

Once the exhibition has been approved, you will set up the full filing system.

In the Exhibition filing drawer, a new hanging folder should be labeled with the exhibition 
number and name. Inside this hanging folder, the following folders, labeled in pencil with the 
exhibition number on the front and the folder name on the tab, should be placed. The following 
material should be placed inside (as it becomes available):

• Master Folder. Inside this will eventually be stored:

Exhibition Steps

Exhibition Information Form

Exhibition Checklist

Exhibition Inventory

Master List

Exhibition Map

Exhibition Report Log

Exhibition Booklet/ Photographs
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• Working Lists: All working object lists should be filed here.

• Movement Information: Incoming and Outgoing Receipts and all Movement Forms. (These 
are kept on a clipboard during the active phases of the exhibition, then stored in this folder, or 
stored in this folder from the beginning. This is done at the discretion of the Associate 
Registrar for Exhibitions.)

• General Information

Correspondence

Permissions

Copies of relevant memos

Exhibition Logbook (for all exhibitions)

Using pen, the loan should be recorded in the Exhibition Logbook, which 
is kept in the log Bookcase.

• Each year should begin on a new right-hand page.

• Each exhibition should be listed consecutively, with a space between 
each exhibition.

• The exhibition number and, when you know it, the number of objects 
(as a range, e.g. 1-139), and the number of pieces (e.g. 145 pieces) 
should be written in three lines in the left-hand margin. 

• The name of the exhibition, in quotation marks, 
should be on the first line for the record on the main 
page.

• The name of the organizer (institution) should be on 
the second line of the main page.

• On the third line, write out the inclusive dates: the 
start date and the end date (the date the exhibition 
will open and the date it will close), e.g. June 14, 
2007 to September 20, 2008.

• If at some point the exhibition is not approved, cross 
out the entry in pen and write “Not Approved + DATE” next to the line.

• If at some point the exhibition is cancelled after approval, cross out the entry in pen and write 
“cancelled + DATE.”

• EMC - Gallery number

You may not be able to complete all of the information here; add to it as the information comes 
into the office. Do not check this off on your Exhibition Steps until it is complete.

NOTE: When the exhibition is closed (see below), put a line through the entry and write “(closed 
+ DATE).”

Manual Object Files
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In the Object filing cabinets, the relevant object files should be flagged with green post-it flags as 
soon as the final object list is approved.

33.2.2. Computer System

The computer files for loans are stored on Hommus and should be backed up whenever changes 
are made. The backups are on Ruby->RCMDD-CM->Exhibitions->In-house_Exhibitions.

Within the In-house_Exhibition folder (on both Hommus and Ruby), there are four main folders, 
labeled as follows: 

1-Pending_Exhibitions

2-Active_Exhibitions

3-Closed_Exhibitions

4-Cancelled_Exhibitions

1-Pending_Exhibitions Computer Folder (for unapproved exhibitions)

Before the exhibition is approved, make a new folder labeled with the exhibition number and the 
proposed name for the exhibition inside the In-house_Exhibitions Folder->1-Pending_Exhibitions 
on Hommus. Put all soft copies of object lists and correspondence inside this folder, and back 
them up immediately on Ruby.

2-Active_Exhibitions Computer Folder (for approved exhibitions)

After the exhibition has been approved, move your preliminary folder from the Pending 
Exhibitions folder to Hommus Desktop-> In-house_ Exhibitions->2-Active_Exhibitions. If the 
exhibition name has changed, modify the folder name accordingly: it should be Exhibition 
Number_ Exhibition_Short_Name, e.g. E.2009.02_Stolen_Treasures. 

Inside this folder, you will create a series of additional folders, as follows (each with the folder 
name preceded by Exhibition Number_):

• Exhibition Number_Master: This contains the following files:

All final lists generated in connection with the exhibition, including scans of any hard 
copies stamped with official seals.

Exhibition map: the final map of the exhibition.

• Exhibition Number_ Working Lists (soft copies)

• Exhibition Number_ General Information:  Correspondence, permissions for receiving 
packing supplies, soft copy of the catalogue, etc.

• Exhibition Number_Catalogue Name (Catalogue Name as provided by exhibition organizers; 
just add Exhibition Number before the name). Also attach the soft copy of the catalogue to its 
bibliography record in the database.

3-Closed_Exhibitions Computer Folder (for closed exhibitions)

After the exhibition is completely closed (all objects returned to their Permanent Locations), 
move the entire Exhibition folder into the Closed Exhibitions folder.
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4-Cancelled_Exhibitions Computer Folder (for cancelled exhibitions)

If the exhibition is cancelled, move the folder into the Cancelled Exhibitions folder.

33.2.3. Database System

As soon as possible, you should create loan and event records for the exhibition in the database. 
Each exhibition will have a Loan record in the Loan module, and a Master Event record in the 
Event module.

Loan Record

Create a new record in the Loan module, and fill out the relevant information in the database 
record from the Exhibition Information Form.

On the Information 1 Tab:

• Loan Number (in this case the Exhibition Number)

• Loan Direction (Incoming)

• Loan Status from the 
dropdown list:

I-Pending

II-Approved

III-In Process

IV-Installed

V-Packed

VI-Deinstalled

VII-Completed

VIII-Cancelled

• Radio button for Closed - tick 
this when the Exhibition is completed.

• Borrower/Lender (institution sponsoring the exhibition - should attach to record in the Parties 
module).

• Short Name: the short name used by the museum, e.g. Stolen Treasures.

• Loan Title: (name of the exhibition) this should be the full, official name of the exhibition, as 
soon as it is known; e.g. Stolen Treasures: Restoring Egypt’s Heritage.

• Associated Event (Master Event record for the exhibition that will be created in the Event 
module).

• Loan Supervisor (contact for the organizing institution - should attach to record in the Parties 
module).

On the Information 2 Tab:

• Requested By: Organizers.

• Authorized By: Usually EMC.
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On the Dates Tab:

• Commencement Date (date on which the 
exhibition opens).

• Completion Date (date on which the exhibition 
closes).

• Previous Due Date (use if the exhibition dates 
are changed to record the original dates).

On the Objects Tab:

• Objects: The records for all objects included as 
part of the exhibition should be attached 
here. The preliminary list can be attached 
here, and then updated as changes are 
made to the object list, or you can work in 
the Catalogue module first, and attach the 
list here later in the process.

• Number of Objects: Add the number of 
objects here.

• Number of Pieces: Add the number of 
pieces here.

Master Event Record

Step 1: Create a Master Event record for the exhibition.

In the master event record, fill out the relevant information. 

On the Event 1 tab:

• Event Number (the Exhibition number).

• Event Type (Exhibition).

• Event Locality (Internal).

• Title (Title of the Exhibition).

• Description (Short Name).
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On the Events 2 Tab:

• Add the name of the institution organizing the 
exhibition under Organisers. 

• Under Bibliographic Reference, attach the 
Bibliography record for the exhibition 
catalogue, when you have it (probably much 
later in the process).

On the Dates Tab:

• Commencement Date (date on which the 
exhibition begins).

• Completion Date (date on which the exhibition 
ends).

On the Venue Tab:

• Venue, which will usually be EMC - R44.

• Commencement Date (this should be the date 
at which the exhibition opens).

• Completion Date (this should be the date on 
which the exhibition closes).

• Person to Notify (exhibition organizer; this 
should link to the Parties module).

• Preparation details (any other useful 
information).

On the Object Tab:

• When it has been completed and checked, the full object list should be attached to the 
Object tab (see below).

On the Multimedia Tab:

• You need to choose a master image to represent the exhibition, and place it first in the 
multimedia tab. This image will show up online when the exhibition is published on the 
museum website.

• Eventually, a map of the exhibition space will be attached here (see below).
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Sub Event Records

You will need to create individual Sub event records for each of the individual sources 
(magazines, other museums, sections within the EMC) for the objects included in the exhibition. 
To do this, simply ditto the Master Event record, and add the name of the magazine, museum, or 
section in parentheses after the exhibition name. Then go to the object tab and leave only the 
objects relevant for that magazine, museum, or section attached to its Sub event record.

Remember to link the Sub event record to its Master Event record on the Events 1 tab.

33.2.4. Publishing an In-House Exhibition on the Museum Internet Site

All pending and current exhibitions should be published on the museum Internet site. The site 
draws all the exhibition information from the database. You need to fill the following fields 
correctly before publishing an exhibition.

• Exhibition title comes from Master Event: Events module - Event 1 tab - Title.

• Venue comes from Master Event: Events module - Venue tab - Venue Name.

• Dates come from Master Event: Events module - Venue tab - Commencement date, 
Completion date. 

• Image comes from Master Event: Events module - Multimedia tab. First image shows.

• Narrative text comes from Narratives module, from a record attached to the Master Event.

• You need to mark the Loan record, Master Event record and Narrative record to be published 
on Internet to make the record show correctly.

33.3. Prepare Object Records and Lists

Probably the most important part of the RCMDD’s work on exhibitions is to create lists of objects 
for each exhibition. It is essential that all objects associated with an exhibition, whether on 
preliminary or final lists, be cross-checked as fully as possible so that accurate lists can be 
provided to the Exhibition Coordinator, the Museum Director, and other authorized personnel 
(including the conservation lab). Begin processing lists as soon as they come to the office; do not 
wait for final object lists. You can modify the object list as necessary, until the final list has been 
approved.

NOTE: Preliminary lists should be set up by the Associate Registrar for Exhibitions. The object 
records should be created and cross-checked first by one of the senior checkers, then checked by 
the Associate Registrar for Exhibitions, and then sent for approval by the department heads.

Create Object List (Loan module)

Each Exhibition record should have a group of objects associated with it. Once you have a 
tentative object list, you can immediately attach these to the Object tab in the Loan module. It is 
best to do this here so that it can be copied over to the Event modules easily. If there are objects 
without catalogue records, you will need to create one now.
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• If an object comes from the Egyptian Museum, use all official museum numbers to create and 
cross-check record (See Cross-checking Object Records).

• If an object has another SCA museum number, or a proper SCA magazine number, this should 
be used in the ID field. Make sure to use the correct Object Status for non-EMC objects.

• If an object does not have one of these types of numbers, a provisional number 
(Exhibition.Number.sequential number, e.g. E.2007.04.15) should be used as the ID number. 
These numbers will be assigned by the Associate Registrar for Exhibitions. Make sure to write 
all temporary exhibition numbers directly onto a hard copy of the object list.

Whenever the RCMDD is given a copy of the Exhibition Catalogue, this should be used to 
acquire and check object information. Remember to attach the exhibition catalogue record 
reference to each object (Reference tab), and add the catalogue # and page # to the Bibliographic 
Notes field.

Any RCMDD-assigned Exhibition Numbers should be added in pencil to the catalogue. The 
catalogue itself will be kept on the Catalogue Bookcase.

Make sure that any other numbers that are being used by the museum for tracking (sometimes 
excavation numbers but most often non-unique magazine numbers) are entered into the 
Excavation # and Magazine # fields on the database (Catalogue module). These numbers are 
often used by the museum’s Exhibition Coordinator. A magazine number will generally be 
referred to in the lists that come to the office as “Magazine no. xxx,” Reg. no. xxx” or “Exc. No. 
xxx.” Enter them as “Reg. xxxx.” Excavation numbers can take a variety of forms.

Cross-Check Objects (Catalogue module)

Begin the process of doing full cross-checks on all these items. By the time the final object list is 
ready, all exhibition objects should be fully cross-checked, and as many as possible should be 
sent for approval. This means not only that all object information should be checked against the 
registers and Porter and Moss, but also that images and locations should be obtained and 
locations confirmed. The Exhibition Checklist will help you track this process.

• Flag the objects in the database, in the Object Status field of the Catalogue module, as 
Chosen for Exhibition.

• Make sure you have at least one reference image for each object.

If the object is from the Egyptian Museum and there is no image in the database, find the 
object in the galleries and photograph it, following the usual RCMDD  protocols.

If the object is not from the Egyptian Museum, coordinate, if possible, with the museum or 
magazine from which it will come and get an image.

The exhibition organizers will usually have images of all of the objects. Try to get soft 
copies of these to add to the database.

• Make sure you have Permanent and Current locations for all exhibition objects:

Working with the section heads wherever necessary, find proper Permanent and Current 
Locations for all of the Egyptian Museum objects that do not already have Permanent and 
Current Locations in the database (see Inventory). Add these to the database.
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If the object belongs to another SCA museum or storage magazine, attach the Level 1 
location record for this museum or magazine to the Permanent location field of the record. 
If a more detailed location is known, you can attach this; as always, do not attach a 
current location unless you have confirmed it yourself.

• Do number checks on all objects in situ, if possible (this is likely to be possible only for EMC 
objects).

• Once the final list has been approved, send all EMC objects that have not already been 
approved for Object Record approval. Once each object is approved, create a catalogue card 
and manual object file.

Copy Object List to Event Records

When the object list has been finalized, copy it from the Loan module to Event records. You can 
do this by going to the Object tab in the exhibition record in the Loan module, opening the list in 
the Catalogue module, and dragging the list to the Master Event record. Remember that if there 
are changes later, you will need to update these by hand in each module, or update them in the 
Loans module and then recopy the list to the Events module. 

Enter Exhibition Catalogue Numbers (Events module)

So that lists can be sorted 
consistently, all final 
exhibition objects should be 
assigned Exhibition/Loan 
Catalogue Numbers. These 
numbers are entered into 
the Events module -- 
highlight each object 
associated with the 
exhibition (in the Objects 
tab of the Event record) and 
enter the number in the 
Catalogue Number field.

If numbers have been assigned by the exhibition organizers, use these numbers (and try very hard 
to get this information from the organizers as soon as possible). Otherwise, sort your list by JE, 
then CG, then TR, then SR, and number the objects according to this sort order. 

NOTE: Pieces that belong to one object (e.g. a canopic vase and its lid) should be given #.1 and 
#.2, etc. In general, the last catalogue number should correspond with the number of objects, not 
the number of pieces.
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Enter Sections or Outside 
Museums/Magazines (Events 
module)

In the Accountable Unit field, 
enter the EMC section to 
which the object belongs (e.g. 
EMC-Section-1), or the 
outside SCA museum or 
magazine that is its 
Permanent location. You 
might be able to use this field  
for reports, although currently 
sub events are also created for 
the purpose or sorting this 
information.

Enter Packing Information (Events module)

The exhibition organizer and/or the SCA magazines/museum staff should provide the RCMDD 
with detailed information about how the objects will be packed. This should be entered in the 
Master Event record for the exhibition, in the Notes field. 

The format will be: L#_the full number of the box, e.g. L.2010.01_Box-08EC0608-01.

Use only one line per object.

33.4. Provide Object Lists

An important part of the job of the RCMDD is to provide accurate object lists at various stages of 
the process. In the early part of the process, these will be used to assist the various committees in 
choosing objects. Later on these will be the final lists given to the exhibition organizers and the 
Museum Director’s office; these will be the official lists.

It is essential NOT to give out lists that have not been properly checked. Preliminary/interim 
lists must go through the full Cross-check process before they can be given out. The RCMDD is 
often pressured to give out lists before they are ready; please avoid doing this at all costs. 
Giving out object information that has not been checked properly puts the reputation of the 
office in jeopardy, and could undermine the the effectiveness of the RCMDD.

Final object lists should go through the Group cross-checking process; as mentioned above, and 
all records for EMC objects should be submitted for final approval.

NOTE: Remember to save all of these lists as pdfs in the Exhibitions Folder on Hommus. The lists 
can be printed again from these pdfs, if necessary, and they serve as backups.

Exhibition Report Log: Remember to record all lists that are given out on the Exhibition Report 
Log that should be created for the exhibition and stored in the Master Folder. This is a manual 
form that records the name of the report, a description, the date on which the list was generated, 
the name of the person to whom it was given, and the date on which it was delivered.
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The following are the types of reports that should be created for dissemination. The name of the 
module from which the report should be run is in parentheses after the name of the report.

Master Exhibition List (from Events 
module)

When all of the objects have been Fully 
Cross-checked and approved, generate 
and print the Master Exhibition List, 
sorted by Exhibition Catalogue Number. 
This should be run from the Master 
Event record.

The title on the report should be 
Exhibition Number - Exhibition Name 
(generated from the database). The 
filename should be 
Exhibition.Number_Master_List.

Store an electronic copy in the 
computer filing system, and print a hard 
copy for the manual files.

Copies of the Master Exhibition list should go to 

The Museum Director

The Exhibition Coordinator

The head of the Conservation Lab

The exhibition organizers

Section Head and Magazine/Museum Lists (from Events module)

You will also need to print a list of the objects from each outside SCA magazine and museum, 
and from each EMC section, for the person responsible for each group of objects. You will do this 
by going to the relevant Sub event record for the location, and running the Master Exhibition list. 
The filename should be e.g. Exhibition.Number_Section/MAGX.

Website Information

For each exhibition, a narrative record 
that includes the name, dates, venue(s), 
and a brief narrative text about the 
exhibition should be prepared. If 
possible, the exhibition organizers 
should be asked to prepare the narrative 
text; otherwise, the department heads 
should take charge of this. See Narrative 
Module for details on how to create 
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these records.

33.5. Track Process 

Once the exhibition has been approved, you will need to make sure that all of the office 
protocols have been followed, and track the movement of the objects through the various stages 
of the exhibition.

33.5.1. Process Tracking Forms

The office has a number of forms to assist you 
with tracking the exhibitions process. One of 
these, the Exhibition Steps form, is discussed 
above, as this should be started at the very 
beginning of the process.

The following forms and reports should be 
generated as soon as possible, and used to track 
various aspects of the exhibition.

Exhibition Checklist (from Events Module)

To help the office track the overall process, you 
will want to print an EM Exhibition Checklist 
from the Events module. You will use this to make 
sure you have all the relevant information, 
including images, number checks, and locations 
for each object, and to track the major movements 
associated with the Exhibition (to the museum, to conservation, installed, deinstalled, returned 
home).

If an object is dropped from the exhibition and does not come to the museum at all, you should 
cross it out from the list and write NIE (Not In the Exhibition). Put NIE in the Event Catalogue 
number field in the Event module of the database.

If the object has already come to the museum, but is not displayed, write ND (Not Displayed) in 
the blank field next to the ID number field. Put ND in the Event Catalogue number field in the 
Event module of the database.

If additional objects are added to the final list, you can print out a checklist for only these objects 
and add it to the original one.

For all objects that have already been fully cross-checked, check off the appropriate steps for 
these objects. Continue to fill in the blanks or check off the items on this list as the exhibition 
progresses:

• Number Check: make sure a number check has been done on the object. If this was 
completed before the Exhibition Checklist was printed, there should be a notation in the box 
already. By the time the exhibition is installed, there should be a visible number on each 
object or piece.
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• Permanent Location: A Permanent location should be found for each exhibition object as 
soon as possible.

• The boxes at the bottom of each record should be checked off as the major object movements 
connected with the exhibition occur:

To the EMC/Unpacked

To Conservation

Installed

Deinstalled/Packed

Returned Home

Exhibition Full Location List (from Loans module)

This list provides ID numbers, title, material, 
dimensions, Current and Permanent locations, and 
thumbnails. The title should be Exhibition Number - 
Exhibition Name (pulled up automatically in the 
report), and the filename should be 
Exhibition.Number_Full_Location. A copy of this 
should be given to the EC and the Conservation Lab 
as soon as the object records have been fully cross-
checked, to help them organize their work.

A soft copy should be kept in the Working Lists 
folder in the computer system.

Incoming and Outgoing Receipts for non-EMC Objects (from Event module)

Make sure to print separate Incoming and Outgoing 
Receipts for the objects that do not belong to the 
EMC, but which will be brought to the museum for 
the exhibition. These will be used to track their 
arrival at the museum and their return to their 
Permanent locations.

• Go to the relevant Sub event record for the 
magazine or outside museum.

• Generate an Incoming and Outgoing Receipt for 
these objects from the Events module (EM 
Incoming Receipt; EM Outgoing Receipt)

• Repeat for each non-EMC location.
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NOTE: Remember, If an object is dropped from the 
exhibition and does not come to the museum at all, 
you should cross it out on the receipt list and write 
NIE (Not In Exhibition).

NOTE: If an object is accessioned into the museum 
rather than returned to its original Permanent 
Location, cross it off the outgoing receipt and write 
accessioned on the form.

Exhibition Map

Usually the RCMDD is provided with the map of the 
exhibition space (hard and soft copy). The soft copy 
should be kept in the Exhibition Master folder, 
labeled as Exhibition.number_Map,  e.g. E.
2007.05_Map. If this map is modified before or during the installation of the exhibition, save the 
updated map over this one -- in the end, you should have the soft copy of only the final map. 
Store any hard copies of the map, or variations of it, in 
the Master folder in the manual system.

Exhibition Inventory List (from Event module)

This is the list to be used to inventory the exhibition. It 
contains abbreviated object information, thumbnails, 
and Current Location. It should be generated 
immediately after the installation of the exhibition, to 
confirm that all objects are in place and the movements 
have been entered correctly. 

Track Movements and Inventory Exhibition
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You will now use the process tracking forms to track 
the movements of the objects throughout the course 
of the exhibition. Continue to fill out the Exhibition 
Steps and Exhibition Checklist throughout the 
process.

The attending registrar(s) should, when possible take 
photos of those committees, as well as of the 
Installation and Deinstallation processes, and the 
opening of the exhibition. Choose the 25 best of 
these to store in the Multimedia Module and attach 
to the Exhibition Master Event record.

The attending registrar(s) should be fully prepared 
with their aprons with their tools, clipboards and the 
camera. Try to keep the number of registrars 
attending committees to a minimum, as there are 
many people at these sessions and it can get 
crowded, which endangers the objects.

You will use the regular Movement Forms for 
exhibition movements. Make sure you fill out the 
Exhibition number and name on the line beneath the 
title. The line next to the title is used as a cross-reference on your Exhibition Checklist. For details, 
see the Movement protocols.

Under Purpose, always check the Exhibition box 
only. Any additional information will be entered in 
the Movement Notes box.

Track non-EMC Objects into the museum

Use a regular Movement form and the non-EMC 
Objects Incoming receipts for each museum or 
magazine.

Movement Notes: Leave blank unless there is some 
sort of incident that needs to be noted.

 As soon as a complete group of objects has 
entered the museum from an outside source (SCA 
museum or magazine), the Incoming Receipt has 
been signed, and the objects checked off on the 
object list, make a copy of the receipt and object 
list and give it to the museum’s Exhibition 
Coordinator and the curator or inspector from the 
SCA museum or storage magazine. 

Mark that the receipt and object list have been 
copied and given out on the original forms and in 
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the Exhibition Report Log.

Track objects to conservation lab

Use a regular movement form for this. Use the back of the form to inventory the objects. The 
objects can go to the lab for a variety of reasons, so make sure to list these in the Movement 
Notes field. You may list one or more of the following:

Movement Notes: Conservation; Photography; Unpacking; Packing

Track objects to the exhibition space (Installation)

Use a regular movement form to track the objects into the exhibition space. Inventory on the 
back of the form and cross-reference on your Exhibition Checklist.

Movement Notes: Installation

Map the Exhibition Space

The RCMDD should have been provided with the map of the exhibition space at the early stages 
of the process in hard and soft copy. When the exhibition is mounted, you should either approve 
or modify this map. If you have not gotten a map from the exhibition organizers, you should 
make your own sketch map, in most cases using the R44 plan as a template (unless, of course, 
the exhibition is held in another gallery). You do not need to measure the vitrines, a sketch is 
sufficient. Make sure all locations and vitrines are properly labeled.

After you finish, you can scan the map. File the hard copy in the file cabinet in the exhibition 
folder and the soft copy in the computer system. Attach the scan to the Multimedia module and 
link it to the Exhibition records.

Inventory Objects in situ

• Print out the Exhibition Inventory List, which will include only the objects that have actually 
been displayed in the exhibition space.

• Do a full inventory of the gallery space. Make sure that the locations on the form are correct.

• Check these locations against the Current locations in the database (the current locations will 
reflect the movement into the exhibition space). Make sure everything is where it is supposed 
to be.

• File this list in the cabinet in the exhibition folder (See the manual system in Step 11 above).

• Take general views of the exhibition as a whole.

• Take at least one photograph of each vitrine.

• Store these photographs in the Event Images backup system, import them into the Multimedia 
module, and attach them to the Exhibition Master Event record, in the order in which you 
would like them to appear in your Exhibition Report. Make sure to give the images whatever 
captions you would like to have show up in the report.

Monitor Exhibition

At least once a week, visit the exhibition space and make sure that everything is in its place and 
that no significant changes have occurred. If you notice a problem, bring it immediately to the 
attention of the Exhibition Coordinator and log the issue. If no action is taken, work with the 
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department heads to draft a memo about the issue and submit it to the Exhibition Coordinator, 
with a copy to the Museum Director. File the hard copy of the memo in the Exhibition Folder in 
the file cabinet and file the soft copy in the exhibition folder in the computer.

Track objects out of the Exhibition Space (Deinstallation)

For EMC objects, this will usually be back to their 
Permanent locations. For these, use the regular Movement 
form and inventory the objects on the back. Check off the 
objects on the Exhibition Checklist as they are returned to 
their Permanent Locations.

Movement Notes: Returned Home

For non-EMC objects, this will usually be the packing 
step. Use the Outgoing Receipts for the individual 
magazines or museums.

Track non-EMC objects back to their Permanent locations

Note that there may be intermediate moves between the 
deinstallation and the return to the Home locations. Track 
these with regular Movement forms, but the Movement Notes field may be left blank (unless 
there is an incident that needs to be recorded).

For the move out of the museum, use a regular Movement form with the Outgoing Receipts that 
you have prepared for these objects.

Under Movement Notes: Moved out of EMC.

As soon as a complete group of objects has been sent back to its Permanent location (SCA 
museum or magazine), the Outgoing Receipt has been signed, and the objects checked off on the 
object list, make a copy of the receipt and object list and give it to the museum’s Exhibition 
Coordinator and inspector or curator from the SCA museum or storage magazine. 

Mark that the receipt and object list have been copied and given out on the original forms and on 
the Exhibition Report Log.

Note that in some cases, objects that come to the EMC for exhibitions are chosen to stay and be 
accessioned into the museum. If this happens, make a notation on the Outgoing Receipt with the 
relevant object, “Kept in EMC.” Mark the object as selected for EMC, and change the Object 
Status and Rating accordingly.

It can often take a long time (even years) for objects that are brought to the museum for an 
exhibition to be returned to their permanent homes. If one or more objects or object groups 
remain in the museum for more than two months after the end of the exhibition, retire the 
exhibition clipboard, and move the Exhibition Checklist and the remaining Outgoing Receipts to 
a binder, kept in the Bookcase, filed according to exhibition number. The Associate Registrar for 
Exhibitions is responsible for checking this binder regularly. A a task with alarm/notification can 
also be created to remind the team to check this binder periodically.
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33.6. Close Down Exhibition

Once all the objects have been returned to their home locations and all paperwork and database 
entry work has been completed, close down the exhibition.

• Mark the Loan Status in Loans Module as VII-Completed. Tick the radio button for Closed.

• Make sure to change the Object Status and Rating for the objects.

• Remove flags from the EMC object files.

• Cross out the exhibition in the Exhibition log book.

• Move the manual exhibition files to the Exhibition Archive cabinet.

• Move the computer folder to the Closed Exhibitions folder on Hommus and Ruby.

33.7. Create Exhibition Booklet
After the exhibition is over, put together an exhibition report as a reference for the museum and 
give copies to the Secretary General, the Museum Director, and the Exhibition Coordinator. This 
is set up as a report in the Events Module of the database.

As the exhibition is being processed, the team should be taking photographs of the process and 
adding them to the Multimedia module. Only the best and most informative photographs should 
be kept; the rest should be discarded. Make sure that good captions are written for these images 
and put into the Description field in the Multimedia module. These images should be attached to 
the Event record for the Exhibition in the order in which you want them to show up on the 
Exhibition Report. Once you have done this, you will only need to run the report as a pdf, then 
print hard copies for the Museum Director and the Secretary General. The EC may be given soft 
copy of the pdf.
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34. Traveling Loans
An important responsibility of the RCMDD is to help the EMC and the SCA track their traveling 
loans. The museum has an Exhibitions Abroad Committee (henceforth EAC) to deal with these 
loans; it is the job of the RCMDD to support this committee, and to track any objects that come 
from or through the EMC to and from each loan. They also work closely with the Packing 
Coordinator, who is a curator from the museum responsible for overseeing the packing process 
and escorting the objects to and from the Cairo airport.

A loan is made up of a specific group of objects that are sent from the museum, or from the SCA 
system as a whole, since there are often objects included in traveling loans that come from other 
SCA museums and magazines that travel to one or more venues abroad and then are returned to 
Egypt. A single loan can include multiple venues as long as it is managed by a single organizer. 

It is important that the RCMDD, led by the Associate Registrar for Loans and the Head Registrar, 
communicate frequently and effectively with the Exhibitions Abroad Committee and the Museum 
Director so that the office has access to information and correspondence about all loan requests 
as soon as the process begins, and throughout the period of the loan.

This protocol begins with an overview of the main phases of a loan, and then is divided into 
broad categories of tasks and responsibilities that are to be carried out by the RCMDD. Note that 
much of the work will be started before the loan has been officially approved, and some loans 
are cancelled after considerable effort has gone into them already. In general, process all loans as 
if they will take place; details about which procedures should not be carried out until the loan 
receives official approval are given below.

34.1. Loans Overview

The RCMDD tracks the loan for its entire period, both before and after approval is given by the 
Museum Board and the Permanent Committee. The following outlines the main phases of the 
loan process, covering the entire period of time during which the objects are chosen, prepared 
for travel, leave the museum, travel from one venue (exhibition location) to the next, return, are 
checked for damage, and are returned to their permanent locations.

This is meant as a general outline of the process; details about the procedures followed by the 
RCMDD are reviewed in the protocols below. Steps here often occur in different orders, or do 
not occur at all. The active or responsible party for each step is indicated in parentheses. Loan 
approval can occur at any point in this process.

Phase 1: Request Submitted; Object Lists Prepared

• Request for loan is submitted (exhibition organizer).

• Preliminary group of objects selected (museum staff, sometimes including RCMDD heads, or 
exhibition organizer).

• Proposed objects are cross-checked and object list is prepared (RCMDD).

• Full Location list prepared for the conservation lab and the EAC (RCMDD.)

• Conservation lab reviews and approves or rejects objects (Head of Conservation).

• Permanent Location List and Presentation prepared for EAC and Museum Board (RCMDD).
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• Object list is reviewed and modified or approved by Museum Board (Museum Board).

• Approved Object list [Permanent Location List] sent to exhibition organizer (RCMDD 
prepares list; Museum Director’s office sends it out).

• Contract prepared and signed; copy submitted to RCMDD for filing (SCA legal department; 
exhibition organizers).

• Loan and Venue Information provided to the RCMDD (exhibition organizers; Museum 
Director’s office; SCA Secretariat).

• Insurance Values provided to the RCMDD (Museum Director’s office).

• Master Lists (including Section Master lists) prepared and distributed (RCMDD prepares; 
RCMDD and Museum Director’s office distribute).

• Packing and Shipping information provided to the RCMDD (exhibition organizers; Museum 
Director’s office).

• Loan Checklist and Outgoing Receipts prepared (RCMDD).

• Copy of Outgoing Receipt given to Packing Coordinator, who is a curator from the museum 
(RCMDD)

Phase 2: Objects are Prepared and Leave Museum

• Objects are moved to conservation lab to be prepared (section heads; conservation; recorded 
by RCMDD).

• Condition reports are completed on the loan objects (condition reporting committee; 
currently RCMDD has no role here).

• Objects are moved to packing (section heads; conservation; packing coordinator; packing 
company; exhibition organizers; recorded by RCMDD).

• Objects are packed (packing company; packing coordinator; exhibition organizers; recorded 
by RCMDD).

• Objects leave museum (packing company; packing coordinator; recorded by RCMDD).

Phase 3: Objects Abroad

• Objects travel to one or more venue (couriers, packing company; packing coordinator; 
exhibition organizers; recorded by RCMDD).

• Incoming Receipts prepared (RCMDD; copy of full receipt given to packing coordinator; 
Section Receipts given to sections).

NOTE:  Couriers send reports to the Exhibitions Abroad Committee from the venues. The RCMDD 
does not currently get a copy of these reports, but should try to do so in the future.

Phase 4: Objects Return

• Objects are returned to Egypt (couriers, packing company; packing coordinator; exhibition 
organizers; recorded by RCMDD).

• Objects are unpacked (packing company; exhibition organizers; section heads; conservators; 
recorded by RCMDD).
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• Conditions of objects checked (condition reporting committee; exhibition organizers; no role 
for RCMDD).

• Object returned to their permanent locations (section heads, conservation staff; recorded by 
RCMDD).

34.2. RCMDD Traveling Loan Procedures
The following are the procedures to be followed by the RCMDD for traveling loans. It is difficult 
to detail all of these procedures in order, since there is no standard procedure followed by the 
museum. Therefore, outlined here are all of the steps that should be taken at some point during 
the course of the loan, in general as soon as possible, along with details about the forms used 
and reports generated and disseminated by the RCMDD.

34.2.1. Loan Setup (Manual, Computer, and Database)

Each loan needs to be tracked in the manual, computer, and database systems of the RCMDD. 
You will do a preliminary setup in each category, and continue to develop each system as more 
information becomes available, and as the loan goes through the approval process. Set up the 
loan in all of the systems as soon as you have enough information to do so.

Manual System

The manual files for loans are stored in the Current Loan filing drawers (Drawer-1 and Drawer-2) 
in File Cabinet 3.

The following are the principal elements of the manual system, and how they are managed:

Loan Information Form

For each loan, there should be a completed Loan Information Form. In the early stages of the 
loan,  it will usually only be possible to fill out a small part of this form. Use pencil, as there may 
be changes. Continue to fill this out as the information becomes available to the office.
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• Loan Name: This may be tentative at the 
beginning; if there is not yet an official name for 
the loan, use something that identifies the loan in 
some way (e.g. Spain Boat Loan).

• Loan Number: Even though the loan may never 
happen, it is important to assign a loan number 
from the beginning of the process. This will help 
track the process in the database and the manual 
system, and often loans are cancelled and then 
reactivated. The loan number should take the 
form: L.four-digit-year.two-digit-sequence 
number. 
Example: L.2006.09. This number should be 
assigned by the Associate Registrar for Loans.

• Loan Start Date: opening date at first venue.

• Loan End Date: closing date at last venue.

• Borrower: Name of institution organizing loan. 
Fill this out if there is a single venue or a single organizer that will be overseeing the entire 
loan. If there will be multiple organizers, put SCA here, and detail information about the 
individual organizers on the venue forms (see below).

• Total # of Objects/Pieces: detail here both objects, as counted by the museum, and pieces, as 
counted by the RCMDD.

• Contact Person (for organizer).

• Title (of Contact Person).

• Phone (of Contact Person).

• Fax (of Contact Person).

• Email (of Contact Person).

• Total # of Venues: proposed number of venues to which the loan will travel.

• Total fee expected for loan: if known; note that the RCMDD rarely has access to this 
information).

• Insurance Company.

• Total Insurance Value: add this after the object list has been processed and the insurance 
values totaled.

• Outgoing Packing/Shipping Company.

• Outgoing Packing Date.

• Outgoing Shipping Date.

• Incoming Packing/Shipping Company.

• Incoming Date.
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NOTE: Again, it will not be possible to get complete information at the outset of the process; the 
form should be completed as additional information becomes available.

When you have enough information to do so, you will fill in a brief Venue Schedule (dates and 
names of venues) by hand at the bottom of the form. If necessary, continue on the back.

Loan Steps

The Loan Steps form will help you track the progress of 
your work on the loan. When you are informed of the 
loan, get a new Loan Steps form from the Blank Forms 
section of the filing cabinet. Write the tentative name 
of the loan and the Loan Number on the top of the 
form and begin tracking your work. By the end of the 
loan, all possible steps should be checked off on this 
form. If a step cannot be carried out for some reason, 
put an X through the checkbox.

Venue Information Forms

A Venue Information Form should be filled out for each 
venue, once you know what the venues will be (often 
after loan approval has been given). Again, it may not 
be possible to get complete information immediately, 
so missing information should be filled in as it 
becomes available.  

• Loan Name

• Loan Number

• Venue Serial # (Event # for Venue from database, 
see below)

• Total # of Venues

• Order of Venue

• Venue Name

• Exhibition Start Date (at venue)

• Exhibition End Date (at venue)

• Contact Name 

• Contact Title

• Contact Phone, Fax, and Email

• Mailing Address

• Shipping Address

• Fees Expected (information often unavailable)

• Incoming Packing/Shipping Company
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• Arrival Date (not currently available to RCMDD)

• Shipping Address

• Outgoing Packing/Shipping Company

• Shipping Date (not currently available to RCMDD)

• Names and Tenures of the Couriers (information often unavailable)

Notes on any excluded or added objects for individual venues can be attached here.

Preliminary File Folder (for pending loans)

Mark a manila folder in pencil with the Loan Number and proposed name for the loan (e.g. 
Fayum Portraits). File the partially filled out Loan Information Form and Loan Steps in this folder, 
which will go into the Pending Loans hanging folder in the front of the Loans filing drawer. All 
correspondence and object lists should go into this folder as well.

Full Filing System (for approved loans)

Once the loan has been approved, you will set up the full filing system.

In the Loans filing drawer, a new hanging folder should be labeled with the Loan number and 
name. Inside this hanging folder, the following folders, labeled in pencil with the loan number on 
the front and the folder name on the tab, should be placed. The following material should be 
placed inside (as it becomes available): 

• Master Folder. Inside this should be kept: 

Loan Information Form

Venue Information Forms

Loan Steps

Final Object List

Loan Checklist

Loan Report Log

• Working Object Lists: All working object lists should be filed here.

• Legal Papers (the RCMDD rarely gets copies of any of this)

Loan contract (often referred to as Exhibition Contract)

Loan guarantee

Certificate of Insurance

• Incoming and Outgoing Receipts and their cover sheets. These may be kept in a notebook or 
on a clipboard during the active phases of the loan, then stored in this folder, or stored in this 
folder from the beginning. This is done at the discretion of the Associate Registrar for Loans.

• Condition Reports (currently N/A)

• General Information

Correspondence

Permissions
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Copies of relevant memos

Loan Logbook (for all loans)

Using pen, the loan should be recorded in the 
Loan Book, which is kept in the log Bookcase.

• Each year should begin on a new right-hand 
page.

• Loans should be listed consecutively, with a 
space between each loan.

• The loan number and, when you know it, the 
number of objects (as a range, e.g. 1-139), and 
the number of pieces (e.g. 145 pieces) should 
be written in three lines in the left-hand 
margin. 

• The name of the loan, in quotation marks, 
should be on the first line for the record on the 
main page.

• The name of the organizer should be on the second line of the main page.

• On the third line, write out the inclusive dates: the start date and the end date (the date the 
objects will leave the museum and the date they will return), e.g. June 14, 2007 to September 
20, 2008.

• On the fourth line, write the total number of venues (when you know it) and the total 
insurance value (when you know it).

• If at some point the loan is not approved, cross out the entry in pen and write “Not Approved” 
next to the line.

• If at some point the loan is cancelled after approval, cross out the entry in pen and write 
“cancelled + DATE.”

You may not be able to complete all of the information here; add to it as the information comes 
into the office. Do not check this off on your Loan Steps until it is complete.

Manual Object Files

In the Object filing cabinets, you will flag the relevant object files with blue post-it flags as soon 
as the final object list is approved.

34.2.2. Computer System

The computer files for loans are stored on  Ice Cream and should be backed up whenever 
changes are made. The backups are on Ruby->RCMDD-CM->Loans->Outgoing Loans.

Preliminary Computer Folder (for unapproved loans)

Before the loan is approved, make a new folder labeled with the loan number and the proposed 
name for the loan inside the Outgoing Loan Folder->Pending Loans on Ice Cream. Put all soft 
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copies of object lists and correspondence inside this folder, and back them up immediately on 
Ruby.

Final Computer Folder (for approved loans)

After the loan has been approved, move your preliminary folder from the Pending Loans folder to 
Ice Cream Desktop->Loans. If the loan name has changed, modify the folder name accordingly: 
it should be Loan Number_Loan Short_Name, e.g. L.2006.09_Treasures. 

Inside this folder, you will create a series of additional folders, as follows (each with the folder 
name preceded by Loan Number_):

• Master: all final lists generated in connection with the loan, including scans of any hard 
copies stamped with official seals  

• Legal: insurance documents, agreements 

• Packing , Shipping, and Receipts (including scanned versions of signed forms)

• Condition Reports (N/A for now; do not create unless system changes)

• Working Lists 

• General Information:  Correspondence, permissions for receiving packing supplies, etc.

34.2.3. Database System

As soon as possible, you should create loan and venue records for the loan in the database. Each 
loan will have a Loan record in the Loan module, and a Master Event record as well as a series of 
Venue records in the Event module.

Loan Record

Create a new record in the Loan module, and fill out the relevant information in the database 
record from the Loan Information Form.

Information 1 Tab

• Loan Number

• Loan Direction (Outgoing)

• Loan Status from the 
dropdown list:

1-Pending

2-Approved

3-In Process

4-Packed

5-Shipped

6-Returned to EMC

7-Unpacked/Returned

8-Completed

9-Cancelled
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• Radio button for Closed - tick this when the Loan is completed.

• Borrower/Lender (exhibition organizer - should attach to record in the Parties module)

• Short Name: the short name used by the museum, e.g. Tut 1

• Loan Title: (name of the loan) this should be the full, official name of the loan, as soon as it is 
known; e.g. Tutankhamun and the Golden Age of the Pharaohs.

• Associated Event (Master Event record for the loan that will be created in the Event module)

• Loan Supervisor (name of chief curator or organizer for loan - should attach to record in the 
Parties module)

Dates Tab

• Commencement Date (date on which the 
exhibitions opens at the first venue)

• Completion Date (date on which the exhibition 
closes at the last venue)

• Notification Date-Loan Commencement 
Details (date on which the objects will leave 
the museum) 

• Notification Date-Loan Due Details (date on 
which the objects will return to the museum)

NOTE: Early in the process, you may only know 
the dates on which the exhibition itself will open and close at the first and last venues.

Object Tab

• Objects: the records for all 
objects included as part of the 
loan should be attached here. 
The preliminary list can be 
attached here, and then 
updated as changes are made 
to the object list, or you can 
work in the Catalogue module 
first, and attach list here later in 
the process.

• When you have the final count, 
add the number of objects and 
number of pieces in the 
appropriate fields.
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Master Event and Sub Event Records

Step 1: Create a Master Event record for the loan. 
If there is only one venue for the loan, only one 
event record will be needed. If there are multiple 
venues, a sub event should also be created for 
each venue. 

In the master event record, fill out the relevant 
information:

Event 1 Tab

• Event Number (the loan number)

• Event Type (Loan)

• Event Locality (External)

• Title (Title of the Loan, e.g. Eternal Life)

• Description (Short Name for the Loan, e.g. Japan Loan)

Dates Tab

• Commencement Date (date on which the loan 
begins)

• Completion Date (date on which the loan ends)

Venue Tab

On the Venue Tab, fill out as many venues as necessary with the relevant information from the 
Venue Information Form.

• Venue Name (name of venue; this should link 

to the Parties module).

• Commencement Date (this should be the date 
at which the loan comes to the venue; for now, 
it will be the display date (the date on which 
the exhibition will open), since this is the only 
information received by the RCMDD).

• Completion Date (this should be the date at 
which the loan leaves the venue; for now, it 
will be the date on which the exhibition will 
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close, since this is the only information received by the RCMDD).

• Person to Notify (if possible, name of courier for venue; this should link to the Parties 
module).

• Preparation details (any other useful information).

• The full object list should be attached 
in the Object tab by opening the loan 
list in the Catalogue module, 
selecting all the objects in the list and 
dragging them over to the Object tab 
in the Master Event record. This list 
can be edited as the choice of objects 
is refined, but it is best to do this 
editing in the Catalogue module and 
copy the list across to both the Loan 
and Event when it is done. Make sure 
that ALL objects from all venues are 
included. In some instances, objects are added during the course of the loan; these should be 
added whenever such information reaches the RCMDD.

Multimedia tab

• You need to choose a master image to represent the loan, and place it first in the multimedia 
tab. This image will show up online when the loan is published on the museum website.

Step 2: Create Sub Events

If the loan has multiple venues, you need to create 
a sub event for each.

For each venue:

• In the Event 1 tab, fill out the Event Number 
field with the loan number plus a short form of 
the venue name (e.g. L.2009.03_MMA).

• Under Event Type, enter Loan.

• Under Title, enter the Loan name + the full 
name of the venue.

• Under Description, enter the Short Name.

• In the Master Event field enter the Master Event number and click on the green plus button. 
This will link the Master Event and the Sub event record. 

• In the Dates tab complete the Commencement Date and Completion Date fields with the 
dates that the exhibition will be on display at this venue. (Again, the ideal would be the dates 
at which they come to and leave the venue, but the RCMDD simply does not get this 
information as yet.)
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• In the Venue tab enter the Venue information.

• Once the object list for each venue has been finalized, make sure the object list is attached. 
Since in most cases the object list will be the same for all of the venues, you can simply ditto 
the object list from the Master Event record into the Venue records. If some objects are 
excluded from a particular venue, they can be removed from the object list for that venue 
only (remember that the Master Event record and the Loan record should include all the 
objects that will be traveling at any point during the loan). Since there can be many changes 
to object lists, it is recommended to add the object lists to the venue records late in the 
process. If there are major changes, you will want to delete the old list, update the Master 
Event record, and ditto the list again.

Note that the Sub Event records will appear in the Master Event record in the Sub Events 
fields on the Event 1 tab.

34.2.4. Publishing a Traveling Loan on the Museum Internet Site

All current loans should be published on the museum Internet. The site draws all the loan 
information from the database. You need to fill the following fields correctly before 
publishing a loan.

• Loan title comes from Master Event: Events module - Event 1 tab - Title.

• Venues comes from Master Event: Events module - Venue tab - Venue Name.

• Dates come from Master Event: Events module - Venue tab - Commencement date, 
Completion date.

• Image comes from Master Event: Events module - Multimedia tab. First image shows.

• Narrative text comes from Narratives module, from a record attached to the Master Event.

• You need to mark the Loan record, Master Event record and Narrative record to be published 
on Internet to make the record show correctly.

34.3. Prepare Object Records and Lists
Probably the most important part of the RCMDD’s work on loans is to create lists of objects for 
each loan and each venue. It is essential that all object lists associated with a loan, whether 
preliminary or final, be cross-checked as fully as possible so that accurate lists can be provided to 
the Exhibition Committee, the Museum Director, and other authorized personnel (including the 
conservation lab). Begin processing lists as soon as they come to the office; do not wait for final 
object lists. You can modify the object lists as necessary, until the final list has been approved.

Create Object List (Loan module)

Each loan record should have a group of objects associated with it. Once you have a tentative 
object list, you can immediately add these to the Object tab in the Loan module. It is best to do 
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this here so that it can be copied over to the Event modules easily. If there is an object without a 
catalogue record, you will need to create one now.

• If an object comes from the Egyptian Museum, use all official museum numbers to create and 
cross-check record (see Cross-checking Object Records).

• If an object has another SCA museum number, or a proper SCA magazine number, this should 
be used in the ID field.

• If an object does not have one of these types of numbers, a provisional number (PV.4-digit-
year.sequential number, e.g. PV.2007.15) should be used as the ID number. These numbers 
will be assigned by the Associate Registrar for the Permanent Collections.

Cross-Check Objects (Catalogue module)

Begin the process of doing full cross-checks on all these objects. By the time the final object list 
is ready, all loan objects should be fully cross-checked, and as many as possible should be sent 
for approval. This means not only that object information should be checked against the registers 
and Porter and Moss, but also that images and locations should be obtained and locations 
confirmed. The Loan Checklist will help you track this process.

• Flag the objects in the database, in the Object Status field of the Catalogue module, as 
Chosen for Loan.

• Make sure you have at least one reference image for each object.

If the object is from the Egyptian Museum and there is no image in the database, find the 
object in the galleries and photograph it, following the usual RCMDD  protocols.

If the object is not from the Egyptian Museum, coordinate, if possible, with the museum or 
magazine from which it will come and get an image.

• Make sure you have Permanent and Current locations for all loan objects:

Working with the section heads wherever necessary, find proper Permanent and Current 
Locations for all of the Egyptian Museum objects that do not already have Permanent and 
Current Locations in the database (see Inventory). Add these to the database.

If the object belongs to another SCA museum or storage magazine, attach the Level 1 
location record for this museum or magazine to the Permanent location field of the record. 
If a more detailed location is known, you can attach this; as always, do not attach a 
current location unless you have confirmed it yourself.

• Do number checks on all objects in situ, if possible (this is likely to be possible only for EMC 
objects).

• Once the final list has been approved, send all EMC objects for approval, and create a 
catalogue card and manual object file if one is not already in the system.

Enter Insurance Valuations (Catalogue module)

It is important to maintain accurate and up-to-date records of insurance values for objects 
traveling on loan. This information is part of the basic object information, but should only be 
shared with museum staff and authorized exhibition organizers. At present, insurance 
information is available only for objects on loan, as these are the only objects that are insured.
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Note that multiple valuation records can be attached to each object. These will sort by date, with 
the most recent showing in the Valuation History of the Valuations tab of the Catalogue module. 
The following instructions cover both entering original valuations and entering subsequent 
valuations.

Step 1: Receive Insurance Information

Insurance information will generally be given to the RCMDD by the museum’s Exhibitions 
Abroad Committee.

Step 2: Enter Valuation information into the Database

1. Open the Catalogue module and go to the 
Valuation tab.

2. If you know who has done the valuation, attach 
the parties record for the “Valued By” field to 
your record by pressing on the + button next to 
the field. The Parties Module will open. Search 
for the name you want; when you find it, press 
the + button at the top right corner of the 
screen. You can also type the name into the 
field and press the + button to run a search for 
your Parties record.

3. Type the loan number under Reason for Valuation from the Drop-down list. At the moment, 
loans are the only reason that museum objects are given insurance values.

4. Insurance values are always given in US dollars, so choose $ from the Drop-down menu in 
the first currency field.

5. Enter your valuation amount in both Amount (Local) and Amount (Foreign) fields.

6. The Date Valued is automatically filled in with the day on which you do the data entry; you 
can change this by hand if necessary.

7. Enter any notes in the Valuation Notes field.
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8. Save and refresh your record (Ctrl+R or View-
>Refresh). A Valuations record has now been 
created in the Valuations Module 
and you can see the summary 
information in the Valuation 
History fields at the bottom of the 
tab. 

NOTE! If you need to make any 
changes to an existing Valuations 
record you should make them in the 
Valuations Module, NOT in the tab in 
the Catalogue Module.

Copy Object List to Event Records

When the object list has been finalized, copy it from the Loan module to the related Event 
records. You can do this by going to the Object tab in the Loan record, opening the list in the 
Catalogue module, and dragging the list to each Event record. Remember that if there are 
changes later, you will need to update these by hand in each module, or update them in the 
Loans module. It is probably best to work in the Master Event record at this point, and then copy 
this list over to the other records. Remember that the Master Event record should include all 
objects from all venues, and that the object lists 
attached to the sub event records can be edited 
separately.

Enter Exhibition Catalogue Numbers (Events 
module)

So that lists can be sorted consistently, all final 
loan objects should be assigned Exhibition/Loan 
Catalogue Numbers. These numbers are entered 
into the Events module -- highlight each object 
associated with the loan (in the Objects tab of the Event record) and enter the number in the 
Catalogue Number field.

If numbers have been assigned by the loan organizers, use these numbers (and try very hard to 
get this information from the organizers as soon as possible). Otherwise, sort your list by JE, then 
CG, then TR, then SR, and number the objects according to this sort order. 

NOTE: Pieces that belong to one object (e.g. a canopic vase and its lid) should be given #.1 and 
#.2, etc. In general, the last catalogue number should correspond with the number of objects, not 
the number of pieces.

Enter Sections or Outside Museums/Magazines (Events module)
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In the Accountable Unit field, 
enter the EMC section to which the 
object belongs, or the outside SCA 
museum or magazine that is its 
Permanent location. You will use 
this field  for sorting and choosing 
subsets of objects for various lists/
reports.

Enter Packing Information (Events 
module)

The exhibition organizer and/or 
the packing/shipping company 
should provide the museum with 
detailed information about how the objects will be packed. This should be entered in the Master 
Event record for the loan, in the Notes field. 

If the boxes are numbered; the code of the box should be: Ex. #_Accountable Unit_Box-# (e.g. E.
2009.01_MAG-Saqqara_Box-1)

If the boxes are NOT numbered the code of the box should be: Ex. #_Accountable Unit_Box(#) 
(e.g. E.2009.01_MAG-Saqqara_Box(1)]

Use only one line per object.

34.4. Provide Object Lists

An important part of the job of the RCMDD is to provide accurate object lists at various stages of 
the process. In the early part of the process, these will be used to assist the various committees in 
choosing objects. Later on these will be the final lists given to the exhibition organizers and the 
prime minister’s office; these will be the official lists.

It is essential NOT to give out lists that have not been properly checked. Preliminary/interim lists 
must go through the full Cross-check process before they can be given out. The RCMDD is often 
pressured to give out lists before they are ready; please avoid doing this at all costs. Giving out 
object information that has not been checked properly puts the reputation of the office in 
jeopardy, and could undermine the the effectiveness of the RCMDD.

Final object lists should go through the Group cross-checking process; as mentioned above, and 
as many records as possible should be submitted for final approval.

NOTE: Remember to save all of these lists as pdfs in the Loans Folder on Ice Cream. The lists can 
be printed again from these pdfs, if necessary, and they serve as backups.

The following are the types of reports that should be created for dissemination. The name of the 
module from which the report should be run is in parentheses after the heading for the report.
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Loan Report Log: Remember to record all lists that 
are given out on the Loan Report Log that should be 
created for the loan and stored in the Master Folder. 
This is a manual form that records the name of the 
list, a description, the date on which the list was 
generated, the name of the person to whom it was 
given, and the date on which it was delivered.

Full Location Object List (from Loan module)

This list provides ID numbers, title, material, 
dimensions, Current and Permanent locations, 
and thumbnails. The title should be Loan 
Number - Loan Name (pulled up automatically 
in the report), and the filename should be 
Loan.Number_Full_Location. It should be sorted 
by Exhibition Catalogue number. A copy of this 
should be given to the Conservation Department 
so that they can review the list, preferably before 
the list is presented to the Museum Board.
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Permanent Location Object List (from Loan 
module)

This list provides ID numbers, title, material, 
dimensions, provenance, dating, permanent 
locations, and thumbnails. The title should be 
Loan Number - Loan Name (pulled up 
automatically in the report), and the filename 
should be Loan.Number_Permanent_Location. It 
should be sorted by Exhibition Catalogue 
number. A copy of this should be given to the 
EAC to pass to the Museum Board.

Presentation: Outside Request Information (from 
Catalogue module)

This is used in the early stages of the 
loan to provide object images and 
basic information to the Museum 
Board to review. The department 
heads will normally take these 
presentations to the museum board 
and show them as slide shows on 
Preview. To create these, run the 
Outside Request Information report 
from the Catalogue module by 
opening the Object tab in the Loan 
module, clicking on the blue arrow 
to bring up the objects in the 
Catalogue module, and running the report.

The filename for this should be Loan.Number_Presentation.

Master Loan Lists (from Events module)

When all of the objects have been Fully Cross-
checked and approved, generate and print the Master 
Loan Lists, sorted by Exhibition Catalogue Number. 
These should be run from the Master Event record. 

There are two of these: one that includes the 
valuations, and one without. Otherwise, they are 
identical, and should include the ID Number, title, full 
object information, and thumbnail. 

The title on both reports should be Loan Number - 
Loan Name (generated from the database). The 
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filename should be Loan.Number_Master 

OR

Loan.Number_Master_Val.pdf 

Store an electronic copy in the computer filing 
system, and print a hard copy for the manual 
files.

A copy of the Master_Val list should be given 
to the Museum Director.

Copies of the Master list without valuations 
should go to 

The head of the Conservation Lab

The exhibition organizers

The Secretariat (the office of the 
Secretary General of the SCA)

Section Head Lists (from Catalogue module)

You will also need to print a list of the objects in each section for the appropriate section head. 
You will do this by going to the Object tab in the Master Event record, sorting by Event Section, 
highlighting the relevant objects (which will now be grouped together), opening these objects in 
the catalogue module by hitting the blue arrow, and running the Master Loan (without Valuations) 
list. The filename should be Loan.Number_SectionX.

Prime Minister’s List (from Events module)

The Prime Minister’s office will require an official object list to attach to the Exhibition Contract. 
When all numbers 
have been 
confirmed and all 
insurance values 
have been entered, 
generate this list 
(EM PM List), 
sorted by 
Exhibition 
Catalogue 
Number. Save this 
report as L.number.PM_English.

Using the Numbers template: Ruby->RCMDD-CM->Loans->Loan Forms-
>Prime_Minister’s_Report_Template.numbers. Translate the Prime Minister’s list into Arabic and 
save as L.number.PM_Arabic.
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Give hard copies of both the English and Arabic versions to the office of the Museum Director.

Loan List with Description (from Loan module)

The museum has begun to ask the RCMDD for 
object descriptions, often for the purpose of 
catalogues. Since a description is an essential 
part of the catalogue card, these should be done 
immediately as part of the preparation process. 
Once all records are approved, a Loan List with 
Description report can be run and given to the 
Museum Director. This should be saved as 
L.number_Description.

Website Information

For each exhibition, a narrative record that 
includes the name, dates, venue(s), and a brief 
narrative text about the exhibition 
should be prepared. If possible, the 
exhibition organizers should be asked to 
prepare the narrative text; otherwise, the 
department heads should take charge of 
this. See Narrative Module for details on 
how to create these records.

34.5. Prepare Condition Notebook
The project had previously developed a full process for this, but for now the Exhibitions Abroad 
Committee has declined to use the forms and notebooks that the RCMDD provided to them. 
Attached here are screenshots of the Filemaker reports that the project designed to track this 
process; if at a later date, the museum wants the assistance of the RCMDD in this process, similar 
reports could be designed in EMu.

The process is fairly simple: for each object, an Initial Loan Condition Report; a 1 Venue Loan 
Condition Report (which includes a space for the condition upon return to the EMC) or a Multi-
Venue Loan Condition Report; and a Return to EMC Loan Condition Report. These should be 
arranged by Catalogue Number and put into a ring-binder for the condition reporting team to fill 
out and pass on to the couriers.

Below are examples of each of these types of report.
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Initial Loan Condition Report

1-Venue Loan Condition Report
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Multiple Venue Loan Condition Report
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Return to EMC Loan Condition Report

34.6. Track Process 

34.6.1. Process Tracking Forms

Once the loan has been approved, you will need to make sure that all of the office protocols 
have been followed, and track the movement of the objects through the various stages of the 
loan. 

The office has a number of forms to assist you with tracking the loans process. One of these, the 
Loan Steps form, is discussed above, as this should be started at the very beginning of the 
process.

The following forms and reports should be generated as soon as possible, and used to track 
various aspects of the loan.
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Loan Checklist (from Events Module)

To help the office track the overall process, 
you will want to print an EM Loan Checklist 
from the Events module. You will use this to 
make sure you have all the relevant 
information, including images and locations, 
for each object, and to track the major 
movements associated with the loan (to 
conservation, packed and shipped, returned 
home). You do not need to save this as a pdf, 
as it is a manual form.

For all objects that have already been fully 
cross-checked, check off the appropriate 
steps for these objects. Continue to fill in the 
blanks or check off the items on this list as 
the loan progresses:

• Number Check: make sure a number check has been done on the object. If this was 
completed before the Loan Checklist was printed, there should be a notation in the box 
already. By the time the loan leaves the museum, there should be a visible number on each 
object or piece.

• Permanent Location: A Permanent location should be found for each loan object before the 
object is sent abroad.

• The boxes at the bottom of each record should be checked off as the major object movements 
connected with the loan occur:

To Conservation

Packed

Shipped

Returned to EMC

Unpacked

Returned Home

Incoming and Outgoing Receipts for non-EMC Objects (from Event module)

Make sure to print separate Incoming and Outgoing Receipts for the objects that do not belong to 
the EMC, but which will be brought to the museum before and after they travel. These will be 
used to track their arrival at the museum and their return to their Permanent locations.

• In the Master Event Record, sort by Event Section.

• Highlight all of the objects in the first non-EMC location.

• Generate an Incoming and Outgoing Receipt for these objects from the Events module (EM 
Incoming Receipt; EM Outgoing Receipt)
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• Repeat for each non-EMC location.

NOTE: Remember to save these lists as pdfs on Ice Cream as Loan.Number_MUS/
MAG_Incoming/Loan.Number_MUS/MAG_Outgoing. The lists can be printed again from these 
pdfs, if necessary (and if the information has not changed), and they serve as backups.

Outgoing and Incoming Receipts for Loan

Outgoing and Incoming Receipts are used to track 
the  loan objects out of the museum when the loan 
begins and back to the museum when the loan 
ends, and to record the person(s) taking 
responsibility for receiving the object(s). Create the 
Outgoing Receipt when your information about the 
packing and shipping dates, and packing 
information, is as complete as possible. Create the 
Incoming Receipt just before the loan objects are 
returned. Note that copies of both the Outgoing 
and Incoming Receipts should be provided to the 
Packing Coordinator, and Section Incoming 
Receipts should be given to the Section heads.

NOTE: Remember to save theses lists as pdfs on Ice 
Cream as Loan.Number_Outgoing/Loan.Number_Incoming. The lists can be printed again from 
these pdfs, if necessary (and if the information has not changed), and they serve as backups.

34.6.2. Track Movements

You will now use the process tracking forms to track 
the movements of the objects throughout the course of 
the loan. Continue to fill out the Loan Steps and Loan 
Checklist throughout the process.

You will use the regular movement cover sheets for 
loan movements. Make sure you fill out the loan 
number and name on the line beneath the title. The 
line next to the title is used as a cross-reference on 
your Loan Checklist.

Under Purpose, always check the Loan box only. Any 
addition information will be entered in the Movement 
Notes box.

Track non-EMC Objects into the museum

Use the non-EMC Objects Incoming receipts for each 
museum or magazine.

Movement Notes: Into EMC

Track objects to conservation lab
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Use a regular movement form for this. Use the back of the form to inventory the objects. The 
objects can go to the lab for a variety of reasons, so make sure to list these in the Movement 
Notes field. You may list one or more of the following:

Movement Notes: Conservation; Photography; Condition Reports; Packing

Track objects to packing and shipping

Use the Outgoing Receipt you have prepared to track the objects to packing and then as they are 
shipped out of the museum. A separate cover sheet should be used for each committee 
overseeing release of the objects to the shipper, if the objects are packed or shipped in more than 
one group.

Movement Notes: Packing; Shipping

If the office is given packing information ahead of time, this will have been entered into the 
database already and will appear on the receipts. Otherwise, fill out the crate and drawer 
information by hand as the objects are packed and enter them into the database later. 

The box below the crate and drawer numbers is for a final number confirmation (written 
manually in the lower rectangular box).

As each object is packed and shipped, check it off on your Loan Checklist.

Note that there may be intermediate movements between the conservation lab and packing/
shipping, or even after the objects are packed and before they are shipped. Track these, but the 
Movement Notes field can be left blank.

Track movement of objects from venue to venue

This is done only in the database, using the Group Movement feature.

Track return of objects to museum and unpacking

Fill out a separate cover sheet for each committee that receives objects and attach these to the 
Incoming Receipt. These will be signed by the persons receiving responsibility for the objects.

Movement Notes: Returned to EMC

Fill out the Incoming Receipt as the objects are returned by the packing/shipping company to the 
museum.

Track the unpacking process.

Movement Notes: Unpacking

If the office is given packing information ahead of time, this will have been entered into the 
database already and will appear on the receipts. Otherwise, fill out the crate and drawer 
information by hand as the objects are unpacked and enter them into the database later. 

The box below the crate and drawer numbers is for a final number confirmation (written 
manually in the lower rectangular box).

As each object is returned and unpacked, check these steps off on your Loan Checklist.

Track objects back to their Permanent locations
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For EMC objects, use the regular Movement form and inventory the objects on the back. Check 
off the objects on the Loan Checklist as they are returned.

Movement Notes: Returned Home

Note that there may be intermediate moves between the return to the museum and the return to 
the Home locations. Track these, but the Movement Notes field may be left blank (unless there is 
an incident that needs to be recorded).

34.7. Close Down Loan

Once all the objects have been returned to their Permanent locations and all paperwork and 
database entry work has been completed, close down the loan.

Mark the Loan Status in Loans Module as 8-Completed. Tick the radio button for Closed.

Change Object Rating for all objects to their defaults.

Remove the post-it flags from the manual object files.

Move the manual file for the loan into the Old Loans filing cabinet.

The Associate Registrar for Loans should put a diagonal line through the loan entry in the 
Outgoing Loan Logbook in red, place the date the loan was returned in the margin, and initial.
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35. Outside Requests
One of the RCMDD’s responsibilities is to assist with the handling and tracking of outside 
requests for object information, photographs, and access to objects for study. Written guidelines 
for scholars, students, and photographers are available in hard or soft copy from the RCMDD 
during office hours. These will also be made available online, on the SCA and Egyptian Museum 
websites, as a downloadable PDF document.

There are four principal types of requests outlined here: 

• Requests to consult the register books and the database itself

• Requests for basic object information

• Requests for object study

• Requests for images

For everything but the first type of request, it is essential to keep in close touch with the requester. 
It often will take a long time to process a request, especially if it involves multiple objects or 
objects in storage. When a request is received, the department heads must respond immediately, 
even if it is to say that the office will not be able to help anytime soon, and should keep the 
requester posted, sending an email at least once a month with an update.

It is also important to limit the scope of requests for information, object study, and images. The 
guidelines developed by the department are as follows:

• The request must be specific. The office will not assist with general requests such as 
“everything from the Late Period,” or “objects from Deir el Medina.” The office can only 
provide information or photographs for 20 objects per request.

• If the requester sends a list of specific objects, the list cannot contain more than 20 objects. If 
more than 20 objects are included, the office should inform the requester that only the first 20 
objects will be processed, or ask them to resubmit the request with only 20 objects on it.

• Except for special circumstances (assisting a scholar who has contributed to the database or 
the office in some way), the RCMDD will not fill more than one request per quarter for any 
individual requester. This rule does not apply to SCA staff; requests from museum and other 
SCA personnel will be filled as quickly as possible, depending on their scope. 

• The office is not expected to provide information from outside the register books, unless such 
information is already in the database. The RCMDD is NOT required to do scholarly research 
for scholars; they should do their own.

35.1. Requests to Consult Register Books and the Database

Scholars and students are welcome to consult the printed versions of the JEs and TRs whenever 
the office is open. When a scholar or student comes to the RCMDD to consult the register books, 
they should be greeted immediately by a member of the staff and given the guest book to sign. If 
necessary, they should be given a brief orientation on how to use the books. They may NOT take 
any of the register books out of the office or photograph books; this must be made clear.
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Scholars and students may, as per a decree signed by the museum’s director (see Appendix: 
Decree for Scholar Access), also use the Intranet version of the database, the Filemaker 
facsimiles, and the old Search database while in the office, on a computer dedicated to this 
purpose. Note that there are written instructions to be provided to all scholars and students. 
Anyone using the Intranet will need to sign a form to indicate that the rules have been 
understood and will be followed. See Handbook for Outside Users and Instructions for Intranet 
Use for Outside Users. 

35.2. Requests for Object Information, Study, or Photographs
Outside requests for object information or photographs, or requests to study or photograph 
objects for scholarly purposes are usually received by letter or email. Scholars and students may 
also come in person without advance warning, and curatorial and SCA requests are also often 
made in person. 

See Appendix for Guidelines for Outside Requests (for information or study), the SCA’s Rights and 
Reproductions Policy, and related forms.

Process Overview

Requests for object study by outside scholars or students must be approved by the Museum 
Board, and must be managed by the Department of Foreign Missions, which will handle security 
clearance. The RCMDD will no longer be involved in managing these requests.

The request should be made at least 6 months before the study is to take place. 

All requests should be submitted to the office of the Museum Director. 

Outside Requests for information or images may be submitted to the RCMDD.

Requests for basic object information can be handled by the RCMDD, in cooperation with the 
curatorial staff.

Requests for images can also be handled by the RCMDD, in cooperation with the curatorial staff, 
and with approval from the SCA Secretary General.

 For either object information or images, the requester should fill out an Outside Request Form, 
detailing their request. This should include:

• Name

• Date of Form

• Affiliation

• Email

• Phone/Fax

• Status (whether the requester is a student, scholar, photographer, publisher, or other)

• Description of the request (make sure to include the desired dates here if the requester has a 
deadline for receiving information or images) 

• Purpose of the request

Reference
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Scholarly publication

Commercial publication

Other

• What is requested

Object information

Reference photographs

Publication-quality photographs

• A list of the relevant objects

If the request will require approval from the 
Museum Board and/or security clearance, it should 
be passed on to the office of the Museum Director.

35.2.1. Internal Process

Requests for object information, object study (if the 
RCMDD is told about it), and images of museum 
objects are tracked both in the manual system and 
in the database. The manual system for pending 
requests is stored in the Outside Request 
notebook; the database record is stored in the 
Events Module.

The Outside Request notebook is arranged 
alphabetically, by scholar’s last name. The material for each request is kept together in a plastic 
sleeve.

At the front of the Requests In Process section is a series of Outside Requests at a Glance forms. 
This is the master manual system on which the requests are tracked. When all of the requests on 
the top sheet have been completed (or crossed out because all pending requests have been 
copied to a new sheet), you can throw it away.

The outside requester should be provided with an Outside Request Form (available in hard copy 
in a plastic sleeve at the back of the OR folder. A copy is also kept in the blank forms file, and in 
electronic form on Ruby->RCMDD-ADMIN->Forms->RCMDD Forms, and is available for 
download on the SCA and Egyptian Museum websites) and asked to fill it out. If the request is 
made by SCA staff (curatorial or otherwise), the RCMDD may fill the form out for them. If the 
request is received by email, the RCMDD may also fill out the form for the scholar.

After the form has been filled out, follow these steps:

35.2.2. Begin Database Record

• In the database, go to the Events Module.

• Go to the Event 1 Tab, and create a new record. Fill out this tab with the following 
information:
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Event Number: next sequential 
number.

Event Type: select “Outside 
Request.”

Event Locality:

• For requests from 
museum or SCA 
personnel, check Internal.

• For outside scholars or 
students, check External.

Title: this should be Last-
name_First-name_sequential-
number (unless this is the first request from the requester).

Description: fill in description, including dates, from the Outside Request Form.

• Go to the Request 1 Tab, and fill out the following:

Request Status: To do, On 
hold, Passed on, Awaiting 
Publication, Cancelled, or 
Completed.

Request date.

Request priority (assigned by 
the heads). This should be 
between 1 and 5.

Requester: Type in all or part 
of the name with * and hit 
tab, and you will be taken to 
the Parties database to choose 
the correct person; if there is no record for this person you should add it now (see Parties 
Module).

Request description: Any additional information about the request can go here (as on the 
Outside Request at a Glance form), such as a short but informative summary of the 
request. Please specify whether the scholar has provided proper ID #s or whether the 
RCMDD must search for them!!

Use of Collection: You will use 
this to record Museum Board 
approval or denial, again, only if 
the RCMDD is informed of this.

Collection Use Details: You will use this to record any other information about the request.
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• Go to the Request 2 Tab, and check 
the appropriate radio buttons, 
indicating what has been requested. 
This tab will also be used to track 
what has been received from the 
requester.

• If the requester is asking for the right 
to publish an unpublished object, 
this should be marked in the 
Catalogue Module for that object, in 
the Associations 2 Tab. In the 
Related Events section, Enter 
“Publication Rights Requested” 
under Relationship, and Link the 
Event Record to the Catalogue 
Record. If permission is granted, 
change the Relationship to 
“Publication Rights Granted.” Note 
that the right to first-time 
publication for recently excavated 
objects that are not yet published is 
retained by the excavator for a 
certain period of time; this should be marked in the Associations 2 Tab, under Related Parties 
(Relationship: Publication Rights; link to Parties).

• Put any extra information you want to keep track of and share in the Notes Tab.

35.2.3. Begin Manual Record

• Consult the Events module of the 
database, and assign the request the next 
OR event number, in this format: 
OR.YYYY.SN (e.g. OR.2009.14). 

• Fill out the first blank line on the Outside Requests at a Glance form:

Event #: e.g. OR.2009.78.

Title: This should be the name of the requester (Last Name_First Name), with a sequential 
number if they have submitted more than one request at any point (please check in the 
database by searching for the requester’s name in the Events module): 
LastName_FirstName_SN. eg. Hawass_Zahi_2 (note that the first request will not be 
followed by a number).

Date received.

Summary of request: this is important; keep it short but informative.

Head: Name of the department head overseeing the request.
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Assisted by: Name of the registrar, if there is one, who will take lead on assisting with the 
request.

• Begin a manual file for the new request:

Add the Event # and Name to the Outside Request Form.

File the Outside Request Form and hard copies of any correspondence in a plastic sheet, 
arranged chronologically from front to back (earliest in front, latest in back). The Outside 
Request Form should stay in the front of the sheet, to act as the cover sheet. Work on the 
request will be tracked manually here and digitally in the database.

File the plastic sheet alphabetically in the Outside Requests notebook by the scholar’s last 
name.

35.2.4. Begin Tracking Request (Tasks Tab)

You should track the request in the 
Tasks tab of the relevant event record.

Every step of the process must be 
recorded here:

• Open the Tasks tab in the relevant 
event record.

• Write a description of the task (e.g. 
Photographing objects).

• Fill in Assigned to - this is the person 
who will complete that specific task.

• Fill in Assigned by - this is the head responsible for the request.

• Fill in Commencement date - the date this task was given out.

• Choose No in Completion.

• Save the record.

• Once the task has been completed, the person completing the task should change No to Yes 
and add Completion Date.

You can have several completed and uncompleted tasks at the same time - to create a new task 
go to Tasks list in the bottom of the window, and click on a new row, underneath the latest one 
filled out. This will let you create a new task in the spaces above.

35.2.5. Add Objects

You now need to attach the objects for which information or photographs are being requested to 
the record. To do this:
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• Open the Objects Tab in the 
relevant event record.

• Type the ID Number into the first 
line. If the object is in the Catalogue 
Module already, it will automatically 
attach to the record. Otherwise, 
open the Catalogue Module. Do a 
search for each record you want to 
add, or search for a group. Attach 
the records by typing an ID number 
or title in the object field, then 
hitting tab.

• If the request includes first-time publication, remember to check the Associations 2 tab in 
each record to make sure the publication rights are not still with the excavator or have not 
been granted to a previous requester.

NOTE: A senior egyptologist should always check the object list against the request itself to make 
sure the right objects are there, especially if ID #s have not been provided by the requester. 

35.2.6. Process Request

The extent to which each request should be processed will depend on the type of request and the 
details of the request itself. All request processing should begin with an image (if possible) and 
location (through in situ inventory if possible) and then full cross-check of the object or objects 
associated with the request, as processing these requests provides an excellent opportunity for 
database cleanup. Make sure to track the status of the request in the database (in the Tasks tab).

• Cross-check and Inventory Objects according to the RCMDD’s usual protocols. The group 
should be added by the heads to the Group-Checking Checklist (see Checking Object 
Groups).

The head taking responsibility for the list has ultimate responsibility for the list set-up; they 
may delegate this to an associate registrar, but should indicate this in the DB record.

The head should also be responsible for final review of the report generated after the 
cross-checks and inventories are completed.

• After the group has been fully checked, if 
the request is for information only, an 
Outside Request Information report should 
be run and sent or given to the outside 
requester as a pdf.

• If the request is for images for publication, 
the RCMDD should coordinate with the 
museum photography department to have 
the necessary photographs taken (see 
Scheduling Coordination). The museum’s 
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photography department will give copies to the RCMDD, who will then send them to the 
requester. The RCMDD must make sure that there is a copy of the signed approval (signed by 
the Museum Director or the SCA Secretary General) for the request in the OR file before 
sending the images; if the request is for commercial publication, the RCMDD must receive 
written confirmation of payment before releasing the images. Any signed forms should be 
scanned and linked to the multimedia tab in the events module. Hard copies should also be 
filed in the manual system.
This process will be recorded in the Tasks tab in the database by making new entries to 
specify the steps, e.g.:

Request for images for publication received; 

Request passed on to the museum photographer; 

Images received from the museum photographer; 

Signed approval received from the Museum Director/SCA secretary-general; 

Confirmation of payment received [when needed]; 

Images sent to the requester.

• All reports and photographs should be filed properly in the computer system and attached to 
the proper event or object records.

35.2.7. Emergency Image Requests

Even when working with requests for images only (both reference and publication images) the 
RCMDD prefers to fully cross-check all the objects included and give out an informative list on 
pdf. However, in some cases the requester will only want photographs. In the past, this kind of 
request has often gone straight to the museum photographers via the Museum Director and 
requesters may have been given the images right after shooting. This policy is faulty in many 
ways: there is no guarantee that these images will make their way to the museum database, and 
there’s always the danger of misidentification of objects and wrong ID numbers being connected 
to them.

To avoid these problems, the RCMDD should work with the museum photographers even on 
requests of more than 20 objects, as long as the requester has gotten the required permissions 
from the SCA Secretary General. Ideally, the RCMDD should liaise between the photographer 
and the requester, getting images from the photographer, renaming them according to RCMDD 
protocols, doing full cross-checks on the objects, and giving them to the requester according to 
museum protocol. 

However, there have been and will continue to be instances in which a requester is given 
permission for a large number of photographs in a short period of time, involving more objects 
than the team has the time and resources to handle. In these cases, the RCMDD should simply 
get copies of the photographs, and process them whenever there is time.

Remember that RCMDD does NOT give out actual object information lists without having done 
full cross-checks on the objects. (Disclaimer lists should be used VERY sparingly.) If this does not 
happen with an image request of this kind, only the images will be given out.
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35.2.8. Follow Up

For requests involving object information, the requester should also be encouraged to give all 
relevant information or corrections directly to the RCMDD. This information includes new 
measurements, information about materials, more exact dating or provenance, etc.

The RCMDD will be responsible for getting 2 copies of commercial publications for which 
images are provided by the museum. One of these should be sent to the Zamalek Documentation 
Center.

The RCMDD should keep track of whether or not publications have been provided to the SCA in 
the database by creating an Alarm in the Events module, and asking it to notify the RCMDD on 
the appropriate date. ICal can also be used for this.

Note that any scholar or student not complying with the above guidelines will be prohibited from 
working in the museum again until such time as they have fulfilled their obligations to the 
museum.

35.2.9. Complete Request

When the request has been fully completed, mark the request “Completed” in the database and 
move the materials into a file folder in the OR drawer, filed alphabetically by last name.

Do not mark requests “Completed” until any publications owed to the SCA by the requester have 
been submitted. If everything has been completed but the publication has not been received, 
mark the request “Awaiting Publication” in the database. Then file just the cover letter in the 
"Awaiting publication" file at the back of the OR drawer. The rest of the material should be filed 
in the completed requests files, alphabetically (by last name). Make sure the title of the request is 
clearly written on the top right. The alarms should be set for a year after the request is completed, 
to remind the RCMDD to follow up to make sure that the publication has been received. For 
scholarly publications, check first with the Department of Foreign Missions to make sure they 
have not received the publications before contacting the requester.

When publications are received, record this in the database in the appropriate field in the Events 
2 Tab, and mark the request “Completed.” Make sure to enter the publication in the Bibliography 
module.
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36. Scheduling Coordination
In 2010, the Museum Director, with the support of the RCMDD, instituted a new system for 
scheduling committees within the museum. These committees can be for any purpose: object 
movement within the museum, into the museum, or out of the museum; scholar study; 
photography; loan and exhibition-related activities; or inventory.

The system is not yet functional, as the museum staff still does not plan ahead, and almost 
everything happens at the last minute. But this system can be activated at any time, once the 
museum begins to plan.

The following outlines the basics of the system.

36.1. Overview
The Museum Director (Dr. Wafaa El Saddik) had decreed that scheduling forms would be 
completed and signed for all committees, and a master schedule, to include the weekly 
schedules of all department heads and the dates, times, and relevant personnel for all committees 
would be kept posted in the curatorial offices. This procedure would assist with coordination 
between the various museum departments, and would allow events to be scheduled as efficiently 
as possible for all concerned. Unfortunately, this has not happened successfully, but should be 
kept in mind for the future.

Schedules for the following personnel will be tracked on the master schedule: the Museum 
Director, all heads from sections 1-8, the Head of Conservation, the museum photographer, and 
the heads of the RCMDD.

36.2. Scheduling Team
If this goes into effect, the master schedule for the EMC department heads will be maintained by 
Deputy Director Ms. Siham Abdel Razeq, with the assistance of the Associate Registrar for 
Movement. Nothing should be written on the schedule without the presence of a member of this 
team or their delegate.

36.3. Scheduling Forms
To ensure that everyone is properly informed, and that the committees suit the schedules of all 
heads involved, scheduling forms detailing the date, time, and purpose of the committee, will be 
filled out and signed by key personnel (including the head of security and the head workman) in 
advance. The scheduling team will be responsible for choosing a time that is agreeable to all the 
key personnel, and having them indicate their availability and agreement by signing this form. 
Copies of any additional materials, such as outside requests and relevant object lists, will be 
provided by the RCMDD to key personnel at their request.
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36.4. Master Schedule

The master schedule (with the 
days of the week horizontally 
across the top) will be printed on 
an A3 sheet; four weeks will be 
posted at all times outside the 
curators’ office. Posting the 
schedule will be the 
responsibility of the Associate 
Registrar for Movement. This 
schedule is to be filled out 
manually by the scheduling 
team. All department heads are 
responsible for informing the 
scheduling team of any plans that 
will affect their availability for 
committee work, including their planned working hours and any committees or activities they 
already have scheduled.

At the top of each master schedule will be the daily schedule for each department head. Below 
this will be the schedule for each day. Each entry on the master schedule will include: the time of 
the committee; the purpose; and the key personnel needed for the committee. This will be added 
to and modified as needed.
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37. Condition Reporting
Although the RCMDD does not do condition reports in an official capacity, the staff has been 
trained to do basic condition reporting, and will be doing condition reports as part of their 
Gallery Inventory work. The following are the steps to be followed when the RCMDD does 
condition reports.

Step 1: Get manual form

Blank Condition Reports are stored in the Blank 
Forms section of the filing cabinet; the RCMDD 
staff should also have blank Condition Reports 
on their clipboard at all times. The soft copy 
can be found on Ruby (Ruby->RCMDD-
ADMIN->Forms->RCMDD Forms-
>Condition_Report)

Step 2: Fill out object information

At the top of the form, fill out:

• Date

• Your name

• ID Number

• Title

• Current Location

• Number Check

Step 3: Write the condition report

 Look carefully at the object, and write down 
whatever you see and don’t see. Begin with 
general comments on the overall condition of the object. Then work systematically from top to 
bottom and left to right. Use terminology that is consistent and will be easily understood by the 
reader. You may sketch the object, along with any damage that you notice, on the blank form. You 
may also want to take condition photographs of the object, which you should process as usual. If 
you are doing a group of objects, write the image numbers on the line on the top of the form.

At the bottom of the form, indicate the Condition Status (Excellent, Very Good, Good, Fair, Poor) 
as well whether or not Conservation is needed.
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Step 4: Fill out the Condition tab in the 
database

Go to the Catalogue record for the 
object, and fill out only a few of the 
fields in the Condition tab:

• Condition Status (from the bottom of 
the form)

• Date Checked

• Checked by

Step 5: Scan the manual form, import it 
into the Multimedia module, and link it 
to the Catalogue record for the object.

Step 6: File the manual form

File the handwritten form in its object file. If there is no file, create one, and put the object on the 
list to have a catalogue card completed.
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Part VI:

Office Management
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38. Office Setup and Manual System
It is the job of the Associate Registrar for Office Management to make sure that the manual 
system, which is an essential backup and complement to the database system, is up-to-date, and 
that all forms and documents are filed properly. The following protocols outline the principal 
features of this system.

Current (as of March 2011) plan of the office shown below, soft copy can be found in Akhenaten-
>Ruby->RCMDD-ADMIN->Office_Renovation->Basement Office->Final Basement Plans-
>Basement_Plan_RCMDD.ai.
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38.1. File Cabinets

Described here are the principal contents of the file cabinets, which are labeled by cabinet and 
drawer.  

38.1.1. Office Administration Materials

File Cabinet 1 contains materials related to the administration of the office. 

• Drawer-1 contains official papers, including decrees, permissions, and memos.

• Drawer-2 contains blank forms.

• Drawer-3 contains information on supplies and equipment, including manuals and 
warranties.

• Drawer-4 has information on RCMDD staff, both current and past.

File Cabinet 2 contains materials related to the administration of the office.

• Drawer-1 contains files related to foreign volunteers. 

• Drawer-2 contains files related to Egyptian volunteers.

38.1.2.  Traveling Loan Materials

File Cabinet 3 contains all the materials related to pending, active or completed traveling loans. 

• Drawer-1 and Drawer-2 contain information on the pending and active loans (filed by date, 
most recent one first).

• Drawer-3 and Drawer-4 contain information on the completed loans (filed by Loan number).

File Cabinet 4 has been reserved for completed loans after File Cabinet 3 gets full.
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38.1.3. In-house Exhibition Materials

File Cabinet 5 contains all the materials related to pending, active or completed in-house 
exhibitions. 

• Drawer-1 and Drawer-2 contain information on the pending and active exhibitions (filed by 
date, most recent one first).

• Drawer-3 and Drawer-4 contain information on the completed exhibitions (filed by Exhibition 
number).

File Cabinet 6 has been reserved for completed in-house exhibitions when File Cabinet 5 gets 
full.

38.1.4. Completed Outside Requests

File Cabinets 7 and 8 contain all the materials related to completed outside requests (filed in 
alphabetical order, by requester’s last name). Active requests are stored in a notebook 
(Bookcase-6 - Shelf-2).

38.1.5. Object Files

Object files, consisting mainly of catalogue cards generated from the catalogue records in the 
database (and stored as pdfs in Akhenaten->Ruby->RCMDD-DOC->Permanent_Collections-
>Objects_Files) and relevant printed materials such as publications, are stored in a series of file 
cabinets. Most objects are filed by JE number (File Cabinets 9-19). However, if an object has no 
JE number, it is filed by CG (File Cabinets 20-24), then TR (File Cabinets 25-26), or finally by SR 
number (File Cabinets 27-28).

38.2. Bookcases
The RCMDD has a total of 7 Bookcases, which are used to store a variety of reference books, 
logbooks, and notebooks containing manual forms. 
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38.2.1. Register Books

Digitized and reprinted copies of the museum’s original JE and TR ledgers are stored in 
Bookcase-7. These may be accessed by anyone at any time, as long as the office is open. Outside 
researchers must sign the guest book. If a curator wishes to borrow a book, they must sign it out 
and indicate where it will be; it is preferable to keep these books within the office at all times, if 
possible. Included here is also JE XXV, which is inscribed by hand by the Associate Registrar for 
the Permanent Collections.

38.2.2. Logbooks 

Loan and Exhibition Logbooks, in which the Associate Registrars for Loans and Exhibitions make 
handwritten entries containing the basic information on these events, are stored in Bookcase-6 - 
Shelf-3. EDU Logbook is stored in Bookcase-7 - Shelf-6.

38.2.3. Notebooks 

Completed or in-process manual forms, stored in a series of notebooks, are stored in Bookcase-6. 
These include: 

• Movement log (forms filed by date) (Shelf-5); 

• Accessioning Notebook (filed by date, forms to be filed in object files after accessioning is 
complete) (Shelf-6);

• Outside Request Notebooks (for requests in process) (Shelf-4);

• Gallery Books (maps and current inventories for each gallery, in alpha-numerical order) 
(Shelf-2).

38.2.4. Reference Library

The RCMDD is developing a reference library for the use of the registrars and the curatorial staff. 
Most of these have been donated to the office by the ARCE project and by various scholars. 
Bookplates in the front covers identify the donors. The library consists primarily of Egyptological 
references (Bookcases 1, 2, 4, 5) and books that discuss registrarial and museum practices 
(Bookcase-3).

38.2.5. Loan/Exhibition Catalogues

The department is working to collect a full series of catalogues for loans that the Egyptian 
Museum has sent abroad, and for exhibitions that have been mounted within the museum. These 
are stored in Bookcase-2.

38.3. Clipboards

The RCMDD currently maintains two types of clipboards: personal clipboards and gallery 
inventory clipboards. The personal clipboards belong to individual registrars and are kept at their 
desks; the gallery clipboards are shared, and are kept in Bookcase-6 - Shelf-1.
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38.3.1. Personal Clipboards

Each registrar has a clipboard, on which they are responsible for keeping the following forms:

• Inventory Forms

• Photo Logs

• Movement Forms

• Accessioning Form

• Outside Request Form

• Blank Initial Condition Reports

• Clipboard Checklist

• Graph Paper

38.3.2. Gallery Clipboards

As the RCMDD carries out the Initial Gallery Inventory project (see Inventory for details), a 
clipboard should be created for each gallery that is under way. This should contain all relevant 
gallery, area, and vitrine maps, and inventory forms that are in process. The gallery clipboards are 
shared, and are kept in Bookcase-6 - Shelf-1.

38.4. Aprons

Each registrar should have his or her own apron, to be worn whenever he or she leaves the 
gallery for committee or gallery work. 

Each apron should contain the following supplies:

• 1 pair nitrile gloves

• 1 pair cotton gloves, clean

• 1 magnifying glass

• 1 pencil

• 1 eraser

• 2 pens

• 1 brush

• 1 flashlight

• 1 extra flashlight bulb

• 2 extra batteries

• 1 cloth measuring tape
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38.5. Office Inventory

38.5.1. Furniture Inventory

The office furniture should be inventoried by the 
Associate Registrar for Office Management once 
per quarter. An Excel file (Ruby->RCMDD-
ADMIN->Office_Management->Lists: Office 
Management.xls-Sheet 3) is used to track these 
inventories. Each piece of furniture should simply 
be checked, and notes about condition or other 
problems noted (and then followed up on).

38.5.2. Equipment Inventory

Office equipment should be 
inventoried by the Associate Registrar 
for Office Management once per 
quarter. An Excel file (Ruby->RCMDD-
ADMIN->Office_Management->Lists: 
Office Management.xls-Sheet 2) is used 
to track these inventories. Each piece of 
equipment should simply be checked, 
and notes about condition or other 
problems noted (and then followed up 
on).
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38.5.3. Supplies Inventory

It is important that the office maintains a steady 
supply of the materials it needs to carry out its 
work, such as pens, pencils, paper, and ink. 
These supplies are kept in a series of cabinets, 
storage units, and the large closet in the center 
of the office (the “Storage Room”), as detailed in 
Ruby->RCMDD-ADMIN->Office_Management-
>Lists: Office Management.xls-Sheet 1.

Supplies should be inventoried once a month, 
so that new supplies can be ordered BEFORE they begin to run low. As of March 2011, the 
procedure followed by the SCA for obtaining supplies is still unclear; these protocols should be 
added by the department heads as soon as possible.

38.5.4. Apron Inventory

Aprons should be inventoried by the Associate 
Registrar for Office Management once per 
quarter. S/he is also responsible of restocking 
them.
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39. Information Technology (IT) Protocols
This protocol covers all of the electronic devices in the office, primarily the server, the computers, 
and their peripherals. It also covers the network run through the server. The maintenance and 
upkeep of  devices and the network are the primary responsibility of the Associate Registrar for IT. 
This equipment has been purchased for the RCMDD by the ARCE projects, and remains the 
property of ARCE until the end of the projects.

39.1. Server (Goldfish) and Network (Akhenaten)

The heart of the RCMDD system is the server, Goldfish. This is an Xserve Quad Xeon with 300 
GB storage. The software on this computer allows it to share resources across the network. It is 
hooked up with an Ethernet cable to a router, which routes data to or from the server through 
additional Ethernet cables or a wireless connection (Wifi) information through the cables or the 
Wifi (wireless). 

The server should never be turned off; in case of power outages, it is hooked up to a UPS backup 
power source. It is the responsibility of the Associate Registrar for IT to liaise with the appropriate 
specialists to ensure that the UPS backup power source is working to prevent unexpected server 
close down. For server updates or any serious problems call an expert. Current IT Consultant (As 
of March 2011) is John Martin, john.d.martin.iii@gmail.com, tel. 0165585960.
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39.1.1. Server Maintenance and Troubleshooting

The server is connected with an Ethernet cable to a wireless base station (an Airport Extreme), 
and the office computers are in turn connected to the Airport, either with Ethernet cables (for the 
desktops) or with a wireless connection (the laptops). The wireless connection is called 
Akhenaten. This connection allows all authorized users on the network to access the database, 
the backup files stored in the hard drive (Ruby) that is connected to the Airport and the printers 
(which are also connected to the network through the Airport).

39.2. Internet

The RCMDD’s current (as of March 2011) Internet service is provided by TE Data (Helpline 
number: 19777). The telephone line attaches to the router directly. The desktop iMacs and PCs 
are wired directly to the router via Ethernet cables and network switches; the laptops use the Wifi 
connection (Akhenaten) broadcast by the Airport. The printers are connected to the Airport via a 
USB hub. This is a secure network, which means that you will need the password to access it. To 
log onto the internet, you must first detect the wireless network on your computer, and when 
prompted, enter the password. 

39.2.1. Troubleshooting

39.2.1.1. Connection Problems

Since the iMacs and PCs are connected to the Internet via cables, they are unlikely to have 
connection problems when the router is functioning correctly.

The wifi-enabled devices in the office (the laptops) connect to the internet via a wireless 
connection. When wishing to access the internet via this connection, the user must first identify 
the correct network (Akhenaten) and then enter the appropriate password (as given to you by the 
Associate Registrar for IT).

If your computer is unable to detect the wireless network, first check that you have 
turned on the Wireless Network Detector (on your menu bar): 

If your computer still cannot detect the wireless connection, try the following:

• Turn the Wireless Network Detector on and off.

• Try Network Diagnostics (it will walk you through the process).

• Restart your computer.

• Restart the router.

• Restart the main switch by unplugging it for 30 seconds.

• Check that the Airport is working.

If none of these resolve the issue, you need to contact an expert.
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39.2.1.2. Problems with Parallels

If, when using Parallels, you have trouble connecting to the Internet or 
database, check your network connection from within Parallels. When 
using a laptop you should have “Shared Networking” checked; if you 
are using a desktop computer you should have “en0: Ethernet Adapter” 
chosen. If you have something else checked, choose the correct one. If 
it is still not working, try disconnecting and connecting again. To choose 
the adapter, right-click this icon: 

39.3. Computers
The office currently has 9 desktop Macs, 5 Macbooks, and 5 PCs. As of March 2011, these are 
assigned as follows:

Computer Name Type Assigned to

Twix Macbook Head Registrar

Kinder Macbook Head of Documentation

Big Mac iMac Associate Registrar for Office 
Management

Ice Cream iMac Associate Registrar for Loans

Hommus iMac Associate Registrar for Exhibitions

Banana Cream Pie iMac Associate Registrar for Movement

Rocky Road iMac Associate Registrar for the Permanent 
Collections

Caramel iMac Associate Registrar for IT

Cheesecake iMac Assistant to the Heads

Moonlight iMac Registrarial Assistant

Key Lime Pie iMac Volunteers/Scholars

Cherry Pie iMac Volunteers/Scholars

Butterscotch Macbook RCMDD/Inventory

Huckleberry Macbook RCMDD/Inventory

Chocolate Macbook RCMDD/Inventory

Vanilla Macbook RCMDD/Inventory

Tart (RCMDD-1) PC Desktop Image Processing

RCMDD-2 PC Desktop Sections 1 and 2/Scholars
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Computer Name Type Assigned to

RCMDD-3 PC Desktop Sections 3 and 4/Scholars

RCMDD-4 PC Desktop Sections 5 and 7/Scholars

RCMDD-5 PC Desktop Volunteers/Scholars

39.3.1. Computer Maintenance

All of the computers need to be maintained on a regular basis. The schedule created for the 
frequent, regular check-up and maintenance of those computers allocated to visiting scholars 
must be adhered to at all times and they remain the responsibility of the Associate Registrar for IT. 

The responsibility for the regular maintenance, cleaning, appropriate storage and scheduled 
backing up of all the equipment as outlined below is the responsibility of the Associate Registrar 
for IT. The only exceptions are the computers assigned to individual registrars: every registrar is 
responsible for the maintenance, upkeep, cleaning and security of the computer and all the 
composite parts of the unit assigned to them. 

All the computer components, specifically monitors, keyboards and towers, are to be protected 
with dust covers whenever they are not in use.

A maintenance schedule should be posted on the wall of the office, with tasks checked off as 
they are completed.

Each computer should have the following carried out on a regular basis:

• Clean screen, keyboard, and mouse (at least once a month). ALWAYS use the correct 
materials -- never use anything except the computer cleaning cloth on the screen, and do not 
get anything too wet.

• Clean CD/DVD drives (at least once a month). There is a jWIN Laser Lens Cleaner CD stored 
with the drives in a separate cover.

Macs

• Run permissions (set up through ical to run automatically every Sunday)

Open the Disc Utility program, which is located in the "Utilities" folder of the 
"Applications" directory. 

Highlight your hard drive from the list and click on the “Verify Permissions” button.

After the verification is complete, click on the “Repair Permissions” button.

• Keep software updated. Users will automatically be alerted when new updates become 
available: These updates should be immediately implemented – this is done simply by 
clicking on the update alert and following the steps outlined until the installation is complete.

Note that unlike PCs, Macs do not generally benefit from defragging the hard drive; after 
installing updates and/or new applications, the system will optimize itself. Defragging the hard 
drive on a Mac is possible, but time consuming and unlikely to result in noticeable improvement.

PCs
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Unlike the Macs, the desktop PC computers have not been set up to automatically run 
permissions on a regular basis. These PCs are not regularly used and may remain turned off for 
long periods of time, with the result that regular and necessary maintenance is not carried out. It 
is the responsibility of the Associate Registrar for IT to ensure each of these PCs are regularly 
turned on, with updates run manually. At this point a virus scan should also be completed and all 
highlighted issues should be dealt with immediately. 

Unlike Macs, PCs generally benefit from defragging the hard drive at regular intervals. For a 
heavily used machine this should take place every six months. Defragging improves load times 
and can speed up your computer, particularly if you frequently download material. The steps for 
defragging the hard drive on a PC are as follows:

• Click the Start icon (or Windows symbol) – this is usually located in the bottom left hand 
corner of the screen.

• Select the “Control Panel” folder. In this, you should find a program which allows you to run 
the defrag. You may find it easier to find using search terms such as “hard drive defrag.” PCs 
with newer operating systems such as Windows Vista and Windows 7 are programmed to 
automatically defrag at regular intervals. If this applies, you will see an dialogue box to this 
effect if you try to start the defrag manually.

• Defragging the hard drive is likely to take several hours. Please be aware of this when you 
plan your defrag. 

The Associate Registrar for IT must ensure that these steps are carried out regularly according to 
the IT maintenance schedule and that the CD/DVD drive, keypad and mouse are cleaned without 
fail at least once each month on each computer, with the checklist marked off accordingly.

39.3.2. Computer Troubleshooting

If you have difficulty with your computer (for example, it becomes sluggish, or freezes), take the 
following steps:

• Make sure all cables are connected securely.

• Make sure you do not have too many programs open. Especially if you are running Parallels 
with the database, do not try to run a memory-intensive program like Adobe Photoshop.

• For Macs, run permissions and software updates.

• For PCs, update the software and run an antivirus scan.

• Check how much space you have in your hard drive. If you have less than half of your hard 
drive free, you will need to think about deleting things.

• Ask the Associate Registrar for IT for assistance. If s/he cannot solve the problem, s/he will 
contact the office’s IT consultant. [add hyperlink to contact info for IT person]
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39.4. Backup and Transfer Devices

The RCMDD has a number of external memory devices that are used to store backup files and/or 
transfer files from one computer to another. An overview of the contents of the backup drives is 
given here; see Computer Filing System for details of what files are stored on which drive.

39.4.1. Networked Drives

The office has two key backup drives that are accessed through the network. 

My Book Images 

My Book Images is a 1TR drive attached to the server (Goldfish). It contains backup files of 
images in the database; these include Object Images, Event Images, Condition Images, and LR 
Facsimiles.

Ruby (Active Files)

Ruby is a 320GB portable hard drive connected to the network through the Airport. It is 
accessible to everyone on the network and contains the Active files for the RCMDD 
documentation (RCMDD-DOC), collections management (RCMDD-CM), and administration 
(RCMDD-ADMIN). These include Office Management, Permanent Collections, Outside Requests, 
Traveling Loans, In-house Exhibitions, Labels and Panels, Library, Protocols, and IT. The material 
on Ruby is backed up on Licorice.

It is essential that all users store daily up-dated records of their work on Ruby, allowing access by 
others and also as a backup in case of a problem with a user’s personal computer.

39.4.2. External Hard Drives 

The office has both smaller portable drives and larger external drives. It is essential that these be 
kept at recorded and safe locations, so as to protect them from damage or theft at all times. 

Portable Drives

The portable drives are small drives that connect to the computer with a USB cable and do not 
need an external power source. There are currently ten portable drives: Ruby, Licorice, Salmiac, 
CG Storage, ARCE_3, Magic Carpet, EMu Backup 1, EMu Backup 2, RCMDD_1, and RCMDD_2. 

Name Content Location

Ruby

RMCDD Active Files: Administration, Office 
Management, Permanent Collections, 
Outside Requests, Traveling Loans, In-house 
Exhibitions, Labels and Panels, Library, 
Protocols, and IT

Connected to 
the Airport

Licorice Ruby Backup and LR facsimiles Cupboard 1
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Salmiac
Archival material for PM (HR, LR, PDF); CG 
manuscripts; RAW, LR; CG images, spreads, 
LR and the CG Position Book.

Cupboard 1

CG Storage Second backup for the material kept on 
Salmiac. Cupboard 1

ARCE_3 Filemaker Final Backup Offsite: ARCE 
Library

Magic 
Carpet ARCE Administrative backup; travel drive Various

EMu Backup 
1

Used for offsite backup of EMu database 
(SCA) (in turns with EMu Backup 2)

Cupboard 1/
Offsite: SCA 

Foreign Office

EMu Backup 
2

Used for offsite backup of EMu database 
(SCA) (in turns with EMu Backup 1)

Cupboard 1/
Offsite: SCA 

Foreign Office

RCMDD_1 File Transfer Cupboard 1

RCMDD_2 GEM Photos Cupboard 1

In addition to Licorice, five of the desktop computers are also used to back up the files on Ruby:

• Ice Cream: Traveling Loans

• Hommus: In-House Exhibitions

• Rocky Road: Permanent Collections

• Big Mac: Maps, Labels and Panels

• Caramel: IT.

It is essential that the files on Ruby are kept up to date.

External Drives

The external drives are larger in size and require an external power source. There are currently 
eleven of these: Freda D2, Freda D3, ARCE_1, ARCE_2, George, Leopold, Raja, Terry, Time 
Machine, My Book Images, and el-Guapo. Each drive has its own power cable and USB cables; 
for Terry, only the Firewire cable works. All cables should be clearly labelled.

Details of the contents, capacities and locations of the drives can be found in Ruby->RCMDD-
CM->IT_and_Database_Admin->Lists->Digital_Storage.xls. It is the responsibility of the Associate 
Registrar for IT to keep this document up to date.
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39.4.3. USB Mass Storage Devices

There are a number of USB Mass Storage Devices (more commonly referred to as memory sticks 
or flash/thumb drives) available for common use in the RCMDD office. They are stored in Storage 
Unit-2 - Drawer-3. The memory sticks are prone to pick up viruses, and should be scanned and 
cleaned at regular intervals to prevent the virus from being spread from one computer to another. 
Although these will not affect the Macs, they WILL affect the PCs.

39.5. Peripherals

The maintenance of office equipment includes peripherals such as printers, scanners and 
photocopiers. Since this equipment is shared among all the staff of the office, the responsibility 
for their maintenance and up-keep rests with the Associate Registrar for IT.

39.5.1. Printers

The RCMDD has two printers, both accessible through the network. Both are color printers: the 
Epson Stylus Photo 1280 is an inkjet printer; the Xerox Phaser 6120 is a laser printer. Getting a 
black and white laser printer from the SCA is a priority.

The Epson Stylus printer runs on 110V. Make sure never to plug it into a 240V outlet!!!

Problems with the printer can be addressed by following the guidelines from the user manual or 
from the manufacturer’s website. If problems do occur, before taking any other steps, first confirm 
that:

• All the cords are attached and there is a power supply to the printer.

• There are no paper jams. 

• There is sufficient ink – take care to buy cartridges specifically designed by the printer's 
manufacturer for the make and model of the printer (see above).

You may also wish to try turning the printer off and on again, and clean the printerheads by 
attaching a computer directly to the printer and running the check function. If none of these steps 
help, the Associate Registrar for IT should contact the manufacturer or a repairer (after getting 
authorization from the SCA).

39.5.2. Xerox Photocopier

The photocopier is a shared unit and as such is the responsibility of the Associate Registrar for IT. 
To use the photocopier, the user must first identify him/herself by inserting the appropriate code 
as given to you by the Associate Registrar for IT.

Problems with the Xerox most frequently result from incorrectly attached or loose cables, paper 
jams, or depleted ink. The screen on the side of the Xerox will detail problems and give 
guidelines on how to fix them – if the screen is blank, check the power source and cables, and 
make sure that the machine is turned on. If problems persist, an expert may have to be called in.
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39.5.3. Scanner

There is one scanner (Epson Perfection V750 PRO) in the RCMDD office, attached to one of the 
office PCs. This is used primarily for scanning slides and decrees.

In order to minimize the chance of tripping over leads and cords, the power cable for the scanner 
is kept detached from the power socket. The first step when scanning is to ensure the power cable 
is plugged in.

The scanner runs on 110V. Make sure never to plug it into a 240V outlet!!!

39.5.4. Cameras

The RCMDD office has one digital camera; ARCE has a second camera that is available, for now, 
to the RCMDD (when not being used by ARCE staff) until the RCMDD can get a second camera 
from the SCA. (This is to replace a camera provided by ARCE earlier in the project and stolen 
from the office -- a replacement for this was promised in 2009, and should be obtained as soon 
as possible.) Photos must be transferred immediately to the computers from either camera’s 
memory card, and appropriately labelled and stored, as per the Imaging protocols.

It is the responsibility of all of the registrars, but especially of the Associate Registrar for IT, to 
ensure that all batteries are charged, and that the cameras and tripod are returned immediately to 
the Storage Room in the center of the RCMDD office after use.

39.6. Cables and Cords

All the cables and cords in the office should to be regularly checked to ensure they are in good 
condition. In order to minimize the chance of accidents, which can result in injuries to staff or 
damage to equipment, cables should not be left loose or hanging, but should be taped to the wall 
and the floor. Cords and cables which are not in use should be rolled up and stored in the space 
allocated for the storage of electrical equipment (Cupboard-1).

39.7. CDs, DVDs, Software 
All CDs and DVDs are stored in Cupboard 1. These include blank rewritable CDs and DVDs as 
well as installation CDs for software for both Macs and PCs. The cupboard is to be kept 
organized, locked and secure at all times. The management of its content rests with the Associate 
Registrar for IT.
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40. Computer Filing System
A variety of documents, including blank forms used in the manual system; copies of decrees, 
memos, and reports; and backup copies of images and other object-related files, are kept in the 
computer filing system. This system is divided into Active Files, which are stored on Ruby and 
backed up on Licorice; and Archival Files, namely backups of material that has already been fully 
incorporated into the database, which are stored on other hard drives. For details, see Digital 
Storage (Ruby->RCMDD-CM->IT_and_Database_Admin->Lists->Digital Storage.xls)

40.1. Active Files
All active files are stored on Ruby and backed up on Licorice.

40.1.1. RCMDD-ADMIN

• Conferences and Presentations: Information about the Registrars Symposiums and Emu 
Conferences, and presentations given by the members of the RCMDD; and files related to the 
outside (non-ARCE) training provided to the RCMDD office.

• Decrees: Scans of all official decrees, organized by date and Event number and correlated to 
Event records in the database.

• Letterheads and Logos: Museum and office letterheads and logos.

• Memos: Office memos, organized by Event number.

• Office Renovation: Files and plans related to the old and new offices.

• Office Management: Files related to Office Management, such as supply lists and equipment 
inventories.

• Permissions: Different kind of office permissions (e.g. permission for RCMDD to let scholars 
use the Intranet, permission for RCMDD to map the basement, permissions to bring 
equipment into the museum, etc.).

• Personnel: Job descriptions; information on EMC and RCMDD staff members, scholars, and 
volunteers.

• Reports and Logs: Daily logs, weekly reports, and minutes.

• Forms: Blank digital copies of all the manual forms used by the RCMDD.

40.1.2. RCMDD-DOC (Documentation):

• Database Population: Files related to cross-checking and  JE/CG/TR/SR transcription tracking.

• Labels and Panels: Contains final label and panel files.

• Outside Requests: Files related to outside requests, organized alphabetically by last name of 
requester.

• Permanent Collections: Files related to the Permanent Collection, such as gallery maps, soft 
copies of inventories and catalogue cards, and files related to accessioning.

• Library: Contains Digital Library and Bookplates.
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• Non-SCA Databases: Object databases with information on EMC objects; usually created by 
and received from outside scholars.

40.1.3. RCMDD-CM (Collections Management)

• In-House Exhibitions: Files connected with In-house Exhibitions, including lists, forms, and 
other related materials. This is a backup of the system kept on Hommus.

• Traveling Loans: Files connected with loans sent abroad, including lists, forms, and other 
related materials. This is a backup of the system kept on Ice Cream.

• IT and Database Admin: Files related to IT such as software and digital storage lists, and files 
related to database admin such as Crystal Reports, Import Tool and Authority Lists.

• Protocols: Archival copies of old protocols; digital version of current protocol.

40.2. Archival Files

These are located in various drives, as outlined here and detailed in the Digital_Storage.xls 
(stored in Akhenaten->Ruby->RCMDD-CM->IT_and_Database_Admin->Lists).

40.2.1.  Facsimile Files

• JE Files: Raw photos, Spreads, LR facsimiles; Indesign layouts, and pdfs.

• CG Files: Spreads, LR facsimiles; and pdfs. (Note that this set is not yet complete.)

• TR Files: Raw photos, Spreads, LR facsimiles; Indesign layouts, and pdfs.

• SR Files: Raw photos, Spreads, LR facsimiles; Indesign layouts, and pdfs.

• PM Files: Spreads and LR facsimiles.

40.2.2. Image Files

All backup copies of images are stored on My Book Images, which is connected directly to the 
server, and can be accessed through the network. My Book Images is divided into the following 
subfolders:
• EMS_Object_Images: All backup copies of object images are stored on My Book Images-

>EMS_Object_Images in a series of folders called EMS_IMAGES_SN_YEAR. A new image 
folder will be started each year; the current folder is therefore EMS_Images_4_2010. The IDSC 
scan project is stored in a separate folder within EMS_Object_Images, called IDSC_Scans.

• Event Images: Backup copies of photographs of events, incidents, and activities. 

• Condition Images: Backup copies of photographs relating to Condition Reporting.

• LR Facsimiles: All backup low-resolution copies of facsimiles, e.g. digitized images of register 
books or CGs, are stored in this folder.

40.2.3. Database Backups

• EMu Database Backup: The KE-EMu Database has two backup systems: automatic and 
manual.
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  The automatic backup: KE EMu is backed up every hour automatically by the Time 
  Machine software to the Time Machine hard drive, which is connected directly to 
  the server.

 Note:  Time Machine saves the backups until the hard drive is full and then it will 
 start replacing the oldest ones with the new ones.

  The manual backup to be stored offsite: Offsite backups are organized according 
  to a rotating system. The Associate Registrar for IT Registrar is responsible for doing 
  the backup on a portable hard drive (EMu Backup 1 or Emu Backup 2) monthly, on 
  the second Sunday of each month. After the backup is finished, the portable hard 
  drive should be taken immediately to the SCA’s Foreign Office in Zamalek, and 
  replaced with the portable hard drive that contains the previous month’s backup.

 Backup Procedure:

Step 1:  Connect the drive (EMu Backup 1 or 2) you are going to use for the  
 backup to your computer.
Step 2:  Finder -> Go -> Network -> Goldfish.
Step 3:  Connect as registered user (with your database username and  
 password).
Step 4:  Open MyBook Backup Dump folder (Goldfish->MyBook Backup Dump).
Step 5:  Drag the (YYYY.MM.DD_offsite_backup file) and drop it into the  
 connected backup drive. 

• Filemaker Final Backup

  Final Filemaker backups are stored offsite in the ARCE Library (ARCE_3 portable 
  hard drive) and in the RCMDD office (Terry external hard drive).
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Part VII:

Administration
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41. Search and Replace (Global Replace)
The Search and Replace tool is a very efficient way to modify large numbers of records at the 
same time. However, this is a very powerful action, and must be used extremely carefully. You 
would use this, for example, if you want to change all instances of the incorrect spelling 
“amulette” in the title field to the correct “amulet,” or to change the Object Status of many 
records at once.

Note that you have to be careful with the hierarchy fields, in which all levels must be correct. For 
example if you want to change source details you can only replace provenances that are within 
that specific hierarchy; i.e. for an object with the provenance Memphite Region>Saqqara: 
North>Pyramid Complex of Djoser>Courtyard you can replace Courtyard with Pyramid, South 
Tomb, etc. but cannot replace Pyramid Complex of Djoser with Dahshur North as it belongs to a 
different hierarchy (Memphite Region>Dahshur>Dahshur North).

Note: A global replace is not possible on the  Dating hierarchy, since it is a user ordered look up 
list. Essentially EMu was never designed to do this. User ordered lists are implemented through 
client logic, but a global replace is implemented in the server and by definition it bypasses all 
client logic. This means that it updates the value in the King field but has no knowledge that the 
Sort Order field is related, nor even how to update it.
To use this tool:

Step 1: Search for records

Search for the records you want to correct. MAKE SURE YOU HAVE ONLY THE RECORDS YOU 
WANT TO CHANGE IN YOUR FOUND SET, OTHERWISE YOU WILL CHANGE MORE THAN 
YOU  WANT TO!

You can also fill in blank fields with this. Use ^$ as the wild card for blank space.

Step 2: Replace text

• Go to Edit in the Menu bar and 
select Replace (Edit>Replace). A 
small window opens. To specify 
your Replace criteria, click on New 
in the lower left hand corner or on 
the page icon in the top left corner. 
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• In the Substitution window that 
appears, choose the field that contains 
text you want to correct from the drop 
down list. The ‘Type’ field shows 
whether the field in question uses text 
or integer (number) values. Remember 
to tick Regular expression always when 
the type is Integer, otherwise the global 
replace will not work.

•Type the text/number (e.g. “Amulette”) you 
want the database to search for in the Text to 
Find field.

•Type the text/number with which you want 
the database to replace the previous data (e.g. 
“Amulet”) in the Replace with field. Click OK 

• Select your new Substitution in the 
Replace window and click Replace All. 

Step 3: Check your results

A progress bar appears telling you how many 
records have been modified and the 
percentage that has been completed. Click 
OK when it is done.

NOTE: If you choose to replace something in a field that is 
attached to another module, a green + will appear next to the 
‘Text to Find’ and ‘Replace with’ fields. When you type 
something in these fields, the associated module will open so 
that you can search for your record and attach it.  When you 
have found the correct record, click OK as before. Note that 

the Type field will say integer, and the result will show as an integer, whether or not it really is!  
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Example: Replace American Research Center in Egypt with ARCE (American Research Center in 
Egypt)
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42. KE EMu Registry
The KE EMu Registry module can be used to modify settings in the database for specific users or 
groups, and can also, to some extent, add and remove certain features. For example, through the 
Registry, the Administrator can select what tabs to display in a module, what fields a user is 
allowed to edit and what type and size of images to display in the database. 

The Registry and its functions are detailed in the KE EMu Help and should be consulted for more 
advanced modifications. Below are guidelines for only the most common uses of the registry.

42.1. Overview
From the Control Centre, open the Registry 
module. It will open in Search mode, with the 
Registry and Admin tabs visible. From the 
Registry tab you can search for existing 
Registry entries. These specify a setting that 
defines access permissions, functions or 
display options to be applied to individual 
users, groups or the entire system. 

You can search by Key, Value, or Owner.

Value: The core of the Registry is the value, 
which is the setting (a permission, condition 
or value) you are specifying for a particular user or group of users, and/or for a particular module, 
tab, field, etc.

Keys: The Registry is organized in what are basically levels, which are called Keys. When you are 
creating or editing a Registry record, you will work from Key 1 down, through as many Keys as 
you need (up to 10). The Keys define the specific target for your Registry value, i.e. the condition 
that should be met for the value to be applied. 

Levels: This field defines how many Keys are filled out for the value.

Owner: The owner field specifies the creator of the registry entry.

42.2. Terminology and Codes
It is important to understand the terms that the Registry uses for the elements of the database. The 
most important are that instead of Module, the registry uses the term Table; instead of Field, the 
registry uses the term Column. There are also some basic codes that are used to define values; an 
overview of these is given here.
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Tables: The names of the Tables are very similar to the Module 
names, but an “e” is always added before the name, which is not 
capitalized; e.g. ecatalogue. Here is a list of Table names.

Columns: The Column names are similar to the Field names 
visible in Display mode,  but are written as one word and often 
abbreviated; e.g. NamPartyType  for the Party Type field in the 
Parties Module. To find the proper name for a Column on a PC, 
use KE Emu Field Help by placing the cursor in the database field for which you want the name 

and press F1. On a Mac or PC, click the Field Help button  and then click the field you 
need.

Codes: The following codes are the ones you will use the most often when creating values 
(settings or commands):

All - prefix indicating Insert mode (Tabs).

Qry - prefix indicating Search mode (Tabs).

du - Privilege to Update (Column): prefix to indicate the command will work in Insert 
(update) mode.

dv - Privilege to View (Column): prefix to indicate the command will work in View mode.

da - Operational Privilege ("Privilege to do") (Table).

42.3. Creating a Registry Record

To create a Registry entry you have to select a series of key entries from the attached look up lists 
and type a value in the Value field as in the example below.

The record illustrated here specifies that the 
lookup lists in all the tables are “read and 
write” for the Admin Group.

The chart below describes the Key levels that 
you might work through in creating this 
record, and gives examples of the various 
choices that can be made at each level. There 
are dropdown lists available at each Key level.
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Field Name Lookup Entries (examples) Description Notes
Key 1 User

 

Group

The value will apply the 
setting only to a specific 
user

The value will apply the 
setting to a specified group

Choices available in a drop-
down list.

Key 2 Default 

skayser

Registrars

The settings will apply to all 
users and groups, unless 
otherwise specified 

You can choose one 
specific user to apply the 
settings to

You can also choose one or 
more? group the settings 
should apply to

All users and groups can be 
found in the drop-down list

Use this if you have chosen 
User in Key 1. Choose 
username from the drop-
down list. 

Use this if you have chosen 
Group in Key 1. Choose 
Group name from the drop-
down list.

Key 3 Table Access (see 43.5.1) Table=Module Choose Table if you want to 
create registry entry in a 
specific module
Choose Table Access when 
you want to define what 
modules certain users 
should have access to.

Key 4 ecatalogue

eparties

etc.

Name of Table You can either choose the 
specific name of the Table, 
Field, or choose Default 
here if you want the same 
settings to apply to all 
Tables.

Key 5 Operations (see 43.5.2)

Tabs (see 43.3.2)

Insert Tab Order (see 43.4.2)

Insert Defaults Selected (see 44.1)

Column Access (see 43.5.2)

Lookup (see 43.5.2)

etc.

Type of setting You will find that there are 
many options for level 5 
depending on what type of 
entry you are creating.

Key 6 LocCurrentLocation

etc.

Column Name
Column=Field

For the most part, only used 
when you have Column 
Access or Lookup in Key 5

Values duInsert; duQuery; duReplace

etc.

Operation privileges 
specified for the user

Values can be a Name of a 
Registry entry, a list of Tab 
names, a list of operations, 
etc. 
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42.4. Working with Tabs

The default in KE EMu is usually to display all Tabs in all Modules, but a record can be created in 
the Registry to hide Tabs that are not being used or that you prefer certain users not to see. For all 
tabs to be visible the word All should be the Value in the Value field. Otherwise, you can specify 
tabs to be displayed (+) or hidden (-). Tab names can be found in the KE Emu Field Help, in the 
Column Info Tab.

42.4.1. Displaying and Hiding Tabs

Tabs that are displayed while in the Display, Insert or Edit mode begin with the word All followed 
by the Tab name and the word Tab; e.g. AllOrgTab, while the Tabs that are displayed in the Search 
mode begin with the letters Qry (for Query) followed by the Tab name and Tab, e.g. QryOrgTab.

To specify which tabs will be visible:

• Create a new record in the Registry.

• Select Group or User in level 1.

• Enter the name of the user or group (or Default if you want the same settings for everyone) in 
level 2.

• Select Table in level 3.

• Enter the Table name of the Module in level 4.

• Enter Tabs or select from drop-down list in level 5 and

• Enter Default in level 6.

• In the Value Field, enter the Tab names of the Tabs that will be visible.

There are several different ways to list the Tabs to display or hide:

• List each Tab to display when in both the Insert and Search modes, e.g. 

AllXxxTab

QryXxxTab

• Type –All to hide all the tabs, and list the specific tabs you want to see with +, and All for 
Insert and Qry for Search:

-All

+AllXxxTab

+QryXxxTab

+AllWwwTab

+QryWwwTab

Etc.

RCMDD Protocols 12-2010  334



• Type All to list all Tabs available for the Module 
and indicate which of these Tabs are not to be 
displayed:

All

-AllXxxTab

-QryXxxTab

Etc.

42.4.2. Setting Tab Order

In some Modules there may be Tabs that 
are used more often than others. To make 
access to these easier, a Registry record 
can be created to switch the order of the 
tabs, so that the most commonly used tabs 
are first. This can be done by and for 
individual users, or for groups, or as 
default settings. To do this:

• Create a new record.

• Select Group or User/Name of Group or 
User/Table/Name of Table/Insert (Query) 
Tab Order/Name (name of registry entry).

• In the value field, enter the names of the Tabs in the order you want them. If you are only using e.g. 
five tabs and the Module has 11, you only have to enter the five you are using and arrange them in 
order. The order of the remaining tabs will stay the same. 

To apply this order to a group or user, you 
have to create an “Insert/Query Tab Order 
Selected” record.

• Enter values for the first 4 keys as above.

• In level 5, type Insert/Query Tab Order 
Selected.

• In Value you enter the name of your Insert 
Tab Order record (in this example, Sara).

RCMDD Protocols 12-2010  335



42.4.3. Tab Switching

In some Modules you may want to display a 
different order of tabs depending on a certain 
criteria; e.g. in the Events Module, different tabs 
may be used for different types of Events. An 
important example in our database is that the 
Sculpture tab in the Catalogue module only 
appears when Sculpture in the Round is selected 
in the Category.

A Registry entry can be created to switch 
between different Tab orders. 

• In the new Registry record, select Group in 
level 1.

• Enter the name of the Group in level 2.

• Select Table from the drop-down list in level 3 (or type it in) and

• Enter the Table name of the Module you want to create an entry for in level 4.

• In level 5, select Tabs from the drop-down list and 

• Enter the name of the Column that defines the tab switching; e.g. EveTypeOfEvent in level 6 and

• Finally, enter the values in the tab-switching field that will define the tabs to display (as above), i.e., 
enter the names of the Tabs to be displayed when the Value entered in Key 7 (in this example) is 
selected. 

42.5. Defining User and Group Access Permission

There may be occasions where you would want to restrict certain users’ access to a Module or 
fields, e.g. volunteers do not have access to the Look-up Lists Module,  or do not have Delete 
privileges in the Catalogue Module. 

A range of privileges can be defined in the Registry. The most common are described in the 
following section.

42.5.1. Table Access:

To define which Modules users have access 
to (the default being all Modules) you can 
set up a Registry entry with access 
permissions for a group or individual users.

• Open the Registry Module and create a 
New Record.

• Select Group/User from the drop-down list 
in the first level (Key 1)

• In the second level, type or select from 
drop-down, the name of the user or the 
group you want the permissions to apply to.
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• Select Table Access from the drop-down list in the fourth level

• Then type the names of all the Modules you want to give the user or group access to in the Value Field 
to the right. 

• The new Registry setting is now complete, so you can save and close the Registry Module. 

42.5.2. Operational privileges:

Once access to the different Modules have been defined, permissions for specific operations 
within the Modules can also be specified; e.g. registry entries defining who can Delete records, 
or edit Lookup lists.

• Open the Registry Module and create a New Record.

• Select Group/User from the drop-down list in the first level (Key 1).

• Enter the name of the group or the user in level 2.

• Select Table from the Drop-down list in level 3.

• Select the Table name for your Module from the drop-down list.

• In level 4, type Operations (or select from the drop-down list if already there).

• In the Value field, specify what privileges you want to give your group or user according to the 
list below.

Type of Access Description
daQuery Search the Table
daDisplay Display records from the Table
daEdit Edit records in the Table
daInsert Add new records into the Table
daDelete Delete the records from the Table
daReplace Run global replacements or global edits
daDefaults Define their own sets of default values and 

change the set of default values currently 
used

daDesign Create new reports
daEditQuery Edit the search criteria of the previously run 

search in texql format
daEditHelp Edit the field level description
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Example: Give all groups the privileges to 
Search, Display, Edit, Add new records, and 
run reports from the Bibliography Module:

To define access to specific fields, or 
Columns, you create a Registry record similar to the one above but with operational privileges for 
specified Columns.

• Create a new record in the Registry Module.

• Select Group or User in from the drop-down list in the first level (Key 1).

• Type or select the name of the Group or User in level 2.

• Select Table from the drop-down list in level 3 and 

• The name of the Table in level 4 (or Default if you want the privileges to be the same for all 
Modules).

• In level 5, enter Column Access (or select from the drop-down list) and 

• Enter the name of the Column in level 6 (or use Default if you want the same privileges for all 

Columns). Use Field Help  in the field in the database to find the Column Name. 

• In the Value field, specify what privileges you want to give your group or user according to the 
list below. 

Acess Type Description
dvDisplay Column can be viewed when displaying matching records
dvEdit Column can be viewed when editing records
duEdit Column can be updated when editing records
dvInsert Column can be viewed when inserting new records
duInsert Column can be updated when inserting new records
dvQuery Column can be viewed when entering query terms
duQuery Column can be updated when entering query terms
duReplace Column may be used for global replace or edit
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Example: In this example, the Admin 
Group is being given updating and 
viewing privileges for the Catalogue 
module in the LocAcceptedBy Column 
(field).

 

             

42.6. Setting up Default Values
The Registry can be used to set up default values that display in a field when a new record is 
created or when starting a search. Using default values saves time during data entry and ensures 
that certain fields are filled out. Users can set up their own default values for a module and 
Admin users can create default values for all users. 

To set up default values:

• Open the module in which you want to set up the 
values.

• Stay in Search mode if you want default values to 
be displayed when you search or select New 
record if you want your values to display when a 
new record is created. Here we are creating a 
new record.

• Enter the values you want in the field where you 
want them and go to Edit>Default Values>Set As 
Defaults
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• A box will open. Start by giving the setting a name, e.g. Default All, Entry Default, and make sure the 
values you want to appear are in the list.

• When you are happy with your selection go to the Security tab. Add everyone and then click OK.

• Go to Edit>Default 
Values>Change and 
select your new settings 
in the default box. 

Next you have to create an entry in the Registry to set your default values as a default for all 
users.

• Open the Registry module and create a new record.

• Enter the following:

Level 1: ‘Group’

Level 2: the name of the group (i.e. ‘Default’, ‘Admin’, 
‘Registrars’ or ‘Volunteers’)

Level 3: ‘Table’

Level 4: the name of the module (e.g. ecatalogue, 
eparties, emultimedia)

Level 5: ‘Insert Defaults Selected’ or ‘Query Defaults 
Selected’

In the Value field, enter the name of your new setting, e.g. Entry Default

• Save.
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42.7. Look-up Lists Privileges

There may be look-up lists in KE EMu 
that you want to restrict users from 
being able to add to, e.g. in order to 
maintain the current list or to ensure 
there are no misspellings, etc. In the 
Registry, you can create a record 
defining whether a group/user has read 
only privileges or read/write privileges.

• Select Group or User in level 1.

• Enter name in level 2.

• Select Table in level 3.

• If you want the permissions to be 
the same for all look-up lists in all Modules, select Default in level 4.

• Select or type Lookup in level 5.

• In level 6, Default or the name of the column.

• In Value, type either readwrite for full permission or readonly for restricted permission.
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43. Lookup Lists Module

43.1. Overview

The Lookup Lists module is for searching, editing and adding 
values to all the Lookup Lists in all the modules. 

43.2. Important Fields in the Lookup 1 Tab (other tabs have no fields we need to 
use)

1. Lookup List Name

Correct name for each lookup list can be found like this (works in every module): click the Field 
Help Icon and then click the Lookup List field. Alternatively you can use the Lookup List Name 
dropdown list in the Lookup Lists Module and select a value from it.
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2. Persistent

Always choose yes (except before deleting a record).

3. Hidden

Always choose no (except before deleting a record).

4. Sort Order (only used in Dating Hierarchy)

5. Values

Type in values from lookup lists hierarchically. 

43.3. Adding New Values to a Lookup List

There are two ways of doing this. In both examples below, Subcategory 2 ‘Bowl/Cup’ will be 
added under Category ‘Foundation Deposit’ – Subcategory 1 ‘Model Vessel’.

43.3.1. Adding a value directly to the lookup list in a specific module

The easiest way to add new value to a lookup list is just to add it directly to the lookup list you 
need it to be added to.  

1. Open the record in which you want to add this new value.
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2. Choose correct Category and Subcategory 1, and then type Bowl/Cup in the Subcategory 2 
field.

3. Save the record

Note: When saving, the database will ask if you want to insert this new value to that specific 
lookup list. 

Choose yes and the new value will be added to the Lookup Lists Module right away.

4. If you want your value to be persistent in the lookup list, you will need to go to the Lookup 
Lists Module and find your record. Choose ‘yes’ in Persistent field in the record, otherwise this 
new value will disappear from the lookup list if not used.

5. Search for the record in the Lookup Lists Module. Choose correct Lookup List Name and 
Values.

6. Correct value record will open. Choose Persistent ‘Yes’ and save record.
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43.3.2. Adding a Value to a Lookup List Using the Lookup Lists Module

1. Create a New record by clicking the new record button or choosing File->New Record.

2. Enter the name of the Lookup List in the Lookup List Name field.

3. In the Persistent field select ‘yes’ and in the Hidden field select ‘no’.

4. In the first Values field type Object Category value (Foundation Deposit), in the second field 
Subcategory 1 value (Model Vessel) and then in the third field Subcategory 2 value (Bowl/Cup). 
Make sure to spell everything correctly! 
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5. Save the record and your new value can be seen in the Catalogue Module Object Category 
lookup list.

6. Alternatively, you can also create the new record by using the Ditto function; this helps you 
avoid spelling mistakes that would mess up the list. Search for Foundation Deposit – Model 
Vessel in the Lookup Lists module. Make sure the record you find is correct, create a new one 
and ditto the record you’re using as the model. Replace subcategory 3 with ‘Bowl/Cup’ and save.

43.4. Editing a Value in a Lookup List
1. Find the value you need to edit from the lookup list from the module where the list exists. 

2. Search the Lookup Lists Module for the Lookup List using the Lookup List Name field, and if 
possible specify the values you need. 
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3. The record for the selected Lookup List value opens.
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4. Make changes as necessary by overwriting existing values.

5. Save the record.

6. Go back to the module where your lookup list exists and search for all the records with the old 
value. Replace all these values with the new value.

7.  Search for all the records with the old value.

8.  Replace the old value with the new value either by search and replace (if many records) or 
just changing it by hand in each record.
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9. All the old values should now be replaced with the new values.

43.5. Deleting a Value in a Lookup List

1. Search for the value you want to delete in the lookup list in the module where the lookup list is 
used (here: Catalogue Module).

2. Search in the Lookup Lists Module for the Lookup List using the Lookup List Name field and 
value.
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3. The record for the selected Lookup List value displays.
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4. Go back to the module where the lookup list exists and replace the value with a new one or 
an empty one. Use Search and Replace for multiple records.

5. Go back to Lookup Lists Module and the record you need delete. 

Note: Before deleting the record from the Lookup Lists Module, select ‘Yes’ in the Hidden field 
and ‘No’ in the Persistent field. 
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This will allow records that use the value to be found when this value is used in a search, but will 
prevent users selecting this value when entering a new record. The value will still display in the 
Lookup List until a Lookup List rebuild has taken place. (This should happen every night).

6. Delete the record. Go to File->Delete->Current Record.

43.6. Dating Hierarchy

The Dating Hierarchy is a Lookup list but works by sort order numbers. This is the only lookup list 
that works by these numbers. Sort order numbers are added to the values for database sorting 
purposes. This is also the only lookup list that KE EMu is responsible for. The list exists in the 
server, and any editing or deleting needs to be done by KE EMu Staff (currently James Byrne (as of 
March 2011)). A global replace is not possible on the Dating hierarchy, since it is a user ordered 
look up list. Essentially EMu was never designed to do this. User ordered lists are implemented 
through client logic, but a global replace is implemented in the server and by definition it 
bypasses all client logic. This means that it updates the value in the King field but has no 
knowledge that the Sort Order field is related, nor even how to update it.

In the Lookup Lists module there is currently a complete list of records, which was taken from a 
spreadsheet provided by the RCMDD. This includes all periods, dynasties, kings, and absolute 
dates. Every one of these value records has a sort order number.   

1.  For example search for all the Dynasty 19 Kings. Choose correct Lookup List Name, and 
value.

2. All the search values will display. 
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3. You can sort these records with sort order numbers.

RCMDD Protocols 12-2010  353



44. Creating and Editing Crystal Reports
The easiest way to present information from the database is through the reports attached to the 
database. These are done in a software called Crystal Reports. The following protocol reviews 
how to Create or Edit a report using this software.

To create and edit reports in KE EMu, you have to be logged in as reportuser. The password is also 
reportuser.

44.1. Setting up the Report
Set up your report in KE EMu:

1. Open the module you want to use for your report and select some objects to be reported.

2. Click on the Report icon  to open the 
Report box or go to Tools>Reports.

3. Select New to open the Properties box.

4. In the Report Type tab in the Properties box, enter a title for your 
report and select Crystal Reports in the Type drop-down list.
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5. Go to the Fields tab and click 
on Add to select fields you 
want to add to the report. A 
new box is displayed, 
containing all the available 
fields. 

Select the fields you want 
(some fields are tricky to find 
so you may have to go to the 
fields you want in the database 
first and press F1 to find the name) and click on Add. 

Note 1: The fields in the box are different depending on which Module you are in. So if you are in 
the Catalogue module, the main fields displaying are those you will find there; e.g. Title, 
Provenance, Dating, etc. To select fields from other Modules (this includes everything that attaches 
to your main Module (Multimedia, Parties, Bibliography) you can click on the + next to these. If 

the module you want is not available in the list, you can click on the icon.     

Here is a list of the most common fields that can be tricky to find: 

Multimedia:

+ Identifier (Resource Information): Multimedia (for the image), Creator (for the photographer).

Bibliography:

+ Bibliographic References: Summary Data (Note that the page number field, Bibliographic Notes, 
is a Catalogue field!).

Locations:

+ Current/Permanent Location: Summary Data.

Note 2: When you are in a Module other than the 
Catalogue, and you want to add fields from this, 
you will find them under Object: (Object Details). 
Likewise, you will find Event fields under Events in 
the Catalogue module list.

Note 3: Make sure that you select the correct 
measurement fields! i.e. Width (Measurement 
Details). 
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6. When you have selected all the fields you want to use in 
your report, there are a number of things that you can do to 
make the creation of the report easier and other things that 
have to be done for the fields to display properly. 

Note 4: If you are using the ID Numbers, the Creator, or the 
Materials fields, select Set Table as Text by clicking on the 

icon. This will ensure that all data in this field is 
displayed together. 

Note 5:  Group fields to make it easier to locate them in CR, 
or to use them in a sub-report (see below) e.g. Measurements, 
Provenance, Dating, Bibliography. Select a field you want in a 
group and click on the Group icon. 

Name your group appropriately. To add other 
fields to your group, just select them and click on the + Group  
icon. 

Note 6: Change the name of your Summary Data fields to 
distinguish between them in CR, e.g. CurrentLoc for Current 
Location.

Now you should be done with the fields tab.
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7. To ensure that only the first image is displayed, go to the 
Multimedia tab in the Properties box, and select First Image only 
(this is the default so it should already be marked). Set the 
Resolution to H 100 W 100 (first delete space then type).

Click OK and run your report.

8. When you run your new report in KE EMu, you will get a message asking if you want to create a 
new report. Click Yes. This will open Crystal Reports.

44.2. Design a report in Crystal Reports (CR)

1. On the Start Page in CR, select Standard 
Report Wizard and in the box that opens, click 
on the + next to Create New Connection.
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2. In the list that opens, click on the +  next to 
ODBC(RDO). In the window that opens, click 
on the Module you are using (i.e. EMu 
Catalogue, EMu Events) and then on Finish.

3. Select the Data you want in your report from 
the list. If you want to use all the fields, select 
the whole EMu folder (i.e. EMu Catlogue, EMu 
Loans) and click on the double arrows to add it 
to the Selected Tables field.  Click on Finish. 
This will open your report. If it opens in the 
Preview View, you’ll need to go to the Design 
View to add fields to your report. 

4. Format your report before you start the design: 
Go to File>Page Setup if you want to change your 
report to Landscape and set A4 as paper size (if 
this is not already the default on your computer). 
For A4 paper, set the margins on a portrait report 
to 0.193 inches (4.9 mm) and on a landscape 
0.160 inches (4.03 mm).
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5. Next, insert additional Details sections 
(section names are displayed in the gray 
column on the left-hand side of the screen) 
into your report: go to Report>Section 
Expert or right click in a Section in the gray 
column and select Section Expert from the 
list. Select Details and click Insert until you 
have as many sections as you need. If you 
don’t need anything to be placed in the 
Report or Page Headers, select Suppress 
(No Drill Down) for these. This ensures that 
these fields do not take up space in your 
report. 

6. Select Details and 
mark Keep Together to 
ensure that all the data 
for one record stays 
together on one page. 
Close the Section 
Expert.

7. Next, click on the plus next to the Database Fields box in the Field Explorer (to the right of the 
page. If it is not there, go to View>Field Explorer) to expand it and see your fields. To add a field to 
the report, 
click on it 
and drag it 
onto the page 
and place the 
orange square 
where you 
want it in 
your report. A 
blue border 
appears 
around a 
selected field 
and a green 
tick-mark is displayed next to the fields in the Field Explorer when they are used in the report. 
Some fields automatically get a heading. You can edit this by double clicking in it. If no heading is 
added, you can create your own by inserting a text box:  Click on the ab icon or go to Insert>Text 
Object and place the orange box in the report. Then type the text you want and format. If you do 
not want a heading, just mark it (so it turns blue) and delete it. 
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To preview your report, click on the Preview tab (if it is not there already, go to View>Print 
Preview). You can switch between the Design and Preview tabs while you are working on your 
report. 

8. The Font for all fields and field headings should be Verdana, font size 9. You can set this as a 
default for CR. Go to File>Options>Fonts and set up Default fonts.

Fields and Text Objects

Font: Verdana 

Font style: Normal

Size: 9

Field Titles should have the same defaults except for the Style, which should be Bold.

Report and Page Headers:

There are templates for the Report and Page 
Headers for different types of reports (e.g. Loans and 
Exhibitions, Gallery Inventories, OR reports, etc.) 
that should be followed when you create a new 
report. These templates can be found in 
Ruby>RCMDD-
CM>IT>IT_and_Database_Admin>Crystal 
Reports>Templates. 

44.2.1. Field Guidelines:

 To save space in the report, you can place 
the ID Number string in its own Details 
section (or in a section with the 
Multimedia). In the Section Expert, select 
Underlay the Following Sections. 

 If you just add the Materials field as it is, 
the contents will be displayed on several 
rows. For the materials to display on one 
line, you have to use a Formula field 
instead of the Database field you selected. 
To create this Formula field, right-click on 
the X+1 Formula Fields in the Field 
Explorer and select New. Type Material in 
the Name box and click OK. In the 
Formula box that opens paste: 

replace({ecatalog_csv.PhyMaterial_tab}, chr(10), ', ')
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If you are not in the Catalogue Module, you have to change ecatalog_csv to what your .csv file is 
called, usually ObjObjec_csv. 

Click on Save and Close. There is now a field under Formula Fields called Materials. Add this to 
your report. 

 Some fields must be added to a sub-report to work properly. Most commonly: the Measurements, 
Bibliography, Catalogue Numbers and Multimedia with Photographer. These sub-reports are 
explained in detail below.

 To format a field select it and go to Format>Format Field, or right-click in it and select Format Field  
from the list. In the Format box you will probably only need to use the Common and Border tabs. 
On the Common tab, select “Can grow” if you want your field to expand when there is a lot of 
data. On the Border tab, make sure that no borders are selected. 

44.2.2. How to add Multimedia

1. Go to Insert>OLE object, in the Insert Object box, select Paintbrush Picture.

2. Place the orange square in a section in the report. When you release it, Paint formatting options 
will appear. Ignore this and click 
somewhere in your report section 
to get rid of it. 

3. Resize your OLE object (the blue 
square) according to need and 
place it where you would like it to 
display. If you want your image to 
display as a thumbnail to the right 
of your text fields, place it to the 
right in your section, close to the 
top of your report (usually the same 
section as the ID Numbers). Open Section Expert and select Underlay following sections. 

4. To ensure that the image is centred within the OLE box 
when it is displayed in the report, go to Format>Format 
Graphic (or right-click) and on the Border tab, select Single 
borders and Color: White.
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5. Next, select the Multimedia field from the 
Field Explorer and place it inside the OLE 
object. This field contains the path to the 
image and now displays this on the report. To 
ensure that the file path is invisible you have 
to format the Multimedia field. Select it and 
go to Format (or right-click) >Format Field. 
On the Common tab tick the Suppress box 
and click on OK. Resize the field so it is 
completely within the OLE square. 

Note:  You will not be able to see the actual image until you have run your report in KE Emu, but you can 
see where the image will be displayed in Preview. At times you will find that after you have added the 
Multimedia field to the report, you suddenly find yourself with several versions of the same record. This is 
due to a problem with the links between your Multimedia and the object record data. You can usually 
solve it by fixing the links: 

Go to Database>Database Expert or right-click on Database Fields in the Field Explorer. In the Database 
Expert box choose the Links tab and click on the Links button to the left. You will get a message telling 
you that it cannot link by key, and asks if you would like to link by name instead. Click Yes. Hopefully, 
your links are now in order so click OK. CR will ask you if you want to Refresh the report data. Say OK. 
This will update the links between your fields.

44.2.3. How to create a sub-report

You will usually need a sub-report for the Bibliography, the Dimensions, the Photo Credit [the Event 
Catalogue Numbers?], etc. A sub-report is created in the same way as a standard report but can be 
inserted as a field in your main report. Below are descriptions of how to create the most common sub-
reports and what formulas and formatting to use to ensure they display properly in the report.

Dimensions:

1. In the Fields tab in KE Emu: Group the measurement fields (see how to group fields above). 

2. In CR: To create a sub-report, go to Insert>Subreport. In the box that opens, type the name you 
want to give the sub-report in the Create New Report field and click on Report Wizard. This works 
the same way as the Standard Report Wizard. 

RCMDD Protocols 12-2010  362



3. In the Select Data box, select only the Dimensions group (e.g. Dimensio.csv.). 

4. Click Next to select the fields you want to display in the report (you can skip this step and just add 
the fields by hand as you would in the main report).
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5. Click OK and place the orange box in the section where you want the data of your sub-report to 
display. Double click on the sub-report box to edit the sub-report.  This will open it in a new 

Design tab.

6. Start by deleting the Print Date field and the field headings and suppress the Report and Page 
Headers and Footers. If your fields are not already in the sub-report, place them in the details field 
as follows: Height, Width, Depth/Length, Diameter, unit length (cm), Weight and unit weight (gr/
kg).  Add a text box for each type of measurement (H for height, W for width, etc.) and place the 
fields inside these boxes (this will make it easier to space them evenly).

7. To ensure that only the Maximum 
Dimensions are displayed, you 
have to add a formula to tell CR 
not to display all measurements. 
Open the Section Expert and 
mark Suppress (No Drill-down) 
for the Details section and click 
on the x+2 button. In the formula 
field, type: 

not onfirstrecord 
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If the formula is correct, it will turn blue. When you are done, click 
on Save and Close.

8. To preview your sub-report, switch to the Preview tab of the main 
report.

9. Quite often at this stage, you will find that the data in your sub-
report does not display properly (and sometimes not at all). This is usually due to a problem with 
the links between your sub-report and your main report. To fix this, right click on the sub-report 
field in the main Design view and select Change Sub-report Links. 

10. Link your sub-report to the ecatalogue_key or the _key field of your attached objects if you are in a 
different module, e.g. ObjAttachedObjectsRef_key.

11. Click OK and go to the Preview tab to check that the Sub-report works. You will probably get a 
message asking if you want to use old (saved) data or to refresh the data. Choose Refresh Data.                                                                            

 

12. When you are happy with the sub-report, go to the Design tab of the main report and select 
Format  Subreport. On the Common tab, remove the black border around the sub-report. You will 
probably have to work a bit on aligning it with other fields before you are done.
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Bibliography:
This is created the same way as the Dimensions sub- 
Bibliographic References report. Note, however, that the report 
fields are from two different Modules: the actual reference is 
found under (Literary References) and is called Summary Data. 
The field with page numbers, etc. is from the Catalogue 
Module and is called Bibliographic Notes.

Note: It is very important that you create a group for these in 
KE EMu, if you forget this step, the sub-report will not work.  

If you end up with a bibliography looking like this  (screen 
shot) you have to change the links (see above). 

44.2.4. Creating Sub-report with Multimedia and Photographer (Photo Credit) 
1. In KE Emu: Add the Multimedia and Creator fields, and select Set Table as Text for the Creator 

field. 

2. In CR: Create a sub-report as above and insert the OLE object.  Place the Multimedia field inside 
the OLE square as usual and place the Creator field below. 

3. Add a text field and add the text: ‘Courtesy of the Egyptian Museum, Photo by’ and place the 
Creator field inside this after ‘by’. 

4. To ensure that only the photographer that took the image displayed in the report appears, you have 
to go to Section Expert and select the Details field. Click on the x+2 icon next to the Suppress (No 
Drill-Down). In the Formula box, type Not onfirstrecord and click on Save and Close.

5. Make sure your links are in order.

44.2.5. Event Catalogue Number Sub-report

1. If you want to add the Event Catalogue Number to a report run from the Catalogue module, you 
have to make sure to select the correct field in KE Emu. Open the Report Fields box and click on 
the icon to the right (see screenshot) to open the Attachments box. It can take a while to load all 
the modules. Select the Events module and click Add.

2. From your new category of fields, +Objects (Object Details), select  Event Catalogue Number 

RCMDD Protocols 12-2010  366



3. Create a sub-report in CR as above, 
and make sure to link it to the 
ecatalog_csv.ecatalogue_key

4. If you are adding the Catalogue 
Numbers to a report run from the 
Events module, you can select the 
field from there directly.

44.3. Saving and Running the Report
1. While you are working on a report you can save it on your computer (make sure to save regularly 

as it does not save automatically), but when it is finished you should give it an appropriate name 
(e.g. EM_Catalogue_Card) and save it in Ruby>RCMDD-
CM>IT>IT_and_Database_Admin>Crystal Reports>Active Reports. 

2. To save the report in the database, open the Report Properties for your new report and click Save. 
Your browser opens so that you can choose the location of your report and open it. 

3. Your report has now been saved in KE EMu so you can close the Properties and run it. 

44.4. Editing an Existing Report
1. Select the report you want to edit in the Reports box in KE EMu.

2. If you want to add Database Fields to it, add them accordingly and then run the report to ensure 
that there will be a connection to these new fields in CR.

3. Open the properties and click on Open on the Report Type tab. You will be asked to save the 
report. When you edit a report, it is always a good idea to save it under a different name, so that 
if something should go wrong, you at least have an old version of the report. Otherwise, you may 
have to create the whole report again. 

4. When you have it saved, it will open in CR.

5. Make sure to click Refresh so that CR identifies the new fields. If you still can’t see them in the 
Field Explorer, right click on Database Field and select Database Expert. Create a new connection 
and add your new fields.

6. Make your edits and save the report (see section 5 above).
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44.5. Useful Design Features
Place a database field inside a text box: 
This is very useful when you try to align two 
different types of fields or if you want to ensure that something is centered; e.g. Loan Dates, where ‘to’ is 
written in a text box and the two date fields have been placed inside the box, before and after the text. 
In some cases it may be useful to place all object numbers in a text box, see for example 
Emu_Catalogue_Card. 

Page Header:

If you want a Page Header for the report, but you don’t want it to show up on the first page, you have to 
create a formula for the Page Header section. In the Section Expert, click on the x+2  icon next to 
Suppress (No drill down). In the formula box type:  PageNumber = 1

Limit the number of ID numbers that display in the 
report:
A very small number of records have more than six ID 
Numbers, but those that do usually create a problem in 
CR as most reports have limited amount of space. To 
avoid having ID numbers overwriting other fields or 
expanding beyond their allocated space, you can tell CR 
to restrict the numbers. Select the ID Number field and 
go to Format Field. On the Common tab type the number 
of ID numbers you want to allow in the box next to Can 
Grow. 

Place expanding fields in separate sections: 
If you have fields that contain so much data that they tend 
to expand (or grow) and consequently risk overwriting the fields below, place them in a section of their 
own so that the fields in sections below are moved downwards as the section above expands. Fields that 
tend to expand: ID Numbers and the Source Summary

Use the rulers, guidelines and grid to guide you: 
The rulers, grid and guidelines can be activated from the View menu. The rulers can for example help you 
to center fields; the grid makes it easier to see if things are aligned and with the guidelines you can move 
several fields at once.  

Align fields: 
You can align fields manually, but to save time and to be certain things are aligned you can mark two or 
more fields you want to align and then select Align on the Format menu. Choose whether you want to 
align the tops, bottoms, lefts, rights, etc. Aligning regular fields with subreports can be tricky, but if you 
select Suppress blank sections in the section in the subreport where the fields are placed (usually the 
Details section), it will become a little bit easier. 
Sometimes the fields are not the same size or, as above, when you are trying to align with a subreport, and 
just will not align properly. Try changing the size of the field or its location through the Size and Position 
box which opens from the Format menu. It may take a few tries to get it right. 
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44.6. Troubleshooting

44.6.1. Problems running the report in KE Emu:

 If your report doesn’t run, check that you have selected Crystal Report in the Report Type field (the 
default is Crystal Print). 

 If your report runs but does not display all the fields, go back to CR to check that all tables are 
linked and that you have used the correct fields. An error message               

 

usually comes up when you have added fields to your report in Emu but not in CR, or if you have removed 
fields in CR. The problem is easily solved by making sure that the fields in KE Emu Report Properties Field 
Tab correspond with those in CR.  Sometimes you have to make a new connection to the database, refresh 
or delete fields from the report a couple of times before it works. 

44.6.2. Problems displaying data in CR Preview:

 If you have added a field to the report but no data is displayed in the preview, make sure that you 
are using the correct database fields from the appropriate table/module. And of course, make sure 
that there is data for the fields in the database. 

 If no data displays at all, it is probably because the connection to the database is broken. Close the 
report and try running it again from KE EMu and then open it in CR.

 When the data displays erratically it is usually a linking problem. Try linking again. 
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45. Exporting Records to Excel
When you want to gather data for a purpose not covered by the current set of Crystal Reports, 
you can copy it from List View in EMu and paste it into Excel.

This is very simple to do, but remember that all the fields need to be in one module, and you will 
not be able to do this with Images. (NOTE: At some point in the future, the software may have 
developed to the point where it will be possible to do this with iWork Numbers, which handles 
images better, so keep this in mind.)

• Search for a group of objects in the database

• Select or create a list view with the fields you want to have in your Excel file. Note: For ID 
numbers choose ID numbers: ID Numbers, not e.g. EgyJENumber or EgySRNumber.

• Select all the records you wish to have in your Excel File.

• Copy the selected records. Go to Edit-> Copy Special-> and 
choose radio button for ‘Other’ and put  ‘,’ (Comma) in the 
empty field under Line Delimiter and Row Delimiter. Click OK.

• Open Excel.

• Select Edit->Paste from the Excel (CRTL+V).
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• Format the data and manipulate it as required to produce your report.

46. Creating and Modifying User Accounts on the Server and 
Database

46.1. Changing a User’s Password on the Server

Step 1: Connect to the network using a Mac
You must use a Mac for this procedure.
Make sure you are connected and logged into the network either directly, or via VPN connection.

Step 2: Install Mac OS X Server Admin Tools
If you already have Mac OS X Server Admin Tools installed on your machine, skip to the next 
step.
Mac OS X Server Admin Tools can be downloaded from: http://support.apple.com/downloads
(You must ensure that you download the correct version for your computer to connect to Mac OS 
X Server 10.5.8)

Step 3: Open Workgroup Manager
Mac OS X Server Admin Tools installs a “Server” folder in your “Applications” folder. In here, you 
will find an application
called “Workgroup Manager”
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Step 4: Login to the server
Login to the server using the following information:
Address: Goldfish.local (or Goldfish.local.lan if connecting via VPN)
User Name: diradmin
Password: The Associate Registrar for IT has this.

NOTE: DO NOT CHECK “Remember this password in my keychain.” THIS PASSWORD 
SHOULD NOT BE SAVED, IT WOULD ALLOW ANYBODY WHO USES THE MACHINE TO LOG 
INTO THE SERVER AND ALTER THE USER DATABASE.

Step 5: Select the User to Alter
Select “Accounts” from the toolbar.
From the list of users on the left, select the user you wish to alter.

Step 6: Change the User’s Password
Select the “Basic” tab from the information section on the right.
Enter the new password in the ‘Password’ field, and again in the ‘Verify’ field.
Click the “Save” button
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Step 7: Quit “Workgroup Manager”
You must quit the application, do not simply close the window.

46.2. Creating a New User on the Server

Step 1: Connect to the network using a Mac
You must use a Mac for this procedure.
Make sure you are connected and logged into the network either directly, or via VPN connection.

Step 2: Install Mac OS X Server Admin Tools
If you already have Mac OS X Server Admin Tools installed on your machine, skip to the next 
step.
Mac OS X Server Admin Tools can be downloaded from: http://support.apple.com/downloads
(You must ensure that you download the correct version for your computer to connect to Mac OS 
X Server 10.5.8).

Step 3: Open Workgroup Manager
Mac OS X Server Admin Tools installs a “Server” folder in your “Applications” folder. In here, you 
will find an application called “Workgroup Manager”.
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Step 4: Login to the server
Login to the server using the following information:
Address: Goldfish.local (or Goldfish.local.lan if connecting via VPN)
User Name: diradmin
Password: The Associate Registrar for IT has this.

NOTE: DO NOT CHECK “Remember this password in my keychain.” THIS PASSWORD 
SHOULD NOT BE SAVED, IT WOULD ALLOW ANYBODY WHO USES THE MACHINE TO LOG 
INTO THE SERVER AND ALTER THE USER DATABASE.

Step 5: Add a new User
Select “Accounts” from the toolbar.
Click on the “New User” button on the toolbars.
(You can safely ignore the warning about “New users may not have access to services.”)

Step 6: Enter the Basic User information
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Select the “Basic” tab from the information section on the right.
Enter the User’s full name (Firstname Surname)
Edit the “Short Name” to be in the format firstinitial-surname.
(i.e. The short name for “Joe User” should be “juser”)
Enter the password in the ‘Password’ field, and again in the ‘Verify’ field.
Click the “Save” button.

Step 7: Set the User’s Groups
Select the “Groups” tab from the information section on the right.
Click the ‘+’ button to add additional groups to the user.
Drag “Directory Users” from the groups list on the left, into the ‘Other Groups’ list for the User.
Click the “Save” button

Step 8: Quit “Workgroup Manager”
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You must quit the application, do not simply close the window.

46.3. Adding a new username on the Database

Step 1: Create a new account with username and password according to Creating a New User on 
the Server LINK THIS

Step 2: Open Registry

Step 3: Select New Record

Step 4: Key 1: choose User

Step 5: Key 2: type in the same username that has been created in the server

Step 6: Key 3: choose Group

Step 7: Value: the Group you want this User to be in

Step 8: Save Record

Step 9: Next Run emusecurity. (The emusecurity utility must be run whenever a user/group is 
added to the Registry or whenever a user changes groups.) Select Tools->Generate Record 
Security 
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Step 10: Generate Security Box opens and click OK.

Step 11: Try to log in with this new username and password. If you cannot log in immediately, 
just wait awhile and try again. There seems to be some sort of a delay before the database 
recognizes these new settings.
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47. EMC Authority Lists
The RCMDD Authority Lists are kept as a master Excel file (Akhenaten->Ruby->RCMDD-CM-
>IT_and_Database_Admin->Authority_Lists->EMC_Authority-Lists.xls), and as a series of separate 
pdfs, as follows:

EMC_Authority-Provenance

EMC_Authority-Dating

EMC_Authority-Materials

EMC_Authority-Sources

These pdfs are stored on the server, in Goldfish->Users->Shared->Authority, so that they can be 
accessed through both the Intranet and Internet sites. Only the Associate Registrar for IT has the 
access to this folder. Whenever an authority list is updated, a new pdf should be generated from 
the Excel file by printing to pdf:

1. Go to Page Setup and select either portrait or landscape.

2. Go to Page View and make sure the entire table fits on one page across (you can adjust the 
width of the columns if necessary.

3. Set the relevant row headings to print: go to Page 
Setup->Print Titles, and enter the range of row 
headings by clicking on the box next to “Rows to 
Repeat at Top,” selecting the first box you want, 
then holding down shift and clicking on the last.

4. Go to Print and print the relevant sheet to pdf. It is 
best to click on the Preview button, and then save 
the file as EMC_Authority-NAME from Preview.
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48. Permissions and Decrees
Following is a list, with thumbnails, of the major permissions and decrees signed by the museum 
and SCA directors, allowing the RCMDD staff to carry out their work effectively. Hard copies of 
these permissions are stored in File Cabinet 1, Drawer-1, Permissions/Decrees Folders, and soft 
copies are in Akhenaten->Ruby->RCMDD-ADMIN->Permissions/Decrees as well as in the Events 
module in the database.

• Decree submitted to the Ministry of Culture, 2007 (EV.2011.12).

• Memo stating that the museum photographers need to give the RCMDD copies of their 
images, 12/23/2007 (EV.2010.30).
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• Memo stating that RCMDD needs to be informed of movements before they occur and 
receive other information, 9/15/2007 (EV.2010.38).
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• Decree allowing the registrars to attend movements, 7/25/2007 (EV.2010.83).

• Decree stating that the RCMDD is allowed to provide GEM and NMEC with any information 
they might need, 4/11/2010 (EV.2010.77).
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• Decree authorizing the GEM to provide copies of their image for the database, 5/3/2007 (EV.
2007.02).

• Permission for scholars to use the register book facsimiles, Search database, and the database 
on Intranet, 10/21/2010 (EV.2010.73).
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49. Guidelines for Numbering Collection Objects
Every collection object in the Egyptian Museum, Cairo, should have at least one ID number 
marked on it or closely associated with it, so that the object can be identified easily and 
correctly. 

Ideally, objects should be numbered when they are accessioned. If an object has no number 
marked on it or associated with it, or the original number is too faded to read, it can be 
numbered at any time, according to the following guidelines.

49.1. General Principles

A JE or CG number should be written on each object as soon as it is accessioned.

Otherwise, a number should never be written on an object until it has been fully cross-checked 
by the RCMDD, in cooperation with the section head. A significant number of the cross-
references in the various register books are wrong, and these must be corrected before a number 
is put on it. It is far better to wait than to write the wrong number on an object.

For Egyptian Museum objects: only JE, CG, or TR numbers may be written on objects. JE numbers 
should be written in black; CG numbers should be written in red; and TR numbers should be 
written in black in a cross. SR numbers should be written on labels put next to their objects.

An object number should be written on an object in a durable but reversible manner (often 
called semi-permanent). Permanent markings should be avoided because they damage the 
surfaces of objects.  Specific methods for doing this are provided below. Ideally, only the 
conservators should write numbers on objects.

The number should be as small as possible while remaining clearly legible.

For large objects, such as statues, stelae, furniture, and ceramics, numbers should be written on 
the object.

For small objects, such as jewelry, where putting a number directly onto the object will damage it 
or detract from its value, numbers should be written on tags that are attached to the object.

49.2. Specific Methodology
Where: The following principles should be kept in mind when determining where to write an ID 
number on an object: 

1. A good location is one where the number can be seen without excessive handling but is not 
be an area that will be clearly visible when the object is on display. 

2. The number should not be recorded on any fragile or unstable surfaces (areas where there is 
flaking,  corrosion, or pitting) as it will be difficult to add and remove the number, and may 
further damage the surface of the object. 

3. Avoid writing the number on an area of the object that experiences wear or friction due to  
contact with its display or storage materials.

4. If an object is made of more than one type of material place the number on the smoother, less 
porous surface if possible.
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5. Do not write the number on top of old inventory numbers, inscriptions, or major design  
elements. They contribute to the history of the object and should be preserved. 

6. Whenever possible, choose a consistent location on objects of the same type.

7. All detachable and accessory pieces of an object should be individually marked (i.e. a coffin 
and its lid should both be appropriately numbered).

Marking Methods 

For Stone, Ceramics, Metal, Wood:  barrier coat with ink or paint

1. Look carefully at the object to decide in advance where to locate the number, using the 
principles outlined above. Remember that the location should be unobtrusive. Even when 
great care is taken it is possible that the barrier coat will leave a stain.

2. Using a small artist’s brush apply a base coat of clear varnish in a neat rectangle large enough 
to contain the inventory number. Allow the varnish to dry until it is no longer sticky to the 
touch, usually about 10 to 15 minutes.

3. In most cases the number can be written directly on the base coat. However, if it is a dark 
surface and the number should be written in dark ink (according to museum standards) it will 
be difficult to read. In these situations a layer of white paint should be applied over the clear 
varnish base. Be careful that the white layer does not exceed the area of varnish and come 
into direct contact with the object. Allow this to dry fully before writing the number in the 
appropriate black or red ink, which will be clearly legible against the white base.

4. Write the number on the base with a permanent pigment-based ink or in acrylic paint using a 
fine-point technical pen, crow quill pen, or a fine artist’s brush.  

5. To avoid confusion it is important that the choice of color conforms to the museum’s 
established standards, as outlined above: JE and TR numbers in black ink; CG numbers in red 
ink. This should be consistently followed. In the past some JE and TR numbers have been 
written in white on dark objects. This is a valid method when necessary but Method #3 above 
is preferred.

6. Allow the number to dry for at least 30 minutes before applying a protective top coat of clear 
varnish. This second barrier coat is important because it helps to protect the number from 
possible damage or wear. It is best to wait as long as possible to make sure the number is dry 
so that it is not accidentally removed during application of the top coat. It is also important to 
wait until the top coat of varnish dries thoroughly before handling that area of the object.

Recommended Materials

Barrier materials (varnish): Acryloid B72 (manufacturer: Rohm and Haas) 

•  The most stable acrylic resin available for this purpose 

• The preferred solution is 25% in acetone 

• Try not use on painted surfaces, especially where the paint is flaking or chipping. If the object 
is painted, try to find an area where the paint is already gone, or use a place where the paint 
is as stable as possible.
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White base coats: White acrylic artists’ paints 

 White paint formulas containing titanium dioxide

Writing materials: Acrylic paints 

• Composed of ground mineral pigments rather than dyes and are therefore more resistant to 
fading 

• Carbon black, and vermillion or cadmium red are recommended 

• Dissolvable in ethanol and acetone 

• May be applied with a brush or crow quill pen

Inks: 

• Proper inks are quick drying, non-acidic, light fast (contain mineral pigments rather than 
dyes), and write well on a variety of surfaces  

• Inks containing carbon (e.g. India ink) are highly recommended 

The RCMDD Library contains additional materials on appropriate marking methods for a wide 
variety of materials.
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50. Proper Object Handling Guidelines
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51. Preventive Care Guidelines
 
Rules to follow for Preventive Care of Collection Objects: 
 
1. Keep storage areas clean, organized and uncluttered. 
 
2. Do not store objects on top of one another, or inside one another. 
 
3. Provide sufficient space in storage containers to avoid crushing or abrasion of 
objects. 
 
4. Do not crowd objects on a storage shelf – it will hinder retrieval of an object. 
 
5. Do not place objects or object containers directly on the floor in storage areas – 
objects and containers should be raised above the floor for protection in the event 
of flooding. 
 
6. Large and small objects in storage areas should be individually and loosely 
covered to prevent excessive buildup of dust and dirt. 
 
7. Objects should only be stored in secured areas. 
 
8. Do regular spot checks of storage spaces and galleries for pest control and 
irregularities.  
 
9. Turn off the lights in storage rooms when not in use. 
 
10. Objects should only be treated (cleaned) by skilled professionals. 
 
11. Reduce the amount of time light sensitive objects are exposed to illumination (e.g. 
works on paper – papyrus; and textiles).  
 
12. Objects on exhibit, not protected in a vitrine, should be dusted on a regular basis 
and only by trained personnel. 
 
13. When working around objects in storage, during installation, and in the galleries, 
only use pencils.  
 
14. Objects should only be handled by trained museum professionals. 
 
15. Those so trained in object handling should avoid any unnecessary handling of 
objects. 
 
16. Objects should only be handled when wearing appropriate gloves. 
 2 
 
17. Handle objects according to the Museum’s Rules for Object Handling. 
 
18. Enforce the policy that object should not be touched by the public, by tour guides, 
or staff untrained in handling objects. 
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19. No not introduce amounts of water into display and storage areas for cleaning 
purposes without extreme care and control. 
 
20. Do not spray aerosols near an object. 
 
21. Do not use tools or work above or beside an exposed object – objects must first be 
removed, or covered, depending on the work being performed. 
 
22. Do not eat, drink, or smoke in the vicinity of objects. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
References:  
Museum Basics, Timothy Ambrose and Crispin Paine. London: Routledge, 1993, pps. 162-173
Caring for Your Collections, The National Committee to Save America’s Cultural Collections, Arthur W.  Schultz, 
Chairman. New York: Harry N. Abrams, Inc., Publishers, 1992, pps. 34, 102, 124 
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52. SCA Courier Guidelines

52.1. SCA staff that travel with a loan: 
• Couriers 

• Conservators

• Security

52.2. Roles and Responsibilities of a courier:
• Research the theme of the exhibition and read about the history of the objects.

• Study the objects in as much detail as possible and read their entries in all register books very 
carefully.

• Be part of the committees preparing for the loan and be present during the packing of the 
objects in order to be familiar with the objects and their conditions, as well as with the 
manner in which the objects were packed.  This would enable the courier to better supervise 
the unpacking of the objects later on.

• Read the reports made by the conservators on the condition of each object, and be familiar 
with objects that would require special attention.

• Read all condition reports carefully.

• Make sure the objects are packed in suitable crates and that all crates are stamped with the 
courier’s seal in more than one location.  Make sure the museum seal and the customs seal 
are also on the crate.

• Study the contract between the SCA and the exhibition organizers in order to insure that the 
SCA receives all its rights; as well as keep 2 copies of the contract (one in Arabic and one in 
English).  The courier is responsible for making sure s/he understands all clauses in the 
contract.

• Receive a list of all objects going out on loan.  The list should include the ID number(s) of 
each object, description, material, dimensions, weight (if necessary), date and insurance 
value.  This list should be signed by the parties involved.

• Receive coloured photographs of the objects and make sure that they represent the object 
well (i.e. show all sides of the object clearly).  The photographs should be signed by the 
organizers as well as the SCA representative.

• Study all appendices attached to the contract between the SCA and the borrowing side, as 
well as any additional documents that provide important information about the loan, such as 
the budget, venues and dates, special instructions about proper lighting and temperature and 
humidity levels for each piece as well as insurance and shipping information.

• Receive an official copy of the contract made with the packing and shipping company.

• Receive an official copy of the insurance contract.

RCMDD Protocols 12-2010  400



• Receive an official copy of the contract made with the government of the borrowing country, 
ensuring that the objects would be well taken care of from the moment they leave Egypt until 
they return (as instructed).

• Receive an official copy of the schedule of payment to the SCA, as indicated in the contract, 
so that the courier can make sure it is strictly abided by.

• Receive all documents mentioned in the contract and its appendices and make sure they are 
given to the couriers that would follow him/her.

52.3. Shipping and Exhibition Period:
• All those traveling with the objects (couriers, conservators and security) are to accompany the 

objects as they are being moved from Egypt to the venue(s) according to the loan schedule.  
They are to make sure all crates are safe and that they are stamped with all the necessary 
seals.  They are also to keep track of the number of crates as well as where they will be stored 
before the opening of the exhibition and that the storage space is secure.

• All those traveling with the objects are to take part in the unpacking of the objects.

• Supervise the movement of the objects from the crates to the area in which their condition 
after the unpacking process will be recorded.

• Study all the objects, with specialists from the borrowing side and in the presence of 
representatives of the insurance company, and compare them to the photographs taken in 
Egypt as well as the condition reports and the conservation reports made prior to departure 
and take note of any changes that may have happened to the objects and have all participants 
sign in order to guarantee all the rights of the SCA.

• Actively supervise the movement of the objects into appropriate and secure vitrines with 
functioning alarm systems.

• Stamp the vitrines with the courier’s seal after ensuring that they are appropriately lighted, 
temperature and humidity controlled and that there is a label for each object.

• Ensure that the area is appropriately climate controlled (temperature and relative humidity) 
and that the lighting is suitable for all objects exhibited outside vitrines.

• Go around and check the vitrines daily in order to make sure that all objects are in place and 
that they are in sound condition and that all vitrines are sealed.  Check objects outside 
vitrines and report any changes to the organizers.

• Make sure that the alarm and security systems are in sound condition and report any 
problems to the organizers.

• Be prepared to give tours of the exhibition to VIPs and student groups if asked to do so.

• Participate in activities related to the exhibition and give lectures on Ancient Egypt.

• Add any additional documents related to the loan, especially any conservation reports 
detailing any damage that may have happened to an object(s) to the loan file.

• Send weekly reports to the Secretary General of the SCA and the Director of the Museum 
involved on the condition of the objects, the number of visitors to the exhibition, the number 
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of cultural institutes that visited the exhibition and any cultural activities that the exhibition 
organizers are taking part in, as well as any mention of the exhibition in the media of the 
hosting country/countries and any additional information that the courier feels is relevant 
enough to be reported.

• The courier is to keep all documents related to the loan and file them chronologically, so that 
they are ready to be handed over to the next courier. 

52.1. Period of Movement to a Different Venue:
• The seals on the vitrines are broken in the presence of representatives from both the Egyptian 

and foreign (i.e. the borrowing side) sides, as well as the insurance and packing companies, 
security and representatives from the next venue.

• Objects are taken out of the vitrines and each one is examined carefully and compared to the 
condition and conservation reports, and the photographs taken prior to the exhibition. The 
courier is then to write a report on each object in the presence of the parties mentioned above 
(1).

• Each object is packed after it is examined, if its condition has not changed.  Objects whose 
condition has changed are to be packed after they have been photographed, worked on by a 
conservator, and after a report detailing how and why their condition has changed had been 
written. The report is then to be signed by all members of the committee.

• The new courier (who will be traveling with the objects to the new venue) is to attend the 
committee, along with the old courier and the report is to be signed by both parties.

• Find out where the crates will be stored and make sure everything in each crate is 
documented and that all members of the committee are aware of this.

• Decide, along with representatives from the new venue and with the approval of the Secretary 
General of the SCA, on how and when the crates will be transported to the new venue as well 
as the number of crates that will be transported and how they will be secured from the 
moment they leave the old venue until they reach the new venue.

• Know who will be traveling with the objects, from both the Egyptian and the foreign sides and 
make sure the Egyptian side is represented by the courier, a conservator and a security 
representative.

• The courier of the old venue is to hand over the complete loan file to the courier of the new 
venue and the first party is to sign a document releasing his/her responsibility while the 
second party is to sign the document, claiming responsibility from the first party.

• Write a report detailing everything that took place during this period, signed by both couriers.  
The report is to be sent to the Secretary General of the SCA and the Museum Director.  

• After relieving the old courier from his/her responsibility the new courier is to follow the same 
steps detailed above.
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53. SCA Museum and Magazine Codes

53.1. SCA Museum Codes

The following chart provides the codes that should be entered into Level 1 for SCA Museums.

Museum Name Location Location Code ID Numbers Status

Aswan Museum Aswan Aswan Museum Aswan J. Open

Coptic Museum Cairo Coptic Museum Coptic J. --- Open

Egyptian Museum, 
Tahrir

Cairo EMC VARIOUS Open

Grand Egyptian 
Museum (GEM)

Giza GEM GEM 000 Under Construction

Museum of Islamic 
Art

Cairo Museum of Islamic 
Art

MIA 000 Under Renovation

National Museum of 
Egyptian Civilization 
(NMEC)

Cairo NMEC Under Construction

Alexandria National 
Museum

Alexandria Alexandria National 
Museum

NMA 000 Open

Bibliotheca 
Alexandrina

Alexandria Bibliotheca 
Alexandrina

BA 000 Open

Greco-Roman 
Museum

Alexandria Greco-Roman 
Museum

GRM 000 Under Renovation

Maritime Museum Alexandria Maritime Museum Maritime J. 000 Under Construction

Mosaic Museum Alexandria Mosaic Museum Mosaic J. 000 Under Construction

Abdeen Palace 
Museums

Cairo Abdeen Palace 
Museums

Open

Gawhara Palace 
Museum

Cairo Gawhara Palace 
Museum

Open

Gayer-Anderson 
Museum

Cairo Gayer-Anderson 
Museum

Open

Helwan Corner 
Museum

Helwan Helwan Corner 
Museum

Under Renovation

Manial Palace 
Museum

Cairo Manial Palace 
Museum

Under Renovation

Muhammad Ali 
Palace Museum, 
Shubra

Cairo Shubra Palace 
Museum

Under Renovation

National Police 
Museum

Cairo Police Museum Open
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Museum Name Location Location Code ID Numbers Status

Rashid National 
Museum

Rashid Rashid Museum Under Renovation

Rommel Cave 
Museum

Marsa Matrouh Rommel Cave 
Museum

Open

Royal Carriages 
Museum, Bulaq

Cairo Bulaq Carriages 
Museum

Under Renovation

Royal Carriages 
Museum, the 
Citadel

Cairo Citadel Carriages 
Museum

Open

Alexandria 
Aquarium

Alexandria Alex Aquarium Open

Coin Museum Cairo Coin Museum Under Construction

Egyptian Textile 
Museum

Cairo Textile Museum TM Under Construction

Mummification 
Museum

Luxor Mummification 
Museum

MUM 000 Open

Royal Jewelry 
Museum

Alexandria Royal Jewelry 
Museum

Open

Beni Suef Museum Beni Suef Beni Suef Museum Open

Arish Museum El-Arish Arish Museum AR 000 Open

Hurghada Museum Hurghada Hurghada Museum Under Construction

Hurreyet Razna 
Museum

Zagazig Hurreyet Razna 
Museum

Open

Ismailiya Museum Ismailiya Ismailiya Museum Ismailiya J. 000 Open

Kafr El-Sheikh 
Museum

Kafr El-Sheikh Kafr El-Sheikh 
Museum

Under Construction

Kom Aushim 
Museum

Faiyum Kom Aushim 
Museum

Under Renovation

Luxor Museum of 
Ancient Art

Luxor Luxor Museum Luxor J. 000 Open

Malawi Museum Malawi Malawi Museum Open

Minya Museum Minya Minya Museum Open

Nubia Museum Aswan Nubia Museum Various Open

Port Said Museum Port Said Port Said Museum Under Renovation

Recovered 
Antiquities Museum

Cairo Recovered 
Antiquities Museum

Under Renovation
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Museum Name Location Location Code ID Numbers Status

San El-Hagar 
Museum

San El-Hagar San El-Hagar 
Museum

Open

Sharkeya Museum Sharkeya Sharkeya Museum Open

Sharm El-Sheikh 
Museum

Sharm El-Sheikh Sharm El-Sheikh 
Museum

Under Construction

Sohag Museum Sohag Sohag Museum Under Construction

Suez Museum Suez Suez Museum Under Construction

Taba Museum Taba Taba Museum Under Renovation

Tanta Museum Tanta Tanta Museum Tanta J. 000 Under Renovation

Wadi el-Gedid 
Museum

Kharga Wadi El-Gedid 
Museum

Kharga J. 000 Open

Crocodile Museum Kom Ombo Crocodile Museum MCG 000 Under Construction

Imhotep Museum Saqqara Imhotep Museum VARIOUS Open

Khufu Boat Museum Giza Khufu Boat Museum Open

Mit Rahina Museum Mit Rahina Mit Rahina Museum Open

Agricultural 
Museum

Cairo Agricultural 
Museum

Open

National Military 
Museum

Cairo Military Museum Open

Railway Museum Cairo Railway Museum Open

Citadel Prison 
Museum

Cairo Prison Museum Open
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53.2. SCA Magazine Codes

As of March 2011, the recommended naming codes for SCA magazines have not yet been 
implemented; for now, the RCMDD will use only Reg. numbers for all magazines other than the 
Saqqara magazine.
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54. SCA-EMC Rights and Reproductions Policy - external

Photography of any sort by non-Supreme Council of Antiquities (SCA) photographers is currently 
prohibited in the Egyptian Museum, Cairo (EMC).

Note that scholars will no longer be able to take their own reference photos. Scholars may 
request that a museum photographer accompany them during study sessions to take any low-
resolution reference photographs they might need. Such photographs will be incorporated 
immediately into the museum’s image bank, and copies will also be provided to the scholar. For 
additional information, see the museum’s Outside Request Guidelines.

The following information outlines how to request images of objects from the Egyptian Museum’s 
collections. Please allow a minimum of six weeks for the processing of requests.

General Guidelines

All requests must be in writing.

When making a request, please include clear object descriptions, and, if possible, museum 
identification numbers; please indicate a specific view (front, back, left, or right) if desired (see 
attached form). Please restrict each request to 20 images or less.

Images supplied by the museum may not be cropped or altered in any way without prior 
approval in writing from the Supreme Council of Antiquities (SCA).

All information disseminated about objects for which images are provided by the museum must 
be correct, as determined by the museum.

Note that all images remain the property of the Egyptian Museum, Cairo. The credit line for each 
image should be as provided by the museum for each photograph. This credit line must be 
displayed with the image in printed and web materials and at the end credits of all film, video or 
TV productions.

Low Resolution Images:

Requests for low-resolution reference images may be sent to:

Head of Documentation

Egyptian Museum

Midan Tahrir

Cairo, Egypt

emcregistrars@gmail.com

Permission to use low-resolution images on the web for non-exclusive commercial purposes (i.e. 
for a for-profit web site) must be requested in writing, and an annual fee of $50 per image must 
be paid to the museum. 

To request one or more EMC images for commercial use on the web:

1. Fill out the attached form, specifying the ID Numbers (if known) and a brief description or title 
for the object, and send it to:
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Head of Documentation

Egyptian Museum

Midan Tahrir

Cairo, Egypt

emcregistrars@gmail.com

 Include a cover letter, addressed to:

Dr. Zahi Hawass

 Secretary General of the Supreme Council of Antiquities

 3 Adel Abu Bakr Street

 Cairo, Egypt 

This should detail the following:

 Name of Organization

 Web address

 Purpose of web site

2. The museum will send you an invoice via email, along with wiring instructions.

3. Once payment has been confirmed, the image or images will be sent to you electronically. The 
images will be sent as jpegs, at a pixel size of approximately 2,000 by 1,500. 

4. Permission to use these images must be renewed on an annual basis.

High Resolution Images:

High-resolution digital images of objects in the museum’s collections can be obtained for 
commercial or scholarly use according to the following guidelines and fee schedules.

Permission for use may not be transferred to a third party, and no photographic materials, digital 
files, or their derivatives may not be transferred to any other user.

For Commercial Use:

The fee for one-time, non-exclusive, commercial use (defined as one edition, one publication 
and one print run for print media; or one film, video, or TV production) of an image from the 
EMC collections is $150. This fee is non-negotiable. Additional uses or future reuse must be 
applied for and paid for separately, on a per image basis.

To request one or more EMC images for one-time commercial use:

1. Fill out the attached form, specifying the ID Numbers (if known) and a brief description or title 
for the object, and send it to:

Head of Documentation

Egyptian Museum

Midan Tahrir

Cairo, Egypt
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emcregistrars@gmail.com

 Include a cover letter addressed to:

 Dr. Zahi Hawass

  Secretary General of the Supreme Council of Antiquities

  3 Adel Abu Bakr Street

  Cairo, Egypt

 This should detail the following:

  Title of publication

  Name of author(s) or editor

  Publisher

  Date or anticipated date of publication

  Print run

  Language(s)

2. The museum will send you an invoice via email, along with wiring instructions, for immediate 
payment. Please inform the museum when you have made payment, and include the date and 
any other relevant payment details.

3. Once payment has been confirmed, the image or images will be sent to you electronically. The 
images will be sent as tiffs or jpegs, at a pixel size of approximately 4,000 by 2,500. 

4. Once the images have been published, the requester is responsible for providing, at their own 
expense, two copies of the publication to the SCA. These should be sent to the Head of 
Documentation at the EMC (see above address). If these copies are not received within three 
months, future requests will be denied.

For Scholarly Use:

There is no fee for one-time, non-exclusive (defined as one edition, one publication, and one 
print run for print media; or one film, video, or TV production) scholarly use of museum images.

Scholarly use is defined as follows: The publication must be non-commercial in purpose, for 
educational, scholarly, and/or academic purposes, and if printed must have a print-run of less 
than 5,000.

To request EMC image(s) for one-time scholarly use: 

1. Fill out the attached form, specifying the ID Numbers (if known) and a brief description or title 
for the object, and send it to:

Head of Documentation

Egyptian Museum

Midan Tahrir

Cairo, Egypt

emcregistrars@gmail.com
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 Include a cover letter addressed to:

Include a cover letter addressed to:

 Dr. Zahi Hawass

  Secretary General of the Supreme Council of Antiquities

  3 Adel Abu Bakr Street

  Cairo, Egypt

 This should detail the following:

  Title of publication

  Name of author(s) or editor

  Publisher

  Date or anticipated date of publication

  Print run

  Language(s)

2. If the request is approved, the image or images will be sent to you electronically. The images 
will be sent as tiffs or jpegs, at a pixel size of approximately 4,000 by 2,500.

3. Once the images have been published, the scholar is responsible for providing ten copies of 
the publication to the SCA. These should be sent to the Head of the Department of Foreign 
Missions (Dr. Mohamed Ismail; 3 Adel Abu Bakr Street; Zamalek, Egypt; 
sca_missions2@hotmail.com). If these copies are not received within three months of 
publication, future requests will be denied.

NOTE: Please be aware that failure to follow the proper procedures will result in the automatic 
denial of further requests. 
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55. SCA-EMC Rights and Reproductions Policy - internal
High-resolution copies of all photographs taken by museum and outside photographers should be 
provided immediately to the Registration, Collections Management, and Documentation 
Department of the Egyptian Museum, Cairo (RCMDD). The RCMDD will store these, properly 
identified as to object ID number, photographer name, and photograph date, in the EMC 
database.

All outside requests for object images must be approved by the SCA Secretary General. 

All requests for object images will henceforth be processed by the RCMDD, according to the 
following guidelines:

Low Resolution Images:

Scholars can receive low-resolution images for reference purposes directly from the RCMDD.  No 
signed permission is necessary.

Permission to use low-resolution images on the web for non-exclusive commercial purposes (i.e. 
for a for-profit web site) must be requested in writing, and an annual fee of $50 per image must 
be paid to the museum. Permission to use these images must be renewed on an annual basis.

High Resolution Images:

High-resolution digital images of objects in the museum’s collections can be obtained for 
commercial or scholarly use according to the following guidelines and fee schedules.

Permission for use may not be transferred to a third party, and no photographic materials, digital 
files, or their derivatives may be transferred to any other user.

For Commercial Use:

The fee for one-time, non-exclusive, commercial use (defined as one edition, one publication 
and one print run for print media; or one film, video, or TV production) of an image from the 
EMC collections is $150. This fee is non-negotiable. Additional uses or future reuse must be 
applied for and paid for separately, on a per image basis.

For Scholarly Use:

There is no fee for one-time, non-exclusive (defined as one edition, one publication, and one 
print run for print media; or one film, video, or TV production) scholarly use of museum images.

Scholarly use is defined as follows: The publication must be non-commercial in purpose, for 
educational, scholarly, and/or academic purposes, and if printed must have a print-run of less 
than 5,000.

Processing Procedure:

When a request for one or more EMC images for any of the above purposes is received by the 
RCMDD, the office will submit the request to the Secretary General for approval.

If the request is received by the Museum Director, it should be given to the RCMDD to submit to 
the Secretary General.
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If the request comes directly to the Secretary General, he will approve or deny it, and his office 
will pass the approved or denied request to the RCMDD.

If approval is denied; the RCMDD will inform the requester of this fact.

If approval is granted:

1. The RCMDD will ascertain whether or not adequate images exist in the museum’s Image Bank. 
If there are images already, they will send the images as per the procedures and fees below (3-5).

2. If new images need to be taken, the RCMDD will give the museum director a copy of the 
signed request and a list of the images needed, along with the names of the section heads 
responsible for the relevant objects. The director's office will be responsible for making sure the 
pictures are taken promptly by assigning a museum photographer to the request, and then 
passing the request and list on to the Egyptian Museum’s administrative office. This office will 
make copies of the letter and distribute them to all the relevant parties.

3. The RCMDD should be notified as soon as a photography session is scheduled. A registrar 
must be present while the objects are being photographed, and a copy of the images must be 
given to the RCMDD immediately.

4. NOTE AGAIN: only the RCMDD is authorized to distribute images. Museum photographers 
and curators should NOT give images to scholars and will be penalized if they do so.  Scholars 
who attempt to take images directly from a museum photographer may risk being banned from 
the Egyptian Museum in the future.

5. If there is no fee involved, the RCMDD will send the image or images electronically, as tiffs or 
jpegs, at a pixel size ranging from approximately 2,000 by 1,500 to 4,000 by 2,500, depending 
on their purpose, via pando.com.

6. If there is a fee involved, the RCMDD will send the requester an invoice via email, along with 
wiring instructions for payment. Payment must be confirmed by the SCA financial office, in the 
form of a fax addressed to the RCMDD. Once the RCMDD has received a faxed confirmation 
from the SCA financial office, they will send the image or images electronically, as tiffs or jpegs, 
at a pixel size of approximately 4,000 by 2,500, via pando.com. 

Follow-up

Once the images have been published, the requester is responsible for providing, at their own 
expense, two copies of commercial publications and ten copies of scholarly publications to the 
SCA. 

 a. Commercial publications should be sent to the Head of Documentation at the EMC. If 
 these copies are not received within three months, all future requests will be denied. 

 b. Scholarly publications should be sent to the head of the Department of Foreign 
 Missions (Dr. Mohamed Ismail; 3 Adel Abu Bakr Street; Zamalek, Egypt; 
 sca_missions2@hotmail.com).

 Failure to follow the proper procedures will result in the automatic denial of further 
 requests.
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56. Handbook for Outside Users
The project has a small handbook that can be give to outside users, mainly scholars, to help them 
use the tools in the office. The text of this handbook is included here:

56.1. The Search Database
You can search for different ID #s for an object using the old Search database. You can do a 
search by JE, CG, TR or SR.

• Type the relevant number, without 
a code, in the relevant Registration 
No. box. For TR numbers, use 
slashes rather than periods (e.g. 
1/3/15/24). When searching by an 
SR #, type the section number in 
Section box, and the sequential 
number in both the Sr. from and 
Sr. To boxes.

• Click Start Search

• Once your results have been 
returned, you can double-click on the record you 
want, or highlight the record and click on the Details 
button to see the complete record. This will give you 
any other ID numbers that are recorded in this 
database.

Note that there are many errors here, so 
DO NOT assume the information is 
correct. Also, Search only finds exact 
matches. If you want to find JE 12345a, 
you have to type in 12345a. Wildcards do 
not work. In addition, the way the 
numbers are written can be quite random: 
for example, JE 12345a might also be 

written 12345 a (with a space), which you can only find by typing in exactly. 
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56.2. Using the Register Book Facsimiles on Filemaker

You can use the register book facsimiles on Filemaker to browse through museum’s register books 
(JE, CG, TR, SR), as well as Porter-Moss.

Step 1: Log into the database by choosing the 
radio button for Guest Account and pressing 
OK.

Step 2: You can choose the register book series 
you want from the buttons on the top of the 
page or by using the dropdown menu on the 
left. 

   

Step 3: Once you’ve chosen the book series you can search by either the name of the book or for 
a certain object using its ID # in that series (i.e. if you want to find an object by its JE #, search in 
the JE books).

• Searching by ID number

You can search by choosing Apple + F or pressing the magnifying glass icon for in the upper left 
corner of the page. The database will now be in search mode.

Type the ID # to the fields on the left side. You have to enter the number 
in right format. 

JE: JE 12345

CG: CG 12345

TR: TR dd.mm.yy.SN – use dots, not slashes. (eg. TR 24.2.21.1)

SR: SR N/ 1234 (N being the section number). If you don’t know 
the section the object belongs to, you can just search, for 
example, for 1234 and find it in all the SR sections, and then scan 
the found set of records to find the object you’re looking for.

PM: you can search for any of the above.

Press the Find button (or Return/Enter on your keyboard).
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The database will give you one or several pages to which the number has been linked. 
You can browse these by using the arrow button on the left of the page. The database 
tells you how many pages it has found under the arrow. 

On the pages, you can zoom in and out by using the mountainview icons 
in the lower left corner of the page.

If you are reading a page in a register book and wish to move to the previous or following page in 
the same book, you can choose Apple + J. This will bring up all the pages in the register book 
series you’re browsing. They should be in the right order, if not, you can sort them (Apple + S, 
then tell the database to sort by Filename).

• Searching by Register Book

If you 
know 
which 
register 
book you would like to browse, you can search the database for the whole book. The name of the 
book will be the beginning of the filename, so you need to enter this in the Filename field on the 
bottom of the page. 

You need to enter this in right format to find the book.  For different book series use:

JE: JE_IX_

TR: TR_IX_

SR: SR2.4_

CG: consult CG book list 

For example, enter SR2.4_ and press Find.  This search should bring back the whole book -- 
Section 2, Book 4. To make sure pages are in right order, sort them by pressing Apple + S, and 
highlight Filename on the left. Press Move, and Sort.
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57. Instructions for Intranet Use for Outside Users
Visiting scholars wishing to use the database on Intranet need to read the instructions below and 
sign a form to indicate that they have understood and will follow them.

Please read the instructions below carefully before using Registration, 
Collections Management and Documentation Department (RCMDD) computers:

A scholar must schedule his/her visit to the RCMDD, in advance, by selecting a time 
slot and entering his/her name and the date on which s/he wishes to work in the 
“Schedule for Intranet Use by Scholars.” Scholars who drop in without scheduling their 
visit may only work if one of the two computers assigned for scholars is available and 
will be asked to leave if the time for a scholar's scheduled visit arrives.

Scholars must wait to be seated by one of the registrars before they can start to work.

A scholar can use a computer for a maximum of 90 minutes per day.

Only one scholar is permitted to use a computer at a time. Scholars who are not using 
a computer should wait outside the RCMDD office.

Use of flash drives, external hard drives or CDs on RCMDD computers is strictly 
prohibited.

No cameras are allowed inside the RCMDD office.

Scholars may NOT photograph, photocopy or scan register book pages.

Scholars may ONLY use pen and paper to copy data. Other methods of data transfer 
are strictly prohibited.

If additional information or photographs are needed, scholars should fill out an outside 
request form and submit it to a member of the RCMDD staff.

Scholars can only use the RCMDD computers to access the intranet. They are not 
permitted to open or use any other program.
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When done working on a computer scholars should inform one of the registrars to log 
out for them.
 
Failure to follow the instructions above may result in the banning of the scholar from 
using the intranet in the future and the rejection of any future requests submitted by 
him/her to the RCMDD.
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58. Manual de Codage
Transliterations of hieroglyphic names in the database are done using the manual de codage, 
which uses normal English letters to render ancient Egyptian alphabetic sounds. The following 
table shows the correspondences from traditional transliteration to the MdC.
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59. Protocol for processing GEM object movements
The RCMDD has decided not to attend GEM committees to move objects out of the EMC, 
because the office cannot process and properly cross-check as many objects as are moved -- up 
to 450 objects weekly. However, at the end of each week, the RCMDD will be given a full set of 
photos of the objects that have been packed to move out and will carry out minimal processing 
of these objects in the database.

Keep in mind that the principal goal is to track what objects have left the museum and gone to 
the GEM, and when. Further cleanup of the relevant records can be done in the future. The team 
does not have time to process the object records fully, but will have the following:

• An image of the object;

• Most or all of the EMC ID numbers associated with the object (although we will not be able 
to guarantee that all of these are correct);

• The new GEM number;

• The date on which the object left the EMC;

• The information that the object has gone to the GEM.

Step 1: Select and reorganize images and import them into the Multimedia Module

• Folders given to us by the GEM are organized by date. Within each dated folder are a number 
of unnecessary subfolders containing multiple images of each object. You will choose one or 
two images of each object and delete the rest. To do this:

• Create a new folder and name it according to our protocol, e.g. “Ahmed_Mohamed-
Elhami_Aly_2010-04-10.” 

• Look through the images by using icon view, list view, or Apple-Y. Choose at least one image 
for each object and drag it to the new folder. Do not include duplicates, but in some cases, 
you will want to include both a front and back view of the object. 

NOTE: Do not rename the images as per our usual protocol; leave them with the default 
filenames given to them by the camera.

• Delete the original folder and all its subfolders.

• Import the images from the new folder into the Multimedia Module using the Import Tool.

NOTE: If the photos will not be imported immediately, move the renamed main folder to 
the Ready to Import folder (as per our usual protocols).

After they have been imported, your images will appear in a list in the Multimedia Module. Save 
the list as a group (see Creating Static Groups) and name it GEM and the date of the folder e.g. 
GEM_2010-06-02. 

Step 2: Link image to object (Catalogue Module, Multimedia Tab) 

• When you are ready to work on the group, open it in the Multimedia Module. Choose View 
Details so that you can see the image. This should include the principal ID numbers (SR and 
GEM numbers) of the object, which are on a board. 
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• Find the correct catalogue record for the first image (see Finding ID Numbers). If there is not 
yet an object record that includes the SR number, try to find the object by checking the SR 
facsimiles and then searching by the JE, CG, or TR cross-referenced there. Make sure the 
image matches the title and description of the object! If it does not, call in a senior checker to 
help you (but make sure you pay attention to how they search for the object, so you can try it 
yourself next time). If no record exists under any of the ID numbers, create it.

• Link the image to the catalogue record. 

• NOTE: Keep the found set/group in the Multimedia Module open in Detail view. 

Step 3: Add ID numbers and status (Catalogue Module, Title Tab) 

Fill out the following fields: 

• ID Numbers: add all ID numbers associated with the object to this field, including the GEM 
number (visible on the number board in the image). You do not need to order them according 
to the usual protocol, both to save time and so that the team knows that the record has not 
been fully cross-checked. 

• Main Title: check that the title matches the image.

• Other Museum: write the GEM Number here.

• Object Status: choose Other SCA Museum.

• Object Rating: Leave this field blank.

• Requested by GEM: choose the radio button  “Yes.”

Step 3: Add movement and new Permanent location (Catalogue Module, Location Tab) 

Fill out the following fields:

• Permanent Location and Current Location fields: [From Committee] – GEM. 

• Purpose: Permanent move out of Museum.

• Date Moved: the date of the movement (the date when the photo was taken).

• Registrar: Not present.

NOTE: According to our normal protocols, if a registrar does not attend a movement, s/he should 
fill out a movement form and ask the Heads to write a memo to the Museum Director, as per our 
Object Movement protocol. These steps should be skipped here.
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